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FOREWORD 
 
This 3rd Edition of the SALT text brings you all the details you need to master 
language sample analysis in the most expeditious manner using the most recent 
version of the software, SALT 20. The chapters detail the process, the reference 
databases, and specific issues you will face in practice. There are chapters 
covering how to code dialect, fluency, and written language. And there is a 
chapter filled with case studies that will shed enormous light on just how 
important language sample analysis (LSA) is to the diagnostic process. Use the 
material in this text to supplement the free online training materials available 
on the SALT website.  
 
Our aim has always been a strong dedication to improving and facilitating the 
assessment of language acquisition and disorders through the use of language 
sampling. We are happy to report the use of LSA in research and practice 
continues to increase and is considered part of best practice in the assessment 
of Spoken Language Disorders.  
 
Communication is central to daily living, whether in person, in writing, or via 
phone, FaceTime, or social media platforms. Good communication skills are 
essential at work or in school, at home or with friends. And LSA is the most 
comprehensive and authentic method of evaluating spoken communication 
skills. In the school setting, LSA provides you the opportunity to assess student 
language within contexts fundamental to the curriculum; conversation, 
narration, exposition, and persuasion. It helps you understand how student 
language skills compare with peers’, documenting strengths and weaknesses. 
LSA can be used to track progress, validate other assessments, and support the 
need for services or dismissal from services.   
 
Although we’ve streamlined the process of LSA, we understand there is time 
and effort involved in eliciting and transcribing language samples. The 
arguments for putting in the time and effort far outweigh skipping the process 
or minimizing it to an extreme. The outcomes from a thorough analysis of the 
language produced, in the manner in which it was spoken, yield a valid picture 
of real-life communication skills. No other method of assessment can do this. 
Someday we may have speech recognition software that takes a recorded 
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sample and accurately converts it to text - every part we are interested in - the 
filled pauses, repetitions, revisions, part-word productions, and the errors. At 
present, this technology is not available. So we take the time to elicit and 
transcribe our language samples, and use SALT to quickly and easily generate 
the assessment reports. We continue to use best practices in the assessment of 
spoken language.  
 
Because this text is in your hands, it is our hope that you will be a user and 
proponent of LSA in your practice. Whether you work with children or adults, 
assessment of spoken language should include a look at functional, natural 
language production in real-life contexts via language sample analysis.  
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CHAPTER 

1 
 

Introduction to LSA Using SALT 
 

Jon F. Miller 
Karen Andriacchi 
Ann Nockerts 
 
Language sample analysis (LSA) is the only assessment measure that captures a 
speaker’s typical and functional language use. Although traditional standardized 
tests play an important role in spoken language assessment, LSA shows how 
language is put to use in the home, with friends, at school, and within the 
community.  
 
The goal of this book is to show how LSA using Systematic Analysis of Language 
Transcripts (SALT) software can be used to measure the real-life spoken 
language of essentially any speaker. SALT standardizes the entire LSA process 
from selecting the sampling context to interpreting the results, thus giving 
consistent and reliable measures of spoken language. 
 

Background: The History of LSA 
 

Language sample analysis has a long history as a tool used to investigate 
language development. Studying what children said over time was seen as a 
reasonable index of what they knew. Since the stream of speech is transitive, 
writing down exactly what was said created a permanent record. This record 
made evident the words and sentence structures used and how they changed 
through childhood. Because this process required writing down by hand what 
was said as it was spoken, it was limited by the rate of speech and by the 
attention of the investigator. Also, there was no way to verify the accuracy of 
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the record. As electronic recording equipment emerged, investigators recorded 
speech samples for later transcription. They were no longer limited by the 
speaking rate or the length of the sample. Larger samples increased the 
likelihood of capturing every vocabulary word and grammatical feature the child 
was capable of using at that time. Systematic investigations of several children 
at a time were undertaken in the 1960s, electronically recording samples every 
few weeks. These studies made a number of ground breaking discoveries that 
radically changed our views of language development from a passive imitation-
based process to an active rule-based process. This work revived research 
interest in language development and promoted interest in children who 
experienced difficulty developing language.  
 
The most prominent example of this work was Roger Brown and his students at 
Harvard (Brown, 1973). Brown and his students recorded samples of more than 
700 utterances from three children every few weeks, capturing their 
advancement from single-word utterances to utterances that were four to five 
morphemes in length. These samples were transcribed and grammars were 
written for each child following linguistic discovery methods. This approach 
revealed two major discoveries; first, children were constructing grammatical 
rules for producing utterances longer than one word that were consistent across 
children. Second, these grammars advanced systematically as utterance length 
increased. Mean utterance length defined stages of syntactic development up 
to utterances five morphemes in length. These concepts seem commonplace to 
us now, but at the time they were revolutionary and prompted a great deal of 
research on all aspects of language development. Those of us interested in 
language disorder followed this work with great interest and used the LSA 
methodology to develop measures of syntax using the findings of the research 
on language development in typical children. These measures focused on 
identifying the types of sentences used at the different stages of development. 
 
The use of very large language samples was impractical for clinical work, but LSA 
was still viewed as an essential part of clinical problem solving. Several clinical 
measures of syntax which emerged from research have withstood the test of 
time and are in use today; Developmental Sentence Scoring (DSS, Lee & Canter, 
1971); Language Assessment, Remediation, and Screening Procedure (LARSP, 
Crystal, Garman, and Fletcher, 1976); Assigning Structural Stage (Miller, 1981). 
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These measures were calculated by hand from conversational samples between 
mothers and children. As time consuming as these measures were, the results 
provided a detailed account of a child’s syntactic development.  
 
This early work provided the pathway for identifying language delay in children 
using tested methods that had at least some data from research studies. These 
efforts elevated LSA from a descriptive method to a criterion referenced 
method when using summary data from the developmental literature to 
interpret the results (Miller, 1981). The key components from this early 
research, powerful for both researchers and clinical practitioners, have driven 
the revitalization of the LSA process with the use of computer technology. It is 
agreed within the field that LSA is an essential component to the assessment of 
spoken language. Best practice guidelines (per ASHA) across a number of 
populations, including developmental delays, specific language impairment, and 
autism spectrum disorders, suggest LSA as an approach to 1) problem solve 
language differences or deficits, 2) generate clear goals for intervention, and 3) 
assist in monitoring progress. 

 
LSA Has Stood the Test of Time and Should Be Part of Your Clinical Tool 
Set 
 
Re-thinking the LSA process 
The LSA process provides a way to preserve the auditory speech signal for 
analysis. Representative samples of spontaneous language provide direct access 
to language use in everyday communication. Historically, listening to and 
transcribing the sample by hand, using paper and pencil, was the method for 
this procedure. This wasn’t as simple as one might think. In order to accurately 
and authentically capture the language, rules to define utterances, words, and 
morphemes had to be created, and they had to remain consistent. To analyze 
the transcript required manually counting words and morphemes per utterance 
as well as the number of different words produced across the sample. To 
interpret those results required knowledge of language development through 
direct experience with children and knowledge of the research literature on 
language development. Without this knowledge, one was unable to document 
what constituted typical, or atypical, oral expression of three, four, or five-year-
olds. Rigorous as LSA was, it did not fall to the wayside even when it was all 
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done by hand. This difficult and time-consuming process was far too valuable to 
abandon, and our efforts have focused on making the process more accessible 
for clinical use. Since the mid-1980s SALT has employed computer technology to 
standardize the LSA process. We now have a defined transcription system, high-
speed analyses in all domains of spoken language, and databases of typical 
speakers to facilitate the interpretation process.  
 
How LSA provides insight into language use  
Even difficult-to-test individuals have some means of communicating. Usually 
direct observation of communication with familiar partners, such as family 
members, provides insight into the frequency and complexity of their language 
use. Recording and transcribing this language allows for a detailed analysis at all 
language levels. Additional samples can be recorded at home or school to 
complete the communication profile. Analysis and interpretation of these 
samples is enhanced with the use of SALT by providing instant analysis at all 
language levels. Reference databases provide sets of typical age-matched or 
grade-matched peers for comparison to aid interpretation of the results. LSA 
provides a key resource for the resolution of complex clinical problems and 
allows for monitoring change over time in everyday communication contexts.  
 
A review of key features  
There are a number of key features of the LSA process that have prompted its 
continued use and motivated its revitalization and improvement.  
 
1. LSA is flexible. It allows for multiple analysis of the same sample, offering 

many different views of the speaker’s performance in each of the language 
domains; syntax, semantics, and discourse. LSA can be used with anyone 
who can produce language regardless of cognitive, perceptual, or motor 
ability. Speakers who have challenges such as learning a second language, 
speaking a dialect, developmental disabilities, or who are on the autism 
spectrum are excellent candidates for LSA. Additionally, LSA is culturally 
unbiased; if the examiner is sensitive to cultural characteristics, bias will be 
eliminated. 

 
2. LSA is repeatable. Language samples can be recorded daily, weekly, or 

monthly to document change in performance or to note differences 
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between spoken language tasks such as conversation and narration. 
“Everyday” language, authentic to the speaker, is elicited in natural and 
functional communication contexts (i.e., in an uncontrived setting) as often 
as deemed necessary. Because a language sample is basically a snapshot of 
the speaker’s typical spoken language, realistic therapy goals, which highly 
impact communication and language learning, can be developed directly 
from the analyses. From the assessment we learn how the speaker puts to 
use his or her knowledge of the language. As soon as we know this, we then 
have an avenue for remediation. Once intervention is underway, 
generalization of skills can be readily assessed and documented by eliciting 
another language sample. Test-retest reliability issues, which can be a 
problem with standardized measures, are not a factor in LSA.  

 
3. LSA is valid. It documents change in everyday communication skills or in 

spoken language requirements in school. Performance on grade-level state 
and school district standards can be documented through the use of LSA. 
Examples might include the ability to debate or produce an exposition such 
as “how the heart pumps blood” or “how a bill becomes a law”. Research by 
Miller, et.al. 2006, found significant correlations between several measures 
of oral narrative performance and reading achievement in both Spanish and 
English. The higher children’s oral narrative language skills were in either 
language, the higher their reading scores. The measures of oral narrative 
skill taken from Miller’s story retell protocol predicted reading scores better 
than the Passage Comprehension subtest from the Woodcock Language 
Proficiency Battery Revised: English and Spanish (1991). 

 

4. LSA is accountable. It can measure language growth at all levels and at 
frequent intervals to meet evidence-based practice standards. LSA 
augments standardized measures and can substantiate the results of those 
measures as well as the reason for referral. It is important to know how a 
child performs compared to his or her peers using the norms from 
standardized tests. Standardized tests are required by school districts to 
qualify students for speech-language services but their sensitivity in 
diagnosing language disorders is inconsistent. They tend to look at language 
use narrowly, requiring only morpheme, word, or phrase responses. 
Whereas, LSA assesses spoken language from a functional use perspective. 
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A student with language impairment could score within the average range 
on some standardized measures yet fail to retell a coherent narrative or 
provide an organized exposition. 
 

5. LSA aligns with Common Core State Standards. Implementation of the 
Common Core State Standards inherently requires methods to measure 
outcomes, or progress, related to those standards. Speech-Language 
Pathologists are held responsible for measuring the progress of students on 
their caseload. Appendix U contains a table which illustrates how to link LSA 
using SALT software to the Common Core State Standards for Speaking and 
Listening in grades K-12. The table suggests the appropriate language 
sample contexts for eliciting samples that will reflect achievement of, or 
progress on, the Speaking and Listening core standards. Additionally listed 
are suggested measures in SALT that can quantify progress on a standard. 

 

Streamlining the Process to Make LSA Accessible 
 
LSA has always been time consuming, particularly in clinical settings. 
Transcription and analysis, sometimes still completed by hand, can take hours. 
Streamlining the process was a necessity in order for the benefits of the process 
to outweigh the arduousness of the procedure. Consistency of the process was 
historically a problem in terms of the types of samples, the length of sample, the 
different transcription procedures and rules used, and the specific analyses 
generated. Until computers came into general use, interpreting the results of 
language samples relied solely on the users’ knowledge of language 
development. There were no databases of typical children’s language 
performance in specific speaking contexts. 
 

Over the past 40+ years, there have been a few groups of researchers using 
computer technology to work out solutions to the LSA implementation 
problems. One group developed tools for child language researchers to enhance 
research productivity (McWhinney, 2000). A second group computerized 
analyses from classic research on language development (Long, Fey, & Channell, 
2008). The third group, the focus of this book, automated the LSA process, 
making it as standardized as possible by providing reference databases for 
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comparison (Systematic Analysis of Language Transcripts (SALT), Miller & 
Iglesias, 2015).  

 
SALT Solutions to Improving LSA Accessibility: Overcoming the barriers 
to efficient clinical use of LSA 
 
Since its inception, SALT has continually focused on developing solutions to 
make the LSA process quicker, easier, and more accessible for both clinicians 
and researchers. The improvements in computer technology, including more 
advanced programming languages, more sophisticated operating systems, and 
higher performing hardware, have improved the process of LSA. Fast-forward to 
the present day and consider how the current version of SALT improves the LSA 
process by addressing the most common misconceptions.  
 

Time:  It takes too much time to transcribe and analyze a language sample. 
The practice of eliciting 100 utterances (or 15 minutes) of spoken language was 
the standard for many years. LSA research shows that shorter, focused samples 
provide robust measures of language performance (Miller, et al., 2006). SALT’s 
transcription format uses minimal coding to gain maximal analysis outcomes. A 
story retell narrative, for example, with 3 – 6 minutes of talking, will take, on 
average, 15-30 minutes to transcribe, less time than it takes to give most 
standardized language tests. Our research has shown it takes roughly five 
minutes for a trained transcriber to transcribe each minute of spoken language. 
This assumes that the speaker is fluent and intelligible, the context is familiar, 
and the recording is of high quality. SALT analyses are generated in seconds. 
 

Consistency:  Consistency of the process is a problem in terms of the types of 
samples, sample length, transcription procedures and rules used, and the 
specific analysis performed.  
The SALT language sample elicitation protocols, transcription format, and 
computer analyses guarantee consistency across language samples. This 
consistency allows for comparison across speakers or within the same speaker 
over time. Sample length can be controlled within SALT. Comparisons can be 
made using same amount of elapsed time, same number of utterances, or same 
number of words.  
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Interpreting the results: Interpretation of the results relies solely on the user’s 
knowledge of language development. There are no databases of typical 
speaker’s language performance in specific speaking contexts.  
SALT has moved beyond charts of typical development, though they are still 
useful. Our databases of several thousand typical speakers allow the user to 
compare an individual speaker to age-matched or grade-matched peers in the 
same speaking conditions. An individual’s performance can be monitored 
relative to typical language growth over time.  
 

SALT has improved the entire process of LSA at the sampling, transcription, 
analysis, and interpretation levels with: 
 

● detailed elicitation protocols used to collect the samples from typical 
speakers 

● transcription tools to facilitate the process, e.g., specialized editor and error 
checking routine 

● online contextual help systems to provide information wherever you are in 
the program; available using F1 key when in the SALT editor 

● instant analysis reports from standard measures of syntax, semantics, 
discourse, rate, fluency, errors, and omissions 

● databases of more than 7,000 typical speakers in a variety of speaking 
contexts to aid interpretation 

● automated comparison of the target sample to a set of age or grade-
matched peers selected from the relevant database in standard deviation 
units 

● routines to search transcripts for specific features, e.g., responses to 
questions or a list of the different words used and their inflections 

● analysis tables, a comprehensive narrative report, and selected utterances 
which can be incorporated into clinical reports 

● online courses and YouTube videos to take the learner through each step of 
the LSA process 
 

The strength of language sample analysis is its flexibility to capture language use 
in everyday communication contexts, accurately measuring lexical, morphemic, 
syntactic, discourse, rate, and fluency features of the same sample. This 
procedure has been a research staple for more than sixty years and has 
provided the means to document language development in typical and atypical 
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populations. The validity of this procedure is beyond question, and the reliability 
has been documented (Heilmann, et al., 2008). We established standardized 
protocols and transcription procedures for several genres and across ages 
(Miller, Andriacchi, and Nockerts, 2016). This led us to confirm the stability of 
the LSA measures calculated by SALT. 
 

Over the years, our research on LSA measures has produced a range of results 
that inform us about how these measures can characterize spoken language 
performance. Here is a summary of what we have learned about typical children 
and how LSA measures inform us about language production. 
 

 Mean length of utterance (MLU), number of different words (NDW), 
number of total words (NTW), and words per minute (WPM) significantly 
correlate with age in 3 – 13 year olds, r = .65 - .72. 

 MLU is longer and WPM is higher when producing a narrative than a 
conversation. 

 Children produce more mazes in narration than conversation suggesting 
narration is the more difficult context. 

 Number of mazes increase as utterance length increases. 
 Measures of MLU and SI increase as the difficulty of the context increases: 

conversation -> narration (story retell) -> exposition-> persuasion. 
 Short conversational samples produce relatively the same data as longer 

samples, i.e., 50 vs. 100 utterances. 
 Narrative story retell samples of 35 – 65 utterances provide stable and 

robust results. 
 Measures calculated from story retell samples predict reading achievement 

in Spanish and English better than the Passage Comprehension subtest from 
the Woodcock Language Proficiency Battery Revised: English and Spanish 
(Miller, et al., 2006). 

 Expository samples result in significantly longer samples with more complex 
syntax than conversation or narrative retell samples. 

 Persuasion samples are shorter than expository samples, but facilitate the 
production of more complex language.  

 Standardizing the LSA process results in reliable measures across ages and 
speaking conditions. 

 LSA produces valid measures of functional language use. 
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The remainder of the book provides detailed considerations of each step in the 
process; elicitation, transcription, analysis, and interpretation. Our goal is to 
walk you through the process of learning to use SALT to facilitate the clinical use 
of LSA. 



  

CHAPTER 

2 
 

Eliciting Language Samples 
 

Jon F. Miller 
Karen Andriacchi 
Ann Nockerts 
 
We have learned a great deal about language sample analysis as an assessment 
tool through our research and that of others over the past 40 years. Eliciting 
“the best” sample for an individual can be considered from several perspectives 
at this point in time. 
 

• Developmental. Sampling contexts expand with advancing age and ability 
level. Up through age four, children are acquiring conversational skills. After 
age four narrative skills emerge and branch into several narrative types such 
as personal narratives, story retell, and exposition. 
 

• Functional. Functional considerations focus on how language difficulties 
manifest themselves. In the preschool years, this will be language use in 
conversation. In elementary school years, language problems usually 
concern aspects of the curriculum which require oral narrative ability. This 
can involve written language as well. In the late elementary and early 
adolescent years, the curriculum requires expository abilities in spoken and 
written form, that is, explaining how to do something (find a library book) or 
how to play a game. Adults may experience difficulties in any one or all of 
these language genres. 
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• Precision of interpretation. SALT offers an additional consideration to 
selecting the type of sample to elicit, databases of typical speakers to 
improve the precision of interpretation. We have assembled databases of 
more than 7, 000 language samples from children 3 – 18 years of age in 
conversation, narrative, expository, and persuasive sampling contexts. 
Because we do not have complete sets of language samples for all ages 
across all possible speaking conditions, we are left with the challenge of 
finding the best sampling context to optimize language use and exhibit the 
language difficulty, with optimum opportunity to interpret the results. 
Ideally we want to select an elicitation context that fits the speaker’s spoken 
language abilities and reveals the language difficulty, with a SALT database 
to quantify the results. 

 

Selecting the Optimum Language Sample  
 
The optimum language sample for an individual will meet as many of the 
following objectives as possible. 
 
1. Provide maximum information about the speaker’s language 

▪ Vocabulary, syntax, semantics, and discourse 
▪ Structure and organization 
▪ Fluency, efficiency, and accuracy 

2. Motivate the speaker to do their best talking 
▪ Age appropriate  
▪ Attentive listener or conversational partner 

3. Identify speakers’ spoken language strengths and weaknesses within: 
▪ Community 
▪ School 
▪ Workplace 
▪ Family 

4. For school-aged children, clearly demonstrate the student’s difficulties with 
functional language regarding: 
▪ Classroom curriculum 
▪ State-wide spoken language standards 
▪ Social language use 
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5. Optimize opportunity to interpret results 
▪ Follow the relevant elicitation protocol 
▪ Adhere to SALT transcription conventions 
▪ Where possible, compare performance to typical speakers (SALT 

databases) 
 
These objectives will help guide you in choosing the sampling condition that 
best captures the spoken language issue(s) in question. 
 

Sampling Contexts or Genres  
 
A clear understanding of the different types of sampling contexts is inherent to 
a valid and effective language sample, and is central to implementing the 
objectives listed in the previous section. Research has demonstrated that each 
of the speaking contexts places different demands on the speaker and produces 
somewhat different results. For example, conversational samples help 
document discourse skills, while narrative, expository, and persuasion samples 
work well to illustrate organizational skills. The reference databases in SALT 
consist of samples from the following sampling contexts: 
 

• Conversation in play  
 

Conversation, where adults speak to children about ongoing events, is the 
basic platform for learning language. Children begin to respond with 
gestures or verbalizations, such as ba-ba, da-da, ma-ma, that are received 
with delight and interpreted to mean whatever is relevant. As 
understandable words appear and word combinations signal the emergence 
of grammar, language learning accelerates with rapid gains in every aspect 
of verbal communication. Samples of conversation can be recorded as soon 
as children can be understood and throughout the life span.  
 

Young children are most comfortable conversing while playing and are likely 
to talk more with familiar partners than strangers, e.g., parents versus 
newly encountered adults. Although most young children tend to talk more 
in play situations, this should be confirmed for each child. The play context 
can be adjusted to meet individual preferences, individual interests, gender, 
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culture, and experience. Consider that some children may prefer novel 
versus familiar toys. Discussion with parents may be helpful in selecting the 
optimum talking contexts and partners. Parents are usually the most 
familiar conversational partners, and often can elicit the most talk. 
Professional examiners can direct the language sample by pointing out 
situations to talk about and asking questions of increasing complexity; 
yes/no, what, where, why, or when, for example. Play samples are most 
productive up to about age four or five, after which the child will usually talk 
to an adult about a topic without physical interaction with objects. This is a 
somewhat variable ability in typical children. Remember, the goal is to 
record the best language use possible. When the play session is completed, 
confirm with the parents as to the validity of the sample. 
 

Play-based language samples are particularly useful when evaluating the 
communication skills of late talkers, individuals with developmental 
disabilities, those on the autism spectrum, and those with neurological 
disorders. Consider that recording language samples in play offers the 
opportunity to evaluate communication in the individual’s most productive 
medium, demonstrating his or her optimum language use.  
 

Play is the natural context for language learning and the most comfortable 
method of interaction with toddlers when evaluating language. A good 
sample of play is child initiated. Samples of interactive play not only give an 
authentic picture of current levels of language production, they can also 
reveal non-verbal behaviors that go along with communicative 
development. Where non-verbal behaviors are important to analyze, 
samples of play should be videotaped in order to assess both verbal and 
non-verbal communication skills.  
 

Samples of children producing utterances of two words or less can probably 
be transcribed by an observer as the child is talking. With utterances longer 
than two words, a recording of the speech is necessary to insure an accurate 
record of language use. Keep in mind that children talk more as they get 
older. The length of the sample will need to be sufficient to allow 
opportunity to display their best spoken language skills. 
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• Conversation with adult partner  
 

Conversational samples uniquely document the use of oral language to 
exchange information at a spontaneous level. Conversations are governed 
by the rules of discourse and, as such, they offer insight into the social 
aspect of language use. From a conversation we can assess the speaker’s 
ability to orchestrate turn taking, topic initiation and maintenance, and 
ability to repair breakdowns in communication. In a conversation, speakers 
must follow certain conventions. For example, they must listen attentively, 
limit interruptions, say only what needs to be said, and say what is true. 
These conventions are learned by talking. Speakers get better at conversing 
as they get older and have more experiences initiating topics, staying on 
topic, responding to questions, providing more utterances per turn, and 
using more diverse vocabulary and longer utterances.  
 

Conversation, with both familiar and unfamiliar partners, allows for careful 
description of the social use of language. Eliciting conversational samples 
places more responsibility on the examiner than any other context. 
Examiners need to monitor their language to engage the speaker in 
conversation while having the least influence on the speaker. To do this, 
examiners should ask open-ended questions rather than yes/no questions, 
and should allow the target speaker to introduce new topics. Eliciting a 
conversational sample is like talking with your grandmother to find out what 
life was like when she was growing up; you get to listen a lot and say 
encouraging things to express your interest. Hopefully she will do most of 
the talking – which is the point of the conversation.  
 

Conversational samples are particularly useful in documenting language 
abilities of children and adults diagnosed with autism spectrum disorder and 
the related diagnosis of social communication disorder. These samples 
provide access to the social aspects of communication, such as listening, 
initiating and responding on topic, adding new information, responding to 
requests for clarification, answering questions, and allowing the partner to 
speak. 
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• Narration - story tell or retell 
 

We engage in narrative language when we tell someone about an event 
attended, a book, a T.V. episode, or a movie. Narrative samples, in general, 
require less interaction from the examiner as the focus is on the target 
speaker to tell or retell a story. The examiner introduces the task, helping 
the speaker identify a story to tell or reviewing a specific story to retell. 
After that, it is up to speaker to proceed with as little coaching as possible. 
Narratives require remembering sequences of actions or events that must 
be told in order to form a coherent text. Narratives emerge between three 
and four years of age. However, our research reveals that narrative ability is 
not consistent until after age four. Our work also documents that children 
produce longer and more complex utterances in narration than in 
conversation.  
 

Where conversations are utterance based, narratives are text based, formed 
by many utterances produced in a logical order to convey the information. 
Narratives fall into two groups for language sample analysis purposes, 1) 
narratives where the speaker knows the content but the examiner may not, 
and, 2) narratives where both the speaker and the examiner know the 
content. Event narratives entail relating an event experienced directly. 
Telling a story from memory, relating a movie or an episode of a TV show, 
making up a story, or retelling a story just heard are also types of oral 
narratives. There are excellent reasons to consider each type of narrative, 
determining the optimum language sample to collect. If you let the speaker 
choose the story, you may foster individual motivation to tell the best story. 
If you choose the story, you can interpret the content and vocabulary in 
detail.  

   

• Narration - expository 
 

When we impart information, such as how to do something or how to play a 
game, we are engaging in exposition, also called procedural narration. 
Expository skills are acquired later in childhood through adolescence. 
Research documents exposition produces more complex syntax than story 
retelling or conversation (Nippold, 2010). Exposition in spoken and written 
language is part of every state’s instructional standards from middle 
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elementary through high school. This suggests that expository language 
samples are an excellent choice for late elementary, middle, and high school 
students, as well as adults. The most common expository task used in oral 
language research is the telling of how to play a favorite game. This can be 
an individual sport, a team sport, or a board game. Our research on 
exposition corroborates other studies documenting that speakers produce 
more complex language in exposition than in conversation or story 
narratives (Malone, et al., 2008; Malone, et al., 2010). Our research also 
documents that game types are equivalent in eliciting valid expository 
language samples. 
 

• Narration - persuasion 
 

Persuasion can be defined as “the use of argumentation to convince 
another person to perform an act or accept the point of view desired by the 
persuader” (Nippold, 2007). It figures prominently in academic standards, 
such as the Common Core State Standards, that cut across modes of 
communication: speaking, listening, reading, and writing (National 
Governors Association, 2010). The ability to persuade is required across the 
secondary curriculum. Acquiring persuasive skills is critical to success in 
college and career, and to full participation in social and civic life. 
Persuasion challenges students to take into account their audience’s 
perspective and to use complex language to express complex ideas. Our 
preliminary research indicates that this sampling context produces shorter 
samples than the expository task, but facilitates the production of more 
complex language. 
  

In general, consider eliciting conversational samples for children less than 4 – 5 
years of age because narrative skills are just emerging at about four years. We 
have found that narrative samples, particularly story retell, exposition, and 
persuasion expand the information we can glean from the language sample as 
they are more challenging than conversation and are central to language arts 
curricula in schools. The SALT narrative databases allow measures of vocabulary, 
syntax, rate, fluency, and textual content and structure relative to age or grade-
matched peers reported in standard deviation units. Narrative samples require 
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less examiner vigilance, increasing examiner confidence in the reliability of the 
sample.  
 

Sample Length 
 

How long does a language sample need to be to ensure a valid reflection of oral 
language performance? This question has been asked repeatedly over the years. 
The answer is, as you might expect, it depends. We have spent a great deal of 
effort addressing this issue as it reflects on all other aspects of the LSA process. 
Shorter samples are faster to elicit and transcribe. But will they include the 
important features of language under scrutiny? Our original target sample size 
of 100 utterances, which turned out to produce consistent results across 
children of the same ages, could be recorded in 10-12 minutes and transcribed 
in 60 – 90 minutes. Subsequent research determined that smaller samples 
produced similar results in a much shorter time frame. Conversational samples 
of 5 minutes in duration resulted in approximately 50 utterances, cutting 
transcription time in half. We also learned that children talk more as they get 
older so it takes longer to elicit a sample of 50 utterances from a three-year-old 
than a 5-year-old. In fact, there is a linear relationship between age and amount 
of talking per unit time. Children having difficulty with spoken language usually 
take longer to produce a reliable language sample. For more information on the 
impact of sample size on outcome measures, read the article Language 
Sampling: Does the Length of the Transcript Matter? by Heilmann, Nockerts, and 
Miller, J. (2010).  
 

SALT Reference Databases 
 

Participants included in the SALT databases vary in age, gender, socioeconomic 
status, and geographic location. Different elicitation protocols were used to 
collect the samples, and each sample included in a database was elicited 
following the corresponding protocol. The participants in each database were all 
typically developing and reflected the range of SES and school ability in their 
communities, with no history of special education. Each database was the 
product of one or more research studies confirming stability of performance 
within ages and grades, and documenting changes associated with advancing 
age across a range of measurements. Selecting a sample type using these 
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sampling protocols allows you to create an age or grade-matched set of peers to 
document strengths and weaknesses. You can also elicit more than one sample 
type to make sure language production is representative of a variety of speaking 
conditions found in daily use. 

 

SALT Reference Database Samples Ages Grades Location Appendix 

Play 69 2;8–5;8 P,K Wisconsin A 

Conversation 584 2;9–13;3 
P,K,1,2,3,5,

7 
Wisconsin 
California 

B 

Narrative SSS 
(Student Selects Story) 

330 5;2–13;3 K,1,2,3,5,7 Wisconsin C 

Narrative Story Retell 
Frog, Where Are You? (FWAY) 
Pookins Gets Her Way (PGHW) 
A Porcupine Named Fluffy (APNF) 
Doctor De Soto (DDS) 

 
145 
101 
53 

201 

 
4;4–7;5 

7;0–8;11  
7;11–9;11  
9;3–12;8 

 
P,K,1 

2  
3  

4,5,6 

Wisconsin 
California 

D 

Expository  354 10;7–18:9 
5–7,  
9–12 

Wisconsin E 

Persuasion 179 
12;10–

18;9 
9–12 

Wisconsin 
Australia 

F 

Bilingual Spanish/English Story Retell 
Frog, Where Are You? (FWAY) 
Frog Goes To Dinner (FGTD) 
Frog On His Own (FOHO) 

 
2,070 
1,667 
930 

 
5;0–9;9 

5;5–8;11 
6;0–7;9  

 
K,1,2,3 

K,2 
1  

Texas 
California 

G 

Bilingual Spanish/English Unique Story 
One Frog Too Many (OFTM) 

 
475 

 
5;0–9;7 

 
K,1,2,3 

Texas 
California 

H 

Monolingual Spanish Story Retell 
Frog, Where Are You? (FWAY) 
Frog Goes To Dinner (FGTD) 
Frog On His Own (FOHO) 
One Frog Too Many (OFTM) 

 
366 
360 
188 
154 

 
5;10–9;11 
6;4-10;6 
6;1–10;1 
6;9–10;7  

 
1,2,3 
1,2,3 
1,2,3 
1,2,3 

Guadalajara, 
Mexico 

I 

ENNI (story generation from pictures) 300 4;0–10;0  Canada J 

Test of Narrative Language 
TNL-2 
TNL  

 
778 
500 

 
4;0-14;11 
5;0–11;11 

 
P,K,1-8 

--- 
4 US Regions K 

New Zealand/Australia Databases 
Conversation 
Story Retell (Anna Gets Lost) 
Personal Narrative 
Expository 
Persuasion 

 
350 
476 
355 
107 
179 

 
4;5–8;4 
4;0–8;9 
4;5–8;4 
6;1–8;4 

14;8-18;9 

 

New Zealand 
Australia 

 
L-1 
L-2 
L-3 
L-4 
L-5 

Figure 2-1 
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Figure 2-1 lists the reference databases included with SALT software. Language 
samples you collect, following SALT’s protocols, may be compared to age or 
grade-matched peers selected from these databases. For each database, the 
number of samples, the age range, grade range (if available), and the 
geographic locations are listed.  
 

• Play database 
 
Language samples from young children, ages 2;8 to 5;8, were collected in a 
play format allowing the child to talk about ongoing events and refer to past 
and future events as they were able. Like other conversational samples, the 
examiner was required to follow the child’s lead, expand utterances, 
comment on ongoing actions and events, and ask open-ended questions to 
encourage talking when necessary. See Appendix A. 
 

• Conversation database 
 
The SALT Conversation database was one of our earliest databases, driven 
by the wealth of developmental data from research studies on language 
development. This SALT database uses a protocol prescribing face-to-face 
talk with an examiner on general topics of home, school, or holidays for 
children 2;9 to 13;3 years of age. Conversation requires examiners to 
introduce topics, then encourage speakers to expand on their own 
experiences, responding to open-ended questions and requests for 
clarification. See Appendix B. 

 

• Narrative SSS (Student Selects Story) database  
 

The SSS narrative protocol was developed to provide speakers with the 
most motivation to tell their best story. The protocol allows the speaker to 
select a story, movie, or TV program to retell with minimal prompts from 
the examiner. The advantage of this genre is the speaker’s familiarity with 
the story, which optimizes motivation to tell as complete a story as possible. 
The disadvantage is that the content of the story and specific vocabulary 
may not be known by the examiner, which may limit interpretation of 
vocabulary use and story structure. 
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This protocol was the earliest narrative protocol examined in our research. 
It was developed as part of a project focused on comparing conversational 
and narrative language from school-aged children. Children younger than 
4 - 5 years had difficulty with this task, which allowed us to identify the 
baseline for documenting narrative language. For children older than 4 - 5 
years, this protocol worked very well. The Narrative SSS protocol is a more 
linguistically challenging task than conversation. See Appendix C. 
 

• Narrative Story Retell database  
 
The next narrative protocol examined in our research was story retelling 
where children narrated a story just told to them. This protocol allowed us 
to develop methods to analyze narrative structure and specific content 
because the story was known or familiar to both the examiner and the 
speaker being assessed. This protocol required us to select specific stories 
that would be age appropriate and motivating for speakers of both genders, 
and be as culture-free as possible. We began by using the story Frog, Where 
are You? (Mayer, 1969) which had been used in language development 
research for decades with children 4 - 10 years of age. Different stories had 
to be identified for children beyond first grade, as research, and our 
experience, indicated that children did not use more complex language after 
about age eight. We used different stories for the 2nd, 3rd, and 4th - 6th grades 
(see Figure 2-1 for the story titles). These stories increased in complexity 
while providing age-appropriate interest. Our research on children’s story 
retells indicates that children retell increasingly complex stories with 
advancing grades. Their stories are longer with more complex syntax, larger 
vocabularies, and more complete story structures.  
 
The databases can be used to compare age or grade-level expectations. 
Using the same stories allows you to compare what the child included in 
their retell as well as what they left out. Specific vocabulary for each story 
can also be compared. Our research has shown story retells produced short 
consistent samples that were easily transcribed. The examiner introduces 
the task, reviews the story while sharing the pictures, then asks the speaker 
to tell the story. This context places minimal demand on the examiner, and 
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results in stories that are short, focused, and consistent over age and grade. 
See Appendix D. 

 

• Expository database  
 
The expository protocol involves describing how to play a favorite game or 
sport. This can be an individual or team sport, a board or yard game. Our 
initial research project involved 7th and 9th graders and we found that, no 
matter which type of game was described, the language produced was 
similar in amount and complexity (Malone, et al., 2008). This finding is very 
helpful when helping a student select a familiar game to talk about and 
compare to the database samples.  
 
The Expository database was recently expanded and now contains language 
samples from 5th - 7th, and 9th - 12th grade students. Research on language 
development in adolescents and the experience of clinicians providing 
services for middle and high school students motivated the creation and 
subsequent expansion of this database. Research on exposition documents 
that students produce more complex language in exposition than in 
conversation or narration, making it a more challenging sampling context 
(Malone, et al. 2008; Nippold, 2010). Expository sampling using SALT 
requires the examiner to introduce the task and help select the game or 
sport to talk about. The examiner then monitors the speaker, who makes 
notes using a matrix of topics that should be covered when providing a 
complete rendition of the game or sport. The speaker’s notes are used to 
guide the speaker through the task. This task is linguistically challenging and 
research is still exploring the limits of its use for children and adults (Miller, 
Andriacchi, & Nockerts, in press). See Appendix E. 
 

• Persuasion Database 
 
The persuasion protocol requires the student to present a persuasive 
argument for a change in their school, workplace, or community. The 
argument is to be directed at the student's principal, supervisor, or 
government official. The student can choose an issue of personal interest or 
select from a list of suggested issues. The student is given a few minutes to 
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complete a planning sheet which contains six topics (Issue Id and Desired 
Change, Supporting Reasons, Counter Arguments, Response to Counter 
Arguments, Compromises, and Conclusion). Next to each point is a brief 
description of what is covered within that topic and space for making notes. 
The student is then asked to present his or her persuasive argument. The 
persuasion task reflects a skill essential for success across the secondary 
curriculum and for success as a friend, family member, employee, and 
citizen. Oral persuasion is under-represented in standardized speech-
language assessment tools and is a linguistically challenging task that we 
believe is sensitive to language impairment.  
 
The Persuasion reference database consists of samples from typically 
developing adolescents fluent in English. Students were drawn from public 
schools in two geographic areas of Wisconsin: Milwaukee area school 
districts, and Madison Metropolitan School District and from public schools 
across the state of Queensland, Australia. There are students from a variety 
of economic backgrounds and ability levels. See Appendix F. 

 

• Bilingual (Spanish/English) Story Retell & Bilingual (Spanish/English) Unique 
Story databases 
 
The Bilingual (Spanish/English) databases were the result of a collaborative 
research project supported by the NIH - NICHD and the Institute for 
Educational Research, U.S. Office of Education. The goal of this research was 
to investigate factors associated with successful reading and school 
achievement among bilingual children whose first language was Spanish. 
Several thousand children living in Texas and California attending K - 3rd 
grade served as participants. Language samples were collected from each 
child retelling the same story in both Spanish and English. A subset of these 
children also told a similar, but unfamiliar, second story in each language. 
The databases were created to provide clinical access to typical, 
Spanish/English bilingual children allowing comparison of their English and 
Spanish language skills. These databases are unique, as they are the largest 
set of oral language samples from bilingual children nationally or 
internationally. See Appendices G and H. 
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• Monolingual Spanish Story Retell Database 
 
The Monolingual Spanish Retell stories were contributed by Dr. Claude 
Goldenberg as part of the NICHD grant R01 HD44923, ‘‘Language and 
Literacy Development in Mexican Children’’ on which he was a P.I.  
 
The Narrative story retells in Spanish were elicited using a standard protocol 
which included a story script to aid the examiner when modeling the story, 
from a wordless picture book, in their own words. Examiners were trained 
to use minimal open-ended prompts when eliciting the samples. The child 
was seated next to an examiner who told the story in Spanish. The examiner 
and child looked at the story together as it was told. The examiner then left 
the book with the child, moved slightly away from the child, and instructed 
the child to tell the story back using his/her own words. See Appendix I.  
 

• ENNI Database 
 
The Edmonton Narrative Norms Instrument (ENNI) was developed by Phyllis 
Schneider who was interested in providing normative data for typical 
children in Edmonton, Canada (Schneider, Dubé, & Hayward, 2005). The 
Province provided grant funds for the project.  
 
Stories were written and children aged 4 - 10 retold them using a specific 
protocol. The major outcome of this work was the consistency of their oral 
narrative performance within age groups and the consistent progress across 
the entire age range. This work confirms our findings that oral language 
samples do provide a consistent and powerful index of language skills over 
time and across genres. The ENNI project, along with the stories and 
elicitation protocols, can be found at ww.rehabmed.ualberta.ca/spa/enni/. 
See Appendix J. 
 

• TNL Narrative Samples 
The narratives in the TNL2 Narrative Samples database came from Ron 
Gillam’s normative testing of the TNL-2: Test of Narrative Language - Second 
Edition (Gillam & Pearson, 2017).  
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The narratives in the TNL Narrative Samples database came from Ron 
Gillam’s normative testing of the original Test of Narrative Language (Gillam 
& Pearson, 2004).  
 
Dr. Gillam was interested in adding his transcribed narratives to SALT to 
allow users to examine the narratives elicited from the test in more detail. 
These databases can provide users with the opportunity to examine word, 
utterance, and narrative structure using objective measures. See Appendix K. 
 

• New Zealand – Australia Databases 
 
The New Zealand databases were the result of collaboration with Gail Gillon 
and Marleen Westerveld. They were interested in creating a national 
database of oral language samples which would document language 
development for New Zealand children and allow these data to be used to 
document disordered language performance. A practice-based research 
project was undertaken with volunteer speech-language pathologists from 
around the country. Each recorded 5 - 7 samples from typical children of 
specific ages. The result was a database of several hundred children 4 - 8 
years of age producing conversations, story retells, personal narratives, and 
expositions. Several published research papers have resulted from this work 
(Westerveld, Gillon, & Miller, 2004; Westerveld, Gillon, & Moran, 2008; 
Westerveld and Gillon, 2010a, 2010b), the most recent comparing the New 
Zealand and American data sets (Westerveld & Heilmann, 2010). The results 
revealed remarkable similarities across the two countries. The most 
significant difference occurred with the five-year-olds who, in New Zealand, 
seem to be slightly more advanced than their American counterparts. It is 
suggested that this difference may be due to when they enter school. 
Children in New Zealand enter school on their fifth birthday rather than 
waiting for the start of the next school year as is done in the U.S. This 
research collaboration led to the creation of the first national database of 
New Zealand language development. 
 
Marleen Westerveld expanded the databases by collecting samples from 
students in Queensland, Australia following the same protocol as was used 
when collecting the New Zealand samples. See Appendix L. 
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Eliciting Samples for Comparison with the SALT Reference Databases 
 
The SALT databases provide the opportunity to compare an individual language 
sample to age or grade-matched peers. In order for the comparison to be valid, 
however, language samples must be elicited following the same protocol as was 
used to collect the database samples. Conversations must be all conversation 
without narratives intruding. Similarly, narratives must be all narratives without 
conversation intruding. Comparison of narratives requires following the specific 
protocol used in eliciting the narratives in the comparison database. Narratives 
where the student selects the story (SSS narratives) can validly be compared to 
any story the speaker selects following the SSS protocol. Story retell narratives, 
where the speaker retells the same story they’ve just heard or followed, should 
only be compared to other story retells of the same story. And expository and 
persuasive narratives must be compared to their respective database samples in 
order to get valid results. In each case the protocol will result in samples that 
are comparable, with reliable outcomes, as long as they were collected under 
the same conditions and transcribed using SALT’s transcription conventions.  
 
From a developmental perspective, our research documents that the language 
produced by these different sampling contexts provides speakers with 
increasing challenges. From conversation to narration to exposition to 
persuasion, speakers produce more complex language, longer sentences, and 
more different words, as well as more errors, repetitions, and revisions. As 
students progress through the curriculum, conversational skills become less 
important, with the exception of some students on the autism spectrum. 
Narrative and expository skills underlie much of the literacy curriculum, 
particularly written language.  
 

What if There Isn’t a Comparable Database?  
 
Even without a reference database to use for comparison, a good language 
sample can provide a wealth of information about a person’s expressive 
language. The SALT Standard Measures Report groups together some of the 
most informative language measures to give an overall summary of the 
speakers' language performance. This report provides data on transcript length, 
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syntax/morphology, semantics, discourse, intelligibility, mazes and abandoned 
utterances, verbal facility and rate, and omissions and errors.  
 
Two samples from the same speaker may be linked for a Time1/Time2, 
Pre/Post, Language1/Language2, or Protocol1/Protocol2 comparison. This 
information can be extraordinarily useful for diagnostic purposes as well as for 
tracking response to intervention.  
 

Suggestions for Eliciting the Best Language Sample 
 
Speakers are more likely to converse if they believe listeners are really 
interested in what they have to say. If they doubt a listener's sincerity, younger 
speakers may simply refuse to cooperate. Older speakers may cooperate but 
may provide only minimal responses that do not reflect their language ability. 
The speaker who has difficulties is often reticent and requires an environment 
of trust to achieve optimal communication. How can the examiner create this 
environment and gather the most representative sample of the speaker’s 
expressive language skills? 

 
The first few minutes of the language sample interaction are critical. If the 
examiner fails to establish a comfortable rapport with the speaker, the resulting 
language sample may be strained and lack the necessary spontaneity to 
function as a valid index of the speaker's expressive language performance. 
Taking a few minutes to visit before moving on to the sampling protocol is 
helpful. The goal is to elicit a sample which is representative of the 
communicative behaviors in question. The following are suggestions to help 
achieve this goal: 
 

• Be friendly and enthusiastic. Give the speaker your undivided attention, 
showing interest with smiles, vocal inflection, and eye contact. 

• Be patient. Allow the speaker space and time to perform and don’t be afraid 
of pauses. Use a relaxed rate of speech as a fast rate can cause 
communicative pressure. 

• Get the most language by using open-ended prompts and following the 
speaker’s lead. If the protocol allows, ask for clarification. This indicates 
interest and is informative to the assessment.  
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• If the protocol allows for questions, avoid yes/no and specific “wh” 
questions, such as what-are questions, as they tend to elicit one-word 
responses. Ask age-appropriate questions and avoid asking questions when 
the speaker knows you already have the answer. Don’t ask more than one 
question at a time. 

 
These suggestions are relevant for all speakers regardless of their cultural, 
economic, or language background, or their cognitive, physical, or speech and 
language differences. The goal is to provide the speaker the maximum 
opportunity to communicate to the best of his or her ability. There is no 
substitute for experience in talking with speakers of various ages and ability 
levels. But even the most experienced examiner must guard against behavior 
that might inhibit the speaker's performance. 
 

What constitutes a valid language sample? 
 
1. The examiner follows the elicitation protocol. 
2. The elicitation protocol challenges the speaker’s production abilities. 
3. The speaker produces a sample that is representative of his or her language. 
4. At least 80% of the sample is intelligible (find a quiet area and use a quality 

recording device). 
 

What materials are needed to elicit the samples? 
 
1. An audio recorder. Digital is preferred. An external microphone is usually 

not necessary with a digital recorder. 
2. A quiet area, preferably with a table and two chairs. 
3. Any books, pictures, audios, or other materials required for the specific 

elicitation protocol. 
 

Summary 
 

Keep in mind that the people you are trying to evaluate may not have a 
successful history talking spontaneously. The SALT elicitation protocols have 
been very effective in eliciting language under a variety of conditions. Eliciting 
samples still requires your clinical skill to encourage optimum productive 



 Chapter 2  ●   Eliciting Language Samples    29 

 

language from individuals who may be poor communicators. The language 
sample process allows you to take several different samples without affecting 
the outcome of each. So if the first sample does not work out, try again. The 
databases will allow you to bring precision to your interpretation of the results. 
Be clear about your clinical objectives as they are central to collecting a sample 
relevant to meeting your goals. Keep in mind that the better the sample you 
record, the better the analysis results will reflect the speaker’s language skills. 
The next step in the process is to render the sample into a form that SALT can 
analyze. That requires converting the acoustic recording to text, in other words, 
transcription. 



  

 



  

CHAPTER 

3 
 

Transcribing Language Samples 
 

Jon F. Miller 
Karen Andriacchi 
Ann Nockerts 
 
Why Transcribe? 
 
Transcribing spoken language into orthographic text has a long history. It has 
been used to preserve meeting outcomes with “Minutes”, to record legal 
proceedings for trial transcripts and depositions, to provide access to oral 
language for the Deaf community with closed captioning on television, and, for 
many years, stenographers had to “take a letter”. These few examples serve to 
point out that transcribing spoken language captures what was said at various 
events and provides access to that language at a later time. Today, there are 
software applications which convert speech to text. With little or no training, 
these applications can produce fairly accurate text. So can we use them for our 
language samples? The answer, unfortunately, is “not at this time”. Certainly 
speech recognition keeps improving, but it still requires intelligible speech which 
follows standard grammar rules. Our speakers are not so considerate. We could 
have the speech recognition software create a first draft of the text that we 
could then edit. Or we could speak the sample into the computer while listening 
to the recording. We have tried these approaches and find that they actually 
take more time to edit and review for reliability than simply transcribing the 
original oral sample. SALT requires a transcript which follows specific 
transcription rules. These rules specify words, morphemes, and utterances. 
Exact transcription ensures accurate counts for the measures SALT calculates. 
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For now, transcription using software such as SALT, with live listeners and 
typists, is the best and most accurate option for populations seen in the field of 
speech-language pathology.  
 
Transcription is often thought of as an activity that is difficult and time 
consuming. In truth, once the coding conventions are learned, transcription is 
not difficult and the process provides a wide scope of insight into oral language 
skills, showing both strengths and weaknesses. You might consider it to be 
detailed listening. We have created a transcription format that ensures accuracy 
(Heilmann, et al., 2008) and provides for many levels of detail. At the basic level, 
you can code words, morphemes, and utterances and the software will provide 
measures like mean length of utterance, number of different words, and total 
words. Marking pauses and transcript duration produce measures of speaking 
rate and can pinpoint frequency, duration, and location of pauses. Add marking 
for repetitions, revisions, and filled pauses, and get an analysis of their 
frequency as well as a breakdown of repetitions and revisions as partial words, 
whole words, and phrases. These measures allow you to say something about 
whether verbal fluency problems are at the word level, as in word retrieval, or 
at the phrase level having more to do with syntactic formulation. The next 
deeper level of linguistic analysis allows for coding of words or utterances for 
specific features. An example we have incorporated into our analysis set, the 
Subordination Index, is a fast measure of clause density associated with 
complex sentence use. This measure requires coding for each utterance in the 
sample using the SALT coding routines (see Appendix O). The SALT transcription 
process is designed to provide the most information for the least transcription 
effort. Utterances need to be identified with appropriate ending punctuation, 
and words are defined by spaces on each side. Everything else is optional. The 
more you mark or code, however, the deeper and more thorough the 
subsequent analysis will be. 
 

Overview of SALT Transcription 
 
The record of spoken language created with a SALT transcript allows for a 
variety of immediate analyses and offers the opportunity for additional analysis 
in the future. Transcription may seem like a daunting task when just beginning, 
but working through the transcription process has incalculable rewards as the 
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first step for problem solving an individual’s oral language skills. Practice leads 
to proficiency.  
 
The basic transcription protocol in SALT (see Appendix M) specifies conventions 
to identify utterances, words, morphemes, pauses, unintelligibility, omissions, 
and errors used to calculate specific language measures. Our first goal was time 
efficiency, keeping coding to a minimum for basic level analysis. Subsequent 
coding, if desired, would be guided by the results of the initial analyses across all 
language levels.  
 
It was also important to create a readable transcript that could be easily 
followed and understood by family and other professionals. Transcripts can be 
shared with colleagues to increase accuracy in diagnosis and intervention. This 
process is particularly important for complex problems. Clinicians have reported 
sharing transcripts with diagnostic team members, parents, teachers, and 
administrators to clarify oral language concerns and to support other diagnostic 
results. Transcripts, along with the audio/video files, can be stored as part of 
clinical records to facilitate sharing of information.  
 
SALT provides you with helpful tools. A specialized editor facilitates every step 
of the transcription process, from setting up descriptive information about the 
speaker and context to a transcript error routine that identifies format errors 
and guides correction. SALT has built-in help at every level. When transcribing, 
specific transcription coding features can be easily accessed, producing a list of 
all transcription features, their definitions, and examples for use. This is 
particularly useful for infrequently used conventions. Once a transcript is 
completed, a variety of analyses can easily be calculated. This transcription 
format ensures that all analyses are calculated accurately. The uniformity of the 
process overcomes the major weakness cited for completing LSA by hand, 
consistency. With SALT, all transcription is completed using the same method, 
regardless of the type of sample or age of the speaker. 
 

Transcription Requirements 
 
The SALT software and some method for audio/video playback are required for 
transcription. Digital recordings greatly improve the overall sound quality of a 
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language sample which, in turn, improves the ability to accurately and more 
efficiently transcribe what was spoken. Digital recordings also allow for easy and 
fast manipulation of the audio or video file, e.g., moving forward and back, or 
repeating segments of language. File transfer and copying is fast and simple 
with digital recordings. There are a number of options for controlling the 
playback of digital files for transcription. For those who plan on transcribing 
frequently, we have found foot pedal controls (hands free) reduce transcription 
time and improve the overall accuracy of the transcript. There are also a 
number of software programs available for controlling the playback of digital 
files which are often free downloads or come installed on your computer. The 
SALT web site has recommendations for digital recorders and play back 
hardware and software.  
 
You do not need to be a speech pathologist to transcribe a language sample. 
Transcribing spoken language into the SALT editor requires the ability to type, 
fluency in the language recorded, knowledge of the elicitation protocol, and 
familiarity with SALT transcription conventions. With experience, you develop 
the ability to rapidly and accurately code samples using the SALT transcription 
conventions. A number of school districts have set up transcription stations 
staffed by speech pathology aides or individuals with clerical experience. These 
transcribers produce transcripts that can be used to create the basic reports 
leaving more technical coding, when necessary, to individual SLPs. 
 
How long does it take to transcribe a language sample? The transcription tools 
available with SALT greatly speed up the transcription process. In our review on 
frog story retells, transcription time took an average of 40 minutes. This 
included specialized coding for clausal density and story structure. These audio 
files were 3 – 6 minutes in length and averaged about 60 utterances. Longer 
samples take more time of course. Conversational samples generally take longer 
because topics can vary so much. Story retells have the advantage of providing 
the same expectations, characters, vocabulary, and story line for the 
transcriber. Experience also makes a difference. Just as in typing or keyboarding, 
practice makes perfect.  
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The Underpinnings of Transcription 
 
The first transcription decisions to be made are what is a word? and what is an 
utterance? This sounds simple enough, but consistency is required.  
 
What is a word? 
The SALT transcript format defines a word as a set of characters bound by 
spaces. In SALT, fsqwú is a word, though not recognizable in English. We 
transcribe what is said using standard orthography. This means that we 
transcribe the words used but not the pronunciation used by the speaker. 
Articulation errors are not typed in a SALT transcript. Word transcription is 
driven by using the same spelling for words heard regardless of articulation. For 
example, a speaker who reduces /r/ clusters might say “tuck” for “truck”. 
Contextually, the transcriber would know the speaker intended to say “truck” 
and thus would type the word “truck” to get accurate vocabulary measures. 
Similarly, pronunciation differences due to regional dialects are not typed in a 
SALT transcript. As an example, the speaker drops the “g” and says “waitin” for 
“waiting”. This would be transcribed as “waiting” (see Chapter 8 for a discussion 
of dialectal variations in African American English). Note that clinicians 
interested in tracking articulation errors and dialectal variations could mark the 
instances using word codes (see the “Customized Coding” section later in this 
chapter). 
 
The reason for using the intended word rather than the pronounced word is 
consistency. Standard spelling conventions are needed to avoid increasing the 
number of different words used within and across transcripts. Six different 
spellings of the same word would be counted as six different words in the 
program. Uniform spelling is essential to obtaining accurate counts of the 
number of different words used in a sample. “Ahhhh I see”, and “Ah I see”, 
although spoken with different intonation, should be spelled consistently, e.g., 
“Ah”.  
 
What is an utterance? 
A number of rules to define utterances have been used in the research 
literature. Utterances can be segmented using Phonological Units (P-units) 
which are based on speakers’ pauses and intonation in the speech sample 
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(Loban, 1963). Communication units (C-units) are the most commonly used 
method of segmenting (Loban, 1976). They are defined as a main clause with all 
its dependent clauses. Minimal Terminable Units (T-units) are a variation of 
C-unit rules, originally defined to segment written language (Hunt, 1965).  
 
We use C-unit segmentation because we found that the more syntax-based 
rules of the C-unit provided greater consistency (see Appendix N). This was 
particularly true as we increased the age of the children we studied. Despite 
using consistent rules that have been time-tested through research, children 
and adults still say things that are puzzling to segment. These surprises have led 
to the creation of the “utterance of the week” in our lab which has led to many 
spirited discussions on how to segment or code properly. Typically, 95% of the 
transcription process is straight forward with 5% of the decisions requiring more 
thought or creativity.  
 
SALT is focused on word, morpheme, utterance, and discourse features of the 
language, and transcription decisions define the measures calculated for each 
language feature. Language production, rather than speech production, is the 
focus. As you learn the transcription coding rules, you will begin to appreciate 
that each decision for a specific feature has an impact on how other features 
are defined for analysis. Learning to transcribe will help you understand the 
interrelationship among the features of our language.  
 

Anatomy of a Transcript 
 
Figure 3-1 shows an excerpt from a SALT transcript. The lines at the beginning of 
the transcript make up the transcript header. Header information is entered 
into a dialogue box presented when you create a new transcript in SALT. The 
information you enter in the header dialogue box is inserted at the beginning of 
the new transcript. The speaker label line, which begins with a dollar sign, 
identifies the speakers in the transcript. The identification lines begin with a plus 
sign and contain identification information such as the target speaker’s gender 
and current age. The initial timing line begins with a hyphen. The example given 
here is one possibility of what the header information may look like at the 
beginning of a transcript. Your header will vary depending on what information 
you choose to fill in.  
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Figure 3-1 

 
Once the header information is specified, you are ready to type what was 
spoken during the language sample. Each utterance must begin with a speaker 
identification letter. These letters should correspond to the first letter of the 
speaker label as specified in the $ speaker label line. For example, if your 
speaker label line is $ Child, Examiner, each child utterance will begin with C and 
each examiner utterance will begin with E, as shown in the example above. Each 
utterance is segmented according to the rules chosen for the sample. For the 
most thorough and accurate analysis results each utterance should be marked 
and coded following the basic SALT transcription conventions (see Appendix M). 
 

Customized Coding 
 
SALT allows you to devise your own codes to analyze any feature of the 
language sample that you are interested in. These codes can be inserted 
anywhere within a word or at the end of specific words or utterances, 
depending upon the features of interest. One example of custom coding 
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includes marking responses to questions as appropriate [AR], inappropriate [IR], 
or no response [NR]. The transcript might look like the following: 
 

E Do you have any plan/s for the weekend?  
C No [AR].  
E Did you know there/'s a track meet here on Saturday [NR]?  
: 0:05  
E Do you know anyone on the track team?  
C I don't like track [IR].  

 

Codes could be created to mark suprasegmental features if important to the 
diagnostic, e.g., [PR] for pitch rise and [FI] for falling intonation. These codes can 
then be pulled up in the analyses for further investigation of frequency or 
patterns of use. Coding schemes for articulation errors and dialectal variations 
can be created, or existing schemes can be implemented. With bilingual or 
multilingual speakers, we often see code switching. Code switches can be 
marked at the word and/or utterance level with a code, e.g., [CS], to be further 
reviewed or counted. When transcribing from video samples, non-verbal 
communication behaviors such as points, nods, or shrugs can be marked. 
Unique coding is also useful for tracking progress made in therapy with 
specifically coded repeat samples. An example might include work on increasing 
specific referencing with pronoun use. Pronouns with unclear referents in the 
sample can be marked with a code during transcription and later pulled up in 
the analysis. There are endless possibilities for unique coding schemes since the 
coding is so flexible. 
 
When creating new codes or when using less frequently used codes in SALT, it is 
helpful to insert plus lines at the beginning of the transcript to define the codes 
for the reader. See Figure 3-2.  

$ Child, Examiner  
+ Gender: F  
+ CA: 6;8  
+ Context: Con  
+ [EW] = word-level error  
+ [EU] = utterance-level error 
+ [CS] = code switching 

Figure 3-2 
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See Chapter 9 for detailing suggestions for transcribing written samples and 
coding samples for fluency.   
 

Transcription Reliability 
  
At the end of the day, can you learn the basic transcription codes and use them 
reliably to create an orthographic record of oral language? We addressed this 
question in a research project to document transcription accuracy and reliability 
(Heilmann, et.al. 2008). This project looked at English and Spanish narrative 
samples elicited from bilingual children retelling the story Frog, Where Are You? 
by Mercer Meyer (1969). All samples were digitally recorded and later 
transcribed by a trained master’s-level student majoring in speech-language 
pathology. On average, it took the transcribers 30 minutes to transcribe each 
sample. 
 
Transcript protocol accuracy was analyzed by having a proficient transcriber 
review transcripts for adherence to the SALT coding conventions; checking for 
accuracy in utterance segmentation, words within the main body of the 
utterance, words in mazes, and maze placement. Percent agreement was high 
across the board (90% - 100%) suggesting the transcribers consistently adhered 
to the transcription procedure. Transcription consensus was analyzed to identify 
differences in transcripts completed by a single transcriber against the “gold 
standard” transcript; checking for accuracy in words and morphemes, utterance 
segmentation, maze placement, pauses, and utterance type. Transcribers were 
very reliable in transcribing samples with percent agreement of 90% - 99%, with 
the exception of marking pauses (60% - 70%). Test-retest reliability was also 
calculated for samples collected within a two-week period. Results revealed 
significant correlation values from r=.69 to r=.79 noting a very high level of 
agreement that is statistically the same. These data, however, indicate some 
variability across transcripts. To determine the impact of this variability, SALT 
analyses were calculated for each transcript. Statistical analysis found that both 
transcripts (test-retest) provided the same values across measures of syntax 
(mean length of utterance in words), semantics (number of different word 
roots), and total productivity (number of total words and words per minute). 
While some variability is inevitable when making decisions during transcription, 
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these analyses document that the impact on the measures of language 
performance is negligible. 
 
This work demonstrates that language samples can provide consistent data for 
documenting language performance across individuals and within the same 
client over time. You can have confidence that using SALT transcription codes 
will result in reliable transcripts of oral language use. This work also dispels the 
myth that language samples are too variable to provide robust clinical data. On 
the contrary, your transcription of individual samples will provide you with the 
tools to document your practice. 
 

Transcribing in Other Languages: Challenges and Rewards 
 
Our bilingual Spanish/English research project (Miller, et al., 2006) presented us 
with a major challenge; how to make consistent transcription decisions for 
Spanish that would allow comparison with English transcripts. In order to 
compare an individual’s Spanish language skills with their English language skills 
we needed to be sure we were counting the same elements; words, 
morphemes, and utterances. Aquiles Iglesias and Raúl Rojas, who at the time 
were at Temple University, collaborated with us to design the Spanish 
transcription format for SALT (see Chapter 7 for details). It took the better part 
of a year to work out how to code specific features of Spanish which are 
inherently different than English, such as verb inflections and bound versus 
unbound clitics. Once the transcription rules were defined, the final product, 
which included reference databases for comparison in both English and Spanish, 
proved to be such a valuable tool that we built it into the SALT software. This 
has been well received and frequently used by both researchers and clinicians.  
  
Through collaboration with Elin Thordardottir at McGill University (Thordardottir, 
2005) and Elizabeth Kay-Rainingbird at Dalhousie University, SALT now supports 
French transcription and reporting. Funda Acarlar, a colleague at Ankara 
University in Turkey, used SALT to transcribe samples in Turkish to produce its 
own database for comparison in the language, in essence creating local norms 
which resulted in a customized version of SALT (Acarlar & Johnston, 2006). 
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There has been interest in using SALT with other languages as well. The 
challenge is always to make consistent transcription decisions within the 
language. Words and utterances must be clearly defined. The end product, 
however, will offer the benefit being able to analyze functional language 
produced in real-life settings. 
 

Summary 
 
Suffice it to say that transcription is the core of LSA. If done with care and 
consistency you will have a valuable snapshot of spoken language to evaluate. 
Understand that there will be a few puzzling features of almost every transcript. 
To accurately capture the speaker’s language, think about what was said and 
how it was intended. Work toward typing and coding precisely what was 
communicated while appreciating the diversity of human communication within 
and across age (see Appendix M).



  

 



  

CHAPTER 

4 
 

Analyzing Language Samples 
 

Jon F. Miller 
Karen Andriacchi 
Ann Nockerts 
 
Analyzing the sample is where we begin to see the tremendous power that 
computers bring to the task. SALT can be used to create a series of reports of 
word, morpheme, discourse, rate, fluency, and error measures. To make this 
happen it is important to understand the overall structure of the program and 
learn the specifics of the menu choices available. This chapter focuses on the 
organization of the SALT measures, explaining why they are included in the 
software, what you can learn from each score, and where to go to further 
evaluate a specific problem. The software calculates a wide variety of measures 
which are accessed from the menus. In this discussion, the focus is on two of 
these menus: Analyze and Database.  
 
When analyzing language samples, it is important to create an approach that 
examines each transcript systematically, making sure that all levels of language 
performance are evaluated. The transcript includes utterances from one or 
more speakers, representing features of the sample such as unintelligible 
segments, repetitions, revisions, pauses, overlapping speech, abandoned 
utterances, and words or bound morphemes omitted in obligatory context. This 
transcribed sample is the basis for all measures.  
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Review the Transcript 
 
It’s easy to get excited at this point and plunge into the detailed analyses of the 
transcript. It is important to remember, however, that the results of the 
analyses need to be placed in context to create an overall description of oral 
language performance. Prior to analyzing the transcript, it is strongly suggested 
you follow these steps: 
 
1. Re-read the transcript while listening to the recording. This will help you to 

consider the reliability of the recording as a valid index of the targeted 
speaker’s oral language. 
 

2. Make changes to the transcript where necessary. If transcription was done 
by someone other than yourself, there may be unintelligible segments that 
you, as a familiar listener, can understand. Or, it is possible that the 
transcriber upheld the speaker to a higher or lower standard of proper 
syntax than you desire for the speaker’s age or the sample context. You 
should be aware of coding decisions made by the transcriber and make 
changes to ensure the transcript is authentic to the speaker’s intent. 

 

3. Look back on the issues raised in the referral by teachers, parents/family, by 
you, or by a fellow team member. Does the transcript provide a sample of 
oral language which reflects the reasons for referral?  

 

Analysis Menu Options 
 
Analysis of the language in the transcript is completed using two main menu 
options in SALT: Analyze and Database. They are introduced here but are 
discussed, in greater detail, later in this chapter.  
 
The Analyze menu produces reports which summarize information from the 
current SALT transcript independent of the reference databases. These reports 
provide information for two speakers in the sample, as defined by the $ speaker 

line at the beginning of the transcript. 
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The Database menu produces reports which compare language measures from 
an individual's transcript to age or grade-matched samples selected from one of 
the SALT reference databases.  

 
SALT Reference Databases 
 

Language sample analysis has long been held as a valid indicator of expressive 
language performance in children. Several factors, however, have limited its 
general use including a lack of standardized procedures for eliciting language 
samples, validated measurement categories, normative data, and relevant 
interpretation strategies. Over the past several years, each of these issues has 
been addressed through research projects. Analyses of data obtained from 
these projects have led to the development of standardized language sampling 
procedures, language sample norms, and interpretation strategies that can be 
used in the evaluation process for determining the existence of a handicapping 
condition in expressive language. These data also have direct implications for 
determining special education program intervention strategies and in 
monitoring student progress. The language sample norms obtained from these 
research projects have been stored in the SALT reference databases (see 
Chapter 2).  
 

Underlying Constructs 
 

Let us take a look at three important underlying constructs that are the 
backbone of the SALT analysis process. There are default settings for each of 
these constructs which can be changed to suit your needs using the Setup 
menu.  
 

• Analysis Set (C&I Verbal Utts) 

The analysis set in SALT is a subset of the total utterances which is used for 
many of the calculations. Although you may change the analysis set, the 
default analysis set includes those utterances which are complete (not 
abandoned or interrupted), intelligible (do not contain any unintelligible 
segments), and verbal (excludes utterances that do not contain at least one 
verbalized word, e.g., gestures). To illustrate the importance of the analysis 
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set, consider the calculation of mean length of utterance (MLU). To avoid 
negatively influencing the outcome, the only utterances included in the 
calculation of MLU are those in the analysis set, i.e., those utterances which 
are complete, intelligible, and verbal (C&I Verbal Utts). Contrast this with 
the measure of percent intelligibility which is calculated on all of the 
utterances in the sample.  
 
Many of the reports selected from the Analyze menu provide the same 
language measures calculated from both the analysis set utterances and 
from total utterances. Other reports selected from the Analyze menu give 
you the option of specifying the set of utterances to use for the calculations. 
Reports selected from the Database menu, on the other hand, decide for 
you the measures which are based on analysis set utterances and those 
which are based on total utterances. 
 
As stated earlier, the analysis set can be changed to meet your needs. As an 
example, consider that, when eliciting conversational samples, examiners 
are often forced to ask questions to encourage talking. Responding to 
yes/no questions, however, often results in one-word responses. Because of 
this, early research on language development calculated MLU from 
“spontaneous” C&I verbal utterances, eliminating responses to questions. 
Using the Setup menu: Analysis Set option, you can change the current 
analysis set so that it excludes responses to questions. Subsequent analyses 
would then be based on the new analysis set. If the speaker’s MLU is 
significantly longer when responses to questions are excluded, we can 
assume that responses to questions limited verbal output.  

 

• Word Base  

The word base defines which words you want included in the analyses. By 
default, the word base includes all words except those coded as 
((parenthetical remarks)). You have the option of including parenthetical 
remarks as well as excluding, or only including, words that have specific 
[codes] attached to them. Words excluded from the current word base are 
not included in any analyses except the count of all words which is used to 
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calculate speaking rate. In all other respects, they are treated as though 
they were commented out.  
 
An example of the utility of the word base option might include a transcript 
which contains signed words. The signed words would have been coded in 
the transcript to flag them for analysis, e.g., typing the code [SIGNED] at the 
end of each signed word. Using the Setup menu: Word Base option you may 
choose to exclude, or to only include, the signed words.  

 

• Transcript Cut 

The transcript cut setting determines which section of the transcript to 
include in the analyses. All analyses are based on those utterances within 
the current transcript cut. The default transcript cut is the entire transcript 
(nothing cut), but it may be changed to restrict the analysis to a specific 
section of the transcript. The transcript cut is determined by the location of 
the utterances within the transcript (contrast this with the current analysis 
set, which is determined by the contents of the utterances). The Setup menu: 
Transcript cut option is used to change the current transcript cut. You 
specify the transcript cut in terms of a starting point (beginning of 
transcript, specified utterance, timing line or code) and either an ending 
point (end of transcript, specified utterance, timing line or code) or until the 
transcript contains a specified number of utterances, words, or elapsed 
time. 
 
The transcript cut could be used, for example, to limit the analysis to the 
first 50 utterances or to the first 200 words. Suppose your transcript 
contains a series of conversational topics. You could set the transcript cut to 
include only those utterances pertaining to a specific topic. Similarly, if your 
transcript contains a series of stories, you could set the transcript cut to 
include a single story. 
 

Each of these constructs has a default setting that will more often than not be 
used for running measures in SALT. It is, however, important to understand that 
you have the option to change them and how those changes might affect the 
outcome of your analyses. 
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Running the Measures - The Analyze Menu 
 

The Analyze menu provides the opportunity to generate measures for each 
speaker in the transcript. A few of the options are discussed here. Others are 
covered later with specific clinical case examples (see Chapter 10).  
 

The Standard Measures Report (SMR) is the first analysis option in the Analyze 
menu. The SMR calculates summary measures across sample length, 
intelligibility, macro analysis (if coded), syntax/morphology, semantics, 
discourse, verbal facility, and errors. The measures included in this report come 
from the research literature on language production, e.g., MLU, NDW, mazes 
(false starts, repetitions, revisions, and filled pauses), and from the requests of 
SLPs who were interested in measures of speaking rate, pauses, intelligibility, 
and certain features of discourse. This report is designed to provide a profile of 
strengths and weaknesses in individual speakers.  
 

Follow-up analyses are available in the Analyze menu to examine particular 
issues. If mean length of utterance (MLU) is low, for example, you may want to 
generate a summary of the words and bound morphemes found in the 
transcript (Syntax/Morphology Summary) and the distribution of utterances by 
the number of words and morphemes they contain (Utterance Distribution 
Tables). If the number of different words (NDW) is low, you may want to look at 
the follow-up summary (Semantics Summary), an alphabetical list of all the 
different words in the transcript and their frequency (Word Root Tables), a list 
of common words and their frequency (Standard Words Lists), a list of bound 
morphemes with their word roots (Bound Morpheme Tables), and lists of words 
categorized by parts of speech (Grammatical Categories1). Generate a Verbal 
Facility Summary when mazes (filled pauses, repetitions, and/or revisions) or 
pauses are high. The Standard Utterance Lists option pulls up utterances 
containing specific features, e.g., responses to questions, abandoned 
utterances, and utterances containing omissions. The organization mirrors 
clinical decision making by presenting a look at strengths and weaknesses and 
then offering further analysis options to explore each area in more detail (see 
Appendix T). 

 
1 The grammatical category algorithm, dictionary, and software code have been 
generously provided by Ron Channell, Ph.D., Brigham Young University. 
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The Performance Report helps you incorporate the language sample analysis 
findings into diagnostic reports and Individual Education Plans. The data 
generated from the various reports within the Analyze menu is used to create a 
cohesive narrative about the speaker’s expressive language performance 
without the database comparison. This is the only report in the Analyze menu 
which can be edited in the report window. You may want to add clinical 
impressions or observations, or modify some of phrasing to fit your preferences. 
The report can also be saved in RTF format which can be opened using 
Microsoft® Word, or copied and pasted into electronic record-keeping 
programs. 
 
The Analyze menu lists outcomes for each speaker in the transcript. The reports 
have particular utility when eliciting samples for which there is no database for 
comparison such as adult speakers or the hearing impaired. Perhaps you used 
an elicitation protocol different than those used for the SALT databases, or 
perhaps you simply want to look at change over time comparing transcripts 
from the same speaker at different intervals. Even without a reference database 
to use for comparison, a good language sample can provide a wealth of 
information about a person’s expressive language.  
 

Running the Measures - The Database Menu 
 

The Database menu is used to compare a speaker’s performance to age or 
grade-matched peers to generate comparison data. The databases allow you to 
answer the question, is this speaker’s performance across measures typical? 
There are multiple analysis options available in the Database menu.  
 

Selecting the Database Samples for Comparison 
 
In order to utilize the analysis options in the Database menu, you must first select 
a database comparison set. There are three steps to the process: 
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STEP 1: Select database (Figure 4-2) 
Select the appropriate SALT database for 
comparison. The plus lines at the beginning of the 
SALT transcript (Figure 4-1) direct the software to 
pre-select the appropriate database. In the 
example we are using, the Narrative Story Retell 
database was chosen with subgroup/story FWAY 
(Frog, Where Are You?, Mayer, 1969). This 
database selection step typically requires only that you agree with the 
selection made by the software. The selection can, of course, be changed. 

 
STEP 2: Select age, grade, and/or gender criteria (Figure 4-3) 

Choose criteria for matching samples. The options are to match your 
sample to samples in the database by age, grade, and/or gender. An 
age match is the most common criteria used for comparison and is 
usually the default selection. 

Figure 4-1 

Figure 4-2 

Figure 4-3 
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STEP 3: Select method used to equate samples by length (Figure 4-4) 

Select a method to equate your sample and the database samples by length 
in terms of words, utterances, or elapsed time. Some language measures 
vary significantly, depending on the length of a sample. Consider, for 
example, the number of different words (NDW) and the number of errors. 
The longer the sample, the greater the opportunity to use a wider variety of 
words and to make more errors. If the target speaker’s sample was far 
longer than the samples in the database, his or her opportunity to use 
different words and to make errors was greater. Reversely, a target speaker 
who produced a very short sample had less time, thus opportunity, to 
produce different words and to make errors. Equating samples by length 
offers a more fair comparison of the target speaker’s performance to the 
performance of the speakers in the database samples; apples to apples.  

 
Once the comparison set criteria have been selected, all of the analysis options 
in the Database menu become available.  
 
Database Standard Measures Report 
 

The Standard Measures Report (Figure 4-5), selected from the Database menu, 
contains the same measures as the same selected from the Analyze menu. The 
database report provides an overall summary of how the target speaker 
compares to a selected peer group in standard deviation units. The Standard 
Measures Report is the backbone of SALT analysis, providing general measures 
of language performance essential for identifying strengths and deficits at all 

Figure 4-4 
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levels of language use. The individual sections in this report are discussed in 
detail below. 

 

Figure 4-5 
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The heading at the beginning of the Standard Measures Report gives 
information about the target speaker and the database comparison sets that 
were selected. In this example, Timmy, age 5;8, produced a story retell sample 
using FWAY (Frog, Where Are You?, Mayer, 1969). Samples were selected from 
the Narrative Story Retell database (STEP 1: Figure 4-2).  The comparison sets 
chosen included, first, 69 samples matched by age (STEP 2: Figure 4-3), and 
next, 66 of the 69 samples in the database that were cut to 139 Number of Total 
Words (STEP 3: Figure 4-4). Note that 3 of the 69 samples were excluded 
because they contained less than 139 NTW. When you select the Standard 
Measures Report, you are asked to select which of these sets you want to use 
for comparison. For this example, Timmy’s sample is compared to the 69 
samples matched by age using the entire transcript. 
 
Let’s look at the numbers. 
 
As you scan the Standard Measures Report (Figure 4-5), notice that it is divided 
into domain-specific sections. The first column lists the measures. Following the 
measures column are the scores for the target speaker reported as raw scores 
and in standard deviation units relative to the database mean. Note that values 
which are highlighted and followed by one asterisk are used to denote scores 
that are at least 1 standard deviation (SD) from the database mean. Values 
followed by two asterisks are 2 or more SDs from the database mean. The SD 
interval, which affects how measures are asterisked, can be changed from the 
default setting of 1 SD to any value, e.g., 1.5, 1.75, to accommodate diagnostic 
criteria. Careful consideration of the plus and minus standard deviation values 
relative to each score is necessary to make the correct interpretation of 
performance. For example, scores of negative 2 SDs for mazes is considered to 
be a strength while negative 2 SDs for MLU indicates a significant problem. 
Think about the direction the speaker’s performance must deviate to be 
considered a problem. 
 
The final four columns in the report include database values of mean, range of 
scores (min and max), and SD. There is an optional fifth column, the %SD. The 
percent standard deviation is an index of the variability of each score for the 
dataset. The higher the %SD value, the greater the variability of the scores in the 
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comparison set. If desired, use the Setup menu in SALT to toggle the %SD 
display. Refer to Appendix V for a great explanation of standard deviation. 
 
Transcript Length: Measures of transcript length provide data on the length of 
the transcript in terms of utterances, words, and elapsed time. Sample length 
should always be kept in mind when interpreting language measures. Some 
language measures, e.g., NTW, NDW, number of errors and omissions, vary 
depending on the length of a sample.  
 

Intelligibility: The speech intelligibility measures provide an index of how many 
unintelligible segments there are in the transcript. This is important when 
evaluating the language performance in speakers who have articulation issues. 
Speakers with intelligibility scores less than 80% may generate language 
measures that are influenced by their ability to produce understandable 
utterances. Utterances may be shorter and word selection may be reduced to 
fewer syllables. Also, keep in mind that this measure is not speech intelligibility 
per se. This score also reflects the quality of the recording (hopefully improved 
with digital equipment), the skill of the transcriber, the number of unique 
proper names, and limiting listening to three passes of a segment during 
transcription. The intelligibility scores reflect understanding of the recording 
which may be different than face-to-face speech recognition. 
 

Macro Analysis: Scoring procedures were developed to assess the structure and 
content of narrative, expository, and persuasion samples (see Appendices P-S). 
When a transcript is scored following these procedures, the composite score is 
included in this section of the report. In this example, the Narrative Scoring 
Scheme (NSS) was applied to the sample. All the samples in the selected 
database (Narrative Story Retell) were scored for NSS so comparison scores are 
provided. 
 

Syntax/Morphology: Measures of syntax and morphology include MLU in words 
and morphemes which are highly correlated with age from 3 – 13 years 
(Leadholm & Miller, 1992). MLU is one of the measures central to the 
identification of language disorder (Paul, 2007; Rice, et al., 2010). “% Utterances 
with Verbs” and “Mean Verbs per Utterance” are included for English samples. 
Verbs are identified using a large dictionary of English words and a set of 
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grammatical rules (Channell & Johnson, 1999). The SI composite score is 
included with samples coded for subordination index (see Appendix O). 
 
Semantics: Number of Total Words (NTW) is the total count of all words. 
Number of Different Words (NDW) is a direct index of vocabulary diversity. It is 
derived from the production of unique free morphemes (the part of the word 
that precedes the /). For example, play, play/ed, and play/ing would be treated 
as one word (play) occurring three times. Only words located in the main body 
(excludes mazes) of the utterance are counted to calculate these measures. The 
Moving-Average NDW estimates NDW using a moving window. Initially, a 
window size is selected, e.g., 100 words (Moving-Average NTW), and the NDW 
for words 1–100 is calculated. Then the NDW is calculated for words 2–101, 
then 3–102, and so on to the end of the sample. For the final score, the 
individual NDWs are averaged (Moving-Average NDW). Moving-Average Type-
Token Ratio (Moving-Average TTR)  is calculated by dividing Moving-Average 
NDW by Moving-Average NTW. Unlike the traditional calculation of NDW and 
TTR, the Moving Average NDW and TTR are independent of sample length 
(Covington & McFall, 2010). If desired, the window size can be changed using 
the Setup menu in SALT.  
 

Discourse: Discourse measures are available for conversational or play samples 
where mean turn length in utterances and words, percent responses to 
questions and intonation prompts, percent utterances with overlapping speech, 
and percent utterances which interrupted another speaker inform you about 
responsiveness to a conversational partner. These measures are an excellent 
first step in identifying speakers who fail to attend to partner speech.  
 

Verbal Facility: Verbal facility is described by providing a measure of speaking 
rate (in words per minute), pause time as a percent of total time (if silent pauses 
and elapsed time were marked in the sample), percentage of the number of 
total words that were in mazes (Maze Words as % of Total Words), and the 
percent of utterances which were abandoned. The words per minute score 
significantly correlates with age and is considered by bilingual researchers to be 
an index of language facility (Miller, et al., 2006). The more fluent you are in a 
language, the higher your words per minute score. A high number of pauses 
within the speaker’s utterances might be indicative of language processing, 
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word retrieval, or fluency problems. Pauses between utterances may indicate 
processing or formulation difficulties. “Maze” is the term used for false starts, 
repetitions, revisions, and filled pauses. Increased maze use has been linked to 
word retrieval and utterance formulation problems. The maze words to total 
words ratio captures the overall impact of mazes on the whole sample. Silent 
pauses, both within and between utterances, affect overall verbal facility and 
rate. Abandoned utterances can be thought of as severe mazes where the 
speaker does not complete the utterance. These utterances can impact overall 
fluency of oral productions. 
 

Errors: Errors are captured during transcription. “% Utterances with Errors” 
calculates the percent of utterances which contain at least one instance of 
either an omission or an error code. Omission codes are used to mark missing 
words or bound morphemes that have obligatory contexts signaling required 
use. Error codes at the word or utterance level are used to note inappropriate 
word choice or syntactic form. These codes are meant to signal errors that may 
need further review.  
 

Report Footnotes:  

• At least 1 SD (** 2 SD) from the database mean 
Identifies the current standard deviation interval (1 SD by default) used to 
flag measures. One asterisk denotes scores that are at least 1 SD interval 
from the database mean. Two asterisks denote scores that are 2 or more SD 
intervals from the database mean. 

• Italicized measures  
When the report is based on the entire transcript, measures which count 
occurrences are italicized to alert you that these measures can be 
significantly affected by the different sample lengths.  

• Calculations based on C&I Verbal Utts 
Identifies the measures which are calculated using just the utterances in the 
current analysis set (C&I Verbal Utts by default). The other measures are 
calculated using total utterances. 

• Database selection criteria 
Lists the criteria used when selecting database samples for comparison. 
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Performance Report 
Timmy FWAY 
Age: 5;8, Grade: K 
 

Language Sample Analysis with SALT Software 
 

Elicitation Task and Database Overview 
Timmy completed a narrative story retell of 'Frog, Where Are You?' (Mayer, 1969). He listened to the story 
and then retold the story using his own words. Measures of sample length, intelligibility, narrative 
structure, syntax/morphology, semantics, verbal facility, and errors were calculated from his language 
sample and compared with samples from 69 speakers completing the same task. These speakers were 
within 6 months of Timmy's age. Although most measures were calculated from the entire sample, a few 
measures, such as total pause time and number of errors, can be affected by different sample lengths, i.e., 
the longer the sample, the more opportunity to produce them. For these measures, Timmy's sample was 
compared with a subset of 66 samples matched in length by the same number of words. All measures 
were interpreted using a standard deviation interval of 1.00 SD. 
 

Transcript Length 
Timmy's sample contained a total of 26 utterances using 154 words produced in 1 minute and 54 seconds, 
resulting in a shorter sample than his database peers completing the same task. His number of utterances, 
words, and time were 1.35 SD lower, 1.72 SD lower, and 1.71 SD lower, respectively, than the database 
mean. 
 

Macro Analysis 
The Narrative Scoring Scheme was used to assess the structure and content of Timmy's narrative. The 
following categories were included: introduction, character development, mental states, referencing, 
conflict resolution, cohesion, and conclusion. Timmy's composite score of 13 out of a possible 35 points 
was 1.83 SD below the database mean of 18.83. He demonstrated particular difficulty with the categories 
of introduction, character development, mental states, conflict resolution, and cohesion. 
 

Syntax/Morphology 
Timmy's mean length of utterance (MLU) in words was 5.79, which was 1.32 SD below the database mean 
of 6.88. Most frequently, he used 3-word, 6-word, and 7-word utterances. His MLU in morphemes was 
6.46, which was 1.26 SD below the database mean of 7.62. 87.5% of Timmy's utterances contained verbs 
with an average of 1.04 verbs per utterance. These values were both lower than the database mean by 
1.64 SD and 1.40 SD, respectively. Timmy's sample was scored for subordination index (SI), which 
measures the average number of clauses per utterance. In general, higher SI scores indicate increased use 
of complex syntax. Timmy yielded an SI score of 1.05, which was within normal limits. His most complex 
utterance contained 2 clauses. For example: 
        C And then he said, "Don't come back to my home ever again" {E laughs}. 
 

Semantics 
Timmy used 62 different words (NDW) within an analysis set of 139 total words (NTW). This compares 
with database means of 90 different words within 240 total words to complete the same task. NDW can 
be affected by the length of the sample, so the moving-average NDW was calculated by averaging NDW 
across the sample, looking at each set of 100 NTW. Timmy produced a moving-average NDW of 49, which 
was within the normal limits, indicating typical vocabulary diversity. 

…   

Figure 4-6 
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Database Performance Report 
 

The Performance Report  (Figure 4-6) helps you incorporate the language 
sample analysis findings into diagnostic reports and Individual Education Plans. 
The data generated from various reports is used to create a cohesive narrative 
about the speaker’s expressive language performance, noting both strengths 
and challenges.  
 
This is the only database report which can be edited in the report window. The 
report can also be saved in RTF format which can be opened using Microsoft® 
Word, or copied and pasted into electronic record-keeping programs. You may 
want to add clinical impressions or observations, or modify some of phrasing to 
fit your preferences. Any transcription changes or alterations to the comparison 
set that are made to fit the needs of your speaker may be worth noting in the 
report (e.g., changing the grade match or expanding the database age match). 

Figure 4-7 
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Database Quick Look Report 
 
The Quick Look report  (Figure 4-7) includes a list of language measures 
providing a quick view of how the target speaker compares to the selected 
database transcripts. Each language measure is indicated as one of the 
following: strength, within normal limits (WNL), or weakness. 
 

Examples - Selecting Samples from the SALT Reference Databases 
 

There are more than 7,000 samples in the SALT databases across speaking 
genres. As mentioned, the software helps you to identify the correct database 
from which you will select the transcripts for comparison. The first time you 
select a report from the Database menu, you are prompted to choose the 
specific database matching your sample type, the age or grade-match criteria, 
and the basis for comparison by length. This is best illustrated with examples. 
 
Example 1: Blake 8;4 PGHW2 
 

Blake is 8 years and 4 months old. In this example, he is 
retelling the story Pookins Gets Her Way (Lester, 1987). 
To select a report from the Database menu, you are 
prompted to select the database comparison set. 
Based on the +Context and +Subgroup information 
lines at the beginning of Blake’s transcript (Figure 4-8), 
the Narrative Story Retell database (see Appendix D) is 
pre-selected. This database contains samples from 
participants retelling several different stories. Only those participants retelling 
the same story, Pookins Gets Her Way (PGHW), are considered. 
 
Age, grade, and gender criteria are then specified to further refine the 
comparison set. For Blake’s sample, the age criterion is pre-set to +/- 6 months, 
i.e., all database participants in the age range 7;10 – 8;10. The grade and gender 
criteria are not specified using the default settings. They can be selected if 

 
2 Blake 8;4 PGHW is one of the sample transcripts included with the software. 

Figure 4-8 
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desired. In this example, 74 participants matched the age range specified 
(Figure 4-9). 

 

The next step in selecting database samples for comparison is to find a set of 
samples that are equated by length. When comparing an individual’s sample 
with selected database samples, it is important to understand what portion of 
the database transcripts are included in the comparison. The default setting is 
to compare the target sample to samples in the database with the same number 
of total words (NTW). Other options include a comparison using the same 
number of analysis set utterances or the same amount of elapsed time. In this 

The rule of thumb we have developed over the years is to aim for at least 20 
participants for comparison to reduce the variability as much as possible. 
The more participants you have in the comparison set, the better it 
represents language performance of typical speakers of the same age or 
grade, speaking under the same conditions. 

Figure 4-9 
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example, we use NTW to equate the length of the samples. After making this 
selection, you are presented with the best comparison set options varying in 
number of participants and number of words (Figure 4-10).  
 

In this example, 58 of the 74 
participants contained at least 247 
NTW (same NTW as found in 
Blake’s sample). You want to 
maximize the number of 
participants with the most 
language. Often the choice is 
obvious. In this example, six 
options are provided, ranging from 
58 samples with transcripts containing at least 247 words, to 74 samples with 
transcripts containing at least 139 words. The 58 samples provide the longest 
transcripts (247 words versus 139 words), hence the most language to be 
included in the comparison set. The 74 samples maximize the database 
participants but minimize the sample length. Since 58 samples are sufficient, 
this option was selected. SALT then calculated the database values with the 
selected database participants and generated the reports. 
 
Example 2: Timothy 6;1 Con3 
 
Timothy is 6 years and 1 month old. In this example, a 
conversational sample was elicited between Timothy 
and a speech pathologist. Based on the +Context 
information line at the beginning of the transcript 
(Figure 4-11), the Conversation database (see Appendix 
B) is pre-selected. 
 
The age criterion is pre-set to +/- 6 months. The database has 147 samples for 
comparison in that age range. The same number of total words was chosen to 
equate this sample to the database samples by length. Using the same number 
of words in the both Timothy’s sample and the database samples ensures that 

 
3 Timothy 6;1 Con is one of the sample transcripts included with the software. 

Figure 4-11 

Figure 4-10 
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measures, such as number of different words, number of pauses, and errors are 
not influenced by sample length. If your target speaker’s MLU is low and you 
compare samples based on the same number of utterances (rather than words), 
the typical speakers in the comparison set will likely have longer utterances and 
hence more different words because they produced more words per utterance. 
Basing the comparison on the same length in words eliminates this confound. 
146 of the 147 samples had at least as many words as Timothy’s sample (53 
NTW). 
 
At this point you could consider narrowing the age range of the analysis set, 
reducing it from 12 months (+/- 6 months) to perhaps 8 months (+/- 4 months) 
which provides 104 participants with transcripts containing at least 53 words. 
Narrowing the age range even further to 6 months still results in a group of 77 
participants with 53 words. By reducing the age range of the comparison set, we 
improve the match between the individual speaker and the comparison group 
of typical speakers. This reduces the variability inherent in larger age ranges. 
You might also consider matching the database participants by grade and/or 
gender. Some databases are large enough to allow you to adjust the selection 
criteria and still have sufficient participants to create a valid comparison set. 
Some do not allow for this adjustment because the number of participants was 
limited at inception. 
 
What we have done in selecting a comparison set is to create a customized set 
of transcripts that best match the target language sample. In this example, there 
are two comparison sets. The first includes all samples which match the age 
criteria selected and calculations are based on the entire transcript. In the 
second, and length-matched, comparison set, the comparison is based on 53 
words (Timothy’s NTW). The matching database samples are all cut at 53 words, 
i.e., transcript processing stops when the 53rd word is reached in each of those 
samples. The SALT program produces the unique set of measures for each 
comparison set providing the best possible measures of typical performance. 
Each of these comparison sets constitutes a table of normative values like that 
found in any standardized test. Instead of one look-up table, SALT creates 
unlimited look-up tables tailored for each target transcript. 
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Examples - Following up on the Standard Measures Report 
 
A variety of analyses have been created to provide more insight into the 
strengths and deficits identified on the Database menu: Standard Measures 
Report. The remaining examples in this chapter are used for illustration. 
 
Example 3: Steven 15;3 Expo transcript4 
 

Steven is 15 years and 3 months old. In this example, an expository sample was 
elicited. Figure 4-12 shows the Verbal Facility section of the Standard Measures 
Report, generated from comparing Steven’s sample to age-matched peers 
selected from the Expository database (see Appendix E). The results show 
significant weakness in the area of verbal facility with reduced speaking rate 
(words/minute), and increased pause time, maze words, and abandoned 
utterances. 
 

 

The Database menu: Verbal Facility Summary provides additional data on rate, 
pauses, mazes, and abandoned utterances. The Pause Summary section of this 
report provides a breakdown of within and between-utterance pauses as well as 
the total pause time in the sample (Figure 4-13). Within-utterance pauses 
accounted for 9 seconds of elapsed time while between-utterance pauses 
accounted for 23 seconds. That’s a total of 32 seconds of silent pauses out of an 
expository sample that took 4 minutes and 35 seconds to complete. 

 
4 Stephen 15;3 Expo is one of the sample transcripts included with the software. 

Figure 4-12 
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The Standard Measures Report (Figure 4-12) also revealed 18.3% of Steven’s 
total words were in mazes. This is 1.86 standard deviations higher than the 
database mean. Based on these values, this area appears to be a relative 

Figure 4-13 

Figure 4-14 
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weakness for Steven and indicates a more in-depth look at the contents of the 
mazes. The Maze Summary section of the Verbal Facility Summary report 
provides the break-down of the maze contents (Figure 4-14). Using this report, 
we learn that there were a significant number of phrase-level revisions and 
repetitions when comparing to samples in the database. This can be indicative 
of utterance formulation problems. 
 

Over eighteen percent of Steven’s words were in mazes. This has a considerable 
impact on his oral communication. In addition, he produced repetitions and 
revisions at the phrase level. Reviewing the utterances with repetitions and 
revisions may provide additional insight. To do this, use the Analyze menu: 
Standard Utterance Lists option (Figure 4-15). Looking at the mazes in context 
will help identify where they appear in each utterance. Do they seem to indicate 
utterance formulation problems, word retrieval issues, or some of each? SALT 
provides you with the data to make these decisions which will guide you in 
developing an intervention plan. 

 

 Steven abandoned 3 utterances which was significantly more than his age-
matched peers. Use the Analyze menu: Standard Utterance Lists option to show 
the abandoned utterances in context with 2 following entries (Figure 4-16). 
Notice that each abandoned utterance is followed by a silent pause.   

Figure 4-15 
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Using the Analyze menu: Standard Utterance Lists option, you can pull out a 
whole range of utterances from each speaker, e.g., utterances with omissions, 
errors, or pauses. Utterances can be displayed individually or with preceding 
and/or following utterances. They can also be viewed in the context of the 
entire sample. 
 
Example 4: Jeremy 3;3 Play transcript5 
 
Jeremy is 3 years and 3 months old. A play-based sample was elicited and 
compared to age-matched peers selected from the Play database (see Appendix 
A). The Syntax/Morphology variables in the Standard Measures Report, 
generated by comparing Jeremy’s performance to database samples equated by 
same Number Total Words (NTW), show that Jeremy’s MLU in morphemes was 
2.63 standard deviations below the database mean (Figure 4-17). His verb usage 

 
5 Jeremy 3;3 Play is one of the sample transcripts that comes with the software. 

Figure 4-16 

Figure 4-17 
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is also significantly low with only 25% of his utterances containing verbs, 
compared with 55% of his age-matched peers. 
 

The Database menu: Syntax/Morphology Summary can be generated to focus on 
bound morpheme usage (Figure 4-18). The measures in this report are based on 
102 total words (NTW). Jeremy used 6 bound morphemes which was 1.15 SD 
below his age-matched peers who averaged just over 9 bound morphemes. He 
used one contracted “is”, one 3rd person singular morpheme, and 4 plurals. He 
did not use any regular past tense /ed or /ing or possessives. 
 

 

Figure 4-18 
 

The Database menu: Utterance Distribution Tables (Figure 4-19) allows you to 
further evaluate the low MLU score. The number of utterances at each 
utterance length in both words and morphemes can be found in these 
distribution tables. Jeremy does not have any utterances longer than 5 words 
where 7 - 9 word lengths are expected. If a speech motor problem were 
evident, we might see utterances severely restricted in length with utterances 
only at 2 - 3 words. It is important to review these tables when there are low 
MLU scores. The longer utterances produced may give insight into the next level 
of syntax to be mastered. 
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Figure 4-19 

 
The Semantics variables in the Standard Measures Report show that his number 
of different words (NDW) was more than three standard deviations below the 
database mean (Figure 4-20). Low NDW is an indicator of limited vocabulary. 
 

Figure 4-20 

The Database menu: Semantics Summary can be generated to further evaluate 
these measures. In the Standard Word Lists section of this report (Figure 4-21), 
we see that Jeremy produced more question words than his peers but used only 
two different question words. No negatives (where almost 4 are expected), one 
conjunction, no core modals, and significantly limited personal pronouns. 
 
The Database menu: Grammatical Categories examines specific vocabulary use 
in more detail by sorting the words Jeremy used into 23 grammatical categories 
(Figure 4-22). Each word in the analysis set (C&I Verbal Utts) is identified as 
belonging to one of these categories. This is done using a large dictionary of 
English words and a set of grammatical rules (Channell & Johnson, 1999). 
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Figure 4-22 

Figure 4-21 
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To list the vocabulary words spoken within the language sample from a specific 
grammatical category, use the Analyze menu: Grammatical Category Lists 
option and select categories of interest. It may be beneficial to look at words 
produced from categories highlighted as areas of relative weakness when 
compared to the database samples. In Jeremy’s case there were a number of 
grammatical forms more than one standard deviation from the database mean 
Jeremy’s use of interjections may be of interest when reviewing the context of 
the transcript. It may be informative to ponder why these forms were so 
prevalent in his language sample as there were 20 productions compared to the 
average of just under 8 in the database comparison set (Figure 4-23). 

These interjections are either the word “oh” or forms of “yes”. Figure 4-24 
shows a segment of Jeremy’s sample with the interjections highlighted. 
 
Notice that they are all 1-word utterances, contributing to Jeremy’s low MLU. 

Figure 4-23 

Figure 4-24 
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Example 5: Timothy 6;1 Con 
 

This final illustration uses the same transcript as Example 2 where a 
conversational sample was elicited between Timothy (age 6;1) and a speech-
language clinician. Timothy’s sample was compared to 147 age-matched peers 
selected from the Conversation database. The discourse section of the Database 
menu: Standard Measures Report revealed less than expected responses to 
questions at 42.9%. The Database menu: Discourse Summary can be selected to 
follow up this score (Figure 4-25). This table reveals that the examiner asked 7 
questions of which 3 were answered = 42.9%. An answer is defined by a child 
utterance immediately following an examiner question. You will need to read 
the questions to determine if they were correct responses in terms of syntax 
and semantics. The length of Timothy’s speaking turns was within the typical 
range when compared to his age-matched peers. 
 

 
Figure 4-25 
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The Analyze menu: Standard Utterance Lists option can be used to display the 
examiner’s questions in the context of the entries which follow each question 
(Figure 4-26). In this example, the examiner’s questions are displayed with the 
following two entries. The examiner’s second and last three questions were not 
answered. It is informative to look at the questions to see what types of 
questions were asked and to see whether or not the examiner provided 
sufficient time for the child to respond. 
 

 
Figure 4-26 
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Chronological Age versus Cognitive Age 
 
You can use the databases to create an age-matched comparison set based on 
the cognitive age of the target speaker. This is useful, for example, when you are 
working with children with developmental disabilities. Comparing to typical 
peers based on this method provides you with reference scores based on 
cognitive abilities. Creating a second comparison set based on chronological age 
provides you with contrasting scores to help describe the speaker’s 
communication ability comparing cognitive ability with current age 
expectations. 
 
Arguments about which scores qualify for services are still debated in the 
literature, and vary across states and school districts. With this contrast so easily 
accessible, you will be able to document performance to address criteria using 
chronological age versus cognitive age as the reference point. 
 

Analyzing Samples without using the Reference Databases 
 
There may be times when you do not require the databases, or the appropriate 
database is not available for the target speaker’s age or for the sampling 
condition you prefer to use. You may be working with older adults, or a speaker 
who has a native language other than English, or a speaker who uses 
alternative/ augmentative communication. You may prefer to assess language 
use in the home, in a supervised work setting, or while participating in a 
classroom activity. Perhaps you have designed your own elicitation protocol to 
capture specific language use. 
 
The reports in the Analyze menu provide scores for all language levels and 
elicitation contexts. Without a database for comparison, you can use clinical 
judgment or find other sources of information to interpret language ability. 
Books on language development will refresh your information about 
expectations through the developmental period. Paul (2007) provides an 
invaluable resource on developmental expectations extracted from the 
literature through adolescence. Also, SALT contains a variety of graphs 
generated from the SALT reference databases which show patterns across 
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speaking contexts, ages, and grades for a variety of language measures. They 
are included as PDFs, accessible from Help menu: Normative Graphs.  
 
Examining the relationship between communication partners in conversation 
does not require a database, only comparison scores for each language measure. 
The Analyze menu: Discourse Summary provides you with the amount of talking 
for each participant. You can quickly see who is asking questions, who is 
answering, how much each speaker holds the floor, the number of utterances 
containing overlapping speech, and the number of interruptions. Communication 
partners may diverge from following the same topic. Examining each speaking 
turn relative to the preceding turn of the partner allows you to interpret if the 
speaker stayed on topic. This may be an important index for children and adults 
on the autism spectrum or who have sustained brain injury.  
 
There may be other aspects of the language sample you want to evaluate such 
as specific vocabulary or pronoun use. The Analyze menu: Word Root Tables 
provides an alphabetical list of the words used in the sample. The Analyze 
menu: Grammatical Categories option breaks down the speaker’s English 
vocabulary into twenty-three categories based on parts of speech. The Analyze 
menu: Standard Word Lists provides eight different pronoun lists, including 
personal pronouns and possessive pronouns. Suppose you want to flag those 
pronouns where the reference was not clearly established. The Edit menu: 
Insert Code option can be used to help code any aspect of the transcript you are 
concerned about. You can create a code list and save it for future use across 
time or individuals. Once your transcript is coded, the Analyze menu: Code 
Summary, Analyze menu: Word Code Tables, and Analyze menu: Utterance Code 
Tables provide summary reports of your codes.  
 
SALT provides an important tool to facilitate the side-by-side comparison of two 
transcripts. Link your transcripts using Link menu: Link Transcripts and then 
select reports from the Analyze and Database menus to compare the target 
speaker from each transcript. The Link option can be used to compare 
transcripts recorded at different times to chart progress. Samples taken at time-
one and time-two can be compared directly to document changes across 
language levels. This is particularly important when working with individuals 
with brain injury where documenting change is crucial for continuing therapy. 
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Also, because of the wide range of measures available, unexpected changes can 
be documented. You can also use the Link option to make comparisons across 
languages, e.g., English and French. Language samples for each language can be 
compared, allowing a precise index of the speaker’s fluency in each language. 
The Link menu is also helpful in comparing performance across linguistic 
contexts such as conversation vs. narration. A speaker on the autism spectrum, 
for example, may perform differently in a conversational context than a more 
text-based context such as a narrative story retell.  
 

Summary 
 
In this chapter we reviewed the major concepts for using SALT to analyze 
language transcripts. Chief among them are the analysis set, which determines 
the utterances to be included for each measure, and the comparison set for 
selecting database participants. Awareness of the analysis set and the 
comparison set will facilitate accurate interpretation of the results provided for 
each measure. The reference databases are unique to SALT and provide 
comparison data on typical peers. SALT is an assessment tool with vast 
capabilities. The more time you spend with it the more it will reveal about oral 
language performance. 



  

 



  

CHAPTER 

5 
 

Interpreting Language Samples 
 

Jon F. Miller 
Karen Andriacchi 
Ann Nockerts 
 
This chapter focuses on using SALT to build a thorough description of language 
use. SALT provides a range of measures which describes oral language 
performance and creates a profile of strengths and weaknesses. Understanding 
the measures is key to interpreting the outcome of the SALT analysis. It is 
important to be clear what is being measured and how that measurement 
relates to oral language performance. This is the most difficult, but most 
interesting, part of the language sample analysis (LSA) process.  
 
The major outcome of the LSA process is a description of language use in 
functional speaking contexts. LSA, along with other potential measures and 
clinical judgment, can be used to identify language disorder or delay.  
 

Describing Language Use via SALT Measurement Outcomes 
 
The Standard Measures Report (SMR) provides an overview of performance 
across measures of all language levels. When examining a Database menu: 
Standard Measures Report, consider plus or minus one standard deviation (SD) 
as significant in terms of identifying areas that need further examination. This 
criterion allows you to quickly form an impression of strengths and weaknesses, 
or the “profile” of language production exhibited in the sample. The measures 
in the SALT Standard Measures Report are organized into language domains that 
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have been identified by research and/or by clinicians as central to a thorough 
examination of language production, and frequently relate to academic 
performance. The measures cover transcript length, intelligibility, 
syntax/morphology, semantics, discourse, verbal facility, and errors. The report 
provides the target speaker’s raw score and standard deviation for each 
measure as well as the database mean, range, and SD. Each of the measures is 
considered to be a general score, sensitive to disordered performance identified 
by parents, teachers, and SLPs. This range of measures is necessary as there are 
a number of different types of oral language deficits. In other words, not all 
language disordered children show the same profile of scores across the SMR. 
The array of measures allows us to identify strengths as well as weaknesses in 
oral language, an essential ingredient in developing intervention plans. 
 
Refer to Appendix V for a good explanation of standard deviation. 
 

Profiles of Performance 
 
We don’t expect all children with language difficulty to communicate alike, nor 
do we expect them to exhibit the same linguistic profiles within and across age. 
We know that disorders of language production take several different forms 
and, further, that these forms seem to be stable over time. Our own research 
documented this by identifying a number of different problem areas in children 
receiving speech-language services in the schools (Leadholm & Miller, 1992).  
 
The rest of this section discusses how deficit areas converge to create profiles of 
performance. 
 
Delayed language  
The most common problem area is the classic language delay. Indications of 
language delay on the SMR are noted by a low mean length of utterance (MLU). 
Additionally, low number of different words (NDW), and/or low number of total 
words (NTW) are frequently noted with this type of language difficulty. Often 
speaking rate is low, i.e., low words per minute (WPM). Multiple errors at the 
word and utterance level can be evident. And, for younger children, we see 
frequent omissions of bound morphemes and auxiliary verbs. Further 
examination of the low MLU reveals a reliance on simple syntax. These children 
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may just be reticent talkers, producing shorter samples with sparse vocabularies 
and elemental syntax. In these cases, SLPs need to refocus on overall language 
proficiency. Not talking very much may be a function of family style (Hart & 
Risley, 1999), cultural background (Crago, Annahatak, & Ningiuruvik, 1993), or 
lack of language proficiency. Careful review of family status and performance 
across speaking situations can help sort this out. Ultimately, the primary 
intervention target may be to increase talking by providing varied opportunities 
to use language. 
 
Word retrieval and utterance formulation   
Speakers having trouble finding the right word or completing utterances with 
intended semantic content and appropriate syntax frequently repeat and revise. 
We refer to these repetitions and revisions as mazes, after Walter Loban whose 
seminal work coined the term (Loban, 1976). The SMR contains the measure 
percent maze words to total words; which indexes the impact of mazes on the 
entire sample. When this measure is high, it is important to look further at the 
number and types of mazes in both the Database menu: Verbal Facility 
Summary and Analyze menu: Verbal Facility Summary. Here you will find 
important essential information breaking down the contents of mazes, the 
distribution of mazes, (percent of the 1-morpheme, 2-morpheme ... 15+ 
morpheme utterances which contain mazes), the number of mazes (some 
utterances may have more than one maze), the total number of maze words, 
and the average number of words per maze. All of these measures provide 
information which, together, form a picture of the extent and nature of the 
speaker’s difficulty. Where samples are short, percent maze words to total 
words is the best measure, as the other measures are confounded by frequency. 
To distinguish between a word-level and an utterance-level problem we need to 
examine the sample in more detail. Repetition and revision of words and part-
words point to word retrieval issues. Repetitions and revisions of phrases are 
indicative of utterance formulation problems. The number of abandoned 
utterances may also be indicative of either of these problems and is significant 
in that the speaker did not resolve the word or utterance conflict. Consider 
abandoned utterances to be failed utterances which should be reviewed in 
detail to determine if a pattern exists. Are these partial utterances similar 
relative to form and/or content? 
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We have documented cases where speakers produced three and four mazes per 
utterance. When examining these utterances in detail, it was evident that they 
were attempting to string three or more propositions together in a single 
utterance, but didn’t have the necessary command of complex syntax to 
accomplish the task. This is an example of how LSA can provide detailed 
evidence of the language deficit with a clear direction for organizing an 
intervention plan. 
 
Pauses can also be indicative of word retrieval or utterance formulation 
problems. Our clinical experience suggests that either mazes or pauses are used 
when having difficulty finding the right word or formulating an acceptable 
utterance. Seldom are both pauses and mazes used by the same speaker. The 
Analyze menu: Verbal Facility Summary provides several telling pause measures 
such as pauses within utterances and pauses between utterances. The total 
time for all pauses in each category is provided as well. The total time measure 
allows a fast check on the impact of pausing on the overall sample. Pauses 
within utterances may be associated with word-level problems. An analysis of 
where pauses occur in the utterance will help confirm this interpretation. 
Pauses which occur before main verbs, subject or object nouns, or adjectives 
are indications of word selection issues. You can also confirm this by asking 
individuals older than seven or eight who have the capacity to reflect on their 
own language use. Pauses between utterances may be related to utterance-
level problems. Some individuals pause both within and between utterances. 
More assessment should be done to confirm the nature of difficulty. Pauses can 
be a significant deficit. As an example, a middle school student was disciplined 
for not responding to a school administrator, judged to be insolent, and sent 
home. The school SLP intervened with a language sample showing a pattern of 
significant pausing; more than five minutes total pause time in a 15-minute 
sample. This is perhaps an extreme case, but it illustrates how oral language 
deficits can be misinterpreted within the school and community. 
 
Narrative organization   
Documenting this type of problem requires collecting a narrative sample where 
the examiner knows the content expected. Examples include a story retell or an 
exposition of a game or sport familiar to the SLP. Narrative organization 
problems are usually evident when listening to the sample. The scope and 
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sequence of the narrative may be confused, characters may be left out, conflicts 
or resolutions might be missing. The SMR provides only a few helpful measures. 
Frequently, high numbers of pauses both within and between utterances are 
evident and there may also be high maze values. Non-specific referencing, 
which may also occur, can be flagged by inserting word codes within the 
transcript. These codes can then be counted and the words and utterances 
containing them pulled up for analysis. Differentiating word retrieval or 
utterance formulation problems from narrative organization deficits will require 
additional measures such as the Narrative Scoring Scheme (see Appendix P), the 
Expository Scoring Scheme (see Appendix Q), the Persuasion Scoring Scheme 
(see Appendix R), or the Oral Narrative Quality (see Appendix S). These 
applications will be reviewed in the next chapter which entails following up the 
SMR with more detailed measures to confirm language production difficulties. 
Basically, listening to the sample will provide clinical evidence of whether the 
problem is at the word, utterance, or overall text level. Further analyses are 
necessary to document these clinical impressions. 
 
Discourse deficits  
Discourse or pragmatic deficits can take many forms. The SMR provides several 
measures to assist with discourse analysis. Discourse requires an interaction 
between two speakers, in other words a conversational sample. SALT calculates 
the percent of responses to questions and the average speaking turn measured 
in words. It also quantifies overlapping speech and interruptions. Research 
shows that length of speaking turn increases with age as does the number of 
responses to examiner questions. Responses to questions provide a direct index 
of attending to the speaking partner. A closer look at questions within the 
language sample is recommended. This should include reviewing the examiner 
questions and the responses to determine the types of questions that were 
posed and their relative level of difficulty, e.g., yes/no versus “WH” (what, 
where, when, why, or how). Additionally, this analysis should include a review of 
the type of utterance that followed the examiner question, e.g., another 
question, an appropriate response, an inappropriate response. SALT bases the 
calculation of responses to questions on who spoke following the question, the 
examiner or target speaker. If the target speaker spoke and is credited with a 
response, the content and form of the responses should be examined to 
determine if the syntax and semantic content are accurate. Failing to answer 
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questions appropriately, or at all, may also be associated with delayed language 
development. A significant amount of overlapping speech and/or interruptions 
may be an indication of poor discourse skills. Examine the transcript to look for 
patterns. 
 
Fast speaking rate with low semantic content   
Individuals who speak very fast do not necessarily have a language problem. Our 
esteemed colleague Liz Bates spoke very fast but with extraordinarily clear and 
precise language form and content. In relatively infrequent cases, a fast rate 
appears to be an adaptation to not being able to organize thoughts into 
utterances or texts. This is most evident in conversational samples where the 
speaker is sharing information or responding to requests. Rate accelerates and 
content is circumlocuted. The speaker talks around the target adding relatively 
little new information, often without giving the conversational partner 
opportunity to speak. Also, the speaker may lack specific referencing using 
pronouns in the place of specific referencing nouns. So WPM is very high, turn 
length is high, and MLU is high, though not always related to complex sentence 
use. The contrast between a conversational sample and a narrative sample may 
reveal the pattern only appears in conversation, or possibly across all genres. 
Clinical experience suggests that these cases, while rare, are very resistant to 
intervention. Perhaps we do not yet understand the basis for these problems. 
Perhaps written language samples would be informative about these semantic 
issues. 
 

Identifying Language Disorder  
 
Speech-Language Pathologists are the experts in determining if a language 
disorder is present. When oral language issues are in question, we know best 
practice includes language sample analysis. An essential component of the LSA 
process requires a definition and clear understanding of what is a language 
disorder. Once in place you can relate that knowledge to the oral language 
measures calculated by SALT. The American Speech-Language-Hearing 
Association (ASHA) has defined language disorder as “impairment in 
comprehension and/or use of a spoken, written, and/or other symbol system. 
The disorder may involve the 1) form of language (phonologic, morphologic, and 
syntactic systems), 2) the content of language (semantic system), and/or 3) the 
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function of language in communication (pragmatic system), in any 
combination.” (1993, p. 40 as cited in Paul, 2007). Paul (2007) explains language 
disorder in her own words as follows: “Children can be described as having 
language disorders if they have a significant deficit in learning to talk, 
understand, or use any aspect of language appropriately, relative to both 
environmental and norm referenced expectations for children of similar 
developmental level” (p. 4). Both definitions of language disorder agree there 
must be impairment in receptive or expressive language. However, Paul’s 
definition includes the terms “significant”, “environmental expectations”, and 
“norm referenced” which provide the diagnostician more thoroughly defined 
criteria from which to align their assessment. Significant environmental deficit 
judgments are made relative to communication success at home, school, and 
community. Norm referenced deficits refer to performance on standardized or 
norm referenced tests. Paul advocates the position that deficits be identified by 
testing to define age-level expectations and by assessing the ability to use 
language for communication in the activities of daily living. This is particularly 
important for us to keep in mind as we consider the outcomes of LSA. LSA is the 
gold standard for documenting everyday communication, which is a critical part 
of defining language disorders (Paul, 2007). But does SALT’s LSA process qualify 
as a standardized test or a norm-referenced procedure? 
 
Standardization 
To document “impairment”, as required by the definition of language disorder, 
best practice includes documenting performance relative to age-matched peers, 
usually using a standardized test. There are several concepts that make up the 
standardization process. The first part of “standardization” is doing the same 
thing with everyone, following a consistent testing protocol. From its onset, 
SALT has worked toward standardizing the process of language sampling. First, 
we’ve developed detailed protocols for eliciting conversational and several 
types of narrative samples. See Appendices A-L for detailed protocols for each 
sample type, including guides to examiner behavior, scripts for encouraging 
reticent individuals, books for story retelling, and expository and persuasion 
note-taking matrices. Second, language samples are transcribed using a very 
specific and consistent set of rules to identify words, morphemes, utterances, 
and errors. Detailed transcription rules ensure the accuracy of each analysis. 
Uniformity in collecting and transcribing samples has produced consistent 
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analysis results, both within and across speakers (Heilmann, et al., 2010a). SALT 
does meet the first condition necessary for “standardization” with standardized 
administration and transcription protocols. 
 
The next condition of standardization to review is the creation of an index of 
typical performance by administering the “test” to a large group of individuals. 
This process generates a normative sample or comparison group that can be 
used to document performance relative to age-matched peers. The composition 
of the normative sample usually includes stratification of, 1) typical 
development, including high, average, and low performers, 2) geographical 
distribution, to satisfy perceived “Lake Woebegone” bias (“where all the 
children are above average” - Garrison Keillor), and, 3) socioeconomic and 
ethnic diversity. The SALT databases were created following the premise of 
stratification. The databases provide access to the performance of typical 
speakers under the same standardized speaking conditions. The SALT databases 
have some limitations relative to geographical distribution and ethnic diversity. 
Where we have tested geographical differences, we have found no significant 
differences between children in Wisconsin and San Diego. Some differences do 
exist between American and New Zealand children at five years but not six or 
seven. And it has been suggested that the difference at five years is because 
children in New Zealand begin kindergarten on their 5th birthday, typically 
earlier than their American counterparts (Westerveld & Heilmann, 2010). 
Research on ethnic diversity has not shown differences in language 
development for the core features of English. SLPs are responsible for 
recognizing dialect differences that are not consistent with Standard American 
English (SAE). Many features of African American English (AAE), for example, 
could be inappropriately considered as errors from an SAE perspective. The over 
inclusion of AAE speakers into special education has prompted a great deal of 
research which sites AAE as the major source of erroneous identification (see 
Chapter 8). SLPs are responsible for identifying dialectal features when 
transcribing, analyzing, and interpreting language samples. 
 
Next we take up how these data can be used to interpret relative ranking of 
individual speakers. SALT uses standard deviation scores for each measure to 
document the relative ranking of individual speakers. This approach optimizes 
the descriptive value of the measures, sacrificing the “standard score” approach 
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associated with standardized tests typically thought of as a scaled score, i.e., a 
standard deviation of 15 where 85 – 115 is considered typical performance. 
Creating scaled scores requires “smoothing” the data to create the same scaled 
scores for each measure or composite score. SALT, rather, relies on the standard 
deviation scores calculated for each comparison set that corresponds to the age 
and speaking conditions of the target speaker. Smoothing normative data allows 
test builders to interpolate missing data, e.g., data on 5 and 7-year-olds used to 
predict that of 6-year-old children. Creating standard scores makes interpreting 
the results more straightforward for users since all scores have the same 
statistical properties, such as mean and standard deviation. The measures 
included in SALT have come from the developmental literature or the clinical 
experience of SLPs working with language disorder. Measures like mean length 
of utterance, number of different words, and words per minute correlate highly 
with age and have very small standard deviations. Other clinically significant 
behaviors like mazes, pauses, and errors are not evenly distributed and have 
larger standard deviations. The SALT project has opted to keep these more 
descriptive measures that would certainly be discarded if creating a 
“standardized test” with smoothed standard scores for each measure. Creating 
standard scores assumes that each measure functions the same way across 
children over time. Some of the SALT measures that SLPs find useful in 
describing language production do not function the same way across speakers, 
but each captures an important aspect of oral language performance. As 
examples, consider pausing and mazing. Some speakers pause frequently to 
gain time to find the right word or to formulate the rest of an utterance while 
others do not. Similarly, some speakers produce frequent mazes, repeating and 
revising part words, words, and phrases. Both of these behaviors provide 
valuable clinical insight, but neither would appear in a standardized test 
because they do not correlate with age. The measures that are included in 
standardized tests are those that are significantly correlated with age and are 
sensitive to the identification of language disorder. Careful analysis of the 
standardized tests for language reveals that a great deal of work needs to be 
done to create measures that can identify language disorder beyond 70%. SALT 
identifies children with language disorder 76% of the time (sensitivity) and 
identifies children with typical language 82% of the time (specificity). These 
values were calculated from the measures in SALT’s Standard Measures Report 
from 263 typical children and 231 children aged 3 – 13 receiving services in the 
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Madison Metropolitan School District using -1 SD compared to the Conversation 
database (Miller & Klee, 1995). This means that SALT can identify disordered 
children at rates equal or better than most standardized language tests on the 
market today. But it can do more by describing specific language strengths and 
weaknesses. This profile of performance provides the information necessary to 
develop intervention plans to strengthen oral language skills essential for 
meeting everyday communication requirements. 
 
The following is an email exchange on “standardization” between two SLPs who 
use SALT for LSA and a professor who conducts research on LSA. It addresses 
the issue of using LSA to qualify students for services. 
  

Original question from Mary-Beth Rolland: SLP from Madison, Wisconsin: 
 

Could I get some input from you all? The administration has been saying 
that we cannot use SALT to qualify students for speech and language 
because it is not a formal test measure. It is not standardized. You can use 
it to corroborate formal measures like the CELF (Semel, Wiig, & Secord, 
2003). Can you speak to "formal", "standardized" and why LSA is a better 
measure of a child's actual performance than a test like the CELF? I have 
had this discussion so many times I need new info from the ‘experts’. 
 

From Tom Malone: SLP from Brown Deer, Wisconsin: 
 

I have always viewed language sampling, including SALT, as one of the 
informal measures needed to meet state eligibility criteria for language 
impairment (Wisconsin Administrative Code, 2011). Although SALT does 
give you norm referenced measures, it does not give you the sort of 
composite scores that formal (i.e., standardized) tests, like the CELF, can 
provide. The requirement to use composite scores (either receptive, 
expressive, or total) in reporting standardized norm referenced test results 
is spelled out in a technical assistance guide published by the Wisconsin 
Department of Public Instruction (Freiberg, Wicklund, & Squier, 2003) to 
help implement the then-new SL criteria. With SALT you get a wide variety 
of measures on which a student can be compared to his/her peers, but no 
single measure (at least not yet) that tells you whether the student is 
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language impaired. And that, I believe, puts SALT firmly in the informal 
measures camp. 
 

I will defer to Jon (referring to Jon Miller) & John (referring to John 
Heilmann) on whether the SALT databases have the other necessary 
properties of a standardized test, such as normal distribution. The criteria 
do, however, give you an out for qualifying a student using SALT instead 
of formal tests. In those cases in which formal testing is "not appropriate 
or feasible," such as when such tests are not culturally appropriate for that 
student, informal measures can be substituted. 
 

I might also mention that in selling SALT to administrators over the years I 
have gotten some traction in arguing that SALT can often make a compelling 
case for dismissing secondary students, who typically have been receiving 
SL services for a decade or more. That's because SALT, much better than 
formal testing, can address the issue of whether a student ‘has a functional 
and effective communication system’ which, according to the technical 
assistance guide (p. 29), is a major factor in considering dismissal.  
 

From John Heilmann: Assistant Professor, University of Wisconsin –
Milwaukee: 
 

This is a great discussion. I'll add my two cents. Before doing so, I just want 
to say that this is my opinion and that these issues are not clear cut 
(obviously). 
 
The word "standardized" can be used many different ways. Typically, when 
we say standardized test, we think of the CELF or TOLD (Hammill & 
Newcomer, 1988). However, I think it's more appropriate to apply the word 
"standardized" to the test administration procedures. In Ch. 3 of Haynes 
and Pindzola (2011), they state: "Standardization may imply only that the 
procedures for test administration are standard, not that norms are 
provided with the instrument." So, in that sense, LSA could be considered 
standardized, assuming the clinicians are adhering to the protocols used in 
the databases. There could be some debate here, as not every child is 
completing the same items. But, if the children are completing the same 
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protocol and the protocol is pretty structured, e.g., narrative retell, 
expository discourse task, I feel comfortable saying that it is using 
standardized procedures. Some (including me) would call that a 
standardized assessment. Some evidence for this are the differences 
observed when using different protocols. There are many examples in the 
literature. For example, I presented a poster with Marleen Westerveld 
showing that there were significant and clinically meaningful differences in 
children's retells based on the presence or absence of pictures. 
 

The next term to think about is "norm referenced." Basically, that means 
that you compare it to a normative sample. On the surface, it's pretty clear 
that you can compare SALT to a sample of age/grade-matched children. 
Most of the SALT databases are drawn from the Madison area, which some 
could argue is not representative of the broader population. In your 
particular case, I think it strengthens your argument, as you are essentially 
using local norms (recommended by many). But, we have put together 
some data showing that geography alone doesn't really affect the 
measures. You can see that in the 2010 paper you referred to. In the poster 
with Marleen (that I mentioned above), we provide even stronger evidence. 
We showed that the differences due to presence or absence of pictures 
were much greater than the difference due to geography (WI vs. New 
Zealand). 
 

The final issue is "standard scores." This is where LSA using SALT differs 
from traditional "standardized/norm referenced" tests. Tests that generate 
standard scores, e.g., CELF, TOLD, normalize their norm referenced data to 
generate standard scores. That is, they smooth out the differences across 
ages to predict performance of individual children. This is done to increase 
the consistency of the data and smooth out the variations across the 
norming sample. SALT simply finds a group of matched children, generates 
normative data for that particular group (means, SD), and lets you know 
how your child performs in comparison. Another difference is that you can 
get a composite standard score, while, with SALT, you have to rely on each 
of the specific measures. 
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So, I don't know if that answers your question any further. I guess I would 
be interested in knowing why your administrators are concerned about the 
use of SALT. Are they concerned about, a) over identifying children, b) 
under identifying children, or c) reducing costs of transcription? If it's 
identification accuracy, you can cite the 2010 "using databases" paper 
(Heilmann, Miller, & Nockerts, 2010b). In that paper we also cite the other 
two main articles that have shown that LSA can identify children with LI 
(Aram, Morris, & Hall, 1993; Dunn, et al., 1996). There are other papers out 
there that have cautioned against the use of LSA. But, there are also plenty 
of papers that show the ineffectiveness of standardized tests, e.g., 
Dollaghan & Campbell (1998); Plante & Vance (1994). Also, you would be 
amazed at the questionable properties of standardized tests when looking 
at their very own test manuals. That is, many don't do a great job identifying 
children with LI (i.e., not great sensitivity and specificity) and they often 
"stack the deck" for their results, e.g., comparing performance on the CELF 
to the TOLD; they're basically the same test, so they should perform 
similarly on both. 
 

This doesn't even mention the general admirable properties of the task 
[LSA] - functional communication, potentially less format bias for cultural 
and linguistic minorities, gets descriptive information, etc. Let me know 
what you think. Like I said, these are my opinions. I may have a bias given 
that this is my line of research. But, there are others out there who share 
similar views. 
 

From Tom Malone: 
 

It may be that Mary-Beth’s administrators, like me, have focused on the 
legal aspect of eligibility. Like it or not, we are stuck with state criteria that 
require both formal and informal measures, but never really defines what 
those are or how they differ. Based on the emphasis on composite scores 
that I cited from the technical assistance guide (which doesn't really have 
the force of law, but it's all we've got), it seems probable that "formal" was 
meant to refer to traditional standardized tests. What John is saying, I think, 
that the research is showing that there really isn't such a bright-line 
distinction between these two types of testing. 
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Now, I think you know that I'm no big fan of standardized tests. A major 
point of our ASHA case study was to show that SALT was way superior to 
standardized testing in reflecting teacher concerns over our subject's 
language skills (Malone, et al., 2010). But over the years I've had 
administrators that really want to see those standardized scores when 
making eligibility decisions at an IEP meeting. And over the years I've 
become fairly resourceful at coming up with the test scores I need when I 
want to qualify a student, even if the student's SALT results are actually 
the bigger influence in my decision making. I admit it's not the cleanest 
approach, putting me in mind of these lines: 

 

Between the idea 
 And the reality 

Between the motion 
And the act 

Falls the shadow 
 

-T.S. Eliot, The Hollow Men6 
 

From John Heilmann:   
 

I think that's a fair summary. Part of this is probably a cultural issue - 
standardized tests are ingrained in special education. Part of this is a 
psychometric issue. In many situations, you may find that norm referenced 
tests are more stable, particularly when looking at a composite score. There 
isn't a composite SALT score, per say. Laura Justice developed an index of 
narrative microstructure, which may be a good way to go (Justice, et al., 
2006). However, recall that Aram's work showed that MLU is a good general 
measure (superior to standardized test results when identifying children 
with LI). So, I still think the jury is out. And we have to acknowledge the 
limitations of standardized tests for making high stakes decisions (when 
used alone). 

 

 
6 This poem was first published as now known on November 23, 1925, in Eliot's Poems: 
1909-1925. 
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This is the end of their email conversation which highlights some of the issues 
involved in using LSA to diagnose language disorder and qualify individuals for 
services in the schools. These issues remain with us, but the SALT project has 
advanced our confidence in using LSA to evaluate language use in the everyday 
speaking situations necessary to advance through the language arts and literacy 
school curriculum. Standardizing the process of collecting, transcribing, and 
analyzing samples provides confidence in using LSA as a valid and reliable 
assessment tool. SALT, with its databases of typical speakers to use for 
comparison, advances language sample analysis to norm referenced status and 
provides a window into how a range of language measures creates profiles of 
performance. These profiles confirm clinician, teacher, and parent judgments of 
communication difficulties and provide face validity for LSA. 
 

A similar project that confirms the stability of LSA when the process is 
standardized is the Edmonton Narrative Norms Instrument (Schneider, Dubé, & 
Hayward, 2005). The ENNI is aimed at developing norms for narrative story 
retells for children ages 4 – 9 years. While the procedures and stories were 
different from those used when collecting the SALT story retell samples, the 
results were similar in terms of consistency of performance, reliability, validity, 
and advancing language skills with age. This project serves as a replication of our 
research over the years, advancing the use of LSA as a valid and reliable index of 
oral language performance. 
 
What constitutes a “significant” deficit?  
Possibly the most accepted proof of “significance” is to supply a score from an 
assessment. The first step in the LSA interpretation process is to review what 
constitutes a score outside the typical range. The definition of language disorder 
uses the phrase “significant deficit” but does not define the target value. 
Presumably the word “significant” is used in the definition to denote a level of 
performance below that of typical speakers of the same age. It is usually stated 
in standard scores or standard deviation (SD) units. The specific level noting 
“significance” is not an agreed upon number. A significant deficit or delay ranges 
from -0.5 SD to -1.5 SD in the research literature, to -1 SD to -2SD in state 
standards across the country. The value in Wisconsin, -1.75 SD, may likely be a 
political decision as there is no evidence relating this number with oral language 
difficulty having an impact on school performance. These values are important 
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as they determine what percentage of children can qualify for services. A review 
of the normal curve offers some insight into specifying the percentage of the 
population falling at or below standard deviation units from -1 SD, -1.5 SD, -1.75 
SD to -2 SD. 68% of the population will fall between plus and minus 1 SD, 82% 
between +/-1.5 SD, 89% between +/- 1.75 SD, and 95% between +/- 2 SD. If we 
look at the minus end of the curve, 9% of the population fall below -1.5 SD, 5.5% 
below -1.75 SD, and 2.75% below -2 SD. These standard deviation criteria define 
the percentage of children who can qualify for services using standardized tests 
if the population of children with language disorder is distributed along the 
normal curve. These values define “significant” deficit relative to typical 
children. Refer to Appendix V for a good explanation of standard deviation. 
 
We began the chapter with the definition of language disorder that had two 
parts, documenting language performance relative to age-matched peers, and 
difficulty with oral language at home, school, and community. We have seen 
that LSA can provide norm-referenced data across a range of measures that are 
relevant for describing disordered language performance in natural speaking 
situations; conversation, narrative, expository, and persuasive language. SALT’s 
version of LSA is norm referenced, indexing performance relative to age or 
grade status. SALT does not aspire to become a standardized test but it does 
aspire to a standardized language sampling process; it can both define typical 
performance across age and speaking conditions and describe, in detail, the 
specific language features that characterize individual disordered performance.  
 

Conclusion 
 

SALT Analysis provides evidence for several different profiles of language 
disorder: language delay, word retrieval problems, utterance formulation 
deficits, discourse problems, and fast speaking rate with low semantic content. 
We examine each of these problem types further in the next chapter where we 
investigate the more detailed measures necessary to illuminate each specific 
profile. So far we have focused on the clusters of measures on the SMR that 
constitute a distinct profile of performance. Further analysis of each type will 
reveal that there can be overlap among these profiles requiring all of our clinical 
skills and experience to unravel.  
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Beyond the Standard Measures 
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Karen Andriacchi 
Ann Nockerts 
 
Introduction 
 
The central focus of this chapter is the analysis of language samples using a 
database comparison set. We also branch into analyses that do not require a set 
of samples for comparison. These measures are valuable to the assessment 
process through the Analyze menu: Standard Measures Report which contains 
the same language measures as the Database menu: Standard Measures Report 
but is generated without a comparison dataset. The same general principles, 
discussed in this chapter, apply to both reports. For every language measure in 
the Standard Measures Report there are follow-up measures in SALT that can 
support your questions and aid in your clinical interpretation.  
 
The Standard Measures Report provides general measures of performance 
across areas of language that have been identified as significant for functional 
communication as well as academic performance. The task at hand is to figure 
out how the strengths and weaknesses highlighted from language sample 
analysis (LSA) form a complete picture of oral language performance. The true 
power in the diagnostic process comes when the strength of the SALT 
application is combined with clinical knowledge. SALT allows for a highly 
detailed and thorough analysis of language production, but the diagnostician 
must know how to interpret the measures and where to look further.  
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Our approach to interpreting LSA measures, outlined here, has evolved over the 
past 20 years working with SLPs, and from our own research and clinical 
experiences.  
 
Step 1 
Once the sample has been transcribed, generate the Database menu: Standard 
Measures Report (SMR) with the appropriate database comparison group. 
Notice the areas which are flagged as being at least one standard deviation 
above or below the database mean. Interpreting the values correctly is very 
important. Negative values, or those below the database mean, can indicate a 
problem for values like MLU or NDW. But positive values, higher than the 
database mean, can also document problems. Pauses and mazes are examples 
where positive values can indicate oral language issues which may need further 
investigation. Don’t make the mistake of considering all areas that are above or 
below the database mean to be a problem. Think about that aspect of language 
and what impact it has for the speaker. It would be irresponsible to enroll a 
student, for example, who has negative values for mazes, as that student is 
actually more fluent than the average speaker his or her same age. 
 
Look for clusters of measures which point toward a specific profile of language 
production problem. The profiles are meant to be descriptive of the oral 
language performance. They are not independent and, in many cases, may be 
overlapping. Their utility is in providing direction for how we spend our follow-
up time to create a complete description of oral language performance, and to 
create a plan for intervention. Don’t be surprised if you find unique 
performance deficits. We are constantly finding utterances that are distinct, as 
well as overlapping profiles not seen before. Focus on the speaker and his or her 
distinctive communication problems, and allow the SALT measures to document 
these oral language deficits. 
 
Step 2 
After running the SMR, listen to the sample again while reading the transcript. 
This tunes you back in to the speaker’s overall oral language style. It also gives 
an opportunity to review how well the SALT measures captured the language 
difficulties you might have heard in the sample. The SMR does not capture every 
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aspect of language difficulty. So be prepared to be creative in documenting 
issues beyond this report such as problems with narrative organization or non-
specific referencing. It is possible to create customized code lists to mark any 
word or utterance of interest. SALT provides useful utilities to facilitate this 
hand-coding process, making it easy and efficient. We discuss these options in 
more detail later in the chapter. 
 
Step 3 
Generate the Database menu: Quick Look to make sure you didn’t misinterpret 
the results or overlook something obvious. This report provides a visual display 
of strengths and weaknesses. For example, if the value for mazes is more than 1 
standard deviation interval below the database mean, then mazes are marked 
as a strength. If the value is more than 1 standard deviation interval above the 
database mean, then mazes are marked as a weakness. Otherwise mazes are 
marked as “within normal limits”.    
 
Step 4 
Evaluate problem areas in more detail. Measures in the SMR that are above or 
below one standard deviation from the database mean should be evaluated in 
more detail for several reasons. First, we need to confirm that each of these 
measures represents a real problem. Second, it is important to look at the 
utterances and words on which these measures are based, e.g., abandoned 
utterances, utterances with mazes, and words with omitted bound morphemes. 
Third, multiple measures should be reviewed together to determine if they 
constitute a profile of language disorder. SALT often provides more detailed and 
specific analyses that are available as summaries, e.g., Database menu: Verbal 
Facility Summary, or as lists, e.g., Analyze menu: Omissions and Error Codes. 
Exploring these additional analyses provides details about areas of difficulty and 
resolves questions about the impact of the SMR measures. The SMR results 
direct the next steps to help understand the language difficulties presented. To 
work efficiently, further analyses are only run when justified by measures in the 
SMR. If mazes are produced in high numbers, for example, then we want to 
determine if they consist of filled pauses, or part-words, words, or phrases in 
repetition or revision. SALT produces such a table but it is only of interest if 
maze totals are significantly high. In this way, the SMR identifies areas requiring 
further exploration. 
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Step 5 
Generate the Database menu: Performance Report for a customized written 
report, identifying areas where your client’s sample differs significantly from 
his/her peers. The results are provided as text which can be edited, and copied 
and pasted into diagnostic reports.   
 

Follow-up Analyses Organized by Profile Type 
 

The discussion of follow-up analyses (Step 4) has been organized by the profile 
types mentioned in the previous chapter. This allows for discussion of each of 
the standard SALT measures, the more detailed measures, and 
recommendations for hand-coded procedures where warranted. 
 

LANGUAGE DELAY 
 

The primary indicator for delayed language development is low mean length of 
utterance (MLU). This is often in conjunction with low number of different 
words (NDW), low words per minute (WPM), high number of errors, and/or high 
number of omissions. We often see minimal, if any, complex syntax use. Each of 
these areas may need to be examined in further detail to determine if it is an 
accurate reflection of performance, and to support initial findings.  
 

 
Figure 6-1 

 
MLU: We want to make sure MLU shows a range of sentence lengths with the 
mean reflecting an average. Question a low MLU. Could it be limited by speech 
production issues or a lack of respiratory support? Or is it truly language based? 
Look at the Database menu: Utterance Distribution Tables (or the Analyze menu: 
Utterance Distribution Tables if you are not comparing to database samples). 
The utterance distribution table (Figure 6-1) shows the number of utterances 
spoken for each utterance length. This example shows a speaker’s language 
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sample which contained only a few utterances that were longer than six words 
in length, notably less than the database mean values for that age speaker. 
 

This same distribution can also be investigated at the morpheme level. We hope 
to find a range of utterance lengths around the mean, some longer and some 
shorter than the mean value. It is instructive to examine the database values 
relative to the target sample to identify the number of longer utterances 
produced. These utterances may likely be the syntactic forms the speaker is just 
learning. Analyzing the syntax of these utterances provides useful insight into 
the speaker’s language development progress. A reasonable distribution of 
utterance lengths clustering around the mean, e.g., lengths from 1 – 7 with an 
MLU of 3.2, validates the MLU value. It is also good practice to check on the 
examiner’s language for conversational samples (see the Analyze menu: 
Syntax/Morphology Summary and Analyze menu: Semantics Summary). 
Examiner language (MLU and NDW) should be equal to, or less complex than, 
the target speaker. 
 

 
 Figure 6-2 

 
NDW and Vocabulary: Begin examining vocabulary use with the Database menu: 
Semantics Summary (or the Analyze menu: Semantics Summary if you are not 
comparing to database samples). The Standard Word Lists section of this 
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summary (Figure 6-2) provides frequency data for five word lists: question 
words (for conversational samples), negatives, conjunctions (the first complex 
sentence type), core modals, and personal pronouns. The type and total 
frequency for each list is provided.  
 
Conversational samples offer the opportunity to examine question word use. 
Negative utterances have a specific form, so the frequency of these words 
provides evidence of use. Conjunctions provide insight into initial complex 
sentence use. The types and tokens provide evidence for the variety of 
conjoining words used. Modals are another unique form used increasingly as 
development advances. Personal pronouns give some insight into referencing. 
Pronoun use follows a specific reference with appropriate subject and object, 
gender, and number choice. You can find the words used in the sample by 
accessing the Analyze menu: Standard Word Lists. This option lets you explore 
other vocabulary lists as well. 
 

 
Figure 6-3 
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Another useful list is the Database menu: Grammatical Categories (or the 
Analyze menu: Grammatical Categories if you are not comparing to database 
samples). This report (Figure 6-3) organizes all the words used in the sample 
into the categories listed in this table. This is done using a large dictionary and a 
set of grammatical rules (Channell & Johnson, 1999). The Analyze menu: 
Grammatical Category Lists option shows the words in each category. 
 
The Analyze menu: Word Root Tables produces an alphabetized list of all the 
words used in the sample (Figure 6-4). This can be invaluable for exploring the 
vocabulary used in story retell narrative and expository samples where the 
context is familiar to the examiner and certain vocabulary use may be 
obligatory.  
 

 
Figure 6-4 

 
Omissions and errors: Frequently, in younger children, omissions and errors are 
centered around bound morphemes. The frequency and type of bound 
morphemes used in the sample are listed in the Analyze menu: Bound 
Morpheme Tables. The Analyze menu: Omissions and Error Codes summary 
(Figure 6-5) provides a list of all omitted words and bound morphemes as well 
as all the words and utterances coded as errors. The utterances containing the 
omissions and errors are also included in this summary. It is useful to examine 
these utterances to look for patterns.  
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Figure 6-5 
 
Subordination Index: We tend to think about language delay only with children 
under 5 years of age. However, our clinical experience and research have shown 
that these delayed patterns persist through childhood. An important analysis 
often supporting the diagnosis of delayed development is the Subordination 
Index (SI), a hand-coded analysis of clausal density (see Appendix O). SALT has 
utilities for simple insertion of an SI code at the end of each utterance (see Edit 
menu: Insert SI Codes). The Database menu: Subordination Index (or the Analyze 
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menu: Subordination Index if you are not comparing to database samples) 
summarize the results (Figure 6-6). A low SI score indicates the use of simple 
syntax, or lack of complex sentence formulation, which is often characteristic of 
speakers with language delay.  
 

 
Figure 6-6 

 
WORD RETRIEVAL AND UTTERANCE FORMULATION 

 
Word retrieval and utterance formulation problems must be differentiated from 
one another by examining the speaker’s mazes and pauses if scores for these 
behaviors prove to be higher than normal. The Database menu: Verbal Fluency 
Summary (or the Analyze menu: Verbal Fluency Summary if you are not 
comparing to database samples) provides detailed measures of rate, pause, 
mazes, and abandoned utterances. 
 
Rate and Pauses: The Rate and Pause sections of the Verbal Fluency Summary 
(Figure 6-7) provide information on speaking rate (words and utterances per 
minute) and detailed measures of pauses found within and between utterances. 
In our experience, pauses within utterances are associated with word retrieval 
problems and pauses between utterances are linked to utterance formulation 
issues. Frequent pauses may be another indication of word retrieval or 
utterance formulation problems. Some individuals use repetition, revision, or 
filled pauses to find the right word or utterance form. Others just pause silently 
until the solution emerges. Only a few do both. The length of the silent pauses is 
an indication of the difficulty listeners will have in following the message. A 
pause of only 1 - 2 seconds signals an opportunity for speaking turn change. This 
discourse rule leaves listeners hanging when long pauses occur within the 
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speaker’s turn. You can get a list of all the utterances containing pauses in the 
Analyze menu: Standard Utterance Lists option. 
 

 
Figure 6-7 
 
Mazes and Abandoned Utterances: High numbers of mazes revealed on the 
Standard Measures Report is the primary indicator that we are dealing with a 
word retrieval or utterance formulation issue. The Maze section of the Verbal 
Fluency Summary provides a breakdown of the total number of mazes that are 
revisions, repetitions, and filled pauses (Figure 6-8). The maze revisions and 
repetitions are further broken down into their components (part-word, word, 
and phrase) and filled pauses are broken down into single word, e.g., “um”, and 
multiple words, e.g., “um um um”. Speakers with word-level problems have a 
preponderance of part-word and word repetitions and revisions. Speakers with 
utterance-level issues have more phrase-level repetitions and revisions. The 
results can be mixed, requiring further exploration. The Abandoned Utterances 
section provides a count of the abandoned utterances. It should be noted that 
frequent abandoned utterances point to utterance-level issues. You may 
consider an abandoned utterance to be a failed maze in the sense that the 
speaker was not able to resolve the maze and gave up. Use the Analyze menu: 
Standard Utterance Lists to examine each abandoned utterance carefully to 
determine similarity of form and content used.  
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Figure 6-8 
 
The Database menu: Maze Distribution Tables report (or the Analyze menu: 
Maze Distribution Tables if you are not comparing to database samples) 
provides additional maze data (Figure 6-9). The first table, % of Utterances with 
Mazes by Utterance Length in Morphemes, provides you with the percentage of 
utterances with mazes at each length (1, 2, 3, 4, etc.) in morphemes. This is 
informative as you expect more mazes to appear with longer utterances. Note 
which utterance lengths have fewer mazes than expected and which have more. 
Additional tables provide you with the distribution of mazes by maze length and 
by utterance length. Finally, you can examine the distribution of utterances by 
the number of mazes they contain which gives a clear index of how many 
utterances had one maze, two mazes, and so on. These tables provide you with 
insight into maze length relative to utterances attempted and how much 
material is in mazes relative to the total sample. Mazes are disruptive to 
listeners, making it difficult to follow the utterance and the message. Speakers 
with word retrieval problems tend to repeat or revise before subject or object 
nouns, and adjectives. They also repeat or revise before verbs, which is tricky, as 
the problem may be syntax based rather than a problem with word retrieval. 
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Figure 6-9 
 
Utterance formulation problems can be linked to specific syntactic forms like 
complex sentences. When you see a high percentage of mazes in longer 
utterances as well as more than one maze per utterance, review the sample for 
complex sentence use. Note the number of propositions attempted and the 
syntactic forms used by the speaker. If syntax is limited to simple sentence 
forms and more than one proposition is attempted per utterance, then teaching 
complex syntax is your target. You can test this conclusion by working on 
producing one proposition at a time and reviewing the maze frequency. If this is 
the correct conclusion, then mazes will be significantly reduced. If not, work 
through the mazes from a word-level perspective.  
 
To measure complex syntax, you might look at the use of subordination by 
applying the Subordination Index (SI, see Appendix O). The SI has been coded in 
most of the database samples and is available for comparison with an individual 
sample. 
 
Whether the issue is frequent pauses or frequent mazes, you should review 
vocabulary diversity. Review the number of different words (NDW) produced in 
the sample as well as the moving-average NDW. If these measures are below 1 
SD, then re-read the sample to identify circumlocutions and examine pronoun 
use. Pronoun use can also be examined in the Database menu: Semantics 
Summary which provides personal pronoun use compared to peers. The Analyze 
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menu: Standard Word Lists option gives you frequencies of pronoun use for 
several types of pronouns. 
 
Finally, in the pursuit to diagnose utterance formulation versus word retrieval 
difficulties, if you began with a conversational sample you should collect an 
additional narrative sample. Narrative samples put more pressure on the 
speaker to produce specific content which is usually familiar to the examiner. 
Select the type of narrative relative to age or ability level; story retell for 
younger individuals and expository or persuasion samples for those who are 
older. The narrative should elicit more examples of complex syntax from the 
speaker if he or she is capable. It also provides an opportunity to examine 
specific word use. 
 
NARRATIVE ORGANIZATION 
 

Problems with narrative organization are often the only issues arising from the 
language sample. You should collect a narrative sample, of course, but the 
Standard Measures Report may not show any specific deficits. When you listen 
to the sample and re-read the transcript, however, it is clear that the speaker 
doesn’t fluidly tell the story. Characters may not be introduced, plots may be 
ignored, conflicts and/or resolutions may be omitted or included at odd times, 
and so on. These speakers typically have difficulty with written language as well 
as with oral reports in school. Their language at the word and utterance level is 
usually fine, but be aware of possible issues with complex syntax. This is a 
profile that is often identified initially by teachers and SLPs when listening to 
oral language or reviewing written language assignments. The crux of the 
problem in production is taking the listener through the introduction, 
characters, conflicts, resolutions, character mental states, and conclusion in an 
orderly manner.  
 

Narrative Scoring Scheme: We adapted a scoring procedure to document 
narrative organization. The Narrative Scoring Scheme (NSS) is based on the work 
of Stein and Glenn, 1979; 1982 (see Appendix P). The NSS involves assigning 
scores for each of seven categories and then typing the scores into the 
transcript on plus lines inserted at the end of the transcript. SALT has utilities for 
inserting the scoring template (Edit menu: Insert Template → Narrative Scoring 
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Scheme) and reports for summarizing the results (Analyze menu: Narrative 
Scoring Scheme and Database menu: Narrative Scoring Scheme (Figure 6-10)). 
The NSS measure was developed for our bilingual research project and was one 
of the best predictors of reading achievement in both Spanish and English 
(Miller, et al., 2006). 
 

 
Figure 6-10 
 
Expository Scoring Scheme: The Expository Scoring Scheme (ESS), based on the 
NSS measure, was developed to document narrative organization and content 
for expository samples (see Appendix Q). The ESS is scored for ten different 
features. Use the Edit menu: Insert Template → Expository Scoring Scheme 
utility to insert the scoring template at the end of the transcript. Then assign the 
scores and summarize the results with the Analyze menu: Expository Scoring 
Scheme and Database menu: Expository Scoring Scheme reports (Figure 6-11). 
  

 
Figure 6-11 
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Persuasion Scoring Scheme: The Persuasion Scoring Scheme (PSS) was also 
based on the NSS measure as well as the ESS. This scoring scheme was 
developed to document narrative organization and content for persuasion 
samples (see Appendix R). The PSS is scored for seven different features. The 
Edit menu: Insert Template → Persuasion Scoring Scheme utility is used to insert 
the scoring template at the end of the transcript. Once the scores have been 
assigned, the results can be summarized with the Analyze menu: Persuasion 
Scoring Scheme and Database menu: Persuasion Scoring Scheme (Figure 6-12) 
reports. 

 
 Figure 6-12 

 
Oral Narrative Quality: The Oral Narrative Quality (ONQ)  is an assessment tool 
developed to create a more objective narrative structure scoring system for the 
Ana Gets Lost (AGL) story retells included in the New Zealand/Australia Story 
Retell Reference Database (see Appendix L). The ONQ is scored for each of eight 
categories. The Edit menu: Insert Template → Oral Narrative Quality utility is 

Figure 6-13 
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used to insert the scoring template at the end of the transcript. Once the scores 
have been assigned, the results can be summarized with the Analyze menu: Oral 
Narrative Quality and Database menu: Oral Narrative Quality (Figure 6-13). 
 
DISCOURSE DEFICITS 
 

Discourse deficits are best identified from conversational samples where there 
are multiple speaker turns. There are several measures pertaining to discourse 
included on the SMR which SALT calculates automatically. These include Percent 
Responses to Questions, Mean Turn Length (in words), Utterances with 
Overlapping Speech, and Interrupted Other Speaker. Percent Responses to 
Questions provides an index of number of examiner questions followed by an 
utterance, or response, from the target speaker. The utterances need to be 
reviewed to make sure that the target speaker’s utterance was, in fact, a 
response to the question. For speakers with discourse problems we often see 
inappropriate responses or no response when a question is asked. When the 
percentage is low, examiner questions and target speaker responses should be 
looked at clinically. SALT provides an easy way to construct the list of questions 
using the Analyze menu: Standard Utterance Lists option. Select the 2nd 
speaker’s (examiner’s) utterances ending with a question mark and display them 
in context with several following entries - usually 2 or 3 will catch the response if 
it’s available. You will then be presented with a list you can analyze for form and 

Figure 6-14 
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content. Did the examiner allow sufficient opportunity for the response? Was 
the question answered appropriately? Was the right syntax used? In Figure 6-14, 
the target speaker answered all three questions. But in two of the three 
responses the speaker produced one or more abandoned utterances. Perhaps 
the facts were not available to the speaker. Otherwise, we have evidence of 
word retrieval or utterance formulation problems. 

 
If the discourse measures in the Standard Measures Report are questionable 
then generate the Database menu: Discourse Summary (Figure 6-15) (or Analyze 
menu: Discourse Summary if the database comparison set is not available) to 
produce a summary of the number of examiner questions asked, the number 
answered, the number of yes/no responses, and the percentage of questions 
answered. Other indicators of whether or not the speaker is following discourse 
rules include the number of utterances with overlapping speech and the 
number of times the target speaker interrupted the other speaker. The Turn 
Length Summary section provides several measures of the speaker’s turn taking. 
A turn is the number of speaker utterances or words while they hold the floor. 

Figure 6-15 
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As speakers become more language proficient their turn length increases. Turn 
length is also an indication of whether or not the speaker is following discourse 
rules, allowing the speaking partner turns for sharing information. The turn 
length distribution tables enable you to review turns by number of words and 
number of utterances. Look for a distribution of turn lengths, not just short 
responses or long responses. It is important to re-read and listen to the 
transcript focusing on how well the speaker follows discourse rules. We are 
concerned with individuals who are un-responsive to the speaking partner, or 
who seem to have their own topic of conversation, never attending to the 
partner’s speech at all. 
 

A follow-up measure to the turn length analysis is to code topic maintenance 
and change. This can be done by creating customized codes, e.g., 
[Topic_Initiate] and [Topic_Continue], and inserting the appropriate code at the 
end of each utterance (Figure 6-16). Check that “continuations” don’t just dwell 
on detail but provide new information on the general topic, as in a typical fluid 
conversation.  

 

E Do you have any brother/s or sister/s [Topic_Initiate]? 
C I got[EW:have] three brother/s [Topic_Continue]. 
C But they don’t live with us [Topic_Continue]. 
C They live with Grandma_Dale [Topic_Continue]. 
E Oh, ok [Topic_Continue]. 
C Grandma_Dale has got two dog/s [Topic_Initiate]. 
E She has two dog/s [Topic_Continue]? 
C Yeah [Topic_Continue]. 

Figure 6-16 

Figure 6-17 
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Use Explore menu: List - Word and Code List (Figure 6-17) to summarize the 
codes. The summary will tell you who initiated the topics in the conversation 
and who maintained them over the course of time. This will document 
responsiveness to the speaking partner from a content perspective. 

 
FAST SPEAKING RATE 
 

There are individuals who speak very fast yet have difficulty making specific 
references. This is often associated with reduced semantic content. Their 
speaking rate (WPM) is higher than their peers by more than one SD and their 
sample is longer. Their NDW is usually within one SD from the mean, but MLU is 
often higher. Calculating the Subordination Index (SI, see Appendix O) often 
reveals appropriate syntax. A careful reading of the transcript reveals that the 
speakers hold the floor at all costs (very long turn lengths) and continue to 
speak until the content to be conveyed has been produced. This may be an 
adaptation to a word retrieval or utterance formulation problem where the 
problem focus seems to be the content. Evidence for this comes from the 
frequent circumlocutions within speaking turns. Fortunately, these are not 
frequent cases as they seem very resistant to therapies. This suggests that we 
have not identified the basic problem. The follow-up analyses should focus on 
reading and coding the transcript for content errors and circumlocutions that 
suggest a word or utterance-level problem. 
 

Coding More Detail of Specific Clinical Problems 
 

SALT allows you to create customized codes to mark individual words and 
utterances for any feature that may be of special interest. Once coded, the 
program counts each code and lists the words or utterances containing them. 
This was illustrated previously with the example of topic initiation and 
continuation. Measures of specific features like Developmental Sentence 
Scoring (Lee & Canter, 1971) can also be coded and summarized. Lexical or 
syntactic forms targeted in therapy can be coded in spontaneous samples to 
document carry-over into everyday language use. This is perhaps the most 
powerful, yet under-used, feature of SALT. Although it requires you to hand 
code each feature, SALT has utilities to facilitate the task (see Edit menu: Insert 
Code). The Explore menu: List - Word and Code List can be used to identify and 
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list utterances containing specific words, morphemes, phrases, and codes. If you 
are working on a set of vocabulary, for example, create a list of the words of 
interest. SALT will count the number of times each word occurs in the transcript 
and pull up the utterances containing them. If you are interested in discourse, 
you might code the examiner questions for their form, e.g., Y/N, what, where, 
why, to determine the types of questions the speaker is able to answer and 
those that cause difficulty. If you want to mark phonological problems, for 
example, create codes and SALT will count them and show you where they 
occurred. You can easily look for patterns of occurrence from this analysis.  
 

Linking Transcripts for Side-by-Side Comparison 
 

The Link menu in SALT allows you to select any two transcripts for comparison. 
Once selected, you can generate reports for side-by-side comparisons (Figure 
6-18). This facilitates, 1) monitoring change over time to document therapy 
progress or to observe for generalization, 2) comparing performance in different 
speaking contexts, 3) assessing proficiency across languages, 4) documenting RtI 
with naturalistic language use data, and 5) providing the necessary data to 
discontinue services.  
 

Comparing transcripts is an important part of the clinical process. Evaluating 
time-1/time-2 language samples for growth or change can effectively show 
whether or not therapy targets have generalized to functional speaking tasks, 
not simply to drill and practice scenarios. Comparisons across speaking contexts 
can be invaluable to a diagnostic. For example, narratives may present more of 
a linguistic challenge than conversations for a particular speaker. Collecting 
samples in both contexts provides the opportunity for direct comparison of the 
SMR results using the linking tool. Bilingual speakers present a unique challenge 
because, in order to evaluate their total language proficiency, it is important to 
collect comparable samples in each language. Collecting samples in more than 
one language from the same speaker provides the opportunity to compare 
performance across languages. This helps us to distinguish speakers who are 
language disordered from those who need more English (or second language) 
instruction. (See Chapter 7 for a discussion pertaining to evaluating language 
performance of bilingual Spanish/English speakers.) RtI can be documented 
using the linking function. It facilitates the comparison of the speaker’s 



 Chapter 6  ●   Beyond the Standard Measures    113 

 

performance at various points throughout the intervention phase of the 
process. SALT analysis of language samples provides thorough and detailed 

Figure 6-18 



114  Assessing Language Production Using SALT Software  

 

analysis of “real talk”, generating functional data to make the case for 
dismissing a student from caseload. Language sample analysis is the only 
assessment that can prove the speaker does or does not have a “functional and 
effective communication system” which is often a requirement for dismissal. 
 

Summary 
 

SALT offers many ways to characterize oral language deficits. Your task is to 
make use of the tools to better describe oral language. SALT saves you time in 
analysis and provides clear direction on where to focus further diagnostic effort. 
At the end of the day, trust your clinical judgment as to the general problems 
the speaker exhibits. Then use SALT to document those areas to bring together 
a compelling case for enrolling for services, outlining an intervention plan, or 
dismissing from therapy.



  

 
 

CHAPTER 

7 
 

Assessing the Bilingual (Spanish/English) 
Population  
 

Raúl Rojas 
Aquiles Iglesias 
 
This chapter focuses on how to use language sample analysis (LSA) with bilingual 
(Spanish/English) children. Chapters 1 through 6 provided you with valuable 
information on the importance of using LSA, the advantages of the various 
elicitation procedures, transcription conventions, the different reports available 
in SALT, and assessing language production using SALT. In order to effectively 
use SALT with bilingual (Spanish/English) populations, you need to learn some 
additional transcription and segmentation conventions that are specific to 
transcripts elicited from bilingual children. The decision-making process will also 
be slightly different since we are now dealing with two languages rather than 
one. We begin by providing a brief background on the bilingual 
(Spanish/English) population in the United States. This is followed by some 
additional conventions that are specific to the bilingual transcripts. Finally, we 
discuss the decision-making process that should be followed in order to 
adequately assess bilingual children.  
 

Background 
 

Twenty percent of the population of the United States speaks a language other 
than, or in addition to, English. The vast majority of these individuals will speak 
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Spanish, although many communities have very large numbers of speakers of 
languages other than English and Spanish (Shin & Kominski, 2010). All 
demographic predictors indicate that the size of the Spanish-speaking 
population is going to increase substantially in the coming decade; and the 
increases will not be limited to the southwestern states. Furthermore, the 
fastest growing segment of the U.S. student population is children who are in 
the process of learning English as a second language and lack sufficient mastery 
of English to successfully achieve in an English-language classroom without 
additional support (Swanson, 2009). These children are referred to as English 
Learners (ELs). ELs presently account for 10 percent of the elementary school 
population in the United States; with approximately half of the children enrolled 
in grades K-3 (National Center for Education Statistics, 2006) and 75 percent of 
these children are Spanish-speakers.  
 

Regardless of your geographical location, there is a strong possibility that you 
will be faced with a linguistically diverse caseload. Some of your clients will be 
monolingual speakers of English, some will be monolingual speakers of a 
language other than English, and some will show various proficiency levels in 
their native language and in English. This last group presents a challenge since 
both the first or native language (L1) and the second language (L2) of a bilingual 
child will differ from the language of a monolingual child, and the two language 
systems will influence each other. In addition, the children will exhibit various 
levels of proficiency in each of their languages. As a result of these differences 
between monolinguals and bilinguals, the assessment process of bilinguals 
requires that we: (1) examine each of their languages independently, and (2) 
compare their performance in each language to the performance of children 
who are also speakers of the two languages.  
 

The specific linguistic skills bilingual children demonstrate in each language at a 
particular point in time will vary as a function of numerous factors including the 
task and the interactors. For example, while playing with one of their siblings at 
home, a child may use English or Spanish with comparable proficiency. In a 
more cognitive and linguistically demanding situation, e.g., an oral presentation 
on how to play Monopoly in front of his school peers, the same child might 
show different levels of proficiency in each language. The child may have the 
ability to make the presentation in both languages, but there may be an obvious 
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struggle in the less proficient language. This struggle might be characterized by 
an increase in mazes, a decrease in speaking rate, a decrease in mean length of 
utterance in words (MLUw) and number of different words (NDW), and/or an 
increase in grammatical errors. Making a clinical decision solely on their 
performance on an expository narration in the child’s least proficient language 
would be inappropriate. It would also be inappropriate to base a clinical 
decision on a conversational task that did not challenge the child to use complex 
language. Our clinical decisions must be based on tasks that provide examples 
of the child’s optimal linguistic ability. In addition, the child’s linguistic skills in 
each of the two languages must also be taken into consideration when making 
this decision. 
 

Before discussing the clinical decision making process, let’s consider some 
additional SALT conventions we will need in order to ensure that our transcripts 
will be comparable to the transcripts in the Bilingual Spanish/English Reference 
databases (Appendices G & H) that we will be using to compare bilingual 
children’s performance.  
 

Bilingual (Spanish/English) Transcription Conventions and Segmentation 
 

A growing body of research (Bedore, et al., 2006; Gutiérrez-Clellen, et al., 2000; 
Heilmann, Nockerts, & Miller, 2010; Kohnert, Kan, & Conboy, 2010; Miller et al., 
2006; Rojas & Iglesias, 2009, 2010) establishes the importance of conducting 
LSA with bilingual populations. Thorough and accurate transcription is necessary 
to get the best results from SALT. This section focuses on four modifications to 
standard SALT conventions that were developed in order to address the unique 
characteristics of Spanish and bilingual transcripts. 
 

Special Characters 
ISSUE: Accent marks in Spanish serve two distinct purposes. One purpose is to 
assist in the pronunciation of words that do not follow basic stress rules such as, 
words ending in a vowel, -n, or –s are stressed in the penultimate syllable, e.g., 
za-pa-to “shoe”. Thus, a word like comí “I ate” requires an accent mark because 
it is pronounced with stress in the last syllable and this stress pattern violates 
the basic stress rule of penultimate stress on words ending in vowels. The other 
purpose of accent marks is to disambiguate words that otherwise are written 
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the same but have different syntactic roles or meanings, e.g., el “the” as definite 
article vs. él “he” as personal pronoun. Failure to account for lexical stress and 
grammatical category by not marking accents would negatively impact several 
SALT measures and reports, especially NDW and the Analyze menu: Standard 
Word Lists report.  
 

SOLUTION: SALT accepts accent characters and considers homophones 
differentiated by accented letters as distinct words. Thus, words such as que 
“that” (conjunction) and qué “what” (pronoun; adjective) are counted as 
different words and are reflected correctly in the Analyze menu: Standard Word 
Lists report. Figure 7-1 lists some of the most common homophones in Spanish 
that are distinguished by the accent mark.  
 

Non-accented Meaning  Accented Meaning 

adonde (to) where  adónde (to) where? 

aquel this (adjective)  aquél this one (pronoun) 

como as; like; I eat  cómo how? 

cual which  cuál what?; which one? 

cuando when  cuándo when? 

de of; from  dé 
to give 
(subjunctive present) 

donde where  dónde where? 

el the (article)  él he; him (pronoun) 

ese that (adjective)  ése that one (pronoun) 

este this (adjective)  éste this one (pronoun) 

mas but  más more 

mi my  mí me; myself 

porque because  por qué why? 

se himself; herself  sé I know 

si if  sí yes 

te yourself (clitic)  té tea 

tu your  tú you 

que that  qué what? 

quien who  quién who?; whom? 
Figure 7-1 
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Similar to the issue of accented Spanish characters, reflexive and non-reflexive 
pronouns in Spanish use overlapping word forms. To distinguish between these 
words, reflexive pronouns are marked in SALT with the special word code “[X]”, 
e.g., se[X].  
 

Bound Morphemes in Spanish and the Calculation of MLU (in words) 
 

ISSUE: The calculation of MLU in morphemes (MLUm) requires that specific 
bound morphemes (-s plural; -ed past tense; -ing present progressive; -s 3rd 
person regular tense; -‘s possessives) be counted. Although it is possible to mark 
all bound morphemes in Spanish, the process is not as easy as it is for English. In 
English, the SALT convention is to mark the morpheme using the bound 
morphemes “/” convention (walk/ed; walk/3s; walk/ing; dog/s; dog/z; dog/s/z). 
Although there are consistent morphological markers for the different tenses in 
regular Spanish verbs, marking verb morphology using the bound morphemes 
“/” convention would be somewhat difficult and cumbersome since the 
infinitive forms (roots) of the regular verbs are not always maintained across 
their conjugations. In addition, Spanish has a large number of irregular verbs 
that according to Brown’s rules for calculating MLUm should not be counted as 
two separate morphemes. A number of regular (hablar “to speak”; pensar “to 
think”; dormir “to sleep”) and irregular (ser “to be”; ir “to go”) verbs in Spanish 
are conjugated across number and tense in Figure 7-2 for illustration purposes. 

 

 HABLAR PENSAR DORMIR SER IR 

Present 
Indicative 

1st singular hablo pienso duermo soy voy 

2nd singular hablas piensas duermes eres vas 

3rd singular habla piensa duerme es va 

1st plural hablamos pensamos dormimos somos vamos 

3rd plural hablan piensan duermen son van 

Preterit 
Indicative 

1st singular hablé pensé dormí fui fui 

2nd singular hablaste pensaste dormiste fuiste fuiste 

3rd singular habló pensó durmío fue fue 

1st plural hablamos pensamos dormimos fuimos fuimos 

3rd plural hablaron pensaron durmieron fueron fueron 

Figure 7-2 
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Over the years, some individuals have unsuccessfully attempted to establish 
rules for calculating MLUm in Spanish. These attempts have met strong 
resistance from the research community for various reasons. To many, the 
Spanish MLUm calculation appeared to be arbitrary and sometimes 
inconsistent. It is important to remember that the specific bound morphemes 
selected by Brown to calculate MLUm were morphemes in English that had 
multiple phonological variants, received only slight stress, and developed 
gradually. To what extent are these morphemes relevant to Spanish? For 
example, clitics in Spanish also fit Brown’s criteria, should they also be included? 
Instead of developing a new way of calculating MLUm in Spanish, the majority 
of researchers examining language acquisition in Spanish have opted to use 
MLU in words (MLUw); a measure that appears to be equally valuable (Parker & 
Brorson, 2005). Thus, the need to code verb morphology in Spanish becomes 
unnecessary.  
 
However, not accounting for inflected word forms, including verb conjugations, 
would inflate NDW since inflected variants having the same root would be 
counted as different words. Using the verbs in Figure 7-2, soy, eres, es, somos, 
and son, all inflected conjugations of ser “to be”, would be incorrectly 
considered as different words in the calculation of NDW. 
 
SOLUTION: The decision to focus on MLUw, rather than MLUm, eliminated the 
need to develop conventions for marking verb morphology in Spanish. The root 
identification “|” convention was developed to ensure that the rich inflectional 
variation in Spanish was not lost for subsequent SALT measures and reports, 
and to prevent inflation of lexical measures like NDW. The vertical bar character 
“|”, is used to identify verb root forms in any language, e.g., la manzana es|ser 
roja, “the apple is|be red”. The word located to the left of the “|” (actual word) 
is included in the count of total words; the word located on the right of the “|” 
(root word) is included in the count of different words. The root identification 
“|” convention simultaneously (a) captures multiple inflected verb forms in 
Spanish and irregular verb forms in English; (b) credits the speaker for using 
distinct inflections; and (c) maintains the infinitive root form for each of these 
conjugations. It is important to note that using the root identification 
convention is required for Spanish samples and optional for English samples.  
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Identifying the word root of verbs in Spanish is a rather time-consuming task, 
especially when transcribing multiple transcripts. In order to further reduce the 
time required to transcribe the language samples, the Edit menu: Identify Roots 
command is built into SALT. This command, which requires just a few steps, 
automates the process of marking word roots and their inflected word forms. 
The Edit menu: Identify Roots command instructs SALT to automatically check 
over 450,000 inflected verb conjugations in Spanish; SALT then automatically 
inserts the appropriate verb root into the transcript. In cases where there is 
more than one root option, e.g., identical inflectional variants such as fui, which 
can be either fui|ser “I was” or fui|ir “I went”, SALT provides you with a list of 
choices to select from.  
 
If you’re interested in knowing the specific tenses or moods children are using, 
you could create special word or utterance codes to mark this. For example, to 
mark the frequency of particular tenses, you could create a code for each tense 
of interest and attach a code to the verb, e.g., El niño agarró|agarrar[PRT] la 
pelota y se la llevó|llevar[PRT] para la casa “the boy grabbed the ball and took it 
home”; [PRT] codes for preterit. The Analyze menu: Code Summary can be used 
to count these codes and list the verbs associated with them. 
 
Marking plurals in Spanish, however, is rather easy to do when number is 
marked in nouns, adjectives, and adverbs. In order to obtain an accurate NDW, 
the “/“ convention should be used with all plural nouns, adjectives, and 
adverbs, e.g., los perro/s grande/s “the big dogs”. It should be noted that 
articles are not marked for number, as they are considered stand-alone 
morphemes in Spanish. 
 
Pronominal Clitics 
 
ISSUE: In Spanish, direct and indirect object pronouns can be either 
independent words or bound affixes. These pronominal clitics can be located 
before or after the verb, and they can be free standing or bound to the verb. 
Regardless of where the clitic is located relative to the verb, the meaning of the 
utterance typically remains the same. For instance, an imperative statement 
such as, give it to me, can be stated in Spanish as follows: me lo das “give it to 
me”, or dámelo “giveittome”. Orthographic convention dictates me lo das 
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written as three separate words and dámelo written as one word. Both of these 
phrases, however, contain two clitics (me “me”; lo “it”) and one verb (dar “to 
give”). 
 
SOLUTION: The bound pronominal clitics “+” convention was developed in SALT 
to (a) maintain orthographic integrity; (b) credit equal morphological weight; (c) 
control for dialectal variation in Spanish; and (d) to increase the precision of 
certain length-based measures such as MLUw and NDW. For instance, the three 
words (two clitics + one verb) in dámelo would be marked with the bound 
pronominal clitic convention as follows: dá+me+lo.  
 
SALT automatically marks bound pronominal clitics in Spanish via the Edit menu: 
Identify Roots command. It is important to note that the Spanish Nouns and 
Clitics RIF is an incomplete list, based on the most frequent words used to retell 
Frog, Where Are You? (Mayer, 1969).  
 
Utterance Segmentation: Modified Communication Units (MC-units) 
 
ISSUE: The basic unit for segmenting utterances used in SALT is the 
communication unit (C-unit; an independent clause and its modifiers, including 
subordinate clauses). Thus, a sentence like, the boy went running and grabbed 
the frog, would be segmented as one utterance. Although the equivalent of this 
sentence in Spanish, el niño estaba corriendo y agarró la rana, could also be 
segmented as one utterance, doing so would ignore the pro-drop nature of 
Spanish. Whereas omitting subject nouns or pronouns is ungrammatical in 
English, these can be grammatically dropped in Spanish as the null subject 
information is encoded in the verb (Bedore, 1999). For instance, the English 
phrase he jumped, can be grammatically stated in Spanish as: (a) él brincó  (“he 
jumped”) including the pronoun él (“he”); or (b) as brincó (“[he] jumped”) since 
gender is implied by context and the Spanish verb encodes for person. 
 
SOLUTION:  Modified C-units (MC-units), based on rules originally proposed by 
Gutiérrez-Clellen and Hofstetter (1994) for Terminable Units in Spanish, were 
used to segment the language transcripts contained in the Bilingual 
Spanish/English Reference databases in order to (a) account for the pro-drop 
nature of Spanish, and (b) facilitate consistency when transcribing language 
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samples in Spanish and English from the same bilingual speaker. Therefore, 
segmenting utterances as MC-units is recommended in SALT for bilingual 
(Spanish-English) samples. 
 
MC-units follow two rules. The first rule, like standard C-unit segmentation, 
states that an utterance consists of an independent clause and its modifiers, 
including subordinated clauses. The second rule states that independent clauses 
joined by a coordinating conjunction are segmented as two separate utterances 
when there is co-referential subject deletion in the second clause. MC-unit 
segmentation is illustrated in Figure 7-3. The first row illustrates subordinated 
clauses in Spanish and English, which are not segmented as two separate 
utterances. The subordinating conjunction cuando, is used in Spanish; the 
subordinating conjunction when, is used in English. The second row illustrates 
coordinated clauses in Spanish and English, which are therefore segmented into 
two utterances in each language. The coordinating conjunction y, is used in 
Spanish; the coordinating conjunction and, is used in English. Further, pro-drop 
in used in the segmented utterance in Spanish, y olvidó sus llaves (“and [he] 
forgot his keys”). 
 

Spanish subordinated clause (1 utt) 
"C Marcelo se fue cuando se acabó 
la comida." 

English subordinated clause (1 utt) 
 "C Marcelo left when he 
finished the food." 

Spanish coordinated clause (2 utts) 
 "C Marcelo se fue." 
 "C y olvidó sus llaves." 

English coordinated clause (2 utts) 
 "C Marcelo left.” 
 "C and forgot his keys.” 

 

 
Making Clinical Decisions  
 
Sometimes, bilingual children perform poorly on a particular battery of tests. 
One question we should always ask is, was the poor performance due to the 
language in which the assessment was conducted or is the child truly language 
impaired? To illustrate this issue, let’s look at Figure 7-4 which is a two-
dimensional graph where performance in one language (Language A) is on the 
x-axis and performance in the other language (Language B) is on the y-axis. The 

Figure 7-3 
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two dotted lines represent the average performance in each language. The 
intersection of the two lines divides the space into four unique quadrants 
(Quadrants I-IV).  
 

Figure 7-4 
 

Children in Quadrant I (above average in Language A and B) will perform like (or 
above) their typically developing peers regardless of whether they are assessed 
in Language A or Language B. Children in Quadrants II and III will be perform like 
their typically developing peers if we take into consideration the language in 
which they are most proficient (Language A for children in Quadrant II; 
Language B for children in Quadrant III). Children in Quadrant IV are below the 
average in both languages. The decision as to whether children in Quadrant IV 
are typically developing or language impaired will be dependent on the cut-off 
score used to make this clinical decision. SALT contains the Bilingual 
Spanish/English reference databases (Appendices G & H). These databases 
consist of narratives produced in English and Spanish by over 4,600 typically 
developing bilingual (English-Spanish) children enrolled in transitional EL 
classrooms (kindergarten through third grade) in Texas and California. The 
narrative retell language samples were elicited using a series of Mercer Mayer’s 
wordless picture books; Frog, Where Are You? (Mayer, 1969), Frog Goes To 
Dinner (Mayer, 1974), and Frog On His Own (Mayer, 1973), following a 
standardized elicitation protocol. The unique story samples were elicited using 
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wordless picture book, One Frog Too Many (Meyer & Meyer, 1975). These 
databases allow users to compare a speaker's performance in either language to 
age and/or grade-matched bilingual peers retelling the same story using the 
same language.  
 
As should be clear by now, children’s performance can vary as a function of the 
language in which they are assessed. The clinical decision making process 
involves: (1) deciding to which of the four quadrants the child belongs to; and 
(2) determining whether the child’s performance is significantly below the 
performance of his or her peers in both languages, particularly if the child’s 
performance falls within Quadrant IV. Ideally, we should first assess the child in 
his or her native language. However, we are clearly aware that for many speech-
language pathologists, assessing the child in his native language will be 
impossible since the majority of clinicians do not speak a language other than 
English. This can also be the case for clinicians who may be bilingual, but do not 
speak the native language of the client. Thus, we suggest that clinicians first 
assess the child in the language in which the clinician is the most comfortable. 
Figure 7-5 graphically illustrates the decision making process we recommend for 
bilingual children. 
 

 
Figure 7-5: Clinical decision-making process – Potential scenarios 

 
In some cases, clinicians will only need to assess one language. In other cases, 
they will not be able to make a diagnosis until both languages are assessed. 
First, assess the speaker's language in English or in Spanish and compare the 
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performance to the English or Spanish of typical bilinguals. If the performance is 
within normal limits, then stop. However, if the performance in the first 
language assessed is below what is expected based on bilingual norms, then 
assess in the other language. If the performance in either language is within 
normal limits, then there should be no clinical concern. However, if testing in 
English and testing in the native language both reveal areas of concern, then the 
speaker is at risk for a language disorder and intervention plans should be 
developed.  
 
To illustrate the decision making process, let’s look at the performance of four 
children, illustrated in Figure 7-6. Four children (Alex, Betty, Carlos, and Daniel) 
were asked to narrate Frog, Where Are You? (Mayer, 1969) following the 
protocol from the Bilingual Spanish/English Story Retell databases. The 
Database menu: Standard Measures Report was obtained from the children’s 
narration compared to grade-matched peers. Their performance on MLUw and 
NDW can be seen in Figure 7-6. 
  

 ALEX  
Grade 1st  
Age 7;4 

BETTY 
Grade 1st   
Age 6;10 

CARLOS 
Grade K 
Age 5;10 

DANIEL 
Grade 3rd 
Age 10;1 

ENGLISH 
MLUw 6.57 (0.19) 5.53 (-0.86) 5.52 (-0.22) 4.69 (-2.52) 

NDW 94 (0.80) 72 (-0.07) 55 (-0.15) 53  (-1.71) 

SPANISH 
MLUw 5.19 (-1.33) 5.86 (-0.56) 5.43 (-0.33) 4.67 (-2.52) 

NDW 41 (-1.87) 85 (0.27) 72 (0.42) 72 (-1.52) 

 
 
Alex: Alex’s performance was within the normal range in English (0.19 and 0.80 
SD for MLUw and NDW, respectively). His performance in Spanish was 
significantly below that of his peers (-1.33, and -1.87 SD for MLUw and NDW). 
Based on the fact that his performance was within the normal range in one 
language (in this case English), he is functioning as a typically developing child.  
 
Betty and Carlos: Although Betty and Carlos demonstrated low-level 
performance in several of the measures in English and in Spanish, these results 
do not indicate language impairment since the performance was never 
significantly below the normal range in either language.  

Figure 7-6 
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Daniel: Daniel’s performance in English and in Spanish is consistently below the 
normal range (below -1. 5 SD). His overall below average performance in both 
languages indicates that he is likely to be language impaired. 
 

Summary 
 
LSA should be used as a fundamental component of clinical practice with 
bilingual children who speak Spanish. A series of articles by Rojas and Iglesias 
(2009; 2010) discuss LSA methods and approaches with bilingual language 
samples, including (a) how to implement LSA for purposes of assessment and 
intervention with Spanish-speaking children who are learning English as a 
second language, and (b) how to use LSA to measure language growth.  
 
For an example of how LSA is used to assess the language production of a 
bilingual (Spanish/English) student, refer to Case Study 6 in Chapter 10.



  



  

CHAPTER 

8 
 

The Dialect Features of AAE and Their 
Importance in LSA 
 

Julie Washington 
 

Introduction 
 
Historically, it has been difficult to distinguish the linguistic features of African 
American English (AAE) from linguistic forms characterizing language disorders. 
Further, many of the earliest reports of AAE focused on children from 
impoverished backgrounds, fueling beliefs that AAE was an impoverished 
language system. These shortcomings in the literature and ultimately in our 
understanding, fueled reports by educational psychologists and others that 
African American children growing up in poverty were significantly behind their 
middle-class White peers in their language development (Bereiter & Englemann, 
1966).  
 
A paucity of language assessment measures appropriate for use with AAE 
speakers has contributed to over-diagnosis of language disorders in the African 
American school-aged population. In the last decade tremendous growth has 
been made in the development of language evaluation instruments appropriate 
for students speaking AAE. This research and development has provided 
practitioners with a growing number of language evaluation instruments that 
are non-discriminatory when used with this population. In particular, Language 
Sample Analysis (LSA) has proven to be one of the most non-biased measures of 
oral language production across English speaking populations. However, this is 
only true if the examiner has knowledge of the specific linguistic features of the 
language being assessed. The goal of this chapter is to instruct readers on the 
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dialect features of AAE, support the use of LSA for use with AAE-speaking 
children, and ensure a non-biased component to the language evaluation 
process. After reading this chapter you should be able to recognize dialect when 
you see it in African American children. Our hope is that you apply this 
knowledge to the LSA process.  
 

What is African American English? 
 
The most neutral definition of “dialect” defines it simply as a language variety 
shared by a group of speakers (Wolfram & Schilling-Estes, 1998). Dialects are 
systematic, rule-governed variants of a parent language. African American 
English (AAE) is a dialect used by most, but not all, African Americans in the 
United States. AAE is developmental. Some of the forms used when children are 
young fade out with age, whereas others develop and become more 
sophisticated as speakers get older. AAE is the most studied dialect of English in 
the United States.  
 
Earlier in its history, it was believed that AAE was simply a poor variation of 
English, not rule-governed, not predictable, and not systematic in any way, but 
that it developed from poverty and from poor knowledge of English. That belief, 
which was called The Deficit Hypothesis, has been disproven. Many linguists in 
the late sixties and early seventies put forth great efforts documenting the use 
of the dialect and defining what makes AAE a dialect. At this point in history, it is 
well accepted that AAE is a dialect of English.  
 
It is important to remember that AAE is used by most, but not all, African 
Americans. It would be a mistake to assume, because a person is African 
American, that person is a dialect speaker. When talking about children in the 
United States, it is the case that approximately ninety-five percent of children 
entering school are dialect speakers. Consider the importance of the other five 
percent. If the belief were that all African American children used dialect, those 
five percent who don’t, but who show some difference in oral and/or written 
language may, in fact, be language impaired. Thus, one must be careful not to 
over-generalize this dialect to those approximately five percent who do not 
speak it 
 



 Chapter 8  ●   Dialect Features of AAE   131 

 

When thinking about AAE as a dialect in children, it is important to recognize 
that AAE is used almost exclusively by children in the United States who are 
referred to as “African American,” and are descended from slavery. AAE is 
considered a creolization of English that arose during slavery when slaves from 
different African countries needed to develop a common language to allow 
them to communicate both with each other and with slaveholders. In contrast, 
children whose families are immigrants from Africa or the Caribbean are not 
typically AAE speakers. These children are more likely to use dialectal variations 
derived from their native countries and languages.  
  
All children typically enter school bringing with them the language of their 
homes and their communities. AAE is highly variable in the amount of dialect 
used by a given child or community. The way this is described is called “density 
of dialect”. We know that some kids are low density users, some are moderate 
users, and some are very high users. Those that are the highest users of the 
dialect are the ones that sound the most “non-standard”. A high user of AAE 
might have 50% of their words or 35-50% of their utterances marked with one 
or more features of the dialect, and they would sound very different from a low 
density user. Interesting to note is that these two speakers may not have to 
come from different regions or geographic areas. They may come from the 
same neighborhood or live on the same street. 
 

Considering AAE in Language Assessment 
 
The two most common or frequently used forms in AAE, deletion of the copula 
and subject verb agreement, happen to be the most common markers of a 
disorder among Standard American English (SAE) speakers. This makes it very 
difficult to diagnose language impairment in the AAE population. There appears 
to be considerable overlap between the forms that are used by impaired SAE 
speaking children and typically developing AAE speaking children. Despite the 
fact that some of the forms and features are the same in these two groups, the 
overall quality of the talk is not the same. This, coupled with the high variability 
of density of dialect, is of concern to the SLP as this may influence language 
assessment and the diagnosis of language impairment in this population. Today, 
many more of the morphosyntactic forms used in AAE are included in some 
language assessment instruments used by SLPs. In the past, only the most 
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common features, more easily recognizable to SAE speakers, were included in 
assessments. Although improvements in standardized measures are flourishing, 
familiarity with the features of AAE is of the utmost importance when 
conducting a language assessment.  
   

AAE and the Written Form 
 
AAE has developed as an oral dialect with no well-developed written 
counterpart. Because we write like we talk, however, you will notice African 
American children write using dialect features. It is not that the dialect has a 
written form. It is instead that children perceive language the way they use it. If 
a child is using some AAE features in their oral language, you may see those 
features are also used in their writing. In addition, African American children 
who speak SAE may write using AAE dialect features. Children who come to 
school speaking SAE have an advantage when text is presented to them. That 
text is similar to what they speak and probably hear. This often will not be the 
case for African American children who use AAE. 
 
Writing is both a bridge and a mirror into code switching with African American 
students. So if you are an AAE speaker, you will also write using AAE. Teachers in 
public schools often say, “These kids write just like they talk.”  That is absolutely 
true. The way that you speak syntactically, phonologically, is also the way you 
will write. Thus, African American students who can write in SAE can also speak 
in SAE. When you encounter an AAE child who is writing standard classroom 
English, he or she is a child who is probably able to code switch to the use of 
standard classroom English. So for educators and clinicians, writing is both a 
bridge to SAE and a mirror into the African American child’s code switching 
ability. This bridge means that if we can teach children to write in SAE, we can 
also assist in the generalization of that writing to oral language. And it’s a mirror 
because, sometimes with a child who is reticent to talk, or from whom we 
cannot hear those features orally, if you ask them to generate something in 
writing, you will see the use of AAE features. The interesting thing about writing, 
however, is that unlike oral language, where we do have some tolerance for 
non-standard forms or for variety, we do not have the kind of tolerance in the 
written domain. It is expected that when you write you will use the conventions 
of writing without deviation. The exception is when writing dialogue. If a child is 
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trying to write in the voice of the speaker often you will see dialect used. We 
see “voice” put in quotation marks and we allow variety within those quotation 
marks.  
 
It’s important to identify AAE features in writing samples for a number of 
reasons, but probably the most important reason is that these are not simply 
errors. If a child has spelling or grammatical errors, they are just mistakes which 
you can point out and the child can fix. What we are talking about here is a 
child’s linguistic system. This is their dialect which is not as easily amendable to 
being changed through editing. This doesn't mean that you don’t target them 
but, what it means for the teacher, typically, is that these will take more time 
for the child to understand because you’re not just asking them to make 
grammatical changes, you’re asking them to switch linguistic codes from AAE to 
standard classroom English. Thus, when you see dialect forms in writing, 
recognize that it likely will take more time, more effort, and more attention to 
change them.  
 

The Features 
 

The features discussed below are those primarily used by children in northern 
dialect regions or the Midwestern states. These are the most common features 
and might be thought of as a core set of features generalized across regions. 
Children from other regions, like the south, will use many of these features. 
However, they also use other features that characterize the regional area. For 
example, children from Georgia or Alabama will use AAE as well as Southern 
English, and they will also speak a form of AAE that is spoken by children in the 
south.  
 
The morphosyntactic features, or those that can be seen from the written 
grammar of the transcript, are best defined by example. These are the features 
we are most interested in when taking a language sample as they affect the 
vocabulary and syntax of the sample. They are explained below in order of 
frequency of use, from most frequently used to least frequently used.  
 

1. Deletion of the Copula & Auxiliary is the first feature defined. The copula is 
a form of the verb “to be”. It is the form of the verb that is not a helping 
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form. The form of “be” stands alone as the only verb. Examples include the 
deletion of the copula “is” as in, “This a dog”, “She hungry”, or, “I happy”. 
Also frequently noted in AAE is the deletion of the auxiliary, which is 
deletion of the form of the verb “to be” as in “They catchin’ a bus”. Here the 
deletion is of the helping form “are” from the phrase “They are catchin’ a 
bus”. The deletion of the copula and auxiliary forms are the most common 
features seen in AAE. If a child or adult is a speaker of AAE, they will be 
deleting the copula and auxiliary forms. This is seen 100% of the time in 
AAE.  
 

2. Subject-Verb Agreement is also very common in AAE. This form is seen in 
85-90% of AAE speakers. For example, the speaker might say, “they was 
eatin’ cookies”, rather than “they were eatin’ cookies”. 

 
3. “Fitna/Sposeta/Bouta” are forms that code imminent action, or something 

that’s getting ready to happen, or that is going to happen immediately. 
“Fitna” is a form of “fixin to”, often used in the south, as in “I’m fixin to do 
something”. In the case of children, it is a catenative form similar to 
“gonna”, “wanna”, or “hafta”. Instead of saying “fixin’ to”, the speaker says 
“fitna”, e.g., “Is she fitna drink some?”, “Is she fitna go to the store? This 
particular form derives from the south. Historically, African American 
people migrated from the south, so AAE has several features that overlap 
with Southern English. There are forms that African American people 
learned to use when they were in the south that are now considered part of 
the dialect because, when those speakers left the south, they took those 
forms with them and they became part of the language of the community. 
You may encounter African American people who speak AAE in California, 
Florida, Maine, or New York, for example, who use features that came from 
the south. Other catenative forms include, “He was bouta get in the car.” 
which derives from “about to”, and, “We sposta go to the store.” which 
derives from “supposed to”. 
 

4. Undifferentiated Pronoun Case is used more frequently by African 
American children than by African American adults. Nominative, objective, 
and demonstrative cases of pronouns occur interchangeably. Examples 
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include, “Them pullin’ up the hill.”, “My uncle forgot they lunch”, or, “Him 
did it”.  
 

5. Multiple Negation, such as, “I don’t got none” is a form that many people 
are familiar with and often equate with AAE. Typically we think of double 
negation, or the use of two negatives in one sentence. But the negative is 
used for the purpose of emphasis, so you may see many multiple negatives 
in one sentence. An example of Multiple Negation is “Why you don’t want 
nobody to put none too close to your mouth?”. This can be interpreted to 
mean “Why don’t you want anybody to put any too close to your mouth?”. 
 

6. Zero Possessive can be used by children in a number of ways. Typically we 
see the deletion of the apostrophe (‘s) in possessive forms such as “That the 
dog (‘s) food”, or “They’re goin’ to her brother (‘s) house”. Also seen with 
younger children is the deletion of the possessive form of a pronoun, such 
as, “They waitin’ for they car” rather than “their car”, or “you house”, 
instead of “your house”. AAE is developmental, thus some forms are used 
by young children, but change or fade as language develops.  
 

7. Zero Past Tense, such as, “he dig a hole” or “she jump over the puddle”, is 
common in AAE. The past tense marker is deleted. In AAE we often see 
elements deleted that would be redundant in Standard English, however 
the speaker will be sure to leave no ambiguity. Both the zero possessive and 
the zero past tense forms are good examples of this. The language will 
include some form of tense marking such as the use of words like 
“yesterday”, “last week”, or “this morning” to ensure the tense is clear. So, 
if a conversation is being held in past tense, for example, in AAE there is no 
reason to include the past tense marker –ed. When working with a typically 
developing African American child, the deletion of the past tense creates no 
ambiguity about whether what is being spoken about is in the past or in the 
present. But, in the case of a child who is not typically developing, for 
example, a child with language impairment, ambiguity is possible.  
 

8. Invariant Be is frequently associated with AAE, however, is it not as 
commonly used as people believe it to be. It is not used frequently by young 
children, but rather, if it is used, we tend to see it in teenagers or adults. It is 
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also regionally dependent in that it is more prominent in the south. 
Invariant “be” is the infinitive form of the verb “be” regardless of the 
subject. You might see “he be”, “she be”, “we be”, “Sally be”. The “be” verb 
is not conjugated. More examples include, “They be getting’ some ice 
cream”, or “He be goin’ down the hill”.  
 

9. Zero To is the deletion of the “to” infinitive marker in front of an infinitive 
verb. An example of this is, “And he waitin’ for the train go”. In SAE, the 
infinitive would be stated, such as, “And he [is] waitin’ for the train to go”. 
 

10. Zero Plural is where the plural marker is removed from a noun. The plural is 
usually marked somewhere in the speech context so there is no ambiguity 
that the word which is missing the plural marker is in its plural form, e.g., “A 
girl puttin’ some glass out on the table to drink”. The word “some” indicates 
to the listener there that there are multiple glasses.  
 

11. Double Modal is most often seen in the southern regions by speakers of all 
ages. It overlaps with Southern English. It is typically heard in adolescent 
and adult speech in forms such as “might could”. “I might could help you.” 
Younger children’s use of the double modal is less mature, or more child-
like, such as, “Why didn’t the boy didn’t stop?”. Here the child used two 
modal auxiliary forms. Also frequently heard in young African American 
children are the double modal forms “I’m am” and “I’m is”. An example 
includes, “I’m am goin’ to the store.” 
 

12. Regularized Reflexive, such as, “He stands by hisself” or “They goin’ by 
theyself”, is characterized by changing the irregular reflexive pronoun 
patterns to a regularized form. The speaker is, in a sense, smoothing out 
irregular patterning of forming reflexive pronouns by applying the same rule 
to all forms in the set. 
 

13. Indefinite Article is characterized by the use of the indefinite article “a” 
even when the following word begins with a vowel. The use of “an” prior to 
a noun starting with a vowel is absent. Examples include “He saw a 
elephant.” or “They’re building a apartment.” 
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14. Appositive Pronoun is where both the pronoun and the noun, or the noun 
phrase that it refers to, are included in the utterance, rather than one or the 
other. In SAE, either the noun or pronoun is used. In AAE in young children it 
is very common to hear examples such as, “My mamma she said I could go.” 
My daddy, he gave me that.” or “My auntie, she bought me my coat.”  A 
more adult form might include “And the other ones they didn’t have 
nothin’.” 
 

15. Remote Past “been” is an interesting form. It is typically used by older 
children because the verb phrase is more sophisticated. The speaker is 
talking about something that happened in the remote past that is habitual 
or continuous. “I been knowin’ how to swim” can be paraphrased as “I have 
known how to swim for a long time”. 

 
The following six forms are not typically heard from children in the early 
elementary grades such as preschool through grade two. However, they are 
used by children in the upper elementary, middle, or high school grades. 
 
16. Preterite Had is the past tense use of had followed by a past tense verb, 

either regular –ed, or irregular such as “had went”. Examples include “You 
had got his toes stuck before.”, “He had went home.”, “And then she had 
called the house.” 
 

17. Completive Done in AAE means it’s over; it’s completed. It is one of the 
forms that overlaps with Southern English. Examples include “I think we 
done ate enough.”, and, “I think we done finished.”  
 

18. Existential It is a form in AAE heard in children and adult’s oral language, 
but seen significantly more in their writing. Instead of saying or writing, for 
example, “There’s a lot more to do now”, an African American speaker 
would say or write, “It’s a lot more to do now”. The word “it's” is used in 
place of “there’s”. Another example might be, “It seems like it’s a lot more 
on here that you haven’t shown me.” 
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19. Resultative Be Done:  Unlike the Completive Done that tells you something 
is over, Resultative Be Done tells you what is going to happen if you keep 
doing something. It is the result. “We be done dropped these and broke 
‘em.” means “if we keep doing this, we’re going to drop these and break 
them”. Another example might be, “We be done got a ticket if we keep 
speedin’.”  
 

20. Double Marked –S is a feature, that, if used in the home by adults, we are 
likely to hear children use as well. We do not often hear it with very young 
children. It is heard more in the south. It is the double marking of –S in a 
possessive case such as “mines”, “mens”, and sometimes in plural cases 
where the plural is double marked. For example, “This one is like mines.”  
 

21. Non-inverted Question is a feature that we frequently hear adults using 
with their children. What is spoken is a statement with rising intonation 
rather than asking a “wh” question. So, rather than “Where is she going?”, 
the question would be formed with rising intonation, “She going to the 
store?”. “How does it go?” would be stated with question intonation, 
”That’s how it go?”.  

 
These 21 morphosyntactic AAE features are summarized in Figure 8-1. 
 
The phonological features of AAE, those which can be heard when listening to a 
speaker, are defined in Figure 8-2. It is important to have some familiarity with 
these features when using LSA. Presence or absence of these features help to 
discern the density of dialect and can indicate the possible presence of 
morphosyntactic features within a language sample.  
 

When transcribing phonological features using SALT, we transcribe the words 
used but not the pronunciation used by the speaker. For example, if the speaker 
drops the “g” and says “waitin” for “waiting”, this would be transcribed as 
“waiting”. 
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Figure 8-1 

Morphosyntactic AAE Features Used by Children in Northern Dialect Regions 

Feature Example Code 

1. Deletion of Copula & Aux they__ catchin’ a bus [COP] 

2. Subject-Verb Agreement they was sittin’ down at the table [SVA] 

3. Fitna/Sposeta/Bouta  
code imminent action 

is she fitna drink some? 
he was bouta get in the car 

[FSB] 

4. Undiff. Pronoun Case Them pullin’ them up the hill [UPC] 

5. Multiple Negation 
why you don’t want nobody to put none too 

close to your mouth? 
[NEG] 

6. Zero Possessive they waitin’ for they car [POS] 

7. Zero Past Tense 
and then he fix__ the food 

yesterday we take the long way home 
[ZPT] 

8. Invariant “be” they be gettin’ some ice cream [IBE] 

9. Zero “to” and he waitin’ for the train __ go [ZTO] 

10. Zero plural 
a girl puttin’ some glass__ out on the table to 

drink 
[ZPL] 

11. Double Modal why did the boy didn’t stop? [MOD] 

12. Regularized Reflexive he stands by hisself [REF] 

13. Indefinite Article they buildin’ a apartment [ART] 

14. Appositive Pronoun and the other ones they didn’t have nothin [PRO] 

15. Remote Past “been” I been knowin’ how to swim [BEN] 

Morphosyntactic AAE Features Used by Older Children and Adults 

16. Preterite had he had got his toes stuck before [HAD] 

17. Completive done I think we done ate enough [DON] 

18. Existential it 
it seems like it’s a lot more on here that you 

haven’t shown me 
[EIT] 

19. Resultative be done we be done dropped these and broke ‘em [BED] 

20. Double marked –s this one is like mines [DMK] 

21. Non-inverted Questions that’s how it go? [NIQ] 
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Phonological AAE Features 

Feature Example Code 

1. Postvocalic consonant reduction 
mouth 

/maU/ for /maU/ 
[PCR] 

2. “g” dropping waitin’, jumpin’ [G] 

3. f /θ , v/ð and t/θ in intervocalic and 
postvocalic positions 

/wif/with/, bave/bathe, 
wit/with 

[STH] 

4. d/ð in prevocalic positions dis/this [STH] 

5. Consonant cluster reduction col-/cold [CCR] 

6. Consonant cluster movement aks/ask; ekscape/escape [CCM] 

7. Syllable deletion --came/became [SDL] 

8. Monophtongization of dipthongs ar/our [VOW] 

9. Voiceless final consonants replace 
voiced 

hiss/hiz (his) [FCV] 

Figure 8-2 

 
Transcription Codes 
 

The codes listed with each AAE feature in Figures 8-1 and 8-2 have been used in 
SALT to flag the occurrences of those features in samples from dialect speakers.  
 
To see an example of how LSA is implemented with an AAE speaker, refer to 
Case Study 7 in Chapter 10.



  

CHAPTER 

9 
 

 

Additional Applications of SALT 
 

Joyelle DiVall-Rayan 

Jon F. Miller 
Karen Andriacchi 
Ann Nockerts 
 
Introduction 
 

While we traditionally think of SALT Software as an assessment tool to evaluate 
and analyze oral language skills, there are other non-traditional applications for 
which SALT can be useful as well. Due to the flexibility of the software and 
ability to customize codes, SALT can be used for almost any language production 
task. In this chapter we highlight two alternative uses of SALT; to assess 
expressive language in written form, and to assess disfluent motor speech 
production.  
 

Using Salt to Assess Written Language 
 

In our technology-driven society, brevity seems to be appreciated when we are 
texting or typing out 140-character tweets. However, strong written language 
skills are still a vital part of the language arts curriculum starting in kindergarten 
and extending through 12th grade. Students are expected to write opinion 
pieces, informative/explanatory texts, narratives, and research texts. The 
Common Core State Standards suggest that, starting in second grade, students 
should, “Use knowledge of language and its conventions when writing, 
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speaking, reading, or listening” (CCSS:L.2.3). Students in second grade are 
required to, “Write opinion pieces in which they introduce the topic or book 
they are writing about, state an opinion, supply reasons that support the 
opinion, use linking words to connect opinion and reason, and provide a 
concluding statement or section” (CCSS: W.2.1). By their senior year, students 
are required to “Write narratives to develop real or imagined experiences or 
events using effective technique, well-chosen details, and well-structured event 
sequences” (CCSS: W.11-12.3). Based on the standards, developing proficient 
writing skills is no small feat. SALT can be used to analyze written language 
samples to provide an abundance of information about developing written 
language skills.  
 
Nickola Nelson, of Western Michigan University, says the following about the 
usefulness of using SALT software when analyzing written language samples 
(personal communication, August 7, 2015).  
 

We have used SALT extensively in our research and clinical work on written 
language with school-age children and adolescents. (See Nelson, 2014a, 
2014b, for information about this work and about a story probe technique 
for gathering baseline samples for a classroom-based writing lab approach.) 
SALT is beautifully suited to conducting some forms of analysis that are 
difficult to manage by hand, such as counting the number of words and 
more particularly, the number of different words. Both of these can be 
helpful repeated measures for written language samples gathered under 
similar conditions. SALT facilitates the process of coding (you can make up 
your own as well as using standard SALT conventions) and counting of 
codes. SALT features allow you to count the child’s use of specific 
conjunctions and pronouns, which can be quite useful as well, in establishing 
baseline levels and marking progress. When transcribing written language 
samples, it is important to follow the special rules for transcribing spelling 
errors in order to make accurate word counts. When dividing utterances into 
C-units (also called T-units within written language samples) it is best to 
treat them as if they were oral language samples (i.e., ignoring student 
punctuation). By transcribing each C-unit as a separate utterance, you can 
use SALT’s calculation of Mean Length of C-unit to compare your student’s 
samples across time or writing contexts. Not to be missed are the 
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advantages of working on language samples that do not have to be 
transcribed from an audio recording and the delights of experiencing how 
children and adolescents express their ideas in writing. 

 

How the text was generated should also be considered when assessing written 
language. Was it hand written? Or was it created by a word processing program 
or a speech-to-text software application such as Dragon Dictate? The question 
must be considered, does the text generation method contribute to the end 
result? Hand writing can be difficult to decipher making it challenging to identify 
words and word boundaries. Certainly, spelling can be a challenge, particularly 
when consistent forms are not used. Broadening definitions of words to 
accommodate “invented” spelling will require using a “rich interpretation” 
strategy where credit is given if the word form is consistent but not correctly 
spelled.  
 

SALT can be used to assess written samples and to track progress on features of 
written language performance from writing conventions such as capitalization, 
punctuation, and spelling to use of specific vocabulary such as linking words. 
Written samples can be coded to capture any feature of writing an evaluator is 
interested in tracking. By applying SALT’s standard transcription conventions 
and codes to the written sample, analysis will also yield measures of linguistic 
performance such as MLU, NDW, and more. The types and extent of coding, as 
is always the case in SALT, is left to the discretion of the user. By marking more 
features within the sample, more information can be yielded from the analysis. 
 

Procedure 
 

The procedure developed to analyze written language in SALT requires typing 
the written language into the SALT editor using SALT transcription conventions 
and then applying the suggested written language coding scheme to the sample. 
Once the sample is entered and coded, SALT can generate reports from the 
Analyze menu with information on specific vocabulary, length of sentences, 
errors, e.g., coded spelling errors, or punctuation errors, and grammar. There 
are no comparison databases with the SALT program for comparing written 
samples. However, samples can be compared time 1/time 2 to track progress in 
writing skills. The following coding scheme is recommended to capture written 
language performance.  
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Written Sample Coding Scheme 
 

 
Misspellings [S] 
 
Mark misspellings for analysis of 
vocabulary, language and 
spelling skills. 
 
  

[S]- spelling error 
Misspelling|correct spelling[S] 
Example: Forg|frog[S] 
 

[S] [EW:__]  spelling and word form error 
Example: Baite|bite[S][EW:bit] 
 

Spelling error and omitted bound 
morpheme  
Example: Lok|look/*ed[S] 
 

Spelling error with correct morpheme 
Example: Cyring|cry/ing[S] 
 

Spelling and overgeneralization error 
Example: Teled|tell[S][EO:told] 
 

Non-grapheme symbol (unidentifiable) 
Example: frXg|frog[S] 
 

Code switch with (Spanish) misspellings  
Example: The abehas|abeja/s[S] chase/ed 
the boy [CS].  

 
Upper/lower case errors [IC] 
 
Incorrect use of upper case or 
lower case letters [IC] 

Obligatory capitalization, e.g., proper 
pronouns or beginning of utterances 
Wrote: the frog was gone. 
Transcribed: the[IC] frog was gone. 
 

Use of capital letters in middle of word. 
Wrote: He rAn home. 
Transcribed: He rAn[IC] home. 

 
Letter reversals 

Type correct grapheme assuming they are 
developmentally appropriate. Create 
custom code to analyze this feature, if 
desired. 



 Chapter 9  ●   Additional Applications of SALT   145 

 

 
Punctuation [PN]  
 
Mark missing, incorrect, and/or 
extraneous punctuation. Do not 
insert commas and quotations 
even if obligatory.  

[PN] – punctuation error 
Missing end of utterance punctuation 
Insert code at end of utterance followed 
by appropriate punctuation.  
Wrote: The frog jumped 
Transcribed: The frog jump/ed [PN]. 
 

Incorrect punctuation  
Type the writer’s punctuation in the code 
followed by correct punctuation outside 
of bracket. 
Wrote: Where are they. 
Transcribed: Where are they [PN.]? 
 

Extraneous punctuation mark 
Insert the [PN] code, including 
punctuation produced, at location of 
extra punctuation. 
Wrote:  He said. to go away. 
Transcribed: He said [PN.] to go away. 

 
Word Punctuation [WPN] 

[WPN]- word punctuation error 
Missing word-level punctuation 
Wrote: The girls coat was red. 
Transcribed: The girl[WPN’]s|girl/z coat 
was red. 

Numbers 
Type numbers as they were written.  
Example: 8 or eight 

Sound effects Type as they were written 

Extra Space [XSP] 
Extra space within written word. 
Wrote:  honey moon   
Transcribed: honey[XSP]moon 

Space Required [SPR] 
Space required within written word. 
Wrote: theyare 
Transcribed: they [SPR] are 
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Case Study: Using SALT for written language sample analysis 
 

The following is an example of a written narrative collected from a first grade 
student writing about the wordless picture book, One Frog Too Many (Mayer & 
Mayer, 1975). 
   

Written Sample 

 
Figure 9-1 
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SALT Transcript 

 

$ Child 
+ Grade: 1 
+ Context: WNar 
+ Subgroup: OFTM 
= case was not coded as it was not of interest to the examiner 
 
C wone|one[S] day the litte|little[S] boy had a geft|gift[S] [PN]. 
C the litte|little[S] boy was exited|excited[S] [PN]. 
C and he saw a card [PN]. 
C and ti|it[S] had hes|his[S] name [PN].  
C and then he open/*ed the box [PN]. 
C and he saw a litte|little[S] frog [PN]. 
C and the big frog dieret|did/n't[S] like it [PN]. 
C and then the big frog bit hes|his[S] leg [PN]. 
C and the boy was mad [PN]. 
C and then they went for a walk [PN]. 
C and then the littl|little[S] frog and the big frog got on the tres|tree/z[S][WPN’] 
back[EW:branch] [PN]. 
C and then the big frog puch|push/*ed[S] the litte|little[S] frog [PN]. 
C and he begen|began[S] to cri|cry[S] [PN]. 
C and then they went on a log [PN]. 
C and they left the big frog [PN]. 
C and then the big frog jump/*ed and puch|push/*ed[S] the littl|little[s] frog in the 
water [PN]. 
C and then the tril|turtle[S] saw it [PN]. 
C and then the boy saw it [PN]. 
C and then they look/*ed for hem|him[S] evry[XSP]wer|everywhere[S]  [PN]. 
C and then the boy went home [PN]. 
C and then they hred|heard[S] a nois|noise[S] [PN]. 
C and it was the litte|little[S] frog [PN]. 
C and he jump/*ed in the wendoor|window[S] [PN]. 
C and he jump/*ed on top of his had|head[S] [PN]. 
C and then the big frog lik|like/*ed[S] hem|him[S]. 

Figure 9-2 



148  Assessing Language Production Using SALT Software  

 

The written narrative (Figure 9-1) shows that the student’s handwriting is 
legible. Other features to note are the lack of capitalization and ending 
punctuation. The transcript (Figure 9-2) shows the missing end punctuation 
marked with the [PN] code. The lack of capitalization could have been coded 
using the [IC] code but was instead just indicated with a comment at the 
beginning of the transcript. Also note the production of multiple spelling errors. 
The student is using emerging sequencing as noted by her use of “and then” to 
begin most sentences.  
 

 
Figure 9-3 
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The Analyze menu contains a number of reports which can be used to analyze 
this sample. The Standard Measures Report (Figure 9-3) provides a summary of 
the sample. The student wrote 25 utterances (sentences) using, on average, 
seven words per sentence. The intelligibility measure indicates that all words 
were legible. A total of 175 words were written with 55 of those being different 
words. Note that the student had errors in 32% of her sentences. There were 
eight omissions (words and/or bound morphemes) and one word or utterance 
marked as an error. The next step is to analyze the codes to further explore the 
written sample. 
 

 
Figure 9-4 

The Code Summary (Figure 9-4) reveals that the student wrote one erroneous 
word, made 28 spelling errors, wrote one word without word-level punctuation, 
and wrote one word with an extra space within the word. Note there were 24 
utterance codes [PN] where the student did not use punctuation. Recall from 
the sample that there were 25 total sentences and ending punctuation was only 
used on the last sentence.  
 
In addition to the frequency and location of the written errors in a language 
sample, it may be valuable to look at the lexicon produced in the writing. The 
Grammatical Categories report (Figure 9-5) lists the parts of speech and the 
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number of times each part of speech occurred in the sample. As reported, the 
student used mostly nouns (57) and determiners (28), e.g., a, the, his. Note that 
the student produced 25 coordinators, which seems high.  
 

 
Figure 9-5 

The Grammatical Categories List (Figure 9-6) produces lists of the specific words 
identified in any of the grammatical categories. After selecting coordinators, the 
report details which coordinators were used. In this sample there were 25 uses 
of the word and. Although there was a high frequency of coordinators, the 
student actually only used this one coordinating form.  
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Figure 9-6 

 
Figure 9-7 
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The Word Code Table (Figure 9-7) lists each word code expanded to show the 
words that were coded. The clinician can then analyze these words for patterns 
in errors. The [S] code marked spelling errors. Spelling information can be 
shared with other professionals on the education team and, if needed, 
interventions can be implemented. In the student’s language sample, she 
consistently misspelled little and substituted “e” for “i” in gift, him, his, and 
window.  
 
Case Study Summary 
 
In the written narrative sample we ascertained that the student had very legible 
writing. She met the core standard, “Write narrative in which they recount two 
or more appropriately sequenced events, include some details regarding what 
happened, use temporal words to signal even order, and provide some sense of 
closure” (CCSS W.1.3). The analyses revealed that the student did not begin 
sentences with upper case letters nor did she use ending punctuation. Temporal 
words produced in the narrative lacked variety as she only used and then to 
sequence her narrative. Finally, it might be beneficial to monitor the student’s 
progress on spelling comparing to subsequent samples to see if the number of 
spelling errors decreases. For children with severely impacted spelling skills, 
computer software for apps may offer support for spelling through spell-
checking, word prediction, or speech-to-text capabilities.  
 
Other Considerations for Written Language 
 
It may be informative to explore various modalities for written language for 
students with and without language disorders. When pulling together an initial 
work-up of strengths and weaknesses, the production method must be taken 
into consideration in order to get an accurate assessment. Comparing 
performance of written language across hand written, word processed, or 
speech-to-text productions may help to discern how the production method 
helps or hinders text creation. It is also the case that software may mask 
difficulties where word choices and spelling help is automatic. It may be 
sufficient to help students work out the best technology-based supports 
possible to enhance their written language production. 
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Using Salt to Assess Fluency 
 
The coding scheme described in this section was specifically designed to mark 
speech disfluencies. The coding can be applied to an existing transcript, 
previously coded for oral language production, or a speech sample can be 
elicited for the sole purpose of assessing fluency. These fluency codes are 
flexible in nature. They can be general, just marking the occurrence of a 
disfluency, or further defined to add more detail. The Analysis menu: Fluency 
Codes and Behaviors report provides detailed information on the number and 
types of disfluent productions within the connected speech sample. This fluency 
report is useful, not only for initial evaluations, but additionally to track therapy 
progress or changes in fluency behaviors over time and/or contexts.  
 
Differentiating typical disfluencies from stuttering is imperative to a fluency 
assessment in order to determine whether there is a need for intervention. The 
American Speech Language Hearing Association (ASHA) provides the 
information below, which demonstrates how a language sample might help 
differentiate what are language vs. fluency production difficulties.  
 

Fluency Disorders/Language Difficulties 
Children with language difficulties at the sentence, narrative, or 
conversational discourse level may exhibit increased speech disfluencies, 
particularly interjections, revisions, and phrase repetitions. However, their 
disfluencies are not likely to involve prolongations, blocks, physical tension, 
or secondary behaviors that are more typical for children who stutter 
(Boscolo, Bernstein Ratner, & Rescorla, 2002).  
 
Word-finding issues can create increased non-stutter like disfluencies that 
are similar to those observed in cluttering; specific standardized tests can be 
used to rule out word-finding difficulties. Assessing organization of 
discourse also can help rule out verbal organization issues that might be 
mistaken for cluttering (van Zaalen-Op't Hof, Wijnen, & De Jonckere, 2009).  
 

Coleman (2013) states that typical speech disfluencies are made up of 
multisyllabic whole-word and phrase repetitions, interjections, and revisions. 
Conversely, stuttering contains sound or syllable repetitions, prolongations, 
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and/or blocks. Other differential behaviors seen in speakers who stutter may 
include physical tension and/or concomitant behaviors such as eye blinks, facial 
grimacing, and changes in pitch or loudness. Negative reaction or frustration 
may be noted. Avoidance behaviors such as reduced verbal output may also be 
present. These behaviors are not seen in speakers with typical disfluencies.  
A family history of stuttering may be also an important differential.  
 
Understanding the difference between typical disfluencies and stuttering helps 
clinicians make decisions about the coding scheme(s) they may want to apply 
during the transcription step of speech sampling. Will the sample be analyzed 
only for fluency, or are there features of oral language that will add to the 
assessment outcomes? 
 
Fluency treatment programs focus on increasing fluent speech production and 
effective communication. A desired outcome is to help the speaker participate 
more fully in social, educational, civic, and/or professional activities. The 
achievement of optimal communication in naturalistic, everyday 
communication contexts, such as in conversation or narration, make speech 
sampling a preferred practice for fluency evaluation since it can assess everyday 
use of oral language as well as speech production in these contexts.  
 
As mentioned previously, SALT’s fluency coding scheme can be applied to any 
transcript from any sample of spoken language. A clinician may collect a typical 
conversational or narrative sample. Or a sample from a specific speaking 
context such as a telephone conversation, ordering at a restaurant, a debate, or 
a mock interview may best capture the speaker’s difficulties with fluent speech 
production. It may be prudent to assess fluency in multiple linguistic contexts to 
determine the impact of each context on oral fluency. For example, a 
conversation, which taps into discourse and pragmatics, may yield different 
results than a narrative sample, where discourse is not interposed. Or, a 
conversational sample could be compared in analysis to a sample of oral reading 
where the opportunity to use alternate vocabulary is not present. The analysis 
results can be compared side-by-side using SALT’s linking feature.  
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Recommended codes to mark disfluent speech production  
 
SALT contains a default list of fluency codes which may be edited to suit your 
purposes. They include: 

[FL] used to mark any unspecified type of disfluency 
[FLR] used to mark repetitions 
[FLP] used to mark prolongations 
[FLB] used to mark silent blocks 

 
Coding Unspecified Types of Disfluencies - [FL] 
 
The insertion of the [FL] code can be used to highlight any type of disfluent 
production and will be tallied in analysis to provide the frequency of occurrence. 
 

• [FL] used to mark disfluent utterances. Insert the code [FL] at the end of any 
utterance containing one or more disfluencies. The fluency report will count 
and display the coded utterances.  

• [FL] used to mark disfluent words. Insert the [FL] code at the end of each 
disfluent word. When the [FL] code is attached to a word, with no space 
between the word and the code, the code indicates the presence of some 
type of disfluent behavior associated with that word. The fluency report will 
count and display the coded words with the option of also including the 
utterances.  

 

Applying the code [FL] at the word or utterance level provides only the number 
of words or number of utterances in the sample that contained disfluencies. 
Using further defined codes will generate more specific results in analysis.  
 
Coding the Type of Disfluency – [FLR], [FLP], [FLB] 
 

The default set of codes for SALT’s fluency analysis were developed to mark 
repetitions, prolongations, and silent blocks. These speech disfluencies occur at 
the sound, syllable, or whole-word level and are marked in the transcript using 
word codes, i.e., codes the disfluent words.  
 

The Edit menu: Insert Code option brings up the dialogue box “Code Lists Used 
to Facilitate Inserting Codes in Transcript” (Figure 9-8).  
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The “Fluency Codes” option, available at the bottom left of the dialogue box, 
brings up the list of default fluency codes. The code list can be changed, or 
customized, and saved for future use if desired.  
 

 
Figure 9-8 

This code list can be used to facilitate coding. Once selected, the “Select code to 
be inserted” dialogue box is displayed (Figure 9-9). 
 

 
Figure 9-9 
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You are provided with options for the position of the fluency codes. The codes 
can be inserted at the point of the cursor in the transcript, at the beginning of a 
word, at the end of a word, or at the end of an utterance.  
 
Basic Coding 
 
Basic coding involves inserting one or more codes at the end of each disfluent 
word within the SALT transcript. This coding option is a fast method of tallying 
the number and types of disfluencies produced in the language sample. 

 
Examples: 

C  My[FLR] mom was really angry. Repeated some or all of the word 
C  She like/3s banana/s[FLP]. Prolonged some part of the word  
C  She is funny[FLB].  Silent block at the beginning or in 

middle of the word 
C The boy woke[FLR][FLP] up. Sound or whole word repetition 

followed by prolongation. 
 
This basic level, inserting codes at the end of each word, does not distinguish 
the position of the disfluency within the word in analysis. Nor does this level of 
coding indicate the number of repetitions produced or the length of a 
prolongation or block.  
 
The fluency report, using the basic level of coding, will count the total number 
of [FLR], [FLP], and [FLB] codes (and/or customized codes) that were inserted in 
the sample. Selecting the Analyze menu: Fluency Codes and Behaviors report 
(Figure 9-10), you specify the speaker, utterance base, and whether counts are 
given for disfluencies within and outside mazes. You have the option of 
displaying the coded words, or you can expand the report to additionally display 
the utterances containing the codes.  
 
Should a more detailed description be of interest, these codes can be positioned 
and/or expanded to provide further information as described in the following 
sections. 
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Figure 9-10 

Indicating Position within the Word 
 
Inserting fluency codes at the position of the disfluency provides additional 
documentation. The fluency report will count the codes and display the specific 
words with their positional codes. 
 

• Repetitions: insert the code immediately before the repeated sound or 

syllable. If the entire word is repeated, insert the code at the end of the 

word. For example, 

C  She like/3s [FLR]banana/s. Repeated the initial sound /b/ or 
syllable /ba/  

C  She like/3s ba[FLR]nana/s. Repeated the medial sound /n/ or 
syllable /na/  

C  She is funny[FLR]. Repeated the whole word  
 

Distinguishing between repeated sounds and syllables 

Notice, in the first two examples, that it may not be evident whether the 
positional code is marking a sound or a syllable. If you wish to distinguish 
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between sounds and syllables for repetitions, expand the fluency codes by 
adding “Snd” for sound and “Syl” for syllable, i.e., [FLRSnd], [FLRSyl]. For 
example, 
 
C  She like/3s ba[FLRSnd]nana/s. Repeated the sound /n/  
C  She like/3s ba[FLRSyl]nana/s. Repeated the syllable /na/  

 

• Prolongations: insert the code immediately before the prolonged sound or 

syllable. For example, 

C  She is [FLP]funny. Prolonged the initial sound /f/  
C  She like/3s ba[FLP]nana/s. Prolonged the sound /n/  
C  She like/3s ban[FLP]ana/s. Prolonged the sound /a/  
C  She like/3s banana/[FLP]s. Prolonged the final sound /s/  

 

• Silent blocks: insert the code at the position of the block. For example, 

C  She is [FLB]funny. Silent block at beginning of 
sound/word  

C  She is fun[FLB]ny.  Silent block in middle of the word, 
between the syllables 

 
Adding Number of Repetitions 
 
When coding repetitions, you may want to indicate the number of repetitions. 
To do this, expand the repetition code by adding a colon followed by a number 
representing the number of extra repetitions. For example, 

C  The [FLR:4]boy is chase/ing the dog. Repeated the initial sound /b/ four 
extra times 

C  The boy[FLR:2] is chase/ing the dog. Repeated the word “boy” two extra 
times 

C  She like/3s ba[FLR:4]nana/s.  Repeated the sound /n/ or the 
second syllable /na/ four extra 
times 
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Note, in this last example, that you could differentiate between sounds and 
syllables by adding “Snd” for sound and “Syl” for syllable, i.e., [FLRSnd:4], 
[FLRSyl:4]. 

 
Adding Length of Prolongations and Blocks 
 
When coding prolongations and silent blocks, you may want to indicate their 
duration. Note that the duration may be measured in a variety of ways, e.g., 
seconds, milliseconds, numeric scale. The duration doesn’t have to be numeric. 
You may want to use a scale such as L=long, M=medium, and S=short. If you 
choose to include duration, just be consistent in how you measure it within and 
across your data sets. In the examples which follow, duration of prolongation is 
measured in number of seconds. 

C  There are [FLP:04]many people.  Initial sound/syllable was prolonged 
for 4 seconds 

C  The kangar[FLP:05]oo was funny.  Final sound was prolonged for 5 
seconds 

C  He like/3s [FLB:03]banana/s. 3-second silent block at beginning 
of word 

 

Coding Concomitant Behaviors 
 

Concomitant behaviors are secondary, or accessory, behaviors that can 
accompany disfluency in speech production. They vary from person to person. 
These characteristics are best rated at the time of elicitation, directly after, or 
from a video recording of the speech-language sample. Rather than code 
concomitant behaviors in the transcript at the point(s) where they occur, these 
behaviors are marked using plus lines inserted at the end of the transcript. The 
suggested coding is divided into the following five categories: 
 

• Vocal quality such as pitch rise, vocal tic, change in volume (louder/softer), 
change in rate (faster/slower) 

• Grimace (facial) such as jaw jerk, tongue protrusion, lip press, squinting, 
tremor of lips or face 

• Eye movement such as avert eye gaze, close eyes, blink eyes 

• Distracting sound such as fast or shallow breathing, sigh, whistle, blow (air), 
click, laugh, clear throat 
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• Movement of extremities such as arm movement, hand movement, hands 
around face, finger movement, shrug shoulders, clap, nod, shake, jerk 

 

Select Edit menu: Insert Fluency Template to insert the following plus lines used 
to rate these five concomitant behavior categories: 

+ Vocal Quality:  
+ Grimace: 
+ Eye Movement: 
+ Distracting Sound: 
+ Movement of Extremities: 

 
Each category is rated on a 0-3 scale as follows: 

0 = does not occur 
1 = LOW frequency of occurrence 
2 = MEDIUM frequency of occurrence 
3 = HIGH frequency of occurrence 

 
Example of using SALT to code disfluencies 
 
Figure 9-11 contains an excerpt from a SALT transcript showing the basic level of 
coding for disfluency as well as the rating of concomitant behaviors. The child in 
this sample is retelling the story Frog, Where Are You? (Mayer, 1969). The [FLR], 
[FLP], and [FLB] codes were inserted at the end of words. , indicating type of 
disfluency but not position within the word, number of repetitions, or length of 
prolongations and blocks. The concomitant, or secondary, behaviors were 
assessed on a scale of 0-3 and the rating values inserted on plus lines at the end 
of the transcript.  
 
The Analyze menu: Fluency Codes and Behaviors report (Figure 9-12) produces a 
list of the disfluent words. The child repeated words 16 times and prolonged 
words 18 times. No silent blocks were coded. At the bottom of the report are 
the severity rating scores applied to concomitant behaviors.  
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$ Child 
+ Context: Nar 
+ Subgroup: FWAY 
+ [FLR]: repetition 
+ [FLP]: prolongation 
+ [FLB]: silent block 
+ [EW:] error at the word level 
 
C Once there[FLR] was a boy  that[FLR][EW:who] had a frog. 
C He like/ed it very much[FLP]. 
C And the dog did[FLR] too. 
C (Um) one night when the[FLP] boy and the dog were sleep/ing the[FLP] frog crept 
out : 02 of the (um) container. 
C Then (w*) right when[FLP] the boy and dog woke[FLR][FLP] up, (he was) he was 
miss/ing. 
C He look/ed everywhere (from hi*) from his boot/s (to hi* his) to inside the 
bowl[EW:jar]. 
C And then[FLR] he call/ed out his name from[FLP] the window[FLP]. 
C Then his dog jump/ed out the[FLP] window[FLP]. 
C Still the container (was[FLR] in his) was on his head. 
C And the[FLR] boy got up with his boot/s and got him. 
C He went[FLP] look/ing for him. 
C They[FLR] went into the woods[FLR][FLP].  
; :02 
C He found[FLP] a hole. 
C And the dog found[FLP] a[FLR] beehive. 
C And then a[FLR] gopher came[FLR] out of the hole. 
C (And the[FLP]) and the[FLP] bee/s start/ed chasing[FLR] the dog[FLR]. 
C Then the gopher was[FLP] stare/ing at the[FLR] boy while[FLP] he was climb/ing up 
the tree[FLR] branch and look/ing[FLP] through a hole. 
......... 
= Concomitant Behaviors 
+ Vocal Quality: 0 
+ Grimace: 0 
+ Eye Movement: 3 
+ Distracting Sound: 0 
+ Movement of Extremities: 2 

Figure 9-11 
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Figure 9-12 
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Benefits of Coding Disfluencies 
 

There are numerous benefits of coding disfluencies in samples of everyday 
communication. The analyses are taken from the very behavior we are 
addressing, frequent social or text-based communication contexts. Taken 
together, verbal fluency and language analyses provide a powerful tool to 
document speech and language performance individually and how they interact 
for the target speaker. These tools provide the information necessary to 
pinpoint specific deficits which can guide the clinician in developing and 
implementing effective intervention programs. 

 
Other Applications of SALT 
 

Over the years, SALT Services has provided consultation and transcription 
services for projects covering a wide array of assessment aims. These projects 
have shed light on just how flexible and valuable coding language samples is to 
the processes of diagnostics, measuring gains or changes in performance, and 
discovering outcomes that may not have been expected. Below are just a few of 
these projects.  
 

• Building local norms 
o SALT has been used by researchers and school districts to build reference 

databases of local norms from samples they collected. 

• Language from AAC devices 
o Alzheimer’s and Primary Progressive Aphasia: Speakers used spoken 

language augmented with low tech AAC (communication boards). Both 
spoken language and use of AAC were captured in transcription, providing 
data to assess the speaker’s combined productive language. 

o The output of AAC devices was transcribed to assess the speaker’s 
vocabulary and discourse. 

o AAC and the conversational partner: The output of the AAC devices was 
transcribed along with the spoken responses of the conversation partners 
to assess the quantity and quality of partner responses to generated 
speech. 
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• Language from LENA™ recordings (LENA™ Research Foundation, 2015) 
o A number of projects have been undertaken to evaluate the quality of the 

language spoken in the home or classroom setting in addition to the 
quantity of spoken language that LENA recordings provide. 

• Language of speakers with hearing impairment 
o Language samples of children with hearing loss were analyzed to track the 

amount of code switching between spoken and signed language. 
o Language samples were collected over time to track the spoken 

performance of children with cochlear implants. 

• Classroom intervention projects 
o Teacher language was recorded and transcribed to assess pre and post 

instruction when teaching language/reading. 
o Classroom language was analyzed to assess student performance pre and 

post direct vocabulary instruction and post shared story intervention. 

• Legal studies research  

o The Netflix 2015 documentary “Making A Murderer” raised questions 
about the possibility that the defendants were victims of law enforcement 
malfeasance. The language of a juvenile defendant and two of the 
investigating detectives was transcribed and analyzed using SALT.  

• Adult assessment of pragmatics 
o Mock job interviews of college students were custom coded for specific 

pragmatic features. 
o Pre and post intervention was assessed for increased use of positive 

words and phrases. 

• Interviews 
o Research interviews were transcribed and coded to quantify responses to 

specific questions. 
o Interview task: transcripts were coded for various pragmatic skills of 

adolescent children with Autism Spectrum Disorder (ASD)  

• Customer support calls 
o Support calls from a large business were recorded, transcribed, and 

analyzed to track the types of calls and the quality of the responses. 

• Gorilla sign language 
o SALT was used to track the vocabulary of a sign-language speaking gorilla. 
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SALT’s flexible transcription and coding options make it a great tool for 
analyzing any type of language sample for multiple purposes. 
 



  

CHAPTER 

10 
 

Pulling It All Together: Examples from our 
case study files 
 

Joyelle DiVall-Rayan 

Jon F. Miller 
 
Incorporating language sample analysis into your practice can best be illustrated 
by working through a series of case studies. These cases are from our clinical 
collaborations with SLPs who have graciously granted permission to present 
their work. We have taken some liberty with commentary to explain why certain 
measures contribute to the overall picture of the oral language skills presented 
by each case. The focus is on the description and diagnostic value of the 
measures with only general consideration of intervention plans. 

 
A main theme of this book is that language disorders take a variety of forms. In 
each case, LSA provides insight into the overall picture of oral language skill in 
naturalistic, everyday communication demands. As you read through these 
cases, focus on the story that the test scores and language sample measures tell 
us about overall communication effectiveness. The challenging part of our work 
as SLPs is figuring out what it means once diagnostic information is collected. 
Enjoy the cases as they capture a range of oral language problems. 
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SALT Transcript: Carter PGHW.slt7 
 
BACKGROUND 
 

Carter is 8;1 and is in the second grade. He is diagnosed with Autism Spectrum 
Disorder (ASD) and Attention Deficit Hyperactivity Disorder (ADHD). He has a 
normal IQ according to neuro-psychological testing. He is receiving 
speech/language services for speech articulation, which has improved his 
speech intelligibility. Carter also received therapy services as a preschooler that 
focused on expressive/receptive language and social skills. He is being assessed 
for language skills following teacher concerns and SLP observations of difficulty 
with utterance formulation in both speaking and writing. Carter was attentive to 
assessment tasks and followed directions well throughout the evaluation.  
 
ASSESSMENT MEASURE 
 

A story retell narrative task was the best choice to assess Carter’s presenting 
language challenges. The narrative task challenged his word, utterance, and 
text-level proficiency, and the skills required for the narrative closely mirror the 
demands of the school curriculum. Carter listened to the story Pookins Gets Her 
Way (Lester, 1987) and then retold the story using the book with the text 
covered. He listened carefully to the instructions and gave his best effort 
retelling the story. The results are considered to be representative of his oral 
language skills. The recorded sample was transcribed and then coded for 
sentence complexity (SI, see Appendix O) and narrative structure and content 
(NSS, see Appendix P). It took Carter 5½ minutes to retell the story and his 
sample contained 480 words and 46 utterances. Carter’s sample was compared 
to samples selected from the Narrative Story Retell database (see Appendix D).  
 

Selected database samples:  
82 samples matched by age: 7;7 - 8;7 
39 samples matched by age and same number of total words (NTW) 

 
7 Carter PGHW is one of the sample transcripts included with the software. 

Case Study 1: CARTER 
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SALT ANALYSIS 
 

Figure 10-1 (Standard Measures Report based on entire transcript) 
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Database Menu: Standard Measures Report (Figure 10-1) 
• Transcript Length: The sample was age appropriate in length for the number 

of utterances and words, as well as elapsed time. 
• Intelligibility: Intelligibility did not impact the sample.  
• Macro Analysis: Analysis of the Carter’s story revealed that his NSS Composite 

Score, although low, was within the normal range of performance.  
• Syntax/Morphology: MLU in words and morphemes were also within normal 

limits. However, Carter’s utterances, while of appropriate length, did not 
include the more complex structure typical for his age and grade. This was 
evidenced by the SI Composite Score, a measure of clausal density.  

• Semantics: Carter’s number of different words (NDW) was higher than the 
database average. So was his Moving-Average NDW, a comparison of NDW 
which is independent of sample length. These are measures of vocabulary 
diversity and the positive SDs indicate a strength in the area of semantics.  

• Verbal Facility: Carter’s rate of speech was comparable to his peers at 86.75 
Words per Minute (WPM). Slightly over 25% of Carter’s words were maze 
words. This is more than two standard deviations higher than the database 
mean and warrants a more in-depth look at mazes.  

• Errors: 17% of Carter’s utterances contained errors, which was within normal 
limits. However, Carter’s sample contained 2 omissions and 11 errors which 
should be examined for patterns. 

 

Database Menu: Quick Look (Figure 10.2) 
The Quick Look report is generated from the database menu and provides a very 
broad overview of skills in an easy-to-read table format, which is convenient for 
summary meetings to show strengths and weakness. Carter’s Quick Look shows 
that his relative weaknesses are in SI (syntax skills) and in Verbal Facility, 
specifically a high number of mazes. His relative strength is his semantic skills 
(Moving-Average NDW).  All other language measures were within normal 
limits.  
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Figure 10.2 (Quick Look based on entire transcript) 
 
Based on these reports, additional information would be valuable for several 
measures: SI, mazes, and error codes. Additional information is provided in 
subsequent reports.  
 
Database Menu: Subordination Index (Figure 10-3) 
The Subordination Index (SI) is a relatively fast way to document the use of 
complex syntax (see Appendix O). This is an important measure from Carter’s 
sample to confirm the SLP’s observation of infrequent use of complex syntax 
and the frequent mazes which may be associated with utterance formulation 
problems, i.e., limited command of complex syntax. SI is a measure of clausal 
density, calculated by dividing the number of clauses by total number of 
utterances. SALT calculated the score and compared it to the matched database 
samples. Carter’s SI composite score was 1.13, which is 1.81 SD below the 
database mean of 1.30. Most of his utterances contained one clause. 
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Figure 10-3 (SI based on the first 312 words) 

 
Database Menu: Verbal Facility Summary (Figure 10-4) 
The Verbal Facility Summary shows that Carter produced mazes at the word and 
phrase level. His word-level mazes were mostly repetitions while the revisions 
were more prominent at the phrase level. These data points provide support for 
both word retrieval as well as utterance formulation problems. 

Figure 10-4 (Verbal Facility Summary: Maze Summary based on the first 312 words) 
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Explore Menu: Utterances without mazes (Figure 10-5)  
To better understand Carter’s frequent use of mazes, let’s examine his 
utterances which don’t contain any mazes. 

Figure 10-5 

 
Notice that all of the fluent utterances had simple syntax (grammatical form). 
Was he attempting to produce more than one proposition at a time without 
command of complex syntax to accomplish the task? Further analysis of complex 
syntax is warranted. Also notice that the code [REF] was applied during 
transcription to mark referencing difficulty, which may be contributing to word 
retrieval impairment. The [REF] code was applied to the troll character because 
Carter referred to this character previously as an elf.  
 
Analyze Menu: Standard Utterance Lists (Figure 10-6)  
Selecting “Utterances with Error Codes” from the Standard Utterance Lists 
displays all the words and utterances coded as errors. This follow-up report 
should be used to look for patterns of errors. Carter made several pronoun 
errors, e.g., it for them, her for his, and several word-choice errors, e.g., before 
for after, and elf and troll both used to refer to the same character. 
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Figure 10-6 

 
STANDARDIZED TEST INFORMATION 
 

Clinical Evaluation of Language Fundamentals-5th Edition 
Language Domain with Composite Score: 
Core Language: 76 
Receptive Language: 59 
Expressive Language: 80 
Language Content: 78 
 
Peabody Picture Vocabulary Test-4 (PPVT-4) 
Standard Score: 116 
Percentile: 86 
Age Equivalent: 8;9 
 
Expressive Vocabulary Test: 2 (EVT-2) 
Standard Score: 117 
Percentile: 87 
Age Equivalent: 8;1 
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Figure 10-7a 

Database Menu: Performance Report (Figures 10-7a & 10-7b) 
 
And to “pull it all together”, SALT includes the Performance Report. This report 
provides a cohesive narrative summarizing the language sample analysis 
outcomes, noting both strengths and weaknesses. This report can be edited to 
add your clinical impressions and incorporate outcomes from standardized 
testing and/or other informal measures. Or just copy and paste relevant 
information from this report into your own report format. The Performance 
Report is extremely comprehensive and can save a lot of time when writing up 
reports. 

Performance Report 
Carter PGHW 
Age: 8;1, Grade: 2 
 
Language Sample Analysis with SALT Software 
 
Elicitation Task and Database Overview 
Carter completed a narrative story retell of 'Pookins Gets Her Way' (Lester, 1987). He listened to 
the story and then retold the story using his own words. Measures of sample length, intelligibility, 
narrative structure, syntax/morphology, semantics, verbal facility, and errors were calculated from 
his language sample and compared with samples from 82 speakers completing the same task. 
These speakers were within 6 months of Carter's age. Although most measures were calculated 
from the entire sample, a few measures, such as total pause time and number of errors, can be 
affected by different sample lengths, i.e., the longer the sample, the more opportunity to produce 
them. For these measures, Carter's sample was compared with a subset of 39 samples matched in 
length by the same number of words. All measures were interpreted using a standard deviation 
interval of 1.00 SD. 
 
Transcript Length 
Carter produced 46 utterances using a total of 480 words in 5 minutes and 32 seconds, which were 
all within normal limits for this task. 
 
Intelligibility 
Carter's intelligibility was within normal limits with 90.9% intelligible utterances and 98.6% 
intelligible words. 
 
Macro Analysis 
The Narrative Scoring Scheme was used to assess the structure and content of Carter's narrative. 
The following categories were included: introduction, character development, mental states, 
referencing, conflict resolution, cohesion, and conclusion. Carter's composite score of 19 out of a 
possible 35 points was within normal limits. He demonstrated particular difficulty with the 
categories of mental states, referencing, and cohesion. 
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Figure 10-7b  

Syntax/Morphology 
Carter's mean length of utterance (MLU) in words was 7.80, which was within the normal range 
compared to his database peers. His MLU in morphemes was 8.85, which was also within the 
normal range. 97.5% of Carter's utterances contained verbs with an average of 1.48 verbs per 
utterance. These values were both within normal limits. Carter's sample was scored for 
subordination index (SI), which measures the average number of clauses per utterance. In general, 
higher SI scores indicate increased use of complex syntax. Carter yielded an SI score of 1.13, which 
was 1.14 SD below the database mean. This indicates that he more frequently used simple syntactic 
sentence structures. Carter's sample contained 34 utterances with 1 clause and 5 with 2 clauses. 
His most complex utterance contained 2 clauses. For example: 
        C (And uh and she was) and she always want/ed to get her own way, which with that she was 
really sassy. 
He used 3 subordinators and 13 coordinators in his sample. 
 
Semantics 
Carter used 145 different words (NDW) within an analysis set of 312 total words (NTW). This 
compares with database means of 129 different words within 321 total words to complete the 
same task. NDW can be affected by the length of the sample, so the moving-average NDW was 
calculated by averaging NDW across the sample, looking at each set of 100 NTW. Carter produced a 
moving-average NDW of 66, which was 1.93 SD above the database mean of 57, indicating relative 
strength in vocabulary diversity. 
 
Verbal Facility 
Carter's rate of speech, at 87 words per minute, was within the normal range. Carter's sample 
contained 8 within-utterance pauses for a total time of 30 seconds, with an average pause time of 
3.75 seconds. The total number of pauses and total pause time were both higher than the database 
mean by 1.80 SD and 2.07 SD, respectively, while the average pause time was within normal limits. 
His sample also contained 9 between-utterance pauses for a total time of 23 seconds, with an 
average pause time of 2.56 seconds. These between-utterance pause values were within normal 
limits. Pause time as a percent of total time was 16.0%, which was within normal limits. In Carter's 
sample, 25.4% of the words were filled pauses, false starts, repetitions, or reformulations. This 
percentage of words in mazes was 2.52 SD higher than the database mean of 11.3%. His sample 
contained 37 mazes, which were found in 62.5% of his utterances. Carter's mazes consisted of a 
high number of both phrase-level and word-level revisions and repetitions. A high number of 
pauses and mazes may indicate difficulty with word retrieval and/or utterance formulation. 
 
Errors 
17.4% of Carter's utterances contained errors, which was comparable to his database peers. He 
omitted the past tense bound morpheme once, although he produced it 20 times. He used the 
plural bound morpheme 18 times, the 3rd person singular bound morpheme twice, the present 
progressive bound morpheme twice, the contracted verb form four times, and the contracted 'us' 
once. He also omitted the word UP once. His sample contained the following overgeneralization 
error: STICKED[EO:STUCK] twice and the following other word-level errors: ASK/3S[EW:SAID] 
once, BEFORE[EW:AFTER] once, ELF[EW:TROLL][REF] twice, HER[EW:HIS] once, IS[EW:WAS] 
once, IT[EW:THEM] once, and MAKE[EW:MADE] once. His sample also contained the following 
utterance-level error: 
        C Finally, when she is[EW:was] big, (the) the elf[EW:troll] (ask/ed :02) ask/3s[EW:said], "(are 
y*) you (made a w* not wise choice :05) made a not wise choice" [EU]. 
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INTERPRETATION 
 

Performance Profile 
Carter’s language sample results are consistent with the word retrieval and 
utterance formulation profile. His simple sentence attempts are produced 
without mazes, consistent with limited complex syntax use and confirmed by 
the SI measure. The Verbal Facility Summary provides evidence for both word 
retrieval as well as utterance formulation issues. The phrase level mazes are 
revisions for the most part, while repetitions are at the word level. His pauses 
within utterances fit these observations as his repetitions and revisions did not 
create enough time to find the right word or the syntax to combine more than 
one idea into one utterance. 
 

Strengths 
Carter was enthusiastic and enjoyed listening to and retelling the story. He used 
diverse vocabulary with number of different words (NDW) being 145, which is 
slightly higher than the database mean. And his Moving-Average NDW, a 
measure of NDW which is independent of sample length, was significantly 
higher than the database mean. He also had adequate mean length of utterance 
(MLUw) of 7.8. These results are substantiated by his score on the Expressive 
Vocabulary Test, where he scored well above average on single word 
expression. Another area of relative strength is the length of his story. Carter 
told the story in average time and his story contained an average number of 
words and utterances. 
 

Challenges 
Carter’s sample contained an abundance of mazes (repetitions, revisions, and 
filled pauses) with 25% of his words being maze words. His mazes consisted of 
part-word, word, and phrase repetitions as well as word and phrase revisions. 
Word-level errors were also common throughout Carter’s sample. Errors 
included overgeneralization, e.g., sticked for stuck, and pronoun errors, e.g., it 
for them and her for his. Of note, Carter was inconsistent when referring to one 
of the main characters in the story; the gnome. He referred to the gnome as elf, 
and troll but not gnome. Carter requested from the clinician the name of the 
main character, Pookins, saying that he forgot her name. Some of these errors 
suggest delays in specific areas of language, overgeneralization of past tense, 
and lack of complex sentence use. The frequent mazes suggest that his self-
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monitoring of language production results in numerous changes to get the 
utterance that he has in mind produced correctly. Improving verbal fluency will 
require both direct instruction on complex syntax and strategies to find the right 
word. 
 
Clinical Impressions 
Carter performs in the average range on standardized tests. With the exception 
of his receptive language on the CELF-5, all other language domains are in low-
average range. His receptive language score may be due to reduced attention to 
the task versus actual issues with auditory comprehension. When looking at his 
score on the PPVT-4 and EVT-2, Carter presents as though he has very high 
expressive and receptive language skills, which is true in some aspects as he has 
an average MLU and NDW. However, these tasks are decontextualized and 
isolate language in a way that does not assess functional language. When Carter 
has to use the whole language system simultaneously, i.e., comprehend picture 
book, organize thoughts, formulate utterances, his language system breaks 
down and he demonstrates utterance and word retrieval difficulties along with 
pauses. This can be frustrating as he has complex ideas as well as strong 
vocabulary skills but cannot always get his intended message across to the 
listener. He also uses gestures and non-specific vocabulary to convey his ideas.  
 

Ideas for Intervention 
Recommendations include: 

• Working on references so the listener clearly knows who/what Carter is 
talking about 

• Word retrieval strategies, e.g., description, synonyms, etc. 

• Taking time to formulate and organize thoughts before talking 

• Direct instruction on complex syntax within a narrative context 

• Fluency practice producing only simple sentences, one proposition at a time 
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SALT Transcript: Max Expo.slt8 
 
BACKGROUND 
 

Max is 11;2 and is in the 5th grade. He began receiving speech/language services 
when he was four years old. He was identified with a learning disability in the 
first grade. Teacher concerns include difficulty expressing himself in a clear and 
concise manner. In speech-language therapy Max has been working on word 
retrieval, thought organization, and staying on topic. Max's conversational skills 
are very good. It is unlikely that someone would realize he has a language 
impairment from a casual conversation with him. He asks appropriate 
questions, makes appropriate comments, stays on topic (most of the time), and 
listens to his partner.  
 
ASSESSMENT MEASURE 
  

Max completed an expository language sample where he was asked to tell how 
to play his favorite game or sport. The expository task began with a planning 
phase of 3-5 minutes where Max was asked to make notes on a template 
addressing ten required categories for a complete exposition. Max chose to 
explain how to play the board game Monopoly. He was compliant during the 
task and appeared to give his best effort. The recorded sample was transcribed 
and then coded for sentence complexity (SI, see Appendix O) and expository 
structure (ESS, see Appendix Q). Max’s sample was compared to samples 
selected from the Expository database (see Appendix E). 
 
Selected database samples:  

88 samples matched by age: 10;8 - 11;8 
83 samples matched by age and same number of total words (NTW) 

 
  

 
8 Max Expo is one of the sample transcripts included with the software. 

Case Study 2: MAX 
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SALT ANALYSIS 

Figure 10-8 (Standard Measures Report based on entire transcript) 
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Database Menu: Standard Measures Report (Figure 10-8) 
• Transcript Length: Max’s expository sample was somewhat shorter in terms of 

number of utterances, number of words, and time than what was produced 
by his age-matched peers.  

• Macro Analysis: Max’s ESS Composite Score, which measures the structure 
and content of the exposition, was more than 3 SDs below the database 
mean.  

• Syntax/Morphology: Max’s average utterance length was shorter than 
expected with MLUw at 1.95 SD and MLUm at 2.07 SD below the database 
mean. His SI Composite Score, which measures clausal density, was low.  

• Semantics: Number of different words (NDW) was 1.32 SD below the database 
average and his Moving-Average NDW, a more meaningful comparison of 
NDW because it is independent of sample length, was also below the mean at 
-1.29 SD. These measures indicate low vocabulary diversity. Perhaps eliciting a 
language sample from another context would provide evidence to determine 
whether or not this is of significance. 

• Verbal Facility: All measures were one or more standard deviations from the 
database means. Max’s rate of speech, measured in words per minute, was 
1.23 SD below the database mean. The low rate of speech was a result, at 
least in part, of the high number of silent pauses. Over 30% of Max’s words 
were in mazes and he abandoned 6% of his utterances.  

• Errors: 14.7% of the utterances in Max’s sample contained errors which was 
within normal limits for the task.  

 

Based on this report, additional information would be especially valuable in 
several areas: Macro Analysis (low ESS), Syntax/Morphology (low MLU and SI), 
and Verbal Facility (low WPM, high number of pauses, mazes, and abandoned 
utterances). Additional information is provided in subsequent reports.  
 

Database Menu: Expository Scoring Scheme (Figure 10-9) 
The Expository Scoring Scheme (ESS, see Appendix Q) was used to score the 
structure and content of Max’s expository sample. His sample was scored on ten 
categories such as preparations, rules, and terminology. Most of these 
categories are based on the planning sheet that Max used to complete his 
expository sample. Max’s composite score was 15 out of 50 compared to an 
average composite score of 32.8 for age-matched peers. The structure and 
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content of Max’s expository language sample was in the minimal/emerging 
range for his age. 

Figure 10-9 
 
Database Menu: Syntax/Morphology Summary (Figure 10-10 & Figure 10-11) 
 
Max’s MLU in words and morphemes was lower than his age-matched peers. 
The Syntax/Morphology Summary from the Database menu (Figure 10-10) was 
produced to try and gain further information about words and utterances 
produced in his sample. This report can often assist in determining if there are 
particular forms that may be the primary contributor to low MLU. Max 
produced fewer total bound morphemes than his age-matched peers retelling 
the same story, though he used similar types of bound morphemes, e.g., 
contractions, plurals, and possessives. However, Max omitted 3 words in 
obligatory context compared to the database mean of less than 1.  
 
The low MLU can be validated by looking at the Number of Utterances by 
Utterance Length distribution tables (Figure 10-11). Notice that Max’s sample 
contained three utterances which were only 1 – 3 words in length, while none of 
the database samples contained such short utterances. Also, only 5 of his 30 
utterances contained more than 11 words compared to the database mean of 9 
out of 21 utterances. 
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Figure 10-10 (Syntax/Morphology Summary based on the first 265 words)  

 
 

 
Figure 10-11 (Utterance Distribution Table based on utterances in the first 265 words)  
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Database Menu: Subordination Index (Figure 10-12) 
 
The Subordination Index (SI, see Appendix O) was applied to Max’s sample. The 
SI measures clausal density and is computed by dividing the total number of 
clauses by total number of C-units. Max yielded a composite score of 1.28 
whereas the database mean for age-matched peers is 1.66. Max’s score was 
1.45 SD below the database mean. He used mostly one-clause utterances (14 
total) and 9 two-clause utterances. 

Figure 10-12 (SI based on the first 265 words)  

 
Database Menu: Verbal Facility Summary  
The Verbal Facility Summary gives detailed information about speaking rate, 
pauses, and mazes, comparing this information to the database. Each of these 
sections is highlighted and described below. 
 
• Rate and Pause Summary (Figure 10-13) 

Max’s sample was 4 minutes, 2 seconds in length which was within normal 

limits for the expository task. His speaking rate was slower than age-

matched peers and his sample contained a larger number of pauses. His 

sample contained 10 within-utterance pauses, which totaled 38 seconds 
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and lasted, on average, 3.8 seconds. Max also had 5 between-utterance 

pauses, which totaled 12 seconds and lasted 2.4 seconds on average. 

Figure 10-13 (Verbal Facility Summary: Rate and Pauses based on first 265 words) 
 

• Maze Summary (Figure 10-14) 
 
29.7% of Max’s total words were in mazes. This is 3.56 standard deviations 
higher than the database mean. The number of total mazes was also high as 
was the average words per maze, indicating that he produced frequent and 
relatively long mazes. Max’s mazes were made up of primarily phrase 
revisions and word repetitions. The maze distribution tables revealed that a 
high percentage of utterances, even utterances that were relatively short, 
contained mazes. In fact, Max had mazes in most of his utterances that 
were longer than 2 morphemes. Compare Max’s values with the much 
lower database mean values provided in this distribution table. As the 
length of his utterances increased, mazes continued to be present. 
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Figure 10-14 (Verbal Facility Summary: Maze Summary based on first 265 words)    
 
 
Analyze Menu: Abandoned Utterances (Figure 10-15) 
The Standard Measures Report (see Figure 10-8) indicated that Max abandoned 
6.3% of his utterances which was 2.39 SD above the database mean. Since 
abandoned utterances are not common at this age level, with most speakers 
producing less than one abandoned utterance, it would be valuable to look at 
Max’s abandoned utterances. The Standard Utterance Lists, selected from the 
Analyze menu, displays lists of various types of utterances, including Abandoned 
Utterances, as well as their context within the sample. Max’s language 
contained two abandoned utterances. These utterances are displayed in context 
with 2 preceding and 2 following utterances. 
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Figure 10-15 
 
INTERPRETATION  
 

Performance Profile  
The delayed language profile is characterized by low mean length of utterance, 
low number of different words, slow speaking rate, and word and utterance-
level errors. Max’s language production fits into this profile. His syntax was 
limited to simple sentences with few attempts at complex sentence forms as 
evidenced by his low SI scores. All of Max’s language sample scores contribute 
to his low scores on the ESS in that his sample is short and syntactic forms do 
not allow him to express complex relationships.  
 
Strengths 
As mentioned earlier, Max has good conversational skills. He was a willing 
participant in the assessment process and made only a few word or utterance 
errors.  
 
Challenges 
Max demonstrated limited lexical diversity with low MLU and NDW. His low SI 
score indicates that he uses simple syntax with limited use of subordination. 
Verbal fluency was decreased as evidenced by increased mazes and pause 
times. This could be related in part to utterance formulation difficulty. Max’s 
ESS scores indicated problems with cohesion, e.g., overall flow of the sample, 
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organization, sequencing, etc., and terminology, e.g., adequately defining new 
terms. Max also scored lower on the content of his expository sample in areas 
such as explaining how the game is scored, strategies used, and preparations for 
the game.  
 
Clinical Impressions   
Max’s performance could be related in part to formulation difficulties as seen by 
the length of his mazes and the fact that mazes were present even in short, 
simple utterances. The expository task is challenging but revealing of his oral 
language issues. Comparing his conversational skills with his expository skills 
may suggest opportunities to improve his overall verbal output. 
 
Ideas for Intervention 

• Foster vocabulary enrichment, such as pre-teaching content words related to 
specific areas of the curriculum  

• Organize thoughts before speaking by practicing with the ESS matrix to fulfill 
expectations for detail 

• Practice narrative retell to improve sequencing of events and story structure 

• Teach complex sentence forms beginning with conjunctions to expand 
utterances
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SALT Transcript: Timmy FWAY.slt9 
 
BACKGROUND 
 

Timmy is a 5-year, 8-month old boy who was in early childhood when he first 
received therapy for language delay. He is now in kindergarten and his therapist 
wants to assess his language production using a story retell as it relates directly 
to the kindergarten curriculum. 
 
ASSESSMENT MEASURE 
  

Timmy completed a narrative story retell using the wordless picture book Frog, 
Where are You? (Mayer, 1969). First, the clinician told the story using a script, 
and then Timmy retold the story using the pictures from the book. Timmy 
completed the task without prompting and the therapist thought the sample 
was a valid indicator of his current level of oral language. The recorded sample 
was transcribed and then coded for sentence complexity (SI, see Appendix O) 
and narrative structure (NSS, see Appendix P). Timmy’s sample was compared 
to samples selected from the Narrative Story Retell database (see Appendix D). 
  

Selected database samples:  
69 samples matched by age: 10;8 - 11;8  
66 samples matched by age and same number of total words (NTW) 

 
SALT ANALYSIS 
 

Database Menu: Standard Measures Report (Figure 10-16) 
• Transcript Length: Timmy used significantly fewer utterances, words, and time 

to retell the story than his age-matched peers.  
• Macro Analysis: Timmy’s NSS Composite Score, which measures the structure 

and content of the narrative, was 1.83 SD below the database mean. 

 
9 Timmy FWAY is one of the sample transcripts included with the software. 

Case Study 3: TIMMY 
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• Syntax/Morphology: Timmy’s MLU in words and morphemes was lower than 
his age-matched peers though his SI Composite Score, a measure of sentence 
complexity, was within the normal range for his age.  

 

 Figure 10-16 (Standard Measures Report based on entire transcript) 
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• Semantics: Timmy’s Number of different words (NDW) was 1.67 SD below the 
database average; however the Moving-Average NDW, a more meaningful 
comparison of NDW because it is independent of sample length, was within 
normal limits. 

• Verbal Facility: Timmy’s words per minute (WPM) score was within the 
normal range for his age. His sample contained very few mazes or a significant 
number of silent pauses.  

• Errors: Although 19% of Timmy’s utterances contained errors, this was not 
significantly more than his age-matched peers. 

 

Based on this report, additional information would be especially valuable in 
several areas: Macro Analysis (low NSS) and Syntax/Morphology (low MLU). 
Additional information is provided in subsequent reports.  

 
Database Menu: Narrative Scoring Scheme (Figure 10-17) 
Timmy’s sample was scored using the Narrative Scoring Scheme (NSS), a tool to 
assess the structure and content of a narrative (see Appendix P). Timmy’s 
composite score on the NSS was 13 out of 35, which is -1.83 SDs below the 
mean compared to age-matched peers. Timmy had lower scores on the 
categories of introduction, mental states, and cohesion. He appeared to have 
difficulty grasping the structure of the narrative task. 

Figure 10-17 
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Database Menu: Syntax/Morphology Summary (Figure 10-18 & Figure 10-19) 
Timmy’s MLU in words and morphemes was lower than his age-matched peers. 
The Syntax/Morphology Summary from the Database menu (Figure 10-18) was 
produced to try and gain further information about words and utterances 
produced in his sample. This report can often assist in determining if there are 
particular forms that may be the primary contributor to low MLU. Timmy 
produced more plural and possessive bound morphemes than his age-matched 
peers retelling the same story and his overall use of bound morphemes is 
comparable to age-matched peers from the database samples. However, Timmy 
uses fewer verbs/utterance. 
  

 
Figure 10-18 (Syntax/Morphology Summary based on the first 139 words) 
 
The low MLU can be validated by looking at the Number of Utterances by 
Utterance Length distribution table (Figure 10-19). His utterances primarily 
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clustered in length between three and eight words. This seems reasonable since 
his MLU in words was 5.79. 
 

 
Figure 10-19 (Utterance Distribution Tables based on utterances in the first 139 words)  

 
Database Menu: Subordination Index (Figure 10-20) 
The Subordination Index (SI) was applied to Timmy’s sample. The SI is a fast 
measure of complex syntax, computed by dividing the total number of clauses 
by total number of C-units (see Appendix O). Timmy yielded a composite score 
of 1.05 which is within normal limits compared to the database mean. This 
means that most of his utterances contained one clause. 
  

 
Figure 10-20 
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Analyze Menu: Omissions and Error Codes (Figure 10-21) 
The Omissions and Error Codes report lists all of the omissions and error codes 
marked in the transcript. In this transcript, there were two omitted words and 
three word-level errors. According to the Standard Measures Report (Figure 10-  
16), omissions and errors are within normal limits when compared to peers. 
However, they should be looked at in case there are patterns of errors that 
could be identified. Notice that all three error codes marked problems with 
verbs, including two instances of over-generalized past tense verbs. 
 

Figure 10-21 
 
INTERPRETATION 
 

Performance Profile  
Timmy’s language production is characterized by low MLU. His sample was far 
shorter than those of his age-matched peers and his narrative organization and 
structure scores revealed his story was less mature and effective. This fits the 
profile of delayed language which is often associated with low MLU and shorter 
samples.  
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Challenges  
Timmy produced a short narrative with short utterances. His vocabulary use, 
albeit not significantly lower than his peers, did lack overall diversity and use of 
verbs. Timmy simply did not talk very much. His short sample contained several 
errors and he had difficulty with the narrative task. It would be beneficial to 
elicit another sample, possibly a conversation, to determine if MLU and 
vocabulary diversity increase.  
 

Strengths  
Timmy’s sample contained very few mazes and the number of errors produced 
were not significant compared with his database peers. 
 

Clinical Impressions 
Overall, Timmy’s sample reveals a reticent talker, possibly because he has not 
been a successful communicator. His limited verbal output may account for his 
low scores for syntax and limited ability with narrative structure. He is a fluent 
speaker with slightly limited lexical diversity, using mostly simple syntax.  
 

Ideas for Intervention 

• Set up language-facilitating games to encourage more verbal output 

• Provide vocabulary enrichment related to curriculum phrases with increased 
length and mature forms 

• Practice story retell using the NSS scoring categories to teach story structure 
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SALT Transcript: Alex 16;7 Con.slt10 
 
BACKGROUND 
 

Alex is a 16;7 year-old high school sophomore who has received special 
education services since age seven for speech and language. In addition, he 
currently receives support services for math and language arts. His productive 
language skills are being assessed as part of his three-year Individualized 
Education Plan (IEP) re-evaluation.  
 
ASSESSMENT MEASURE 
  

A conversational sample was collected as part of an assessment of Alex’s spoken 
language skills. Alex was cooperative throughout the elicitation process. The 
results are considered to be an accurate representation of his oral language 
ability. The sample was transcribed using SALT software and SALT transcription 
conventions. There is no age-matched database comparison for Alex’s 
conversational sample since the Conversational database contains samples from 
participants in the age range 2;9 to 13;3 (see Appendix B). Two options are 
available to help interpret the language sample measures. An informal option is 
to compare his sample to the oldest age group from the Conversation database. 
It seems reasonable to assume that a 16-year-old should have at least the skills 
of a 13-year-old. However, there may be unknown factors which come into play 
suggesting that this might not be a valid comparison. The other option is to use 
the Analyze menu which produces language measures for Alex and the 
examiner, but does not include normative data. For this case study we will use 
the second option and look at his measures independent of the database. To 
help with interpretation, SALT contains a variety of graphs generated from the 
SALT reference databases. They are included as PDFs accessible by selecting 
“Normative Graphs” from the Help menu. For conversational samples, data is 
presented for ages 3 – 13. 
 

Criteria: Measures produced from the Analyze menu 

 
10 Alex 16;7 Con is one of the sample transcripts included with the software. 

Case Study 4: ALEX 
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 Figure 10-22 
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Analyze Menu: Standard Measures Report (Figure 10-22) 
The Standard Measures Report is an overview report showing scores for each of 
the standard language measures. Data from the normative graphs computed 
from the SALT Conversation database (Appendix B) for 13-year-olds (13;0 – 
13;11) are used below to help with interpretation. 

 
• Transcript Length: Alex produced a total of 70 utterances in his four-minute, 

five-second sample; twice as many utterances as the examiner.  

• Intelligibility: There were no significant issues with intelligibility.  

• Syntax/Morphology: Alex’s MLUw was 8.78, which is likely within normal 
limits considering the context of the sample (conversation) and his age (16;7). 
His SI Composite Score indicates that his utterances contained an average of 
1.33 clauses. Note that the normative graphs for 13-year-olds show a mean 
MLUw of 6.0 and a mean SI composite score of 1.2.   

• Semantics: His Moving-Average NDW (number of different words based on a 
window of 100 words) was 63, an indication that his vocabulary diversity was 
adequate. Note that the normative data graph for ages 7 - 13 show a mean 
Moving-Average NDW of approximately 60. 

• Discourse: Alex’s turn length in words was 25.87 compared to the examiner’s 
6.29 words. Alex responded to just 67% of questions posed by the examiner. 
Note that the normative data graph 13-year-olds show a mean turn length in 
words of 12.4 and a mean response to questions of 85%. 

• Verbal Facility: Alex’s speaking rate, measured in words per minute (WPM), 
appeared elevated at 164.57. His % mazes (maze words as a % of total words) 
was 13.1%. Note that the normative data for 13-year-olds show mean WPM of 
116 and mean % mazes of 8%. 

• Errors: There were five error codes in the sample; 7.1% of Alex’s utterances 
contained one or more errors. Note that the normative data graph for 13-
year-olds shows mean % utterances with errors of just over 5%. 

 

Additional information is provided in subsequent reports. 
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Analyze Menu: Standard Utterance Lists → Questions (Figure 10-23) 
Alex’s low response to questions prompts a closer look. The Standard Utterance 
Lists, selected from the Analyze menu, displays lists of various types of 
utterances, including Questions, as well as their context within the sample. 
Using SALT to display the examiner’s questions along with the two subsequent 
entries is revealing. After examining these utterances more closely and listening 
to the audio, Alex’s low rate of responses to questions was likely due to the 
examiner asking consecutive questions. Alex did not have the opportunity to 
respond before the next question was asked. His failure to respond to questions 
was pragmatically appropriate. 
 

Figure 10-23 
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Analyze Menu: Verbal Facility Summary (Figure 10-24) 
Thirteen percent of Alex’s total words were contained in mazes, which is higher 
than expected (8% is typical for 13-year-olds) and interferes with getting his 
intended message across. His mazes averaged 2.10 words in length. The mazes 
consisted primarily of phrase-level revisions. Filled pauses, e.g., er and um, were 
also frequent throughout Alex’s sample. 
 

 
Figure 10-24 
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Analyze Menu: Utterance Code Table (Figure 10-25) 

 
There were three utterance-level errors in Alex’s language sample. These 
utterances are shown in the Utterance Code Table for further investigation. Alex 
switched tenses within the same utterance. This occurred when he attempted 
longer (more complex) utterances as in the first utterance shown in the table. 
This tendency to switch tenses makes utterances awkward and difficult to 
comprehend. 

 

Analyze Menu: Subordination Index (Figure 10-26) 
The Subordination Index (SI) was completed on Alex’s sample. The SI measures 
clausal density and is computed by dividing the total number of clauses by total 
number of C-units (see Appendix O). Alex scored a 1.3, meaning most of his 
utterances consisted of one clause (40 utterances with a score of SI-1). Alex had 
nine utterances with two clauses and five utterances with three clauses.  

Figure 10-26 

 
  

Figure 10-25 
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Explore Menu: Utterances Coded as [SI-3] (Figure 10-27) 
The Explore menu was used to pull up the five utterances which contained three 
clauses (coded as [SI-3]). Four of the five utterances contained direct quotes 
which increased the number of clauses without, necessarily, increasing sentence 
complexity. 
 

 
Figure 10-27 

 
 
INTERPRETATION 
 
Performance Profile   
Alex’s sample showed a fast speaking rate with low semantic content. This 
profile of language disorder features accelerated speaking rate (high WPM), 
high turn length, high MLU, and less complex sentence use. It is supported by 
Alex’s elevated turn length which was more than four times longer than the 
examiner’s turns. His messages were not always effectively completed as 
indicated by frequent rephrasing, circumlocutions, and filled pauses. He also 
had limited content given his high MLU and NDW, and less mature clausal 
structure. 
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Strengths 
Alex used a variety of words in his language sample as seen by the high NDW. 
He was friendly and completed the task with enthusiasm. He also stayed on 
topic during the conversation, and responded appropriately to questions.  
 
Challenges 
Alex’s speaking rate was fast which made his language hard to follow at times. 
Alex talked more than twice as much as his conversational partner. He tended 
to be verbose and didn’t often allow his speaking partner to “chime in.”  He 
tended to rush to complete his thoughts as evidenced by revised word selection 
and sentence structure as well as utterance-level errors. Combined, these 
characteristics made his language relatively difficult to understand. Alex’s SI 
score indicated that he used mostly one-clause utterances, a simplified 
sentence structure. His utterance-level errors occurred when he attempted 
longer, more complex utterances.  
 
Clinical Impressions 
This conversational sample allowed for careful examination of Alex’s speaking 
rate in relation to a speaking partner, his responsiveness to that partner, and his 
ability to express coherent utterances syntactically and semantically. The 
sample showed overall thought organization problems since Alex’s mazes 
consisted mostly of phrase-level revisions and filled pauses. With repeated 
samples, his progress on intervention goals can be tracked. It might also be 
beneficial to elicit an expository sample to monitor his progress. An expository 
sample might better provide an opportunity to examine semantic content, 
syntax, and overall text organization.  
 
Ideas for Intervention 

• Organization: language-based planning activities using the expository 
template or the narrative scoring categories as targets 

• Generate utterances using various subordinating conjunctions to create 
more complex sentences 

• Guided speaking rate practice using a metronome or digital counter 

• Practice slower speaking rate with known content like story retelling or 
expository tasks  
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SALT Transcripts: Sam DDS Pre.slt & Sam DDS Post.slt11 
 

This case study was contributed by Maureen Gonter, M.S., CCC-SLP and Jane 
Morgan, M.S. Speech and Language/AVID Resource Teacher from Madison 
Metropolitan School District. 
 
BACKGROUND: RtI PROGRAM 
 

This case study is an example of how to use language sample analysis as part of 
assessing a Response to Intervention (RtI)12 program. This RtI study was 
completed with 6th grade students who were selected based on: 

• lower scores on 5th grade Wisconsin Knowledge and Concept Examination 
(WKCE), a state standardized test 

• 6th grade Scholastic Reading Inventory score (fall semester) 

• teacher recommendations based on moderate difficulty meeting 6th grade 
standards across academic areas 

• outcomes of Assessment of Classroom Communication and Study Skills, a 6th 
grade whole class screener 

 
Students in the RtI program were involved in a literacy intervention group and 
were seen for 15 sessions over 10 weeks during the course of one school 
quarter. The students received Tier 2 literacy instruction focusing on four areas: 
reading, writing, listening, and speaking. The focus of the intervention was to 
teach the students specific strategies and then give them opportunities to 
practice and apply the strategies to classroom activities and tasks. For example, 
the students were given a strategy to use in the classroom to signal to the 
teacher if they were having difficulty with vocabulary (make a “v” with two 
fingers) or understanding content/ideas (make a “w” for “what?” with three 

 
11 Sam DDS Pre and Sam DDS Post are sample transcripts included with the software. 

12 Response to Intervention is a variation of an old diagnostic method formerly known as 
Diagnostic Therapy (Miller, 1981) and later as Dynamic Assessment (Olswang, Bain, & 
Johnson, 1991). 

Case Study 5: SAM 
Response to Intervention 
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fingers). In this case study we look at one specific student, Sam, and his 
response to intervention. 
  

BACKGROUND 
 

In the classroom, Sam struggles with staying focused and on task. He engages in 
off-task behaviors which distract others such as humming and singing. He 
particularly struggles with attention and focus during math. Teachers believe 
this is because math is a more challenging subject for him. If the task is more 
engaging, Sam is better able to focus. He sometimes does not attempt tasks if 
he feels he will not be successful. He tends to do better on tasks that allow him 
to be creative. His language sample scores seem to reflect his functioning in the 
classroom (as measured by the Assessment of Classroom Communication and 
Study Skills) better than the results of his standardized testing. 
 

STANDARDIZED TEST INFORMATION 
 

Peabody Picture Vocabulary Test-4th Edition (PPVT-4), Form A 
Pre RtI Therapy Program:  

• Standard Score: 104,  

• Percentile:  61 

• Age Equivalent:  13;5 
Score on the on the PPVT-4 was within normal range. Sam used verbal 
mediation throughout this assessment. He would comment about word 
parts, rhymes, or other connections he could make as he tried to figure out 
the meaning of an unfamiliar word. 

 

INFORMAL MEASURES 
 

Assessment of Classroom Communication and Study Skills 

• Reading Comprehension  1 of 4 points 

• Following Directions 7 of 20 points 

• Language Detective 2 of 5 points 

• Vocabulary 8 of 10 points 
 

• Total  18 of 39 points 

• Percentage 46%      (> 70 % is considered passing) 



206  Assessing Language Production Using SALT Software  

 

Narrative Language Sample 
Sam retold the story Doctor De Soto (Steig, 1982) using the book with the text 
covered as per the elicitation protocol (see Appendix D). A retell sample was 
collected at the beginning of the RtI program and then again after participating 
in the 8-10 week intervention.  
 
The focus in this case study is on the differences seen between the pre and post 
intervention language samples. Using the Link menu in SALT, Sam’s pre and post 
samples were linked for side-by-side analysis with the samples equated by the 
same number of total words (NTW = 545). Sam’s linked samples were compared 
to age-matched peers retelling the same story selected from the Narrative Story 
Retell database (see Appendix D).  
 

Selected database samples Pre RtI:  
79 samples matched by age: 11;7 – 12;7  
31 samples matched by age and same number of total words (NTW)  

 

Selected database samples Post RtI:  
55 samples matched by age: 11;10 – 12;8  
24 samples matched by age and same number of total words (NTW)  
 

SALT ANALYSIS 
 

Database Menu: Standard Measures Report (Figure 10-28) 
The Standard Measures Report shows the results of the pre and post samples 
with the relevant standard scores for each of the standard measures.  

• Transcript Length: In each story retell Sam used an adequate number of 
utterances and retold the narrative in average elapsed time.  

• Macro Analysis: Sam’s NSS Composite Score, which measures narrative 
structure and content, increased from 17 (1.79 SD below the database mean) 
to within normal limits at 26 (0.34 SD above the database mean).  

• Syntax/Morphology: His mean length of utterance in morphemes (MLUm) was 
low in both retells. MLUm was 9.27 (1.32 SDs below the mean) on his first 
retell which but increased to 10.33 (0.69 SD below the database mean) on his 
second retell. His SI Composite Score, a measure of clausal density, was also 
low for both retells, but increased from 1.20 in the first retell to 1.43 in the 
second retell. 
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Figure 10-28 Standard Measures Report based on entire transcript 
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• Semantics: Sam used a higher number of different words (NDW) on his second 
sample. 

• Verbal Facility: Areas of challenge included increased pause times and 
increased mazes. Sam’s pause time increased significantly from 3.5% of total 
time on his first sample to 12.9% on the second sample, although both were 
within normal limits. Sam’s mazes also increased in the second sample – from 
18.5% of words to 21.7%.  

• Errors: Sam’s first retell contained 4 omissions while there were no omissions 
in his second retell. Error codes, however, increased from 3 in his first retell to 
6 in his second retell even though the number of errors was within normal 
limits 

 

Additional information is provided in subsequent reports. 
 
Database Menu: Narrative Scoring Scheme (Figure 10-29) 
Sam’s sample was scored using the Narrative Scoring Scheme (NSS, see 
Appendix P) specific to the story Doctor De Soto. The NSS is a tool to assess the 
structure and content of a narrative. The narrative is scored on seven features 
of a narrative such as introduction, character development, mental states, and 
referencing, for a total of 35 possible points. Sam’s composite score on the NSS 
was 17 (1.79 standard deviations below the mean) on the first assessment and 
increased to 26 (0.34 standard deviations above the mean) on the post-therapy 
assessment.  
 

 
Figure 10-29 
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Database Menu: Subordination Index (Figure 10-30) 
The Subordination Index (SI, see Appendix O) measures clausal density and is 
computed by dividing the total number of clauses by total number of C-units. 
The SI was calculated and compared to the database of peers for both pre and 
post intervention assessment. The pre-treatment score was 1.20 (1.90 standard 
deviations below the mean) and the post-treatment score was 1.43 (0.67 
standard deviations below the mean) indicating that Sam used utterances with 
more clauses, i.e., increased syntactic complexity, in the post-intervention 
sample. He had more scores of [SI-2] and [SI-3] in the second sample. His scores 
showed a decrease in utterances marked as [SI-0]. 
  

 
Figure 10-30 SI based on first 545 words 

 
Database Menu: Verbal Facility Summary (Figure 10-31) 
The Verbal Facility Summary indicated that Sam used an abundance of pauses 
during his second story retell as compared to his first story retell. Over 12 
percent of his total time retelling the story was spent in a pause.  He had 12 
pauses throughout his language sample. This is in stark contrast to his first story 
retell where he rarely paused. Sam used more mazes in his second sample than 
his first. His percent maze words to total words increased from 18.5% to 21.7%. 
His mazes were mostly phrase revisions which may indicate utterance 
formulation difficulty 
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Figure 10-31 

 
Analyze Menu: Standard Utterance Lists (Figure 10-32 & Figure 10-33) 
The Standard Utterance Lists, selected from the Analyze menu, displays lists of 
various types of utterances, including utterances with errors and utterances with 
parenthetical remarks. 
 



 Chapter 10  ●   Pulling It All Together: Case Study 5 (SAM)   211 

 

 

• Standard Utterance Lists → Error Codes (Figure 10-32) 
There were more word-level errors in the second sample than the first with 
an increase from three errors to six. The errors that Sam made seemed to 
be varied with no specific pattern. His language sample included errors in 
overgeneralization, word choice, conjunctions, and tense markers.  

Figure 10-32 

 

Figure 10-33 
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• Standard Utterance Lists → Parenthetical Remarks (Figure 10-33) 
Parenthetical remarks are comments that to do not contribute to the story. 
They are excluded from analysis and marked in ((double parentheses)). Sam 
used an abundance of parentheticals that mostly related to word retrieval 
or perhaps working memory difficulty. He specifically stated, “What’s his 
name?”, “I’m just going to say doctor”, “I don’t remember”, and “I don’t 
know.”  There were significantly less parenthetical remarks in the second 
sample than in the first sample.  

 
INTERPRETATION 
 
Performance Profile 
Sam’s oral language skills best fit with the word retrieval and utterance 
formulation profile. His language samples are characterized by increased mazes 
and frequent utterances where Sam stated he “can’t remember” words. 
Additionally, Sam’s samples were marked by pauses that occurred within 
utterances, usually within mazes, which indicates utterance formulation 
difficulty. 
 
Strengths 
Subsequent to the intervention phase, Sam’s MLU in words increased as did his 
syntactic complexity and vocabulary diversity. He had a decrease in word 
omissions. He improved his Subordination Index score indicating that he used 
more complex utterances after completing the intervention. He also increased 
his narrative structure and content score demonstrating improved organization 
and content of his narrative. He also increased the structural components of his 
narrative in the areas of cohesion, introduction, and conclusion.  
 
Challenges 
Sam was responsive to intervention as seen by the many areas of improvement. 
However, he continues to demonstrate difficulty with organization, word 
retrieval, and utterance formulation. He also had significant amount of pausing. 
Difficulty in these areas was highlighted in his second narrative retell. As many 
of his syntactic and semantic features improved, he demonstrated increased 
difficulty with mazes and pauses. He used more complex syntax with richer 
vocabulary but with more difficulty.  
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Clinical Impressions 
Sam’s attempts at longer and more complex utterances support that he is 
generalizing his increase in MLU and NDW, the strategies learned, and the 
general language learning from the intervention program. As he attempted the 
longer and more complex utterances, his mazes, pauses, and utterance-level 
errors increased. These increases likely reflect the production challenges to 
Sam’s language system and his struggle to put what was learned into practice. 
Sam’s improved NSS and SI scores also support these impressions.  
 
Sam would most likely not be a candidate for speech and language 
programming within a special education program since he was responsive to 
intervention and many of his language measures are now within functional 
limits. As Sam begins 7th grade the following suggestions might help him be 
more successful in his academic classes:   
 
Ideas for Intervention 

• Consult with parents at the start of the school year to provide word retrieval 
and language formulation strategies. 

• Encourage Sam to take his time to formulate and organize thoughts before 
speaking. 

• Consult with teachers to provide reminders and cues to use with Sam during 
classroom discussions and/or presentations. 

• Suggest placement in a supported Social Studies classroom where large 
group vocabulary instruction and language activities occur once per month. 
Keep monthly data to monitor his progress. 

• Provide Sam with a visual reminder of the RtI strategies to be kept in his 
planner.
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SALT Transcripts: María English FWAY.slt & María Spanish FWAY.slt13 
 
BACKGROUND 
 
María is 7 years and 3 months old. She is a native Spanish speaker who was 
placed in a transitional bilingual first grade classroom. Her classroom instruction 
is 20% Spanish and 80% English. Although Spanish is the only language spoken in 
her home, María attended a monolingual English daycare prior to starting 
school. She has an older sibling with speech and language needs who received 
services in the school. María was referred for a speech and language evaluation 
by her classroom teacher because of difficulty acquiring English. The clinician 
responsible for the evaluation is a native English speaker with minimal Spanish 
proficiency.  
 
ASSESSMENT MEASURE IN ENGLISH  
 
The clinician first elicited an English sample. María was seated next to the 
clinician who told the story Frog, Where Are You? (Mayer, 1969) in English 
following the provided script. They looked at the story together as it was told. 
The clinician then asked María to retell the same story in English. Her sample 
was transcribed and compared to age and grade-matched bilingual peers 
retelling the same story in English. Comparison samples were selected from the 
Bilingual English Story Retell reference database (see Appendix G). 
 

Selected database samples:  
123 samples matched by age (7;1 – 7;5) and grade (1st) 
114 samples matched by age, grade, and same number of total words (NTW)  

 
  

 
13 María English FWAY and María Spanish FWAY are two of the sample transcripts 

included with the software. 

Case Study 6: MARÍA 
Bilingual (Spanish/English) 
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SALT ANALYSIS OF ENGLISH SAMPLE 
 

 
Figure 10-34 Standard Measures Report based on entire transcript 
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Database Menu: Standard Measures Report (Figure 10-34) 
 

• Transcript Length: María’s sample length was 4.0 minutes long. However, she 
produced fewer total utterances, fewer C&I Verbal Utts (complete, intelligible, 
verbal utterances), and fewer words (including maze words) than her age and 
grade-matched bilingual peers when retelling the same story.  

• Macro Analysis: The NSS composite Score, which measures the narrative 
structure and content, is more than 2 SD below her bilingual peers. 

• Syntax/Morphology: Maria’s MLU in words (MLUw) was 4.92, which is 1.66 
standard deviations below the database mean.  

• Semantics: She had a lower number of different words (NDW); however, her 
Moving-Average NDW, a more meaningful comparison of NDW because it is 
independent of sample length, was within normal limits. 

• Verbal Facility: María’s performance showed a reduced speaking rate, as 
measured in words per minute (WPM), and an increase in silent pauses. Her 
mazes were within normal limits. 

• Errors: María’s errors and omissions were within normal limits. 
 

Comparing María’s English sample to the reference databases, we can see there 
are several areas of concern (MLUw, narrative structure, WPM, pauses) relative 
to her age and grade-matched peers. Without testing in the native language, 
María would appear less language proficient than her peers, and possibly 
disordered. 
 

ASSESSMENT MEASURE IN SPANISH  
 

Because María’s English proficiency was below age and grade-expected norms, 
it was necessary to elicit a language sample in Spanish. Approximately one week 
later, the clinician was able to obtain the services of an aide, fluent in Spanish, 
who elicited a Spanish sample from María. The elicitation process was 
essentially the same for Spanish as it was for English. María was seated next to 
the aide who told the story Frog, Where Are You? (Mayer, 1969) in Spanish 
using the script. The aide then asked María to retell the same story in Spanish. 
María’s sample was transcribed and compared to age and grade-matched peers 
retelling the same story in Spanish. Comparison samples were selected from the 
Bilingual Spanish Story Retell reference database (see Appendix G). 
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Selected database samples:  
117 samples matched by age (7;1 – 7;5) and grade (1st) 
53 samples matched by age, grade, and same number of total words (NTW) 

 
SALT ANALYSIS OF SPANISH SAMPLE 
 

 
Figure 10-35 Standard Measures Report based on entire transcript 
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Database Menu: Standard Measures Report (Figure 10-35) 
 

All of María’s language measures in Spanish were comparable to, and, in some 
areas, superior to her bilingual peers. Her MLU in words (MLUw) and speaking 
rate, measured in words per minute, were within normal limits. Her number of 
different words (NDW) and number of total words (NTW) were slightly above 
the database average. Only 3.6% of Maria’s words were in mazes and there 
were no errors or omissions in her Spanish retell. 
 
COMPARISON OF ENGLISH AND SPANISH SAMPLES 
 
Database Menu: Standard Measures Report (Figure 10-36) 
For a comparison of María’s English and Spanish performance, her English and 
Spanish retell samples were linked (Link menu) with the comparison based on 
the entire transcript. The link feature is helpful when comparing two different 
samples as it provides the reports with the database standard deviation 
information in a side-by-side report. 
 
After the transcripts were linked, the Database menu: Standard Measures 
Report was generated. María’s English sample was compared with 123 age and 
grade-matched samples, with 114 samples equated by the same number of 
total words. Her Spanish sample was compared with 117 age and grade-
matched samples, with 53 samples equated by the same number of total words.  
 
María produced 25 English utterances with 133 words in 4 minutes, and 36 
Spanish utterances with 251 words in 2 minutes and 49 seconds to retell the 
same story. Her NSS composite score, a measure of narrative structure and 
content, was 8 out of 35 points in her English sample and 17 out of 35 points in 
her Spanish sample. Notice that her MLU in words (MLUw) in English was 4.92 
and was 6.75 in Spanish. María’s English vocabulary was not as diverse as her 
Spanish vocabulary (number of different words). Her speaking rate (words per 
minute) was much slower in English (33.25 vs. 89.11) due in part to the large 
number of pauses in her English retell (pause time made up 36% of the total 
time). There were also more mazes, omissions, and error codes in her English 
sample.  
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Figure 10-36 Standard Measures Report based on entire transcript 

  
Database Menu: Narrative Scoring Scheme (Figure 10-37) 
María’s samples were scored using the Narrative Scoring Scheme (NSS, see 
Appendix P), a tool to assess the structure and content of a narrative. The 
narrative is scored on seven features of storytelling such as introduction, 
character development, mental states, referencing, and cohesion. Each category 
can receive a score of up to five points (35 total points). SALT compared María’s 
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NSS scores to her bilingual peers. María’s English NSS score (8 points out of 35) 
was 2.12 standard deviations below the database mean. Since her English story 
was limited by number of utterances, words, and by length of utterance, it is not 
unexpected that she scored lower on narrative form and content. Her Spanish 
composite NSS score was within normal limits at 17 points out of 35. She 
received a slightly lower score on referencing but all other individual category 
scores were within normal limits.  
  

 
Figure 10-37 

 
Database Menu: Subordination Index (Figure 10-38) 
The Subordination Index (SI, see Appendix O) is a measure of clausal density and 
is calculated by dividing the number of clauses by total number of utterances. 
After coding María’s samples for SI, SALT was used to calculate the composite 
score and compare the results to the databases of bilingual peers. Figure 10-38 
details this information with the samples linked. In her English sample María 
used mostly utterances with one clause. In her Spanish sample María used a 
greater variety with more utterances containing two clauses. Her Spanish 
Subordination Index score was actually above the database mean at 1.06. 
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INTERPRETATION 
 
Performance Profile:  English Language Learner  
Since María has adequate Spanish skills, we can assume that she is not language 
impaired. Rather, María’s primary difficulty is in second language acquisition. In 
order for a bilingual student to be considered language impaired, skills in both 
languages need to be below age-expected norms.  
 
Strengths  
María demonstrated good Spanish language skills with age-appropriate 
vocabulary, mean length of utterance, and speaking rate. Her Narrative Scoring 
Scheme score (measure of narrative content and form) was also within normal 
limits. María also used adequate syntactic complexity as her Subordination 
Index score was well with normal limits.  
 
Challenges 
Acquiring English as a second language is María’s primary challenge. Measures 
of verbal fluency, words-per-minute, and increased pauses and pause time 
suggest that María is struggling to find English referents and sentence structure 
to adequately retell the story. These challenges reflect her limited knowledge of 
English. Examining the utterances with errors can be helpful when addressing 
specific challenges. For example, María has difficulty with pronoun use (i.e., his 

Figure 10-38 SI based on first 118 English words and first 243 Spanish words 
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for your). Specific English vocabulary and morphologic features of English are 
also challenging for her (i.e., “He’s be a bird.”)  
 
CLINICAL NOTES 
 
Role of Bilingual SLPs: As clinicians, our job in the assessment process is to 
ascertain whether a speaker is typically developing or language impaired. If 
María had been assessed first in Spanish, the decision-making process would 
have been completed. She is not language impaired. However, there are 
occasions in which it might also be advisable to follow up and test speakers like 
María in English. This additional testing will not modify our conclusions, but it 
might provide other team members critical information that would assist those 
who are in the process of acquiring English. If the referral specifically stated 
that, “María is not developing her English skills as well as her other bilingual 
peers,” it might be beneficial to assess María’s language in English in order to 
determine whether the teacher’s concerns are warranted. English assessment 
would provide the teacher information on the child’s strengths and weaknesses 
in English, and possibly afford the opportunity to collaborate with teachers in 
selecting appropriate materials and instructional strategies. Following this path 
is not necessary for our clinical decision-making process, but it will further 
enhance others’ ability to assist speakers like María. For more information, see 
ASHA’s Technical Report on the role of SLPs in working with ESL instructors in 
school settings14. 
 
PLAN/TREATMENT IDEAS 

• Referral for ESL programming 

• English language enrichment activities within the classroom 

 
14 http://www.asha.org/policy/tr1998-00145.htm 
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SALT Transcripts: Malcolm Nar SSS15 
 
BACKGROUND 
 
Malcolm is a 9;3 third grade student who was referred for a speech and 
language evaluation due to difficulty in the classroom with writing and speaking. 
Since Malcolm is African American and uses African American English (AAE) 
dialect, his teacher is wondering if his dialect is affecting his performance in 
school. His teacher also stated that it takes a lot of time for Malcolm to “get his 
message across.” Writing skills are also an area of concern. Malcolm’s parents 
and siblings speak AAE dialect at home. There is no family history of language 
disorder or learning disability. Malcolm uses AAE dialect at school and does not 
usually code switch into Standard American English (SAE) while at school.  

 
ASSESSMENT MEASURE 
 
A student selects story (SSS) narrative sample was collected. Malcolm retold the 
story of a Batman and Scooby-Doo cartoon he recently watched. The examiner 
used AAE dialect during the elicitation. To help determine language difference 
or disorder, the transcript was coded for morphosyntactic AAE dialect features 
(Craig & Washington, 2004) discussed in Chapter 8. The phonological AAE 
features were not coded in this sample. Malcolm’s sample was compared to 
samples selected from the Narrative SSS database (see Appendix C).  
 

Selected database samples:  
30 samples matched by age: 8;9 – 9;5  
19 samples matched by age and same number of total words (NTW)  

  

 
15 Malcolm Nar SSS is one of the sample transcripts included with the software. 

Case Study 7: Malcolm 
AAE Dialect Speaker 
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SALT ANALYSIS  
 

Database Menu: Standard Measures Report (Figure 10-39) 
The Standard Measures Report reveals that most of Malcolm’s language 
measures are in the average range (just slightly below the database mean). 
Malcolm is slightly older at 9.25 years of age than the database mean of 9.06  

Figure 10-39 Standard Measures Report based on entire transcript  
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years of age. Malcolm told the narrative in the approximately the same amount 
of time as the database age-matched peers. His vocabulary appeared within 
normal limits with an age-appropriate mean length of utterance (MLU), number 
of different words (NDW), Moving-Average NDW, and rate of speech. Malcom 
did produce a high number of mazes (repetitions, revisions, filled pauses). 26.3% 
of his total words were in mazes. This score is 4.34 standard deviations above 
the database mean. Due to the high percentage of mazing, further investigation 
is warranted.  
 

Additional information is provided in subsequent reports. 
 

 
 Figure 10-40 Verbal Facility Summary based on first 308 words 
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Database Menu: Verbal Facility Summary (Figure 10-40 & Figure 10-41) 
From the Verbal Facility Summary (Figure 10-40) we can see that Malcolm used 
an abundance of part-word and phrase repetitions and revisions, indicating 
utterance formulation difficulty. He also had many single-word filled pauses, 
e.g., uh, um. Malcolm might be using filled pauses as a strategy to “buy more 
time” when formulating utterances. The maze distribution table (Figure 10-41) 
shows that, as Malcolm is attempting longer utterances, he tends to have more 
difficulty with utterance formulation. 
 

 
 
 
Explore Menu: Word and Code List (Figure 10-42 & Figure 10-43) 
Since Malcolm’s transcript was coded for AAE dialect features, the Explore 
menu was used to count these codes and pull up the utterances containing 
them. In Figure 10-42, you can see that Malcolm used preterite had, e.g., “you 
had got that one before” 13 times. This AAE dialect feature would not 
negatively impact language measures such as mean length of utterance (MLU) 
or number of different words (NDW). If used often, it would lengthen MLU. 
Malcolm also used one of the most common AAE features, subject-verb 
agreement, e.g., “but they was going then”.  
 

Figure 10-41 Maze Distribution Tables based on utterances in the first 308 words 
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Figure 10-42 
 
Figure 10-43 shows that Malcolm used zero past tense, e.g., “they had scare all 
the people”, 3 times. He also used appositive pronoun forms, e.g., “Scooby Doo, 
he was at the door”. These features of AAE dialect, if upheld to SAE, would likely 
be marked as errors. This, in turn, could make Malcolm appear as though he has 
language impairment. However, these language features represent a language 
difference, not disorder, and are not considered when determining presence of 
language impairment.  
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Figure 10-43 
 
Analyze Menu: Omissions and Errors (Figure 10-44) 
Malcolm had one word-level error and one utterance-level error. This is 
relatively low without a specific pattern of errors.  
 

 
Figure 10-44 
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INTERPRETATION 
 
Performance Profile: AAE Dialect Speaker  
Malcolm’s sample contained a high percentage of mazes with repetitions, 
revisions, and filled pauses which is indicative of potential utterance 
formulation or word retrieval difficulty. Malcolm used AAE dialect. He produced 
a total of 28 utterances which, if compared to SAE, would look like they 
contained errors. Malcolm had only one valid utterance-level error and one 
word-level error when dialect was accounted for.  
 
Strengths 
Malcolm is an outgoing and friendly student who completed the task with 
enthusiasm. He is proficient in AAE dialect. Malcolm demonstrated high 
intelligibility. His semantic skills, as indicated by his MLU, NDW, and number of 
errors, are within normal limits.  
 
Challenges 
Malcolm struggles with utterance formulation (and possibly word retrieval). The 
high number of mazes indicates difficulty with finding the right word or 
syntactic frame to express his thoughts. This difficulty may involve Malcolm 
trying to use SAE without having a solid foundation. The high number of mazes, 
paired with his AAE dialect, may make Malcolm appear language disordered. 
However, there isn’t compelling evidence from his language sample to support 
that diagnosis. Further investigation is warranted to identify the source of his 
fluency difficulties. A story retell language sample would allow for an analysis of 
his overall mastery of the content as well as provide more insight into his 
specific word or utterance formulation difficulties. In regard to his teacher’s 
concern with writing skills, this might be due in part to “writing how he talks” 
with a non-standard dialect.  
 
Clinical Impressions 
It is important to correctly identify the differences between a language disorder 
and AAE dialect use to avoid over or under diagnosing AAE dialect speakers as 
language disordered. For example, the most common features of AAE are 
deletion of auxiliary and copula forms of “to be” along with subject-verb 
agreement, which would be considered errors if held to strict SAE standards. 
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Other features that could be construed as errors and negatively affect language 
measures include undifferentiated pronoun case, multiple negation, and double 
modal. Some features of AAE may, in fact, increase measures such as MLU and 
NDW. Features such as preterite had, e.g., “you had got his toes stuck before”, 
and completive done, e.g., “I think we done ate enough”, are some examples 
where there are more words inserted in the utterance than if the speaker was 
using SAE. The take home message is that clinicians should carefully examine 
utterances from the language sample to determine dialect versus disorder. See 
Chapter 8 on African American English dialect for more information.  
 
Ideas for Intervention 

• Word retrieval tasks 

• Utterance formulation work, with emphasis on increased syntactic 
complexity  

 



  

AFTERWORD 
 
So what’s next? 
 

Go out and collect a language sample, transcribe it, generate the analyses, and 
interpret the results. This book provided the fundamentals, focusing on the 
importance of using LSA to assess productive language. It covered the various 
elicitation contexts, emphasized the importance of accurate transcription, and 
described the reference databases available for comparison. A lot of attention 
was given to understanding the analysis options and interpreting the results. 
Little time, however, was spent on “how to”; how to elicit and record a language 
sample, how to play it back during the transcription phase, how to type it into 
the SALT editor, how to learn the transcription conventions, and how to 
generate the analyses.  
 
So where can you go for help?  
 

You have several options, depending on your style of learning. Do you like to 
jump right in, only seeking help when you get stuck? Or do you prefer to 
complete all available training so you know as much as possible before starting? 
No matter what your style, it’s important for you to know about the resources 
available to you. 
 

• Appendices in the back of this book. Find detailed descriptions of all the 
SALT reference databases including the protocols used for elicitation in 
Appendices A-L. Appendix M contains a convenient summary of the 
transcription conventions and Appendix N details the rules for segmenting 
utterances into C-units. Guidelines for applying the Subordination Index (SI), 
Narrative Scoring Scheme (NSS), Expository Scoring Scheme (ESS), 
Persuasion Scoring Scheme (PSS), and Oral Narrative Quality (ONQ) are 
provided in Appendices O-S. Appendix T provides a guide to the SALT 
variables and Appendix U links language measures produced by SALT to the 
Common Core State Standards. Appendix V provides an explanation of 
standard deviation and how it relates to language measures. 
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• SALT web site (www.saltsoftware.com). Select “Training” for a variety of 
courses covering all the components of LSA using SALT. These courses are 
available for free. Listen to lectures, watch elicitation videos, learn and 
practice the transcription conventions, watch videos demonstrating how to 
use the software, and view case studies. Earn ASHA professional 
development hours while you learn. The material on the Web site is 
continually being improved and expanded so visit often. Also under 
“Training” you’ll find a link to SALT’s YouTube videos where you’ll find quick 
tips on all things LSA and SALT as well as more comprehensive video 
lectures.  
 

• Help built into the SALT software. The context help, accessed by pressing 
the F1 function key, is particularly useful because the help it provides is 
specific to where you are in the software. If you are typing your sample into 
the SALT editor window, F1 brings up a list of all the transcription 
conventions with detailed explanations and examples. If you are viewing a 
report, F1 describes the variables included in that report. In addition, every 
dialogue box contains a help button and the Help menu lets you search for 
topics using keywords. 
 

• Normative Graphs. Accessed from the SALT Help menu, these graphs, 
derived from the SALT reference databases, show age and grade values for a 
variety of language measures. They are available in PDF format. 
 

• Resources. Accessed from the SALT Help menu, these documents are in PDF 
format and provide detailed descriptions of the transcription conventions, 
including those for Spanish, French, and written samples. There are scoring 
guides, and a series of directed exercises to guide you through the 
mechanics of using the software. 

 
So what are you waiting for? 
 

One option is to go and record a language sample from anyone, child or adult, 
using one of the sampling protocols discussed in Chapter 2 and detailed in the 
appendices. Then open the SALT editor and begin transcribing the sample. This 
approach is for those who prefer to learn on the fly, by transcribing a sample. 
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And this approach may work well because of the context help offered by the 
software. If you are typing an utterance containing a revision, for example, just 
press F1 and read about marking mazes. Soon you will remember that mazes 
are enclosed in parentheses. As you work through the transcript, you will 
master the frequently occurring conventions and know where to find help for 
the others. 
 
An alternative learning method offers more support for learning the basics of 
the software. Go to the SALT web site and watch one or two elicitation videos. 
Read about digital recorders. Familiarize yourself with the elicitation protocols 
and go out and record a language sample. Then go back to the SALT web site 
and work through the courses on transcription conventions. At the completion, 
you will be a trained transcriber. Or you may prefer to do the first two or three 
transcription lessons to learn the basics. Then transcribe your sample, accessing 
the context help built into the software and returning to the web site as 
needed. Refer to the Help menu → Resources for directed exercises on using 
SALT to correct errors you may have made during transcription and to generate 
the reports. These lessons are designed to take you through all of the SALT 
features in a step-by-step format.  
 
These learning options are available help you get the most out of SALT so you 
can incorporate language sample analysis into your practice as efficiently as 
possible. 



  



  

 

GUIDE TO THE APPENDICES 

 
SALT Reference Databases of English-fluent Speakers 
 

Database 
Context 
(Subgroup) 

Age Range 
Grade in 
School 

# 
Samples 

Location 
Special 
Coding 

Appendix 

Play Con (Play) 2;8 – 5;8 P, K 69 WI SI A 

Conversation Con 2;9 – 13;3 
P, K, 1, 

2, 3, 5, 7 
584 WI & CA SI B 

Narrative NSS Nar (NSS) 5;2 – 13;3 
K, 1, 2, 3, 

5, 7 
330 WI SI C 

Narrative 
Story Retell 

Nar (FWAY) 
Nar (PGHW) 
Nar (APNF) 
Nar (DDS) 

4;4 – 7;5 
7;0 – 8;11 

7;11 – 9;11 
9;3 – 12;8 

P, K, 1 
2 
3 

4, 5, 6 

145 
101 
53 

201 

WI & CA SI, NSS D 

Expository Expo 10;7 – 18;9 
5-7, 
9-12 

354 WI SI, ESS E 

Persuasion Pers 
14;8 – 18;9 

12;10 – 18;4 
9-12 
---- 

113 
66 

WI 
Australia 

SI, PSS F 

 
SALT Reference Databases of Bilingual (Spanish/English) &  
Monolingual Spanish Speakers 

 
 

Database 
Context 
(Subgroup) 

Age Range 
Grade in 
School 

# 
Samples 

Location 
Special 
Coding 

Appendix 

Bilingual 
Spanish/English 
Story Retell 

Nar (FWAY) 
Nar (FGTD) 
Nar (FOHO) 

5;0 – 9;9 
5;5 – 8;11 
6;0 – 7;9 

K, 1, 2, 3 
K, 2 

1 

2,070 
1,667 
930 

TX & CA SI, NSS G 

Bilingual 
Spanish/English 
Unique Story 

Nar (OFTM) 5;0 – 9;7 K, 1, 2, 3 475 TX & CA SI, NSS H 

Monolingual 
Spanish Story 
Retell 

Nar (FWAY) 
Nar (FGTD) 
Nar (FOHO) 
Nar (OFTM) 

5;10 – 9;11 
6;4 – 10;6 
6;1 – 10;1 
6;9 – 10;7 

1, 2, 3 

366 
360 
188 
154 

Mexico SI, NSS I 
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SALT Reference Databases Contributed by Colleagues 
 

Database 
Context 
(Subgroup) 

Age Range # Samples Location Appendix 

ENNI Nar (ENNI) 4;0 – 10;0 300 Canada J 

TNL2 Narrative Samples  
TNL Narrative Samples 

Nar (TNL2) 
Nar (TNL) 

4;0 – 14;11 
5;0 – 11;11 

778 
500 

USA K 

NZ-AU 
Conversation 

Con  
4;5 – 7;7 
5;5 – 8;4 

248 
102 

New Zealand 
Australia 

L-1 

NZ-AU 
Story Retell 

Nar (AGL) 
Nar (AGL) 
Nar (BUS) 

4;0 – 7;7 
5;5 – 7;7 
5;3 – 8;9 

264 
85 

127 

New Zealand 
Australia 
Australia 

L-2 

NZ-AU 
Personal Narrative 

Nar (NZPN) 
4;5 – 7;7 
5;5 – 8;4 

228 
127 

New Zealand 
Australia 

L-3 

NZ-AU 
Expository 

Expo 
6;1 – 7;11 
7;4 – 8;4 

65 
42 

New Zealand 
Australia 

L-4 

AU-USA Persuasion Pers 
12;10 – 18;4 
14;8 – 18;9 

66 
113 

Australia 
United States 

L-5 

 

Summary Guides 
 

Topic Appendix 

Summary of SALT Transcription Conventions  M 

C-Unit Segmentation Rules N 

Subordination Index (SI) O 

Narrative Scoring Scheme (NSS) P 

Expository Scoring Scheme (ESS) Q 

Persuasion Scoring Scheme (PSS) R 

Oral Narrative Quality (ONQ) S 

Guide to the SALT Variables T 

Using SALT to Assess the Common Core U 
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Play Database  
 

Database 
Context 
(Subgroup) 

Age Range 
Grade in 
School 

# Samples Location 
Special 
Coding 

Play Con (Play) 2;8 – 5;8 P, K 69 WI SI 

 
Participants 
 

Typically developing children, ranging in age from 2;8 - 5;8, were drawn from 
preschools in Madison and kindergarten classrooms in the Madison 
Metropolitan School District. These children, whose primary language is English, 
came from a variety of economic backgrounds and ability levels. "Typically 
developing" was determined by normal progress in school and absence of 
special education services. Economic background was determined by eligibility 
for the free lunch program. Ability level was determined by teacher rating. Age, 
gender, and grade data is available for all children. 
 

Elicitation Protocol 
 

Materials 

• audio or video recorder 

• Play dough, small toys, blocks etc. 

• quiet location free of distractions with a table and two chairs 
 
Preparation 
Check the recorder for loudness levels. Record the date, student's name or ID, 
birth date, age, and grade. 
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Directions 
Playing with play dough or small toys: Follow the child's suggestions, request 
directions etc. Comment on the child's activity. 

"I've bought some play dough for us to play with today. I wonder what we 
could make together." 

     "Let's make ---. What do we need to do to make it?" 
     "Here are two cows. What should we do with them?" 
     "What other animals go in the barn?" 
 

Transcription Notes 
 

Utterances were segmented into C-units (see Appendix N). All transcripts were 
timed and pauses, within and between utterances, of two or more seconds in 
length, were marked. 
 

Coding Notes 
• [EO:word] marks overgeneralization error 

• [EP:word] marks pronoun error 

• [EW] marks an extraneous or unnecessary word in the utterance that, if 
omitted, would make the utterance syntactically correct, e.g., C And he 
shout/ed and[EW] to the frog. 

• [EW:word] marks other word-level error 

• [EU] marks utterance-level error (also marks utterances with 3 or more 
errors) 

• [FP] marks filled pause words such as like, e.g., You (like[FP]) get six card/s. 
 

Subordination Index (SI) Coding  
 

SI coding was applied to all samples. SI is a measure of syntactic complexity 
which produces a ratio of the total number of clauses (main and subordinate 
clauses) to the number of C-units. A clause, whether it is main or subordinate, is 
a statement containing both a subject and a predicate. Grammatically, a subject 
is a noun phrase and a predicate is a verb phrase. Main clauses can stand by 
themselves. Subordinate clauses depend on the main clause to make sense. 
They are embedded within an utterance as noun, adjective, or adverbial clauses 
(see Appendix O). 
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Using SALT to Compare Samples to the Play Database 
 
Use SALT’s Database menu to compare your sample with age or grade-matched 
samples selected from the Play database.  SALT looks at the “+ Context” and “+ 
Subgroup” plus lines in your transcript to determine which database to pre-
select. To pre-select the Play database, include the following plus lines in your 
transcript: 
 
+ Context: Con 
+ Subgroup: Play 

 
Although you can type these plus lines into your transcript, the easiest way is to 
select the correct sampling context (Con) and subgroup (Play) when first 
creating a new transcript (by completing the New Transcript Header information 
dialogue box).  
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Conversation Database  
 

Database 
Context 
(Subgroup) 

Age Range 
Grade in 
School 

# Samples Location 
Special 
Coding 

Conversation Con 2;9 – 13;3 
P, K, 1, 2, 

3, 5, 7 
584 WI & CA SI 

 
Participants 
 

The Conversation database contains samples from typically developing English-
fluent students located in Wisconsin and California. Age, gender, and grade data 
are available for all participants. 

 

• Wisconsin: students, ranging in age from 2;9 -13;3, were drawn from 
preschools in Madison, the Madison Metropolitan Public School District, and 
rural areas in northern Wisconsin. The children were from a variety of 
economic backgrounds and ability levels. "Typically developing" was 
determined by normal progress in school and absence of special education 
services. Economic background was determined by eligibility for the free 
lunch program. Ability level was determined by teacher rating. 

 

• California: students, ranging in age from 4;4 - 9;11, were drawn from two 
public school districts in San Diego County; San Diego City Schools and Cajon 
Valley School District. The students were described as typically developing 
and average performing in the classroom as determined by performance on 
standardized classroom assessments, teacher report, and absence of special 
education services. The participants reflected the county's demographics and 
were balanced by race, ethnicity, gender, and socioeconomic status. 
Socioeconomic status was determined by mother's highest level of 
education.  
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Elicitation Protocol 
 

Materials 

• audio or video recorder 

• quiet location free of distractions with a table and two chairs 
 
Preparation 
Check the recorder for loudness levels. Record the date, student's name or ID, 
birth date, age, and grade.  
 
Directions 
Use one or more of the following conversational topics. Suggested questions 
and prompts are listed for each topic. Introduce at least one topic absent in 
time and space from the sampling condition, e.g. for holidays, "What did you 
do?" or "What will you do?". 
 

1. Classroom activities 
"Tell me about some of the things you've been doing in school lately."  
 Ask about specific classroom units. 

 

2. Holidays 
"Did you do anything special for Halloween (or appropriate holiday)?" 
"Tell me about that." 
"Are you going to do anything special for Christmas ((or appropriate 

holiday)?" 
 

3. Family activities, visits, locations, etc. 
"Are you going to visit your grandma and grandpa?" 
"Where do they live?"  "How do you get there?"  "What do you do there?" 

 

4. Family pets 
"Do you have any pets at home?"  "Tell me about them." 
"What do you have to do to take care of them?" 
“Do they ever get in trouble?” 
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Examiner’s role during the retell 
 

Be an attentive conversational partner. Use eye contact. Encourage the student 
to talk. Avoid asking a lot of yes/no questions. Keep it a conversation. Take turns 
talking. Avoid topics that may result in a narrative, e.g., “Oh, you saw a movie 
last weekend. Tell me about it.”  

 
Transcription Notes 

 
Utterances were segmented into C-units (see Appendix N). The transcripts begin 
and end with the student's first and last utterance, respectively. All transcripts 
were timed and pauses, within and between utterances, of two or more 
seconds in length, were marked. 

 
Coding Notes 
• [EO:word] marks overgeneralization error 

• [EP:word] marks pronoun error 

• [EW] marks an extraneous or unnecessary word in the utterance that, if 
omitted, would make the utterance syntactically correct, e.g., C And he 
shout/ed and[EW] to the frog. 

• [EW:word] marks other word-level error 

• [EU] marks utterance-level error (also marks utterances with 3 or more 
errors) 

• [FP] marks filled pause words such as like, e.g., You (like[FP]) get six card/s. 
 

Subordination Index (SI) Coding  
 

SI coding was applied to all samples. SI is a measure of syntactic complexity 
which produces a ratio of the total number of clauses (main and subordinate 
clauses) to the number of C-units. A clause, whether it is main or subordinate, is 
a statement containing both a subject and a predicate. Grammatically, a subject 
is a noun phrase and a predicate is a verb phrase. Main clauses can stand by 
themselves. Subordinate clauses depend on the main clause to make sense. 
They are embedded within an utterance as noun, adjective or adverbial clauses 
(see Appendix O). 
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Using SALT to Compare Samples to the Conversation Database 
 
Use SALT’s Database menu to compare your sample with age or grade-matched 
samples selected from the Conversation database.  SALT looks at the “+ 
Context” plus line in your transcript to determine which database to pre-
select. To pre-select the Conversation database, include the following plus lines 
in your transcript: 

+ Context: Con 
 

Although you can type these plus lines into your transcript, the easiest way is to 
select the correct sampling context (Con) when first creating a new transcript 
(by completing the New Transcript Header information dialogue box).  
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Narrative SSS Database  
 

Database 
Context 
(Subgroup) 

Age 
Range 

Grade in 
School 

# Samples Location 
Special 
Coding 

Narrative SSS Nar (SSS) 5;2 – 13;3 
K, 1, 2, 3, 

5, 7 
330 WI SI 

 
Participants  
 
The Narrative SSS (student selects story) database consists of narrative samples 
from typically developing students drawn from the Madison Metropolitan Public 
School District, and rural areas in northern Wisconsin. Students were from a 
variety of economic backgrounds and ability levels. "Typically developing" was 
determined by normal progress in school and absence of special education 
services. Economic background was determined by eligibility for the free lunch 
program. Ability level was determined by teacher rating. Age, gender, and grade 
data is available for all students. 
 

Elicitation Protocol 
 

Materials 

• audio or video recorder 

• quiet location free of distractions with a table and two chairs 
 

Preparation 
Check the recorder for loudness levels. Record your name, date, student's name 
or ID, birth date, age, and grade.  
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Directions 
Use one of the following narrative tasks. Suggested questions and prompts are 
listed for each task.  
 

1. Tell about a movie s/he saw. 
“Do you go to the movies?”, “Do you watch movies at home?”, “Do you own 
any movies?”, “What's your favorite movie?”, “What's the last movie you 
saw?” 

 
2. Tell about a book s/he read. 

“Have you read any good books lately?”, “What's your favorite book?”, 
“Have you read (insert current books likely to be of interest)?” 

 
3. Retell an episode from a TV program. 

“What TV programs do you like to watch?”, “Tell me about that one. I 
haven't seen it.”, “What happened on the last one you watched?”, 
“Do you ever watch (insert current programs likely to be of interest)?” 
 

4. With young children: Retell a familiar story such as Goldilocks and the Three 
Bears, Little Red Riding Hood, and The Three Little Pigs. Picture prompts 
should only be used after every attempt is made to elicit spontaneous 
speech. This is not a labeling activity. 
“Do you know any stories?”, “What is one of your favorite stories?”, 
“Oh, I don't know that one very well. Will you tell it?”, 
“Do you know Little Red Riding Hood, etc.? Oh, tell me about that one.” 

 

Examiner Prompts 
 

Using overly-specific questions or providing too much information compromises 
the process of capturing the speaker’s true language and ability level. Avoid 
asking questions which lead to obvious and limited responses/answers. Use 
open-ended prompts. Open-ended prompts do not provide the speaker with 
answers or vocabulary. They do encourage the speaker to try or they let the 
speaker know that it’s ok to move on if needed. Use open-ended 
prompts/questions as necessary. 
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• Acceptable verbal prompts include: 
Tell me more. Just do your best. 
Tell me about that/it. You’re doing great. 
I’d like to hear more about that/it. Tell me what you can. 
That sounds interesting. Oh, that sounds interesting. 
What else? Mhm. 
Keep going. Uhhuh. 
 

• Acceptable nonverbal prompts include: 
Smiles and eye contact. 
Nods of affirmation and agreement. 

 

Transcription Notes 
 

The language samples were segmented into C-units (see Appendix N). All 
transcripts were timed and pauses, within and between utterances, of two or 
more seconds in length, were marked. 
 

Coding Notes 
• [EO:word] marks overgeneralization error 

• [EP:word] marks pronoun error 

• [EW] marks an extraneous or unnecessary word in the utterance that, if 
omitted, would make the utterance syntactically correct, e.g., C And he 
shout/ed and[EW] to the frog. 

• [EW:word] marks other word-level error 

• [EU] marks utterance-level error (also marks utterances with 3 or more 
errors) 

• [FP] marks filled pause words such as like, e.g., You (like[FP]) get six card/s. 
 

Subordination Index (SI) Coding  
 

SI coding was applied to all samples. SI is a measure of syntactic complexity 
which produces a ratio of the total number of clauses (main and subordinate 
clauses) to the number of C-units. A clause, whether it is main or subordinate, is 
a statement containing both a subject and a predicate. Grammatically, a subject 
is a noun phrase and a predicate is a verb phrase. Main clauses can stand by 
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themselves. Subordinate clauses depend on the main clause to make sense. 
They are embedded within an utterance as noun, adjective or adverbial clauses 
(see Appendix O). 
 

Using SALT to Compare Samples to the Narrative SSS Database 
 
Use SALT’s Database menu to compare your sample with age or grade-matched 
samples selected from the Narrative Student Selects Story database.  SALT looks 
at the “+ Context” and “+ Subgroup” plus lines in your transcript to determine 
which database to pre-select. To pre-select the Narrative Student Selects Story 
database, include the following plus lines in your transcript: 

+ Context: Nar 
+ Subgroup: SSS 

 
Although you can type these plus lines into your transcript, the easiest way is to 
select the correct sampling context (Nar) and subgroup (SSS) when first creating 
a new transcript (by completing the New Transcript Header information 
dialogue box).  
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Narrative Story Retell Database  
 

Database 
Context 
(Subgroup) 

Age Range 
Grade in 
School 

# Samples Location 
Special 
Coding 

Narrative 
Story Retell 

Nar (FWAY) 
Nar (PGHW) 
Nar (APNF) 
Nar (DDS) 

4;4 – 7;5 
7;0 – 8;11 

7;11 – 9;11 
9;3 – 12;8 

P, K, 1 
2 
3 

4, 5, 6 

145 
101 
53 

201 

WI & CA SI, NSS 

 

Participants 
 

The Narrative Story Retell database contains samples from typically developing 
English-fluent students located in Wisconsin and California. Age, gender, and 
grade data are available for all participants. 
 

• Wisconsin participants were drawn from the Madison Metropolitan Public 
School System and several Milwaukee area school districts (Brown Deer, Fox 
Point-Bayside, Shorewood, Waukesha, Wauwatosa, and West Allis-West 
Milwaukee). There are students from a variety of economic backgrounds and 
ability levels. "Typically developing" was determined by normal progress in 
school and absence of special education services. Economic background was 
based on eligibility in the free lunch program. Ability level was determined by 
teacher ratings. 

 

• California participants were drawn from two public school districts in San 
Diego County; San Diego City Schools and Cajon Valley School District. The 
participants were described as typically developing and of average 
performance in the classroom as determined by performance on 
standardized classroom assessments, teacher report, and absence of special 
education services. The participants reflected the county's demographics and 
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were balanced by race, ethnicity, gender, and socioeconomic status. 
Socioeconomic status was determined by mother's highest level of 
education.  

 

Elicitation Protocol 
 

1. Preschool, Kindergarten, and 1st Grade 
There are three options for eliciting the samples. Use whichever option you 
prefer as they all elicit similar narratives. The database samples were elicited 
using the 3rd option. 

 

• Materials 
- audio or video recorder  
- copy of the book Frog, Where Are You? (Mayer, 1969) 
- quiet location free of distractions with a table and two chairs 

 

Option 1: 
Use the FWAY script provided at the end of this appendix to tell the story 
to the child. 

 

Option 2: 
Play a recording of the FWAY story. You can record your own audio or 
download one from the SALT web site at 
https://www.saltsoftware.com/resources/elicaids/frogstories 

 
Option 3: 
Play the recording of Frog, Where Are You? which comes with The Strong 
Narrative Assessment Procedure (Strong, 1998). This audio uses a slightly 
different script. 

 

• Preparation 
Check the recorder for loudness levels. Record your name, date, student's 
name or ID, birth date, age, and grade. 

   

• Directions 
Seat the student next to you. 

 

https://www.saltsoftware.com/resources/elicaids/frogstories
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Option 1: 
Say “I would like to find out how you tell stories. First, I am going to tell 
you a story while we follow along in the book. When I have finished telling 
you the story, it will be your turn to tell the story using the same book.” 
Tell (try not to read) the story to the student, loosely following the script 
(provided on the last page). You do not need to memorize the story script. 
Just become familiar enough with it to tell a similar story. 
 

Options 2 and 3: 
Say “I would like to find out how you tell stories. First, we are going to 
listen to the story while we follow along in the book. When we have 
finished listening to the story, it will be your turn to tell the story using the 
same book.” Play the audio. Turn each page while the student listens. 
Make sure the student is looking at the book. 
After telling the story or playing the audio, prepare the recorder to record 
the student’s sample and say “Now I would like you to use your own words 
to tell the story.” 
 
Turn the book to the first page with pictures and start recording. Say “Do 
the best that you can. Now you tell me the story.” 

 
2. Grades 2nd, 3rd, 4th, 5th, and 6th  

• Materials 
- audio or video recorder 
- quiet location free of distractions with a table and two chairs 
- 2 copies of the story book, one with the printed words covered 

▪ 2nd grade: Pookins Gets Her Way (Lester, 1987) 
▪ 3rd grade: A Porcupine Named Fluffy (Lester, 1986) 
▪ 4th, 5th, and 6th grade: Doctor De Soto (Steig, 1982) 

 

• Preparation 
Check the recorder for loudness levels. Record your name, date, student's 
name or ID, birth date, age, and grade.  
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• Directions 
 

Use the book that does not have the text covered while reading the 
story. Seat the student next to you, show the book to the student, and 
say “I am helping your teacher find out how you tell stories. First, I will 
read this story to you while you follow along. Then I’m going to ask you to 
tell the story using your own words.” 
 

Read the story. Make sure the student is looking at the book. 
 

After reading the story, prepare the recorder to record the student’s 
sample. Give the student the copy of the book which has the text 
covered and say “Now I would like you to tell the story. Notice that the 
words are covered up. That’s because I want you to use your own words 
to tell the story.” 
 

Turn to the first page with pictures and start recording. Say “Do the best 
that you can. Now you tell me the story.” 

 
3. Examiner’s role during the retell 

 
During the retell, move slightly away from the student turning so that eye 
contact is easy. The student should be in charge of page turning during the 
retell, but provide assistance if the student has trouble turning pages, or 
starts skipping too many pages. Moving away from the student promotes 
language and minimizes pointing. 
 

Do not give specific cues to the student during the task. You can point to the 
book to focus attention or say “Tell me more.”, “Keep going.”, “You are doing 
a great job.”, “And then…”  if the student stops talking before the story is 
finished. You may also use nonverbal cues such as head nodding and smiling 
to promote continued talking. If the student is unable to start the task, use 
the prompt “One day….”  Using overly-specific questions or providing too 
much information to the student compromises the process of capturing the 
student’s true language and ability level. Open-ended prompts do not 
provide the student with answers or vocabulary. But they do encourage the 
student to try or they let the student know it is ok to move on if needed. 
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Avoid asking the “wh” questions, who?, what?, when?, where? as these 
often lead to obvious and limited responses/answers. 

 
4. Optional Comprehension Questions 
 

Following the student’s retell, you have the option of evaluating his/her 
understanding of the story by asking a series of comprehension questions. 
For details, refer to the SALT web site at 

https://www.saltsoftware.com/resources/elicaids. Please note that the 
SALT Narrative Story Retell database samples were not scored for 
comprehension. 

 
Database Subgroups 

 

When selecting language samples from this database, by default, the 
comparison is restricted to samples from the specific story listed in the 
transcript header. You can specify one of the following subgroups: 

FWAY = Frog, Where Are You? 
PGHW = Pookins Gets Her Way 
APNF = A Porcupine Named Fluffy 
DDS = Doctor De Soto 
 

Transcription Notes 
 

Utterances were segmented into C-units (see Appendix N). The transcripts begin 
and end with the student’s first and last utterance, respectively. All transcripts 
were timed and pauses, within and between utterances, of two or more 
seconds in length, were marked. 

 

Coding Notes 
• [EO:word] marks overgeneralization error 

• [EP:word] marks pronoun error 

• [EW] marks an extraneous or unnecessary word in the utterance that, if 
omitted, would make the utterance syntactically correct, e.g., C And he 
shout/ed and[EW] to the frog. 

• [EW:word] marks other word-level error 

https://www.saltsoftware.com/resources/elicaids
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• [EU] marks utterance-level error (also marks utterances with 3 or more 
errors) 

• [FP] marks filled pause words such as like, e.g., You (like[FP]) get six card/s. 
 

Subordination Index (SI) and Narrative Scoring Scheme (NSS) Coding  
 
SI is a measure of syntactic complexity which produces a ratio of the total 
number of clauses (main and subordinate clauses) to the number of C-units. A 
clause, whether it is main or subordinate, is a statement containing both a 
subject and a predicate. Grammatically, a subject is a noun phrase and a 
predicate is a verb phrase. Main clauses can stand by themselves. Subordinate 
clauses depend on the main clause to make sense. They are embedded within 
an utterance as noun, adjective or adverbial clauses (see Appendix O). 
 
NSS is an assessment tool developed to create a more objective narrative 
structure scoring system. It is based upon early work on story grammar analysis 
by Stein and Glenn, 1979, 1982. This scoring procedure combines many of the 
abstract categories of Story Grammar, adding features of cohesion, connecting 
events, rationale for characters’ behavior, and referencing. Each of the scoring 
categories has specific explicit examples to establish scoring criteria, reducing 
the abstractness of the story grammar categories (see Appendix P). 
 

Using SALT to Compare Samples to the Narrative Story Retell Database 
 
Use SALT’s Database menu to compare your sample with age or grade-matched 
samples selected from the Narrative Story Retell database.  SALT looks at the “+ 
Context” and “+ Subgroup” plus lines in your transcript to determine which 
database to pre-select. To pre-select the Narrative Story Retell database, 
include the following plus lines in your transcript, where the Context is “Nar” 
and the Subgroup is the abbreviation specific to each story retell (see database 
subgroups): 

+ Context: Nar 
+ Subgroup: FWAY (or PGHW, or APNF, or DDS) 
 

Although you can type these plus lines into your transcript, the easiest way is to 
select the correct sampling context (Nar) and subgroup corresponding to the 
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specific story (FWAY/PGHW/APNF/DDS) when first creating a new transcript 
using the New Transcript Header information dialogue box.  
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• Waukesha School District: Patricia Engebose Hovel, Susan Moennig, Lisa 
Haughney, Colleen Raupp, Christine Herro, Maureen Waterstraat 

• Wauwatosa School District: Beth Bliss, Amy Brantley, Betsy Goldberg, Peg 
Hamby, Karen Malecki, Angela Quinn 

• West Allis-West Milwaukee School District: Sarah Bartosch, Joy Behrend, 
Beth Beno, Ann-Guri E. Bishop, Lindsay Bliemeister, Pat Culbertson, Mary 
Fuchs, Nicole Gosser, Joyce King-McIver, Ellen Reitz, Jan Schmidt, Jill 
Vanderhoef, Michele Wolaver 

 
All samples were transcribed and coded by the University of Wisconsin students 
working in the Language Analysis Lab. This project was funded in part by SALT 
Software, LLC.  
 
Resources 

• Story Script for Frog, Where Are You? - found on the following page 

• Elicitation materials 
includes books, laminated protocols and script, comprehension questions

https://www.saltsoftware.com/products/elicitation-materials
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Story Script for Frog, Where Are You? by Mercer Mayer, 1969.  
 

Page Script  

1 
There once was a boy who had a dog and a pet frog. He kept the frog 
in a large jar in his bedroom.  

2 
One night while he and his dog were sleeping, the frog climbed out 
of the jar. He jumped out of an open window.  

3 
When the boy and the dog woke up the next morning, they saw that 
the jar was empty.  

4 
The boy looked everywhere for the frog. The dog looked for the frog 
too. When the dog tried to look in the jar, he got his head stuck.  

5 
The boy called out the open window, “Frog, where are you?” The 
dog leaned out the window with the jar still stuck on his head.  

6 The jar was so heavy that the dog fell out of the window headfirst!  

7 
The boy picked up the dog to make sure he was ok. The dog wasn’t 
hurt but the jar was smashed.  

8 - 9 
The boy and the dog looked outside for the frog. The boy called for 
the frog.  

10 
He called down a hole in the ground while the dog barked at some 
bees in a beehive.  

11 
A gopher popped out of the hole and bit the boy on right on his 
nose. Meanwhile, the dog was still bothering the bees, jumping up 
on the tree and barking at them.  

12 
The beehive fell down and all of the bees flew out. The bees were 
angry at the dog for ruining their home.  

13 
The boy wasn’t paying any attention to the dog. He had noticed a 
large hole in a tree. So he climbed up the tree and called down the 
hole.  

14 
All of a sudden an owl swooped out of the hole and knocked the boy 
to the ground.  

15 
The dog ran past the boy as fast as he could because the bees were 
chasing him.  

16 The owl chased the boy all the way to a large rock.  
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17 
The boy climbed up on the rock and called again for his frog. He held 
onto some branches so he wouldn’t fall.  

18 
But the branches weren’t really branches! They were deer antlers. 
The deer picked up the boy on his head.  

19 
The deer started running with the boy still on his head. The dog ran 
along too. They were getting close to a cliff.  

20-21 
The deer stopped suddenly and the boy and the dog fell over the 
edge of the cliff.  

22 
There was a pond below the cliff. They landed with a splash right on 
top of one another.  

23 They heard a familiar sound.  

24 The boy told the dog to be very quiet.  

25 They crept up and looked behind a big log.  

26 There they found the boy’s pet frog. He had a mother frog with him.  

27 
They had some baby frogs and one of them jumped towards the 
boy.  

28-29 

The baby frog liked the boy and wanted to be his new pet. The boy 
and the dog were happy to have a new pet frog to take home. As 
they walked away the boy waved and said “goodbye” to his old frog 
and his family.  
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Expository Database  
 

Database Context Age Range 
Grade in 
School 

# Samples Location 
Special 
Coding 

Expository Expo 10;7 – 18;9 5 – 7, 9 - 12 354 WI SI, ESS 

 

Introduction 
 

The expository database contains samples from middle and high school 
students, ages 10;7 through 18;9. Exposition was chosen for the following 
reasons: 
 Exposition is central to curriculum in middle and high school 
 Exposition is included as part of state standards for speaking and writing  
 Challenges students to use language in context (authentic, naturalistic, real 

speaking and listening) 
 Allows documentation of oral expository skills relative to peers  
 

Participants 
 

354 typically developing, English-fluent students, ranging in age from 10;7 
through 18;9. The students were drawn from public schools in two geographic 
areas of Wisconsin: Milwaukee area school districts (Brown Deer, Fox Point-
Bayside, Nicolet, Shorewood, Waukesha, Wauwatosa, and West Allis-West 
Milwaukee), and from the Madison Metropolitan School District. They were 
from a variety of economic backgrounds and ability levels. "Typically 
developing" was determined by normal progress in school and absence of 
special education services. Economic background was based on eligibility in the 
free lunch program (25% qualified for free or reduced lunch). Ability level was 
determined by GPA scores and teacher reports (9% were low, 49% were 
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average, and 42% were high). The race/ethnicity of the students was similar to 
that of the geographic area from which they were drawn (75% White, 13% 
African American, 7% Hispanic, 4% Asian, and 1% Hmong). Age, grade, and 
gender are provided for all samples. 
 

Elicitation Protocol 
 

Overview 
 

The elicitation protocol is easy to administer and provides optimum opportunity 
for the student to produce a “good” expository. Following a script, the examiner 
asks the student to explain how to play a game or sport of the student's 
choosing. Discourage the student from talking about video games as they may 
be unfamiliar to the examiner and often result in limited content. The student is 
given a few minutes to complete a planning sheet which contains eight topics 
(Object, Preparations, Start, Course of play, Rules, Scoring, Duration, and 
Strategies). Listed next to each topic is a brief description of what's covered 
within that topic and space for making notes. Following the planning phase, the 
student is asked to explain the game or sport using his/her notes. 
 

Using this protocol, expository samples tend to be between 5 – 6 minutes in 
length and have between 50 – 60 complete and intelligible utterances.  
 

Script 
 

I’m interested in finding out how well you do at giving explanations. I’m going to 
make a recording so I can remember what you say. If you want, you can listen to 
the recording when we’re finished. 
 

I want you to imagine that I am a student about your age. I’m visiting the United 
States from another country and I want to learn as much as I can about life in 
the U.S. You can help me by explaining how to play your favorite sport or game. 
You have lots of choices. For example, you could pick a sport, such as basketball 
or tennis. You could pick a board game, such as Monopoly or chess. Or you could 
pick a card game, such as Poker or Rummy. What sport or game do you want to 
pick? 
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The student offers an appropriate choice. If a choice is not offered or is 
inappropriate (such as a video game), reread the examples given above and/or 
add more examples to aid the student in making an appropriate choice. If the 
student is still having difficulty making a selection, suggest picking a game or 
sport recently played in the student’s physical education class. 
 

Assume that in my country we don’t play [name of sport or game]. I’d like you to 
explain everything I would need to know to so I could learn to play. I’ll expect 
you to talk for at least five minutes. To help you organize your thoughts, here’s a 
list of topics I’d like you to talk about [hand the student a copy of the planning 
sheet found on the next page]. Please take the next few minutes to plan your 
explanation by taking notes in the blank spaces [indicate empty column on the 
right]. But don’t waste time writing sentences. Just write some key words to 
remind you of what you want to say. You can talk about the topics in the order 
they are listed, or else you can number the topics any way you wish. If you don’t 
want to take notes, you can use the backside of the list to draw a diagram or 
make a graphic organizer. Do you have any questions? 
 
If student expresses difficulty with reading any portion of the checklist, read the 
unclear portions aloud. If the student has difficulty understanding the 
vocabulary, give an example from a sport or game different from the one the 
student has chosen. 
 

Go ahead and start planning. 
 

Allow enough time for student to write something for each topic on the 
checklist or to complete a diagram or graphic organizer. If the student stops 
writing or drawing before planning is finished, prompt with, “Please do some 
planning for [topic name (s)].”  
 

I’m ready to turn on the recorder. You will be doing all the talking. I’m going to 
listen to what you have to say. Take as much time as you need to give a 
complete explanation. Remember: I expect you to talk for at least five minutes. 
 

Turn on recording device and have the student begin speaking. After the 
student has finished speaking from his/her planning sheet, turn off recording 
device. If the student finishes speaking before five minutes has elapsed, prompt 
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with, “Is there anything else you can tell me?”. Review the recording for quality 
before releasing the student. 
 
Examiner’s role during the exposition 
 
Be an attentive listener. Do not give specific cues to the student during the task. 
You can use nonverbal cues such as head nodding and smiling to promote 
continued talking. You can also use prompts such as “uhhuh” and “keep going” 
if the student stops talking before the task is completed. Asking questions or 
providing too much information to the student compromises the process of 
capturing the student’s true language and ability level.   
 
As stated in the protocol, if the student finishes talking before five minutes has 
elapsed, prompt with, “Is there anything else you can tell me?”.  If the student 
does not respond, the elicitation is over. 
 

Transcription Notes 
 

The language samples were segmented into C-units (see Appendix N). All 
transcripts were timed and pauses, within and between utterances, of two or 
more seconds in length, were marked. 
 

Coding Notes 
• [EO:word] marks overgeneralization error 

• [EP:word] marks pronoun error 

• [EW] marks an extraneous or unnecessary word in the utterance that, if 
omitted, would make the utterance syntactically correct, e.g., C And he 
shout/ed and[EW] to the frog. 

• [EW:word] marks other word-level error 

• [EU] marks utterance-level error (also marks utterances with 3 or more 
errors) 

• [FP] marks filled pause words such as like, e.g., You (like[FP]) get six card/s. 
 

Subordination Index (SI) and Expository Scoring Scheme (ESS) Coding  
  

SI and ESS coding was applied to all samples. 
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SI is a measure of syntactic complexity which produces a ratio of the total 
number of clauses (main and subordinate clauses) to the number of C-units. A 
clause, whether it is main or subordinate, is a statement containing both a 
subject and a predicate. Grammatically, a subject is a noun phrase and a 
predicate is a verb phrase. Main clauses can stand by themselves. Subordinate 
clauses depend on the main clause to make sense. They are embedded within 
an utterance as noun, adjective or adverbial clauses (see Appendix O).  
 
ESS assesses the content and structure of an expository language sample, 
similar to how the Narrative Scoring Scheme provides an overall measure of a 
student’s skill in producing a narrative. The ESS is comprised of 10 
characteristics for completing an expository language sample. The first 8 
characteristics correspond to the topics listed on the planning sheet that is given 
to students (see Appendix Q).  

 
Analysis Notes 
 
The SALT group transcribed the samples following the SALT format and 
performed a series of statistical analyses to describe the dataset for consistency, 
differences among types of expository samples, age-related changes, and 
differences when compared to existing conversation and narrative samples. 
(Malone, et al., 2008). The following summarize the results of these analyses: 
 

• Different expository contexts (team sport, individual sport, game) do not 
result in significantly different outcomes. Students describing how to play a 
team sport provided similar samples in terms of length, vocabulary, sentence 
complexity as students describing an individual sport or game. This finding is 
very useful in that it allows students to select the type of game they know 
best, optimizing their performance on this task. 
 

• Measures of language production were significantly different for expository 
samples than conversational and narrative samples on measures of utterance 
length and complexity. Students produced significantly more complex 
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sentences in the expository samples than conversation or narratives. This 
finding is similar to the findings of Nippold, et al. (2005; 2008). 

 

Using SALT to Compare Samples to the Expository Database 
 

Use SALT’s Database menu to compare your sample with age or grade-matched 
samples selected from the Expository database.  SALT looks at the “+ Context” 
plus line in your transcript to determine which database to pre-select. To pre-
select the Expository database, include the following plus lines in your 
transcript: 

+ Context: Expo 
 

Although you can type these plus lines into your transcript, the easiest way is to 
select the correct sampling context (Expo) when first creating a new transcript 
(by completing the New Transcript Header information dialogue box).  

 
Planning Sheet 

 
The planning sheet is found at the end of this appendix. Following the planning 
sheet are two example planning sheets. 
 

References 
 

Heilmann, J., Miller, J. F., Iglesias, A., Fabiano-Smith, L., Nockerts A., & Andriacchi, K. 
(2008). Narrative transcription accuracy and reliability in two languages. Topics in 
Language Disorders, 28, 178-187. 

 

Hughes, D., McGillivray, L., Schmidek, M. (1997). Guide to Narrative Language: 
Procedures for Assessment. Eau Claire, WI: Thinking Publications. 

 

Loban, W. (1963). The Language of Elementary School Children. Urbana, IL: National 
Council of Teachers of English. 

 

Loban, W. (1976). Language Development: Kindergarten through Grade Twelve. 
Urbana, IL: National Council of Teachers of English. 

 

Malone, T., Heilmann, J., Miller, J., DiVall-Rayan, J., Rolland, M. (2010), Reaching the 
Tweeners: Extending Two SALT Databases to Grades 5-6, Presented at the American 
Speech and Hearing Association, Philadelphia, PN. 



Appendix E  ●   Expository Database   267 

 

 

Malone, T., Miller, J., Andriacchi K., Heilmann J., Nockerts, A., Schoonveld, E. (2008), Let 
Me Explain: Teenage Expository Language Samples, Presented at the American 
Speech and Hearing Association, Chicago, IL. 

 

Nippold, M., Hesketh L., Kuthie, J., & Mansfield, T. (2005). Conversational Versus 
Expository Discourse: A Study of Syntactic Development in Children, Adolescents, 
and Adults. Journal of Speech, Language, and Hearing Research, 48, 1048-1064. 

 

Nippold, M., Mansfield, T., Billow, J. & Tomblin, J.B., (2008) Expository Discourse in 
Adolescents With Language Impairments: Examining Syntactic Development. American 
Journal of Speech-Language Pathology (17) 356–366. 
 

Acknowledgements 
 

We gratefully acknowledge and thank Thomas O. Malone, a retired speech-
language pathologist, formerly with the Brown Deer School District in 
Wisconsin, for being the driving force behind this project. His influence is 
everywhere including, but not limited to, a) recognizing the need for an 
expository database, b) designing the protocol used, c) recruiting clinicians from 
Milwaukee-area school districts, d) coding for types of subordination and 
applying the Expository Scoring Scheme, and e) presenting the results of the 
project (Malone, et al., 2008, Malone, et al., 2010). 
 
 

We would like to thank the following clinicians who collected the expository 
samples: 
 

• Brown Deer School District: Kari Anewenter, Thomas O. Malone, Katherine E. 
Smith 

• Fox Point-Bayside School District: Jody Herbert 

• Madison Metropolitan School District: Vicki Ashenbrenner, Kelly Chasco, 
Helen Chung, Ingrid Curcio, Alyson Eith, Sheryl Hall, Julie Hay-Chapman, 
Kelsey Beach Hausmann, Lynn Gabrielson, Maureen Gotner, Patty Hay-
Chapman, Marie Hendrickson, Andrea Hermanson, Tanya Jensen, Laura 
Johnson, Abby Mahoney Kabara, Chris Melgaard, Jane Morgan, Andrea 
O’Neill, Nicole Olson, Nan Perschon, Carolyn Putnam, Carrie Rhode, Mary-
Beth Rolland, Liz Schoonveld, Julie Scott-Moran, Jennifer Van Winkle, Helena 
White, Emily Wolf, Meg Wollner 



268  Assessing Language Production Using SALT Software  

 

• Nicolet School District: Karen Kingsbury 

• Shorewood School District: Eva Gulotta, Terry Hrycyna, Katie Koepsell, Inga 
Siler   

• Waukesha School District: Bill Downey, Linda Carver, Judy Ertel, Susan 
Fischer, Jeanne Gantenbein, Lisa Haughney, Christine Herro, Patricia 
Engebose Hovel, Susan Moennig, Colleen Raupp, Jennifer Theisen, Maureen 
Waterstraat 

• Wauwatosa School District: Beth Bliss, Amy Brantley, Betsy Goldberg, Peg 
Hamby, Karen Malecki, Christine Maranan, Lynn Meehan, Kathy Meinecke, 
Angela Quinn, Molly Suberlak, Amanda Voigtlander 

• West Allis-West Milwaukee School District: Sarah Bartosch, Joy Behrend, 
Beth Beno, Ann-Guri E. Bishop, Lindsay Bliemeister, Pat Culbertson, Mary 
Fuchs, Nicole Gosser, Erin Jodie, Joyce King-McIver, Ellen Reitz, Jan Schmidt, 
Jill Vanderhoef, Michele Wolaver. 

• UW-Milwaukee graduate students: Taylor Hansen, Maggie Long, Maricel 
Schulte   

 

Samples were transcribed and coded by the University of Wisconsin students 
working in the Language Analysis Lab and by the staff at SALT Software, LLC. 
This project was funded in part by SALT Software, LLC. 
 
Resources 

• Planning sheet - found at the end of this appendix 

• Elicitation materials 

includes laminated protocols, pad of planning sheets 

https://www.saltsoftware.com/products/elicitation-materials


Appendix E  ●   Expository Database   269 

 

Expository Planning Sheet (The actual form used can be downloaded from the 
SALT web site at www.saltsoftware.com/resources/databases.)  
 

What to Talk About 
When Explaining a Game or Sport 

 

Please use the backside of this page for an optional diagram or graphic 
organizer, or for additional notes.

Topic What’s Covered Notes 

Object What you have to do to win  

Preparations 
Playing Area and Setup 
Equipment and Materials 
What players do to get ready 

 

Start 
How the contest begins, including 
who goes first 

 

Course of 
Play 

What happens during a team or 
player’s turn, including any special 
plays, positions, or roles, both 
offensive and defensive 

 

Rules 
Major rules, including penalties for 
violations 

 

Scoring 
Different ways to score, including 
point values 

 

Duration 
How long the contest lasts, including 
how it ends and tie breaking 
procedures 

 

Strategies 
What smart players do to win, both 
offensively and defensively 

 

file:///C:/Users/ann/Desktop/Book%20edits/www.saltsoftware.com/resources/databases
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Persuasion Database  
 

Database Context  Age Range 
Grade in 
School 

# Samples Location 
Special 
Coding 

Persuasion Pers 
USA: 14;8 – 18;9 
AU: 12;10 – 18;4 

USA: 9-12 
AU: N/A 

USA: 113 
AU: 66 

WI 
Australia 

SI, PSS 

 

Introduction 
 

Persuasion can be defined as “the use of argumentation to convince another 
person to perform an act or accept the point of view desired by the persuader” 
(Nippold, 2007). Persuasion was chosen for the following reasons: 
• It figures prominently in academic standards that cut across modes of 

communication: speaking, listening, reading, and writing (National Governors 
Association, 2010).  

• Acquiring skill at persuasion is critical to success in college and career and to 
full participation in social and civic life.  

• Persuasion challenges students to take into account their audience’s 
perspective and to use complex language to express complex ideas.  

 

USA Participants 
 
Samples were elicited from typically developing students whose primary 
language is English. The students were drawn from public schools in two 
geographic areas of Wisconsin: Milwaukee area school districts, and Madison 
Metropolitan School District. Students were from a variety of economic 
backgrounds and ability levels. "Typically developing" was determined by 
normal progress in school and absence of special education services. Economic 
background was based on eligibility in the free lunch program (25% qualified for 
free or reduced lunch). Ability level was determined by GPA scores and teacher 
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reports (4% were low, 25% were average, and 71% were high). The 
race/ethnicity of the students was similar to that of the geographic area from 
which they were drawn (63% White, 17% African American, 8% Hispanic, 7% 
Asian, and 2% Hmong, and 3% unknown). Age, grade, and gender are provided 
for all samples. 

 
Australian Participants 
 
The Australian dataset contains persuasive samples from typically developing 
students whose primary language is English. The students attended public 
schools across the state of Queensland, Australia. Schools were situated in 
country and metropolitan areas and students were from a range of economic 
backgrounds. "Typically developing" was determined by normal progress in 
school and absence of special education services. Economic background was 
based on the school’s postcode and Socio-Economic Indexes for Areas (SEIFA, 
2011) data. Student ability level was determined by the students’ most recent 
performance in English (~15% obtained a C and 15% an A). The race/ethnicity of 
the students, as identified on the student consent form was predominantly 
‘Australian”. Age and gender are provided for all samples. Grade in school data 
is not available. 
 

Elicitation Protocol 
 

Overview 
The elicitation protocol is easy to administer and provides optimum opportunity 
for the student to produce a “good” persuasive argument. Following a script, 
the examiner asks the student to argue for a change in their school, workplace, 
or community. The argument is to be directed at the student's principal, boss, or 
government official. The student can choose an issue of personal interest or 
select from a list of suggested issues. The student is given a few minutes to 
complete a planning sheet which contains six topics (Issue Id and Desired 
Change, Supporting Reasons, Counter Arguments, Response to Counter 
Arguments, Compromises, and Conclusion). Next to each point is a brief 
description of what is covered within that topic and space for making notes. 
Following the planning phase, the student, speaking from his/her notes, is asked 
to persuade the examiner who stands in for the intended authority figure. The 
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average length of the persuasion is approximately 4 minutes and contains 
around 33 complete and intelligible utterances. 
 
Script 
Today I want to find out how well you can persuade. That’s when you talk 
people into changing their mind and doing something you want. I’m going to 
make a recording. If you want, you can listen to it when we’re finished.  
  
I would like you to pick a rule or situation you would like to see changed in 
your school, job, or community. Imagine that I am an adult who has the power 
to make the change that you want. Here are a few examples:  
1. Pretend I’m the principal of your school and you want to persuade me to 
provide money for a special event;  
OR  
2. Pretend I’m your boss and you want to persuade me to change your hours 
or work schedule;  
OR  
3. Pretend I’m a government official and you want me to change the law so 
that taxes are raised or lowered for a specific purpose.  
  
I expect you to talk for at least a few minutes, so be sure to pick an issue you 
know and care about. You can choose an issue from this list [hand list to 
student] or else pick one of your own.  
  
Allow the student time to review the suggested issues before asking: What issue 
have you picked?  
  
If the student has difficulty choosing an issue, offer assistance. Review the list 
together. If a proposed topic is not an arguable issue, e.g., strawberry ice cream 
is better than chocolate, encourage the student to pick a different issue. If a 
proposed issue is too narrow, encourage the student to modify it. For example, if 
the student wants to argue for a change to his or her individual grade in a 
particular class, suggest that the issue be broadened into an argument for a 
school-wide change to grading policy.  
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Once an appropriate issue has been selected, clarify the intended target of the 
persuasion, e.g., principal, boss, government official, by asking, Who will you be 
trying to persuade? 
  
If there is a mismatch between the issue and the authority figure, help the 
student to resolve the problem. For example, if a student wishes to convince a 
boss to raise the minimum wage, help the student understand that this 
argument is best directed toward a government official.  
  
Once a match has been established between issue and authority figure, proceed 
to the planning directions:  
  
Talk to me as if I’m your [name the appropriate authority, e.g., principal, boss, 
senator] and tell me everything you can to persuade me. To do your best job, 
you’ll first need to organize your thoughts. Here’s a list of points you’ll need to 
cover to make a complete argument [hand the student a copy of the planning 
sheet]. Please take the next few minutes to plan by taking notes in these blank 
spaces [point to the empty boxes in the column on the right]. But don’t waste 
time writing sentences. Just jot down some key words to remind you of what 
you want to say. If you don’t want to take notes, you can use the reverse side 
to draw a diagram or make a graphic organizer. Do you have any questions? 
Go ahead and start planning.  
  
Skill at reading is not being assessed. Therefore, if the student appears to be 
having any difficulty understanding the planning sheet, read the text aloud to 
the student.  
  
Allow enough time for the student to write something for each point on the 
planning sheet or to create a diagram or graphic organizer. Verify that the 
student has done some planning for each point. If not, prompt with, Please do 
some planning for [name(s) of omitted point(s)].  
  
When the student has finished planning, continue with: When I turn on the 
recorder, you will be doing all the talking. I’m going to listen to what you have 
to say. Tell me everything you can think of. It’s OK to look at your planning 
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sheet to remind yourself of what you want to say. Feel free to add to what 
you’ve written. Remember: I expect you to talk for as long as you can.  
  
Turn on the recording device and have the student begin speaking. Do not 
engage the student in a debate. Instead, limit your encouragement to 
affirmations such as: Uhhuh, mhm, I see, OK, ah, etc.  
  
If the student finishes speaking before several minutes has elapsed or has not 
discussed one or more points on the planning sheet, prompt with: Is there 
anything else you can tell me? 
  
When the student has finished speaking, turn off the recorder. Review the 
recording for quality before releasing the student. If there’s time, offer to let the 
student listen to the recording.  
 
Examiner’s role during the persuasion 
Be an attentive listener. Do not give specific cues to the student during the task. 
You can use nonverbal cues such as head nodding and smiling to promote 
continued talking. You can also use prompts such as “uhhuh” and “keep going” 
if the student stops talking before the task is completed. Asking questions or 
providing too much information to the student compromises the process of 
capturing the student’s true language and ability level.   
 
As stated in the protocol, if the student finishes talking before several minutes 
has elapsed or has not discussed one or more points on the planning sheet, 
prompt with, “Is there anything else you can tell me?”.  If the student does not 
respond, the elicitation is over. 
 

Transcription Notes 
 
The language samples were segmented into Communication Units (C-units). All 
transcripts were timed and pauses, within and between utterances, of two or 
more seconds in length, were marked. 
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Coding Notes 
• [EO:word] marks overgeneralization error 

• [EP:word] marks pronoun error 

• [EW] marks an extraneous or unnecessary word in the utterance that, if 
omitted, would make the utterance syntactically correct, e.g., C And he 
shout/ed and[EW] to the frog. 

• [EW:word] marks other word-level error 

• [EU] marks utterance-level error (also marks utterances with 3 or more 
errors) 

• [FP] marks filled pause words such as like, e.g., You (like[FP]) get six card/s. 
 

Subordination Index (SI) and Persuasion Scoring Scheme (PSS) Coding  
 

SI and PSS coding was applied to all samples. 
 

SI is a measure of syntactic complexity which produces a ratio of the total 
number of clauses (main and subordinate clauses) to the number of C-units. A 
clause, whether main or subordinate, is a statement containing both a subject 
and a predicate. Grammatically, a subject is a noun phrase and a predicate is a 
verb phrase. Main clauses can stand by themselves. Subordinate clauses depend 
on the main clause to make sense. They are embedded within an utterance as 
noun, adjective, pronominal, or adverbial clauses (see Appendix O). 
 

The PSS assesses the structure and content of persuasive language, a critical 
language skill in secondary curriculum, using a scoring rubric consisting of the 
essential characteristics of a coherent persuasive argument. These 
characteristics include: 1) issue identification and desired change, 2) supporting 
reasons, 3) other point of view, 4) compromises, 5) conclusion, 6) cohesion, and 
7) effectiveness. The first five characteristics roughly correspond to the topics 
from the student planning sheet. Each characteristic receives a scaled score 0-5 
or NA (not applicable). The PSS scoring guide defines what is meant by 
Proficient/Advanced (score of 5), Satisfactory/Adequate (score of 3) and 
Minimal/Immature (score of 1). The scores in between, 2 and 4, are undefined, 
use judgment. Significant factual errors reduce the score for that topic. A score 
of 0 is given for student errors, e.g., not covering topic, not completing/refusing 
task, unintelligible productions, abandoned utterances. A score of NA (non-
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applicable) is given for mechanical/examiner/operator errors, e.g., interference 
from background noise, issues with recording (cut-offs, interruptions), examiner 
not following protocol, examiner asking overly specific or leading questions 
rather than open-ended questions or prompts. A composite is scored by adding 
the total of the six characteristic scores. Maximum score = 30 (see Appendix R). 
  

Analysis Notes 
 

The SALT group transcribed the samples following the SALT format and 
performed a series of statistical analyses to describe the dataset for consistency, 
differences across samples from AU and USA, age-related and gender related 
changes, as well as topic related changes.  

Using SALT to Compare Samples to the Persuasion Database 

Use SALT’s Database menu to compare your sample with age or grade-matched 
samples selected from the Persuasion database.  SALT looks at the “+ Context” 
plus line in your transcript to determine which database to pre-select. To pre-
select the Persuasion database, include the following plus lines in your 
transcript: 
 

+ Context: Pers 
 

Although you can type these plus lines into your transcript, the easiest way is to 
select the correct sampling context (Pers) when first creating a new transcript 
(by completing the New Transcript Header information dialogue box).  
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Persuasion Topics List 

 

  Changing the time school starts in the morning 

Allowing students to leave campus during the school day without special permission 

Requiring students to do graded homework 

Requiring students to take foreign language classes 

Allowing teachers to socialize with students on social networks such as Facebook, 
Twitter, Snapchat, Instagram, etc. 

Including grades in physical education classes in students’ grade point average 

Allowing students to listen to their music using headphones during free periods 

Changing the access teenagers have to entertainment that is violent or sexually 
suggestive; entertainment includes movies, music, and video games 

Requiring school uniforms or a dress code for students 

Awarding cash or other incentives to students who earn good grades 

Replacing traditional textbooks with notebook computers or digital materials 

Requiring cities to provide free wireless Internet access in public spaces 

Requiring people to get a license in order to become parents 

Allowing alternatives to jail, such as counseling or public service, for convicted criminals 

Requiring colleges to pay their student athletes a salary for playing 

Requiring drug tests for professional athletes 

Allowing employers to require drug tests as part of their hiring procedure 

Requiring workers to pay for their own work uniforms or equipment 

Raising the minimum wage 

Changing the minimum age for voting, drinking, driving, or holding a job 

Other: Topic of your choice  
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Persuasion Planning Sheet (The actual form used can be downloaded from the 
SALT web site at www.saltsoftware.com/resources/databases.)  

 

What to Talk about When Trying to Persuade Someone 

 

Please use the backside of this page for an optional diagram or graphic organizer, or for 
additional notes.

Topic What’s Covered Notes 

Issue ID and 
Desired Change 

What rule or situation do you want 
changed? 
What would you change it to? 

 

Supporting 
Reasons 

What facts or values or evidence helps your 
side? 
Be sure to include how your change would 
help or benefit the listener or people the 
listener cares about. 

 

Counter 
Arguments – 

Other Point of 
View 

What are some good reasons on the other 
side? 

 

Response to 
Counter 

Arguments 

What can you say to knock down or 
weaken the reasons on the other side? 
What reasons on the other side can you 
can agree with, either in whole or in part? 

 

Compromises 
If you can’t get your way 100%, what deals 
would be acceptable so each side wins a 
little? 

 

Conclusion 

Briefly sum up your position: 
What do you want? 
Why do you want it? 
What are the first steps needed to make 
the change happen? 

 

file:///C:/Users/ann/Desktop/Book%20edits/www.saltsoftware.com/resources/databases


 

 

APPENDIX 

G 
 

Bilingual Spanish/English Story Retell Databases  
 

 

Participants 
 

The Bilingual English Story Retell and Bilingual Spanish Story Retell databases 
consist of English and Spanish story-retell narratives from native Spanish-
speaking bilingual (Spanish/English) children. These English learners (ELs) were 
drawn from public school EL classrooms in urban Texas (Houston and Austin), 
border Texas (Brownsville), and urban California (Los Angeles). The children 
reflect the diverse socio-economic status of these areas. Age, grade, and gender 
data is available for all children. 
 

Additional Inclusion Criteria 
 

1. The children were described as “typically developing” as determined by 
normal progress in school and the absence of special education services. 
 

2. All children were within the following age ranges. 
 

Grade Age Range 

K 5;0 – 6;9 

1 6;0 – 7;9 

2 7;0 – 8;9 

3 8;0 – 9;9 

 

Database 
Context 
(Subgroup) 

Age Range 
Grade in 
School 

# 
Samples 

Location 
Special 
Coding 

Bilingual 
Spanish/English 
Story Retell 

Nar (FWAY) 
Nar (FGTD) 
Nar (FOHO) 

5;0 – 9;9 
5;5 – 8;11 
6;0 – 7;9 

K, 1, 2, 3 
K, 2 

1 

2,070 
1,667 
930 

TX & CA SI, NSS 
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3. All children were able to produce both English and Spanish narratives 
containing at least one complete and intelligible verbal utterance in the 
target language. Although the language samples may contain code-switched 
words (English words in the Spanish samples or Spanish words in the English 
samples), at least 80% of the words from each sample were in the target 
language. 

 

Elicitation Protocol 
 

1. General Directions 

The story retell task uses one of the following picture books: 

• Frog, Where Are You? by Mercer Mayer (1969) 

• Frog Goes to Dinner by Mercer Mayer (1974) 

• Frog On His Own by Mercer Mayer (1973) 
 

First the story is modeled for the child in the target language (Spanish or 
English). Then the child is asked to retell the same story. All instructions and 
prompts are given using the target language. 
 
Ideally, you should first assess the child in his or her native language. 
However, we are clearly aware that for many speech-language pathologists, 
assessing the child in his native language will be impossible since the majority 
of clinicians do not speak a language other than English. This can also be the 
case for clinicians who may be bilingual, but do not speak the native 
language of the target speaker. Thus, we suggest that clinicians first assess 
the child in the language in which he or she is most comfortable. If the child’s 
performance is below average compared to age and grade-matched peers, 
then elicit a second sample in the other language. You may elicit the second 
language sample shortly after the first sample, or you may prefer to wait 
several weeks in between.  
 

2. Steps 

a. Sit next to the child at a table. The book should be on the table. The 
audio/video recorder should be checked and ready to be turned on. 
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b. Tell the story to the child, loosely following the story script provided at 
the end of this appendix.  

 

Directions to the child (Spanish sample): 
Examiner: Aquí tengo un libro. Te voy a contar este cuento mientras 
miramos el libro juntos. Cuando terminemos, quiero que me vuelvas a 
contar el cuento en español. Okey? Vamos a mirar el primer libro. Este 
libro nos cuenta un cuento sobre un niño, un perro, y una rana. 
 

Directions to the child (English sample): 
Examiner: Here is a book. I am going to tell you this story while we look at 
the book together. When we finish, I want you to tell the story back to me 
in English. Ok? Let’s look at the book. This book tells a story about a boy, a 
dog, and a frog. 
 
You control the book and turn to the first picture. Tell (not read) the story 
to the child, loosely following the story script. You do not need to 
memorize the story script, but become familiar enough with it to tell a 
similar story.  

 

c. Leave the book with the child and move away – either at an angle facing 
the child or across the table. Moving away from the child helps promote 
language and minimize pointing. Turn on the recorder and instruct the 
child to tell the story back in the same language.  

 

Directions to the child (Spanish sample): 
Examiner: Ahora, cuentame lo que pasó en este cuento. 
 

Directions to the child (English sample): 
Examiner: Okay, now I would like you to tell me the story. 
 

Refer to the following section for a list of prompts which may be used 
while the child retells the story. Remember, all prompts should be in the 
target language.  

 

d. After the child finishes telling the story, turn off the recorder and thank 
the child for telling his/her story. 
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e. Repeat these steps to elicit the sample in the other language. You may 
elicit the second language sample immediately after the first, or you may 
prefer to wait several weeks in between. 

 

3. Prompts 

Use minimal open-ended prompts when eliciting the samples. Using overly-
specific questions or providing too much information to the child 
compromises the process of capturing the child’s true language and ability 
level. Open-ended prompts do not provide the child with answers or 
vocabulary. They do encourage the child to try or they let the child know it is 
ok to move on if needed. Use open-ended prompts/questions as necessary. 

 

• Use open-ended prompts when the child: 
- is not speaking 
- says “I don’t know.”, “Cómo se dice?” 
- starts listing, e.g., “boy”, “dog”, “jar” 

 

• Acceptable verbal prompts (in the target language) include: 
Tell me more. Dime más. 
Just do your best. Haz lo mejor que puedas. 
Tell me about that. Dime sobre eso/esa. 
You’re doing great. Estás haciendolo muy bien. 
I’d like to hear more about that. Me gustaría oír más sobre eso/esa. 
Tell me what you can. Dime lo que puedas. 
That sounds interesting. Eso/Esa suena interesante. 
What else? ¿Qué más? 
Keep going.  Siguele. Dale. 
Mhm . Uhhuh. 

 

• Acceptable nonverbal prompts include: 
Smiles and eye contact 

Nods of affirmation and agreement 
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• Unacceptable prompts include: 
What is he doing? ¿Qué está haciendo (él)? 
Where is he? ¿Dónde está (él)? 
Pointing at scenes in the book while prompting 
What’s this? ¿Qué es esto? 
What’s happening here? ¿Qué está pasando/ocurriendo aquí? 

 

Avoid asking the “wh” questions, who?, what?, when?, where? These often 
lead to obvious and limited responses/answers. 

 

What if the child code switches? 
 

If the child uses an occasional Spanish word in the English sample, just ignore 
it. However, if the child uses a lot of Spanish words or phrases, prompt the 
child with “in English, please” or “tell it to me in English” or “tell me the story 
in English”. Similarly, if the child uses a lot of English words in the Spanish 
sample, prompt the child with “en Español, por favor” or “dimelo en Espanol” 
or “dime el cuento en Español”. Direct the child to use the target language 
with minimal interruption of his or her story. But keep in mind that at least 
80% of the words should be in the target language in order for the sample to 
be valid. 

 

Transcription Notes 
 

The Spanish samples in the reference database were transcribed by fluent 
Spanish speakers. The English samples were transcribed by fluent English 
speakers. 
  

Utterances were segmented into Modified Communication Units (MC-units)  
which were developed specifically for these samples to account for the 
pronoun-drop nature of the Spanish language. 
 

The underscore was used for repetitious words or phrases within utterances. 
This prevented inflation of the MLU due to repetition used to provide emphasis, 
e.g., C  dijeron|decir rana_rana_rana dónde estás|estar.  
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All transcripts have timing markers at the beginning and end of the sample. The 
initial marker indicates the child's first utterance. The final timing marker 
indicates the end of the child's narrative. 

 
Coding Notes 
 

• [EO:word] marks overgeneralization error 
• [EP:word] marks pronoun error 
• [EW] marks an extraneous or unnecessary word in the utterance that, if 

omitted, would make the utterance syntactically correct, e.g., C And he 
shout/ed and[EW] to the frog. 

• [EW:word] marks other word-level error 
• [EU] marks utterance-level error (also marks utterances with 3 or more 

errors) 
• [FP] marks filled pause words such as like, e.g., You (like[FP]) get six card/s 
• [CS] a word code attached to all code-switched words (Spanish words in 

English transcripts or English words in Spanish transcripts) 
• [I] a word code attached to all imitations of vocabulary provided by the 

examiner 
 

The following codes were created to mark Spanish-influenced English: 
• [WO] an utterance-level code signifying words or phrases within an utterance 

which are out of order in Standard English. The content (semantics) of the 
utterance is correct; however the word order is awkward, e.g., C And then 
fall down the dog and the boy [WO]. 

• [F] placed at the end of each utterance lacking a stated subject as a result of 
segmenting utterances using MC-units 

 
Subordination Index (SI) and Narrative Scoring Scheme (NSS) Coding 
 

SI and NSS coding was applied to all the samples in the Bilingual Spanish/English 
Story Retell reference databases. 
 

SI is a measure of syntactic complexity which produces a ratio of the total 
number of clauses (main and subordinate clauses) to the number of C-units. A 
clause, whether it is main or subordinate, is a statement containing both a 
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subject and a predicate. Grammatically, a subject is a noun phrase and a 
predicate is a verb phrase. Main clauses can stand by themselves. Subordinate 
clauses depend on the main clause to make sense. They are embedded within 
an utterance as noun, adjective or adverbial clauses (see Appendix O). 
 

NSS is an assessment tool developed to create a more objective narrative 
content and structure scoring system. It is based upon early work on story 
grammar analysis by Stein and Glenn, 1979, 1982. This scoring procedure 
combines many of the abstract categories of Story Grammar, adding features of 
cohesion, connecting events, rationale for characters’ behavior and referencing. 
Each of the scoring categories has specific explicit examples to establish scoring 
criteria, reducing the abstractness of the story grammar categories (see 
Appendix P). 

 

Using SALT to Compare Samples to the Bilingual Spanish/English Story 
Retell Database 

 
Use SALT’s Database menu to compare your sample with age or grade-matched 
samples selected from the Bilingual Spanish/English Story Retell database. SALT 
looks at the following header lines in your transcript to determine which 
database to pre-select. To pre-select the Bilingual Spanish/English Story Retell 
database, include the following plus lines in your transcript: 
 
+ Language: Spanish (or English) 
+ Bilingual: SE 
+ Context: Nar 
+ Subgroup: FWAY (or FGTD, or FOHO) 
 
Although you can type these plus lines into your transcript, a simpler alternative 
is to select the target language (Spanish or English), bilingual (SE), sampling 
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context (Nar), and subgroup (FWAY, FGTD, or FOHO) when completing the New 
Transcript Header information dialogue box. 

 
Acknowledgements 
 

Language samples for the Bilingual Spanish/English Story Retell reference 
databases were collected and transcribed as part of the grants HD39521 
“Oracy/Literacy Development of Spanish-speaking Children” and 
R305U010001 “Biological and Behavioral Variation in the Language 
Development of Spanish-speaking Children”, funded by the NICHD and IES, 
David Francis, P.I., Aquiles Iglesias, Co-P.I., and Jon Miller, Co-P.I. 
 
Resources 

• Story scripts in Spanish and English - found at the end of this appendix 
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English script for Frog, Where Are You? by Mercer Mayer (1969)  
 

Page Script  

1 
There once was a boy who had a dog and a pet frog. He kept the frog 
in a large jar in his bedroom.  

2 
One night while he and his dog were sleeping, the frog climbed out of 
the jar. He jumped out of an open window.  

3 
When the boy and the dog woke up the next morning, they saw that 
the jar was empty.  

4 
The boy looked everywhere for the frog. The dog looked for the frog 
too. When the dog tried to look in the jar, he got his head stuck.  

5 
The boy called out the open window, “Frog, where are you?” The dog 
leaned out the window with the jar still stuck on his head.  

6 The jar was so heavy that the dog fell out of the window headfirst!  

7 
The boy picked up the dog to make sure he was ok. The dog wasn’t 
hurt but the jar was smashed.  

8-9 
The boy and the dog looked outside for the frog. The boy called for 
the frog.  

10 
He called down a hole in the ground while the dog barked at some 
bees in a beehive.  

11 
A gopher popped out of the hole and bit the boy on right on his nose. 
Meanwhile, the dog was still bothering the bees, jumping up on the 
tree and barking at them.  

12 
The beehive fell down and all of the bees flew out. The bees were 
angry at the dog for ruining their home.  

13 
The boy wasn’t paying any attention to the dog. He had noticed a 
large hole in a tree. So he climbed up the tree and called down the 
hole.  

14 
All of a sudden an owl swooped out of the hole and knocked the boy 
to the ground.  

15 
The dog ran past the boy as fast as he could because the bees were 
chasing him.  

16 The owl chased the boy all the way to a large rock.  
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17 
The boy climbed up on the rock and called again for his frog. He held 
onto some branches so he wouldn’t fall.  

18 
But the branches weren’t really branches! They were deer antlers. 
The deer picked up the boy on his head.  

19 
The deer started running with the boy still on his head. The dog ran 
along too. They were getting close to a cliff.  

20-21 
The deer stopped suddenly and the boy and the dog fell over the 
edge of the cliff.  

22 
There was a pond below the cliff. They landed with a splash right on 
top of one another.  

23 They heard a familiar sound.  

24 The boy told the dog to be very quiet.  

25 They crept up and looked behind a big log.  

26 There they found the boy’s pet frog. He had a mother frog with him.  

27 They had some baby frogs and one of them jumped towards the boy.  

28-29 

The baby frog liked the boy and wanted to be his new pet. The boy 
and the dog were happy to have a new pet frog to take home. As they 
walked away the boy waved and said “goodbye” to his old frog and 
his family.  
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Spanish script for Frog, Where Are You? by Mercer Mayer (1969) 
 

Página Papel 

1 
Había un niño quien tenía un perro y una rana. El tenía la rana en su 
cuarto en un jarro grande a su rana.  

2 
Una noche cuando el niño y su perro estaban durmiendo, la rana se 
escapó del jarro. La rana se salió por una ventana abierta.  

3 
Cuando el niño y el perro se despertaron la siguiente mañana, vieron 
que el jarro estaba vacío.  

4 
El niño buscó en todas partes a la rana. Aún adentro de sus botas. El 
perro también buscó a la rana. Cuando el perro trató de mirar 
adentro del jarro y no podía sacar la cabeza.  

5 
El niño empezó a llamar desde la ventana abierta: “Rana, ¿Dónde 
estás?”. El perro se asomó a la ventana con el jarro todavía en la 
cabeza.  

6 
¡El jarro estaba tan pesado que hizo que el perro se cayera de cabeza 
por la ventana! 

7 
El niño fue a ver como estaba el perro. El perro no estaba herido, 
pero el jarro se rompió.  

8-9 
El niño y el perro buscaron a la rana afuera de la casa. El niño llamó a 
la rana.  

10 
El niño llamaba a la rana en un hoyo que estaba en la tierra, mientras 
que el perro le ladraba a unas abejas en su panal.  

11 
Una ardilla salió de su hueco y mordió la nariz del niño por 
molestarla. Mientras tanto, el perro seguía molestando a las abejas, 
brincaba hacia el árbol y les ladraba.  

12 
El panal de abejas se cayó y las abejas salieron volando. Las abejas 
estaban enojadas con el perro.  

13 
El niño no prestó ninguna atención al perro. El vió un hueco grande 
en un árbol y quería ver si su rana se escondía allí. Así que trepó el 
árbol y llamó a la rana en el hueco para ver si estaba.  

14 
De repente un buho salió del hueco y lanzó al niño al suelo. El buho 
lo vió fijamente y le dijo que se fuera.  
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15 
El perro pasó al niño corriendo tan rápido como pudo porque las 
abejas lo perseguían.  

16 El buho persiguió al niño hasta una piedra grande.  

17 
El niño se encaramó en la piedra y llamó otra vez a la rana. Se agarró 
a unas ramas para no caerse de la piedra.  

18 
¡Pero las ramas no eran ramas reales! Eran los cuernos de un 
venado. El venado levantó al niño con su cabeza.  

19 
Y el venado empezó a correr con el niño que estaba todavía en su 
cabeza. El perro también corrió al lado del venado. Se acercaron a un 
precipicio.  

20-21 
El venado se paró de pronto y el niño y el perro se cayeron por el 
precipicio.  

22 
Había un estanque debajo del precipicio. Aterrizaron en el estanque 
uno encima del otro.  

23 Oyeron un sonido que conocían.  

24 El niño le dijo al perro que se callara.  

25 
Los dos se acercaron con cuidado y miraron detrás de un tronco de 
un árbol.  

26 
Allí encontraron a la rana del niño. Había con él una rana mamá 
también.  

27 Ellos tenían algunas ranitas bebés y una de ellas saltó hacia el niño.  

28-29 

La ranita quería mucho al niño y quería ser su nueva mascota. El niño 
y el perro estaban felices de tener una nueva rana y llevarla a casa. 
Cuando se iban, el niño dijo adiós a la que fue su rana y también a su 
familia.  
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English script for Frog Goes to Dinner by Mercer Mayer (1974) 
 

Page Script  

1 
A boy was getting dressed in his bedroom. His pet dog, frog and 
turtle watched as he put on his best clothes. 

2 
While the boy was petting the dog, the frog jumped into his coat 
pocket. The boy didn’t know he was there.  

3 
As the boy left with his family, he waved and said “Goodbye” to his 
pets. The frog waved goodbye too.  

4-5 
When the boy and his family arrived at a fancy restaurant, the 
doorman helped them out of the car. The frog peaked out of the 
boy’s pocket but no one noticed him.  

6-7 
The boy and his family sat down at a table in the restaurant. While 
they were looking at the menus, the frog jumped out of the boy’s 
pocket towards the band.  

8 
The frog landed right in the man’s saxophone! “Squeak” went the 
saxophone.  

9 
The man looked inside the saxophone to see why it made that awful 
noise.  

10 
Then the frog fell out of the horn and landed right on the saxophone 
player’s face!  

11 
The saxophone player was so surprised that he fell backwards into 
the drum.  

12-13 
The drummer yelled at the saxophone player, “Look what you did to 
my drum- it’s broken!” While they were arguing, the frog jumped 
away on a plate of lettuce salad.  

14 The waiter didn’t notice the frog. He served the salad to a woman.  

15 
Just as she was about to take a bite, the frog popped out of the 
lettuce. The woman was shocked to see the frog.  

16 
She screamed and fell back on her chair. The frog was frightened and 
he jumped away.  

17 
There was a man at the next table who was having a glass of wine 
with his wife. The frog landed right in his glass.  
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18 
The woman complained to the waiter about getting a salad with a 
frog in it. She was very angry!  

19 
Meanwhile, when the man went to take a sip of his drink, the frog 
kissed him right on the nose.  

20-21 
The angry waiter was about to grab the frog who was waving 
goodbye to the man and his wife.  

22-23 

The waiter, who had caught the frog, was going to throw him out of 
the restaurant. But the boy saw the waiter carrying his frog and 
shouted, “Hey, that’s my frog!” The boy’s mother told him to be 
quiet.  

24 The boy asked the waiter to give him back his frog.  

25 
The angry waiter told the boy and his family, “Take your frog and get 
out of this restaurant at once. Don’t you ever bring that frog in here 
again!”  

26-27 
On the way home the boy’s family was angry with him. The frog had 
ruined their dinner!  

28-29 
When they got home the boy’s father scolded him, “You go to your 
room and stay there!” The dog and the turtle peaked around the 
corner to see what was going on.  

30 
When they got in his room, the boy and the frog laughed about 
everything that had happened at the restaurant. The more they 
thought about it, the more they laughed.  
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Spanish script for Frog Goes to Dinner by Mercer Mayer (1974) 
 

Página Papel 

1 

Un niño se estaba preparando para salir a cenar. Sus mascotas el 
perro, la tortuga, y la rana lo miraban mientras él se ponía sus 
mejores ropas. Estaban tristes porque sabían que él iba a salir sin 
ellos. 

2 
Mientras que el niño acariciaba al perro, la rana brincó dentro del 
bolsillo del niño. El niño no sabía que la rana estaba en su bolsillo. 

3 
Cuando la familia se iba, el niño les dijo adiós a sus mascotas. La rana 
también les dijo adiós. 

4–5 
Cuando la familia del niño llegó a un restaurante lujoso, el portero les 
ayudó a bajar del carro. La rana miró con cuidado desde el bolsillo. 

6–7 
En el restaurante se sentaron en una mesa. Mientras miraban el 
menú, la rana se escapó del bolsillo del niño y brincó hacia la banda 
musical. 

8 
¡La rana terminó dentro del saxofón! Cuando el músico empezó a 
tocar su instrumento, el sonido fue horrible. 

9 
Por eso, él miró dentro de su instrumento para ver que pasaba. Los 
otros músicos estaban muy confundidos como él. 

10 ¡Luego la rana le cayó y aterrizó en la cara del músico! 

11 
Y entonces el músico sorprendido, se cayó hacia atrás y cayó  dentro 
del tambor. 

12–13 
El tocador del tambor gritó al otro músico: “¡Mira lo que pasó –  mi 
tambor está roto! ahora, ¿Con qué voy a tocar?.”  Mientras ellos 
discutían, la rana brincó y terminó en la ensalada. 

14 
El mesero no se dio cuenta que la rana estaba en la ensalada. El 
mesero le sirvió la ensalada a una señora. 

15 
Cuando empezaba a comerla, la rana salió por debajo de la lechuga. 
La señora estaba aterrorizada al ver la rana. 

16 
Ella gritó y se cayó para atrás. La rana estaba asustada y salió 
brincando. 

17 
En la próxima mesa había un hombre y su esposa tomando una copa 
de vino. La rana se cayó en el vaso del señor. 
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18 
La mujer se quejó de que había encontrado una rana en su ensalada. 
¡Ella estaba muy enojada! 

19 
Mientras tanto, cuando el señor fue a tomar la copa, la rana salió y le 
dio un beso en la nariz. 

20–21 
El mesero enojado estuvo a punto de capturar la rana. El hombre y su 
esposa se fueron del restaurante porque no se sentían bien para 
comer con animales en la comida.  

22–23 
El mesero cuando capturó la rana,  la cargó hasta la puerta para 
botarla. Pero el niño vió al camarero con su rana y le gritó: “¡Esa es mi 
rana, no la botes!” Su mamá le dijo al niño que se callara. 

24 
El niño estaba preocupado de que el mesero iba a botar su rana en la 
calle. Entonces el niño le dijo al mesero que le diera su rana. 

25 
El camarero les dijo al niño y su familia: “Toma tu rana y salgan de ese 
restaurante inmediatamente. ¡No permitimos animales ni gente que 
los traen en este restaurante!” 

26–27 
Durante el camino de vuelta, la familia del niño estaba enojada. ¡La 
rana arruinó la cena! 

28–29 
Cuando llegaron a la casa el padre del niño lo regañó y le dijo: “Vete a 
tu  cuarto y quédate allí”. El perro y la tortuga miraron de escondidas 
desde el rincón para ver que pasó. 

30 
Cuando llegaron a su cuarto, el niño y su rana se rieron de todo lo que 
había pasado en el restaurante. Mientras más pensaban en todo lo 
que había pasado, más reían. 
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English script for Frog On His Own by Mercer Mayer (1973) 
 

Page Script  

1 
One day a boy walked to the park with his dog, carrying his pet frog 
and turtle in a bucket.  

2 After they got into the park, the frog jumped out of the bucket.  

3 
The frog waved goodbye to his friends as they walked away. He 
wanted to explore the park on his own.  

4 
The frog came upon some flowers. He was watching them very 
closely.  

5 All of a sudden he snapped his tongue high into the flowers.  

6 He caught a big, tasty bug for his lunch.  

7 He put the bug in his mouth and realized that was a big mistake.  

8 The bug was a bumblebee. It stung the frog on his tongue.  

9 
After a while, the frog noticed a man and woman who were having a 
picnic.  

10 
The woman reached into her picnic basket. At the same time, the frog 
crawled into the basket.  

11 
As the woman was digging around for something to eat, she felt 
something strange.  

12 
She quickly pulled her hand out of the basket to find the frog hanging 
on her arm.  

13 
The frog quickly jumped away from the couple. The woman threw a 
coffee cup at him. She screamed, “Don’t you ever come back you 
nasty little frog!”  

14-15 
The frog hopped over to a small pond where he noticed a little boy 
sailing his toy boat. The boy’s mother was on a bench reading.  

16 
The curious frog wondered if he could sail in the boat. He leapt 
though the air…   

17 And landed, splat, on top of the sailboat.  
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18 
The frog was too big for the sailboat and sunk it. The little boy started 
crying and his mother came to pull the sunken sailboat out of the 
water.  

19 
The frog swam across the pond and crawled out on the other side. He 
saw a woman on a bench rocking a baby stroller. Her cat was napping 
by the stroller.  

20 
The curious frog wanted to know what was inside the stroller. He 
took a giant leap toward it.  

21 
The frog landed on the baby’s lap. The baby sat up and looked at the 
frog. It was time for the baby to have a bottle and the mom was 
getting it ready.  

22 
While the mom read her magazine she held out the bottle for her 
baby. The frog was going to drink the bottle while the mom wasn’t 
looking. 

23 
The baby started to cry because he wanted his bottle. The cat climbed 
up the stroller to try to catch the frog. The mother realized what was 
happening and was shocked.  

24-25 She picked up her baby while the cat chased after the frog.  

26 
The frog leapt away as fast as he could but the cat caught him by the 
leg.  

27 The cat wrestled the frog to the ground. The frog was very frightened.  

28-29 
Luckily, along came the boy with his dog and turtle. The dog barked at 
the cat and the boy yelled, “Hey, get away from my frog!” This scared 
the cat who ran away as fast as he could.  

30 
The boy picked up his frog and started to walk home. The frog lay in 
the boy’s arms, very tired from all of his adventures. He was happy to 
be back with his friends.  
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Spanish script for Frog On His Own by Mercer Mayer (1973) 
 

Página Papel 

1 
Un día un niño caminó en el parque con su perro, llevando a su rana y 
la tortuga en un balde. 

2 Después de llegar al parque, la rana saltó del balde. 

3 
La rana le dijo adiós a sus amigos mientras ellos se iban. Ella quería 
explorar el parque sóla. 

4 La rana encontró unas flores. Las miró de cerca. 

5 De repente, metió la lengua en las flores. 

6 Capturó un insecto grande y sabroso para el almuerzo. 

7 Puso el insecto en su boca y se dio cuenta de que era un gran error. 

8 
El insecto era una abeja; y  le picó la lengua de la rana. Y por eso a la 
pobre rana le dolía su lengua.  

9 
Después de un rato, la rana vió a un hombre y una mujer quienes 
estaban de día de campo. 

10 
La mujer metió la mano en la canasta de comida. Ella no sabía que al 
mismo tiempo la rana entró en la canasta. 

11 
Cuando la mujer intentó encontrar algo para comer, sintió algo 
extraño. 

12 
Ella rápidamente sacó su mano de la canasta y descubrió a la rana 
colgando de su brazo.  El hombre se asustó tanto que hasta tiró  su 
taza de café y  se le cayeron sus lentes. 

13 
La rana se fue corriendo alejándose de la pareja. La mujer arrojó una 
taza de café a la rana y  le gritó: “¡Odiosa ranita nunca regreses aquí!”. 
El hombre estaba en el césped riéndose histéricamente. 

14-15 
La rana brincó hasta un pequeño estanque donde vio a un niñito 
jugando con su barco de vela. 

16 La rana curiosa quería saber si podía navegar en el barco. Saltó… 

17 y terminó, salpicado, encima del barco de vela. 
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18 
La rana era demasiado grande y el barco de vela se hundió. El niñito 
empezó a llorar y su madre vino a sacar al barco hundido fuera del 
agua. 

19 
La rana cruzó nadando el pequeño estanque y salió al otro lado.  Vio a 
otra mujer sentada en un banco meciendo el cochecito de un bebé. Su 
gato estaba dormido al lado del cochecito. 

20 
La rana curiosa quería saber que había en el cochecito. Así que saltó 
fuertemente hacia el coche. 

21 
La rana aterrizó en las rodillas del bebé y el bebé se sentó y miró a la 
rana. Ya era hora de que el bebé comiera, así que mientras la madre 
leía su revista le dio el tetero al bebé. 

22 
Y como la madre estaba entretenida leyendo, la rana trató de tomarse  
la leche del bebé. 

23 
El bebé empezó a llorar porque quería su tetero. El gato molesto subió 
en el cochecito para tratar de capturar a la rana. La madre se dio 
cuenta de lo que estaba pasando y se asustó mucho. 

24-25 Ella levantó a su bebé mientras que el gato perseguía a la rana. 

26 
La rana salió saltando lo más rápido posible, pero el gato la atrapó por 
la pierna. 

27 
El gato luchó con la rana y ella terminó en el suelo. La rana tenía 
mucho miedo. 

28-29 
Afortunadamente,  llegó el niño con su perro y su tortuga. El perro le 
ladró al gato y el niño gritó: “¡Deja de molestar a mi rana!”. Esto 
asustó al gato y lo hizo salir corriendo. 

30 
El niño levantó a su rana y empezó el camino de regreso a la casa.  La 
rana se acostó en los brazos del niño, muy cansada por todas sus 
aventuras. Estaba contenta de estar con sus amigos de nuevo. 

 
 



 

 

 

APPENDIX 

H 
 

Bilingual Spanish/English Unique Story Databases  
 

 

Participants 
 
The Bilingual English Unique Story and Bilingual Spanish Unique Story databases 
consist of English and Spanish story tell (not retell) narratives from native 
Spanish-speaking bilingual (Spanish/English) children. These English learners 
(ELs) were drawn from public school EL classrooms in urban Texas (Houston and 
Austin), border Texas (Brownsville), and urban California (Los Angeles). The 
children reflect the diverse socio-economic status of these areas. Age, grade, 
and gender data is available for all children. 
 
Additional Inclusion Criteria 

 
1. The children were described as “typically developing” as determined by 

normal progress in school and the absence of special education services. 
 

Database 
Context 
(Subgroup) 

Age 
Range 

Grade in 
School 

# 
Samples 

Location 
Special 
Coding 

Bilingual 
Spanish/English 
Unique Story 

Nar (OFTM) 5;0 – 9;7 K, 1, 2, 3 475 TX & CA SI, NSS 
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2. All children were within the following age ranges. 
 

Grade Age Range 
K 5;0 – 6;9 
1 6;2 – 7;7 
2 7;3 – 8;9 
3 8;4 – 9;7 

 
3. All children were able to produce both English and Spanish narratives 

containing at least one complete and intelligible verbal utterance in the 
target language. Although the language samples may contain code-switched 
words (English words in the Spanish samples or Spanish words in the English 
samples), at least 80% of the words from each sample were in the target 
language. 
 

Elicitation Protocol 
 
1.  Materials 

• digital recorder 

• copy of the book used for the unique story  

• quiet location free of distractions with a table and two chairs 
 

2. General Directions 
 

This task is a story tell (not retell) using the picture book One Frog Too Many 
by Mercer and Marianna Mayer (1975). The protocol assumes that the child 
has had experience retelling at least one of the frog stories from the 
Bilingual Spanish/English Story Retell database.  This is important because 
the unique story is not modeled for the child in this protocol. The child is 
simply shown the pictures and then asked to tell the story.  
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Ideally, you should first assess the child in his or her native language. 
However, we are clearly aware that for many speech-language pathologists, 
assessing the child in his native language will be impossible since the 
majority of clinicians do not speak a language other than English. This can 
also be the case for clinicians who may be bilingual, but do not speak the 
native language of the client. Thus, we suggest that clinicians first assess the 
child in the language in which the clinician is the most comfortable. If the 
child’s performance is below average compared to age and grade-matched 
peers, then elicit a second sample in the other language. You may elicit the 
second language sample shortly after the first sample, or you may prefer to 
wait several weeks in between. 

 

2. Steps 
 
a. Sit next to the child at a table. The book One Frog Too Many should be 

on the table. The audio/video recorder should be checked and ready to 
be turned on. 
 

b. Look at the pictures in the book.  
 

Directions to the child (Spanish sample): 
Examiner: Aquí tengo un libro que no tiene palabras. Vamos a mirar las 
fotos en este libro. Cuando terminemos, quiero que me diga el cuento 

Note that if the child does not have prior story-retell experience, you should 
provide a model of one of the following frog stories from the Bilingual 
Spanish/English Story Retell database: 

• Frog, Where Are You? by Mercer Mayer (1969) 

• Frog Goes to Dinner by Mercer Mayer (1974) 

• Frog On His Own by Mercer Mayer (1973) 
The scripts and audio recordings of these frog stories are available on the 
SALT Software web site at 
http://saltsoftware.com/resources/elicaids/frogstories. 

http://saltsoftware.com/resources/elicaids/frogstories
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en español. Okey? Vamos a mirar el primer libro. Este libro nos cuenta 
un cuento sobre un niño, un perro, y una rana. 
 

Directions to the child (English sample): 
Examiner: Here is a book that doesn’t have any words. We are going to 
look at the pictures in this book together. When we finish, I want you to 
tell the story to me in English. Ok?  Let’s look at the book. This book tells 
a story about a boy, a dog, and a frog. 
 

You control the book while you silently look at each page together.   
 

c. Leave the book with the child and move away – either at an angle facing 
the child or across the table. Moving away from the child helps promote 
language and minimize pointing. Turn on the recorder and instruct the 
child to tell the story to you in the same language.  
 

Directions to the child (Spanish sample): 
Examiner: Ahora, cuentame lo que pasó en este cuento. 
 

Directions to the child (English sample): 
Examiner: Okay, now I would like you to tell me the story. 
 

Refer to the following section for a list of prompts which may be used 
while the child tells the story. Remember, all prompts should be in the 
target language.  
 

d. After the child finishes telling the story, turn off the recorder and thank 
the child for telling his/her story. 

 

e. Repeat these steps to elicit the sample in the other language. You may 
elicit the second language sample immediately after the first, or you 
may prefer to wait several weeks in between. 
 

3. Prompts 
 

Use minimal open-ended prompts when eliciting the samples. Using overly-
specific questions or providing too much information to the child 
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compromises the process of capturing the child’s true language and ability 
level. Open-ended prompts do not provide the child with answers or 
vocabulary. They do encourage the child to try or they let the child know it 
is ok to move on if needed. Use open-ended prompts/questions as 
necessary. 

 

• Use open-ended prompts when the child: 
is not speaking 
says “I don’t know.”, “Cómo se dice?” 
starts listing (e.g., “boy”, “dog”, “jar”) 
 

• Acceptable verbal prompts (in the target language) include: 
Tell me more. Dime más. 
Just do your best. Haz lo mejor que puedas. 
Tell me about that. Dime sobre eso/esa. 
You’re doing great. Estás haciendolo muy bien. 
I’d like to hear more about that. Me gustaría oír más sobre eso/esa. 
Tell me what you can. Dime lo que puedas. 
That sounds interesting. Eso/Esa suena interesante. 
What else? ¿Qué más? 
Keep going.  Siguele. Dale. 
Mhm.  Uhhuh. 
 

• Acceptable nonverbal prompts include: 
Smiles and eye contact 
Nods of affirmation and agreement 
 

• Unacceptable prompts include: 
What is he doing? ¿Qué está haciendo (él)? 
Where is he? ¿Dónde está (él)? 
Pointing at scenes in the book while prompting 
 What’s this? ¿Qué es esto? 
 What’s happening here? ¿Qué está pasando/ocurriendo 
aquí?) 
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Avoid asking the “wh” questions, who?, what?, when?, where? These 
often lead to obvious and limited responses/answers. 
 

What if the child code switches? 
 

If the child uses an occasional Spanish word in the English sample, just 
ignore it. However, if the child uses a lot of Spanish words or phrases, 
prompt the child with “in English, please” or “tell it to me in English” or 
“tell me the story in English”. Similarly, if the child uses a lot of English 
words in the Spanish sample, prompt the child with “en Español, por 
favor” or “dimelo en Espanol” or “dime el cuento en Español”. Direct the 
child to use the target language with minimal interruption of his or her 
story. But keep in mind that at least 80% of the words should be in the 
target language in order for the sample to be valid. 

 

Transcription Notes 
 

The Spanish samples in the reference database were transcribed by native 
Spanish speakers. The English samples were transcribed by native English 
speakers. 
  

Utterances were segmented into Modified Communication Units (MC-units)  
which were developed specifically for these samples to account for the 
pronoun-drop nature of the Spanish language. 
 
The underscore was used for repetitious words or phrases within utterances. 
This prevented inflation of the MLU due to repetition used to provide emphasis, 
e.g., C  dijeron|decir rana_rana_rana dónde estás|estar.  
 

All transcripts have timing markers at the beginning and end of the sample. The 
initial marker indicates the child's first utterance. The final timing marker 
indicates the end of the child's narrative. 

 

Coding Notes 
 

• [EO:word] marks overgeneralization error 
• [EP:word] marks pronoun error 
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• [EW] marks an extraneous or unnecessary word in the utterance that, if 
omitted, would make the utterance syntactically correct, e.g., C And he 
shout/ed and[EW] to the frog. 

• [EW:word] marks other word-level error 
• [EU] marks utterance-level error (also marks utterances with 3 or more 

errors) 
• [FP] marks filled pause words such as like, e.g., You (like[FP]) get six card/s 
•  [CS] a word code attached to all code-switched words (Spanish words in 

English transcripts or English words in Spanish transcripts) 
• [I] a word code attached to all imitations of vocabulary provided by the 

examiner 
 

The following codes were created to mark Spanish-influenced English: 
• [WO] an utterance-level code signifying words or phrases within an 

utterance which are out of order in Standard English. The content 
(semantics) of the utterance is correct; however the word order is awkward, 
e.g., C And then fall down the dog and the boy [WO] 

• [EW] marks an extraneous or unnecessary word in the utterance that, if 
omitted, would make the utterance syntactically correct, e.g., C And he 
shout/ed and[EW] to the frog. As a general rule, do not mark more than one 
extraneous word in an utterance; instead, mark the utterance using the [EU] 
code 

• [F] placed at the end of each utterance lacking a stated subject as a result 
segmenting utterances using MC-units 
 

Subordination Index (SI) and Narrative Scoring Scheme (NSS) Coding 
 

SI and NSS coding was applied to all the samples in the Bilingual Spanish/English 
Story Retell reference databases. 
 
SI is a measure of syntactic complexity which produces a ratio of the total 
number of clauses (main and subordinate clauses) to the number of C-units. A 
clause, whether it is main or subordinate, is a statement containing both a 
subject and a predicate. Grammatically, a subject is a noun phrase and a 
predicate is a verb phrase. Main clauses can stand by themselves. Subordinate 
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clauses depend on the main clause to make sense. They are embedded within 
an utterance as noun, adjective or adverbial clauses (see Appendix O).  
 
NSS is an assessment tool developed to create a more objective narrative 
structure scoring system. It is based upon early work on story grammar analysis 
by Stein and Glenn, 1979, 1982. This scoring procedure combines many of the 
abstract categories of Story Grammar, adding features of cohesion, connecting 
events, rationale for characters’ behavior and referencing. Each of the scoring 
categories has specific explicit examples to establish scoring criteria, reducing 
the abstractness of the story grammar categories (see Appendix P). 

 

Using SALT to Compare Samples to the Bilingual Spanish/English Unique 
Story Database 

Use SALT’s Database menu to compare your sample with age or grade-matched 
samples selected from the Bilingual Spanish/English Unique Story 
database. SALT looks at the following header lines in your transcript to 
determine which database to pre-select. To pre-select the Bilingual 
Spanish/English Unique Story database, include the following plus lines in your 
transcript: 
 
+ Language: Spanish (or English) 
+ Bilingual: SE 
+ Context: Nar 
+ Subgroup: OFTM 
 
Although you can type these plus lines into your transcript, a simpler alternative 
is to select the target language (Spanish or English), bilingual (SE), sampling 
context (Nar), and subgroup (OFTM) when completing the New Transcript 
Header information dialogue box. 
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APPENDIX 

I 
 

Monolingual Spanish Story Retell Database  
 

 

Participants 
 
The Monolingual Spanish Story Retell database consists of story-retell narratives 
from native Spanish-speaking children. These children were drawn from public 
school classrooms in Guadalajara, Mexico. The children reflect the socio-
economic status of this area. Age, grade, and gender data is available for all 
children. 

 
Additional Inclusion Criteria 

 

The children were described as “typically developing” as determined by normal 
progress in school and the absence of special education services. 

 

All children were within the following age ranges. 
 

Grade Age Range 

1 5;10 – 7;9 

2 6;11 – 9;0 

3 7;10 – 10;1 

 

Database 
Context 
(Subgroup) 

Age Range 
Grade in 
School 

# 
Samples 

Location 
Special 
Coding 

Monolingual 
Spanish Story 
Retell 

Nar (FWAY) 
Nar (FGTD) 
Nar (FOHO) 
Nar (OFTM) 

5;10 – 9;11 
6;4 – 10;6 
6;1 – 10;1 
6;9 – 10;7 

1, 2, 3 
1, 2, 3 
1, 2, 3 
1, 2, 3 

366 
360 
188 
154 

Mexico SI, NSS 
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Elicitation Protocol 
 

1. General Directions 

This is a story retell task using one of the following picture books: 
•  FWAY: Frog, Where Are You? by Mercer Mayer (1969) 
•  FGTD: Frog Goes to Dinner by Mercer Mayer (1974) 
•  FOHO: Frog On His Own by Mercer Mayer (1973) 
•  OFTM: One Frog Too Many by Mercer and Marianna Mayer (1975) 

  

First the story is modeled for the child. Then the child is asked to retell the 
same story. All instructions and prompts are given in Spanish. 

  
2. Steps 

a. Sit next to the child at a table. The book should be on the table. The 

audio/video recorder should be checked and ready to be turned on. 

b. Tell the story to the child loosely following the story script. 
 
Note that the scripts use to present the model for FWAY, FGTD, and FOHO 
can be found at the end of this document.  

 
Directions to the child: 
 

Examiner: Aquí tengo un libro. Te voy a contar este cuento mientras 
miramos el libro juntos. Cuando terminemos, quiero que me vuelvas a 
contar el cuento en español. Okey? Vamos a mirar el primer libro. Este 
libro nos cuenta un cuento sobre un niño, un perro, y una rana. 
  
You control the book and turn to the first picture. Tell (not read) the story 
to the child, loosely following the story script. You do not need to 
memorize the story script, but become familiar enough with it to tell a 
similar story. 
  

c. Leave the book with the child and move away – either at an angle facing 
the child or across the table. Moving away from the child helps promote 
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language and minimize pointing. Turn on the recorder and instruct the 
child to tell the story back in the same language. 
 

Directions to the child: 
Examiner: Ahora, cuentame lo que pasó en este cuento. 
  

Refer to the following section for a list of prompts which may be used 
while the child retells the story. Remember, all prompts should be in 
Spanish. 

  

d. After the child finishes telling the story, turn off the recorder and thank 

the child for telling his/her story. 

3. Prompts 

Use minimal open-ended prompts when eliciting the samples. Using overly-
specific questions or providing too much information to the child 
compromises the process of capturing the child’s true language and ability 
level. Open-ended prompts do not provide the child with answers or 
vocabulary. They do encourage the child to try or they let the child know it is 
ok to move on if needed. Use open-ended prompts/questions as necessary. 

  

• Use open-ended prompts when the child: 
is not speaking 
says “Cómo se dice?” 
starts listing, e.g., “niño”, “perro”, “tarro” 

  

• Acceptable verbal prompts include: 
Dime más. 
Haz lo mejor que puedas. 
Dime sobre eso/esa. 
Estás haciendolo muy bien. 
Me gustaría oír más sobre eso/esa. 
Dime lo que puedas. 
Eso/Esa suena interesante. 
¿Qué más? 
Siguele. Dale. 
Mhm . Uhhuh. 
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• Acceptable nonverbal prompts include: 

Smiles and eye contact 
Nods of affirmation and agreement 
 

• Unacceptable prompts include: 
¿Qué está haciendo (él)? 
¿Dónde está (él)? 
Pointing at scenes in the book while prompting 
¿Qué es esto? 
¿Qué está pasando/ocurriendo aquí? 

  
Avoid asking the “wh” questions, who?, what?, when?, where? These often lead 
to obvious and limited responses/answers. 

 
Transcription Notes 
 
The Spanish samples in the reference database were transcribed by fluent 
Spanish speakers. The English samples were transcribed by fluent English 
speakers. 
  
Utterances were segmented into Modified Communication Units (MC-units)  
which were developed specifically for these samples to account for the 
pronoun-drop nature of the Spanish language (see Appendix N). 
 
The underscore was used for repetitious words or phrases within utterances. 
This prevented inflation of the MLU due to repetition used to provide emphasis, 
e.g., C  dijeron|decir rana_rana_rana dónde estás|estar.  
 
All transcripts have timing markers at the beginning and end of the sample. The 
initial marker indicates the child's first utterance. The final timing marker 
indicates the end of the child's narrative. 
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Coding Notes 
• [EO:word] marks overgeneralization error 

• [EP:word] marks pronoun error 

• [EW] marks an extraneous or unnecessary word in the utterance that, if 
omitted, would make the utterance syntactically correct, e.g., C And he 
shout/ed and[EW] to the frog. 

• [EW:word] marks other word-level error 

• [EU] marks utterance-level error (also marks utterances with 3 or more 
errors) 

• [FP] marks filled pause words 
• [CS] a word code attached to all code-switched words (Spanish words in 

English transcripts or English words in Spanish transcripts) 
• [I] a word code attached to all imitations of vocabulary provided by the 

examiner 
 

The following codes were created to mark Spanish-influenced English: 
 

• [WO] an utterance-level code signifying words or phrases within an utterance 
which are out of order in Standard English. The content (semantics) of the 
utterance is correct; however the word order is awkward, e.g., C And then 
fall down the dog and the boy [WO] 

• [EW] marks an extraneous or unnecessary word in the utterance that, if 
omitted, would make the utterance syntactically correct, e.g., C And he 
shout/ed and[EW] to the frog. As a general rule, do not mark more than one 
extraneous word in an utterance; instead, mark the utterance using the [EU] 
code 

• [F] placed at the end of each utterance lacking a stated subject as a result 
segmenting utterances using MC-units 

 
Subordination Index (SI) and Narrative Scoring Scheme (NSS) Coding 
 

SI and NSS coding was applied to all the samples in the Bilingual Spanish/English 
Story Retell reference databases. 
 
SI is a measure of syntactic complexity which produces a ratio of the total 
number of clauses (main and subordinate clauses) to the number of C-units. A 
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clause, whether it is main or subordinate, is a statement containing both a 
subject and a predicate. Grammatically, a subject is a noun phrase and a 
predicate is a verb phrase. Main clauses can stand by themselves. Subordinate 
clauses depend on the main clause to make sense. They are embedded within 
an utterance as noun, adjective or adverbial clauses (see Appendix O). 
 
NSS is an assessment tool developed to create a more objective narrative 
content and structure scoring system. It is based upon early work on story 
grammar analysis by Stein and Glenn, 1979, 1982. This scoring procedure 
combines many of the abstract categories of Story Grammar, adding features of 
cohesion, connecting events, rationale for characters’ behavior and referencing. 
Each of the scoring categories has specific explicit examples to establish scoring 
criteria, reducing the abstractness of the story grammar categories (see 
Appendix P). 
 

Using SALT to Compare Samples to the Monolingual Spanish Story 
Retell Database 
 
Use SALT’s Database menu to compare your sample with age or grade-matched 
samples selected from the Monolingual Spanish Story Retell database.  SALT 
looks at the + Language, + Context, + Subgroup plus lines in your transcript to 
determine which database to use for analysis. To pre-select the Monolingual 
Spanish Story Retell database, include the following plus lines in your transcript: 
 
+ Language: Spanish 
+ Context: Nar 
+ Subgroup: FWAY (or FGTD, or FOHO, or OFTM) 
 
Although you can type these plus lines into your transcript, a simpler alternative 
is to select the target language (Spanish), sampling context (Nar), and subgroup 
(FWAY, FGTD, FOFO, or OFTM) when completing the New Transcript Header 
information dialogue box.  
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Spanish script for One Frog Too Many by Mercer and Marianna Mayer (1975) 
 

Página Papel 

1 
Había un niño quien tenía tres animales; un perro, una rana y una 
tortuga. Un día vio una caja envuelta con papel regalo. La tarjeta en 
la caja decía que era un regalo para él. 

2 Abrió la caja y se emocionó cuando vio lo que había adentro. 

3 
Había una ranita.  Al niño, al perro  y a la tortuga les gustó la ranita. 
Pero a la otra rana grande no le gustó. La rana grande quería seguir 
siendo la rana favorita del niño. Se puso celosa. 

4 
El niño puso la ranita al lado de sus otras mascotas y dijo: “Esta es mi 
nueva ranita, ¡dile hola a todos!” 

5 
La rana grande le dijo: “Yo soy la rana mas vieja y grande,  ¡No me 
agradas!” 

6 

Entonces la rana le mordió la pata a la ranita. La ranita lloró… “¡Ay,  
ay!” 
El niño no creía que la rana grande le hiciera algo asi a la pobre 
ranita chiquita. 

7 
El niño levantó a la ranita y regañó a la rana grande: “Fue muy malo 
lo que hiciste. ¡Tienes que tratar bien a la ranita nueva!” 

8 
Las mascotas del niño lo siguieron afuera para jugar.  Las dos ranas 
se montaron en la tortuga, pero a la rana grande todavía no le 
agradaba la ranita. 

9 El niño, disfrazado como pirata, iba de primero en la fila. 

10 
Mientras tanto, la rana grande pateó a la ranita y la tumbó de la 
tortuga. 

11 
Pero cuando los demás oyeron a la ranita llorando, se dieron cuenta 
de lo que había pasado.  Todos estaban enojados con la rana por ser 
tan mala con la ranita. 

12 – 13 
El niño llegó con todos sus animales a un estanque donde había una 
balsa. El niño no dejó entrar en la balsa a la rana grande. Pero a ella 
no le gustó que la dejaran sola en la orilla del estanque. 

14 – 15 
Así que la ranita no le hizo caso al niño y brincó a la balsa.  
Solamente  la ranita se dio cuenta de que la rana había brincado en 
la balsa. La rana miró a la ranita con una cara muy brava.  
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16 Entonces la rana grande pateó a la ranita y la tumbó de la balsa. 

17 La rana le sacó la lengua a la ranita y pensó: “Eso le enseñará”. 

18 
La rana grande estaba contenta.  Ahora era la única rana del niño – 
como solía ser antes. Pero,  la tortuga le tocó la pierna al niño para 
avisarle lo que había pasado.  

19 
Cuando el niño se volteó, se asombró de lo que vio. “¿Cómo llegó la 
rana grande hasta la balsa? ¿y dónde está la ranita?” 

20 – 21 
El niño y sus mascotas se bajaron de la balsa  y buscaron a la ranita. 
Ellos miraron por todas partes y dijeron: “Ranita, ¿Dónde estás? 

22 – 23 
Pero ellos no pudieron encontrarla. Durante el camino de vuelta, el 
niño estaba triste y empezó a llorar. La rana grande se arrepintió por 
lo que había hecho. 

24 
Cuando llegó a su casa, el niño se acostó en su cama y se puso a 
llorar. Sus mascotas también estaban tristes. Hasta la rana grande 
estaba triste. 

25 
Entonces, oyeron algo fuera de la ventana. Era el sonido de una 
ranita. 

26 
De repente, la ranita brincó por la ventana abierta. Todos estaban 
muy emocionados de ver a la ranita. Ellos creían que no la verían de 
nuevo, pero allí estaba. 

27 La ranita brincó a la cabeza de la rana grande y se rió. 

28 
La rana grande decidió ser buena con la ranita desde ahora en 
adelante.  Todos estaban muy felices. 

 



 

 

 



 

 

APPENDIX 
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ENNI Database  
 

 
The Edmonton Narrative Norms Instrument (ENNI) is an assessment tool for 
collecting language information from children aged 4 to 9 through storytelling. 
Pictures that portray a story are presented to a child, who then tells the story to 
the examiner. Picture sets were drawn for the ENNI by a professional cartoonist. 
They range from a simple story with 2 characters to a complex story with 4 
characters.  
 
Participants 
 

300 typically developing children, aged 4;0 - 10;0, living in Edmonton, Alberta, 
Canada and speaking English as a first language. Children were drawn from 34 
preschools, daycares and schools in the public and separate school boards. The 
range of economic and ethnic backgrounds reflects the diversity in the 
Edmonton area, as determined by a comparison with Statistics Canada data. 
Teachers were asked to refer two children in the upper level of achievement, 
two children from the middle level, and two children in the lower level (one boy 
and one girl at each level). In all cases, the children who were referred for the 
typical development sample were not to have speech or language difficulties or 
any other diagnostic label such as attention deficit disorder, learning disability, 
or autism. The children constitute the typically developing sample in the 
Edmonton Narrative Norms Instrument (ENNI), which also contains data from 
children with language impairment. 
 

Database 
Context 
(Subgroup) 

Age Range # Samples Location 

ENNI Nar (ENNI) 4;0 – 10;0 300 Canada 
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Elicitation Protocol 
 

The task is story generation from pictures (not retell). Six original picture sets 
with animal characters are used to elicit stories, two each at three levels of 
complexity. The stories are controlled in pairs and systematically varied across 
levels for length, amount of story information, and number and gender of 
characters. The pictures for each story are placed in page protectors with each 
story in its own binder. When administering each story, the examiner first goes 
through all the pages so that the child can preview the story, after which the 
examiner turns the pages again as the child tells the story. The examiner turns 
the page when the child appears to be finished telling the story for a particular 
picture. The examiner holds the binder in such a way that he or she cannot see 
the pictures as the child tells the story, which means that the child needs to be 
explicit if the examiner is to understand the story; the child cannot legitimately 
use pointing in lieu of language when telling the story. The instructions 
emphasize that the examiner will not be able to see the pictures, so the child 
will have to tell a really good story in order for the examiner to understand it. 
 
A training story is administered first consisting of a single episode 5-picture 
story. The purpose of the training story is to familiarize the child with the 
procedure and to allow the examiner to give more explicit prompts if the child 
has difficulty with the task. After the training story is administered, there are 
two story sets which may be given: Set A (Giraffe/Elephant) and Set B 
(Rabbit/Dog). You have the option of administering either or both sets. Both 
story sets were administered to all participants in the database.  
 
When selecting language samples from the database, you have the option 
including both story sets or restricting the selection to a specific story set by 
specifying one of the following subgroups: 

• Sets A & B = Set A and Set B stories 

• Set A = Set A stories (Giraffe/Elephant) 

• Set B = Set B stories (Rabbit/Dog) 
 
Transcription Notes 
 

Utterances were segmented into C-units which consist either of an independent 
clause plus any dependent clauses or of a partial sentence (see Appendix N). 
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Utterances that were broken off by the speaker were counted as mazes. Timing 
is not indicated in the transcripts. Socioeconomic status, parental education and 
ethnic background are not indicated in the transcripts. 
 

Coding Notes 
• [EO:word] marks overgeneralization error 

• [EP:word] marks pronoun error 

• [EW:word] marks other word-level error 

• [EU] marks utterance-level error (also marks utterances with 3 or more 
errors) 

• [FP] marks filled pause words such as like, e.g., You (like[FP]) get six card/s. 

 
Using SALT to Compare Samples to the ENNI Database 
 

Use SALT’s Database menu to compare your sample with age or grade-matched 
samples selected from the ENNI database.  SALT looks at the “+ Context” and “+ 
Subgroup” plus lines in your transcript to determine which database to pre-
select. To pre-select the ENNI database, include the following plus lines in your 
transcript: 

 
+ Context: Nar 
+ Subgroup: ENNI 

 
Although you can type these plus lines into your transcript, the easiest way is to 
select the correct sampling context (Nar) and subgroup (ENNI) when first 
creating a new transcript (by completing the New Transcript Header information 
dialogue box).  

 
Resources 
 

All picture sets and detailed administration and transcription instructions can be 
downloaded free of charge at www.rehabmed.ualberta.ca/spa/enni. The ENNI is 
copyrighted, including the pictures and all other materials. You are welcome to 
download, print, and use any of the materials for clinical, educational, or 
research purposes. None of the ENNI materials may be altered in any way or 
included in publications without permission from the authors. 

file:///C:/Users/ann/Desktop/Book%20edits/www.rehabmed.ualberta.ca/spa/enni
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APPENDIX 

K 
 

TNL2 & TNL Narrative Samples Databases  
 

 

Introduction 
 
There are two TNL databases. The TNL2 Narrative Samples database contains 
narratives collected for the standardization of the TNL-2: Test of Narrative 
Language - Second Edition (Gillam, R., & Pearson, N., 2017). The TNL Narrative 
Samples database contains narratives collected for the standardization of the 
original Test of Narrative Language (Gillam, R., & Pearson, N., 2004). 
 

1. TNL2 Narrative Samples database 

 
The TNL2 Narrative Samples database contains narratives collected for the 
standardization of the TNL-2: Test of Narrative Language - Second Edition 
(Gillam, R., & Pearson, N., 2017). 

 
Participants 
 

The “TNL2 Narrative Samples” reference database consists of narrative 
samples from 778 children, ranging in age from 4;0 to 14;11, including 41 
four-year olds, 59 five-year olds, 73 six-year olds, 103 seven-year-olds, 114 

Database 
Context 
(Subgroup) 

Age Range # Samples Location 

TNL2 Narrative Samples 
TNL Narrative Samples 

Nar (TNL2) 
Nar (TNL) 

4;0 – 14;11 
5;0 – 11;11 

778 
500 

USA 

Database 
Context 
(Subgroup) 

Age Range # Samples Location 

TNL2 Narrative Samples Nar (TNL2) 4;0 – 14;11 778 USA 
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eight-year-olds, 122 nine-year-olds, 109 ten-year-olds, 81 eleven-year-olds, 
29 twelve-year olds, 29 thirteen-year olds, and 18 fourteen-year olds. The 
children were in grades PK, K, 1 - 8. The normative sample is representative 
of the United States as a whole with an equal percentage of male and 
female participants. Children came from four US regions (Northeast, South, 
Midwest, and West). Their primary language was English.   The race 
distribution of the children in the sample is 78% white, 14% black or African-
American, 5% Asian/Pacific Islander, 2% two or more races, and <1% 
American Indian/Eskimo/Aleut. Hispanic status consisted of 22% yes and 
78% no. Twelve percent of the sample had been identified with a disability. 
This is consistent with US Department of Education disability statistics. The 
exceptionality distribution of the sample was 5% Specific Learning Disability 
(including Developmental Language Disorder), 3% Intellectual Disability, 2% 
Attention Deficit Hyperactivity Disorder, 1% Physically Impaired, 1% Other 
Disability.   

 

Elicitation Information 
 

The elicitation format consists of children listening to an adult model of 
three types of stories, answering comprehension questions, and then 
producing a similar type of story. Examiners collected data on children's 
ability to tell stories in three formats: (1) a script-like story (2) a personal-
like story (3) a fictional story. The examiner scripts and picture stimuli used 
to elicit the narratives are available in the TNL-2: Test of Narrative Language 
–Second Edition (Gillam & Pearson, 2017). 
  

• Task 1: McDonald’s – Script-like Story (picture cue) 
In the first narrative task, the examinee retells a McDonald’s script 
about two children who go to McDonald’s with their mother. The script-
like story, told to the examinee prior to the production task, contains a 
number of events that children experience when they eat at a fast food 
restaurant. The examinee retells the story while looking at the single-
picture cue.  

• Task 2: Late For School – Personal-like Story (five sequenced pictures) 
In the second production task, examinees create a story that 
corresponds to a series of pictures about a boy who wakes up late for 
school.  
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• Task 3: Aliens – Fictional Story (single picture) 
In the third narrative production task, the examinee creates a story that 
corresponds to a picture of two children who see an alien family get out 
of a spaceship that lands in a park.  
 

Transcription Notes 
 

Language samples were transcribed according to SALT standard codes and 
conventions by undergraduate and graduate students in Communication 
Sciences and Disorders who completed SALT training on transcription and 
reached 90% or better agreement on three training transcripts. Utterances 
were segmented into C-units, which were defined as groups of words that 
could not be further divided without loss of their essential meaning (see 
Appendix N). After the audio file was transcribed by one research assistant, 
a second research assistant listened to the tape and marked disagreements 
with any of the original segmentation and/or coding decisions. All 
disagreements were resolved by a PhD level research coordinator who 
listened to the tape as she made a third pass through the transcripts.  
 
All samples were timed, with separate timing markers inserted for each 
task. Gender, age, and grade information was included in the header. 
Parentheticals were marked with double parentheses, e.g., The boy ((I don’t 
know his name)) order/ed a sandwich. Pauses of two or more seconds 
within and between utterances were marked.  
 
Coding Notes 

• [EO:word] marks overgeneralization error 

• [EP:word] marks pronoun error 

• [EW] marks an extraneous or unnecessary word in the utterance that, if 
omitted, would make the utterance syntactically correct, e.g., C And he 
shout/ed and[EW] to the frog. 

• [EW:word] marks other word-level error 

• [EU] marks utterance-level error (also marks utterances with 3 or more 
errors) 

• [FP] marks filled pause words such as like, e.g., You (like[FP]) get six 
card/s. 



328  Assessing Language Production Using SALT Software  

 

Transcript Format: 

Each transcript contains all three stories. The stories were separated by plus 

lines with the headers +[BeginMcDonalds], +[EndMcDonalds], 

+[BeginLateForSchool], +[EndLateForSchool], +[BeginAliens],  +[EndAliens]. 

Timing lines show the elapsed time for each task in the transcript.  

For example, 

+ [BeginMcDonalds] 
-  0:00 
C The boy and the girl came home. 
C And they want/ed to go eat. 
E  Ok. 
C ………. 
C And that/'s all I know. 
- 1:05 
+ [EndMcDonalds] 
 
+ [BeginLateForSchool] 
- 2:20 
C The boy woke up. 
C And he was late for school. 
C   …….. 
C The end. 
- 4:15 
+ [EndLateForSchool] 
 
+ [BeginAliens] 
- 4:55 
C A boy and a girl were walk/ing in a park. 
C They saw a big ship land. 
E  Mhm. 
C  ……. 
C And that/'s it. 
- 7:10 
+ [EndAliens]  
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Using SALT to Compare Samples to the “TNL2 Narrative Samples” 
Database 

SALT looks at the “+ Context” and “+ Subgroup” plus lines in your transcript 
to determine which database to pre-select. To pre-select the “TNL2 
Narrative Samples” database, include the following plus lines in your 
transcript: 

          + Context: Nar 
          + Subgroup: TNL2 
Although you can type these plus lines into your transcript, the easiest way 
is to select the correct sampling context (Nar) and subgroup (TNL2) when 
first creating a new transcript (by completing the New Transcript Header 
information dialogue box).  
 
When selecting language samples for comparison, you have the option 
including all three stories or restricting the selection to a specific task by 
specifying one of the following subgroup/story options: 

• All 3 Stories - all three narrative tasks 

• McDonalds - the first narrative task only (script retell)  

• LateForSchool - the second narrative task only (five sequenced pictures)  

• Aliens - the third narrative task only (single picture)  
 
To compare your entire transcript (three narrative tasks) to entire 
transcripts in the database, use the default Subgroup/Story setting “All 3 
Stories”. To compare a specific task you would change the current transcript 
cut (Setup menu --> Transcript Cut) which determines the section of your 
transcript that you want included in the comparison. For example, to 
compare the section of your transcript which contains the narrative based 
only on McDonalds, you would change the transcript cut to begin with the 
line containing the code [BeginMcDonalds] and end with the line containing 
the code [EndMcDonalds]. Then you would compare this section of your 
transcript to the same task from the database by selecting the “McDonalds” 
subgroup/story. 

 
Acknowledgements 
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The narratives in this database were collected for the standardization of the 
TNL-2: Test of Narrative Language (Second Edition), funded by Pro-Ed Inc. 
Sandra Gillam, PhD coordinated the transcription process.  Megan Israelsen 
supervised the transcribers and checked the transcripts while she was a 
doctoral student at Utah State University in Logan. The transcribers were 
Haley Ashcroft, Alison Barlow, Tiegan Beck, Hannah Car, Kennedy Eggertsen, 
Cecily Froerer, Natalie Green, Sarai Holbrook, Natalie Johnson, Aubrey 
Passey, Madeline Peterson, Rebecca Polson, Amy Siler, Sierra Southwick, 
Ashlynn Thompson,  Jenice Winterton, Daylene Weller, and Samantha 
Woodward. Gillam, R., & Pearson, N. (2017). Test of Narrative Language 
(Second Edition), Austin, TX: Pro-Ed Inc 

 
2. TNL Narrative Samples database 

 
The TNL Narrative Samples database contains narratives collected for the 
standardization of the original Test of Narrative Language (Gillam, R., & 
Pearson, N., 2004). 

 
Participants 
 

This reference database consists of narrative samples from participants 
ranging in age from 5;0 to 11;11, including 50 five-year olds, 100 six-year 
olds, 100 seven-year-olds, 100 eight-year-olds, 50 nine-year-olds, 50 ten-
year-olds, and 50 eleven-year-olds. There are an equal number of boys and 
girls at each age. Children came from four US regions (Northeast, South, 
Midwest, and West). Their primary language was English and they had not 
been identified with a disability and were not receiving any special 
education services. The race/ethnicity distribution of the children in the 
sample is 71% white (not Hispanic), 11% black or African-American, 10% 
Hispanic, and 8% other or not reported. 
 

Database 
Context 
(Subgroup) 

Age Range # Samples Location 

TNL Narrative Samples Nar (TNL) 5;0 – 11;11 500 USA 
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Elicitation Protocol 
 

Examiners collected data on children's ability to tell stories in three formats: 
(1) a script retell (no picture cues), (2) a story about five sequenced pictures, 
and (3) a fictional narrative based on a single picture. The examiner scripts 
and picture stimuli that were used to elicit the narratives are available in the 
Test of Narrative Language (Gillam & Pearson, 2004).  

 

• Task 1: McDonald’s - Script Retell (no picture cues) 
In the first narrative format, the examiner reads aloud a story about two 
children who go to McDonald’s with their mother. Because no picture 
cues are provided, the child must rely on auditory memory to answer 
literal and inferential comprehension questions about the story. After 
answering the story comprehension questions, the child is asked to 
retell the entire McDonald's story. The child's retelling was transcribed. 

• Task 2: Late For School - Five Sequenced Pictures 
The examiner shows the child a sequence of five pictures that illustrate 
the critical events in a single-episode story that the examiner tells. The 
story is about a child who creates a school project at home, falls, and 
breaks the project on the way to school, and then fixes the project 
when she gets to school. After reading the story to the child, the 
examiner asks the child to answer nine literal and inferential 
comprehension questions about the characters, events, and 
consequences in the story. The comprehension questions and answers 
were not transcribed. The examiner then shows the child a sequence of 
five new pictures that depict a sequence of events about a boy who is 
late for school. The child's oral story about the sequence of pictures was 
transcribed. 

• Task 3: Aliens - Single Picture 
The examiner tells a multi-episode story that corresponds to a picture of 
two children who are looking at a treasure being guarded by a dragon. 
The examiner asks ten literal and inferential comprehension questions 
about the characters, events, problems, and consequences in the story. 
The comprehension questions and answers were not transcribed. The 
examiner then shows the child a picture of two children who witness a 
family of aliens walking out of a spaceship that has landed in a park. The 
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child's oral story that corresponded to the picture of a fictional event 
was transcribed. 

 
When selecting language samples from the database, you have the option 
including all three stories or restricting the selection to a specific story by 
specifying one of the following subgroups: 

• All 3 Stories - all three narrative story tasks 

• McDonalds - the first narrative task only (script retell)  

• LateForSchool - the second narrative task only (five sequenced pictures)  

• Aliens - the third narrative task only (single picture)  

 
Transcription Notes 
 

Language samples were transcribed according to SALT conventions by 
undergraduate and graduate students in Communication Sciences and 
Disorders who completed a course on transcription and reached 90% or 
better agreement on three training transcripts. Utterances were segmented 
into C-units, which were defined as groups of words that could not be 
further divided without loss of their essential meaning. After the tape was 
transcribed by one research assistant, a second research assistant listened 
to the tape and marked disagreements with any of the original 
segmentation and/or coding decisions. All disagreements were resolved by 
a PhD level research coordinator who listened to the tape as she made a 
third pass through the transcripts. Timing information was not coded. 
Gender, age, and ethnicity information is included in the header. 

 
Coding Notes 

• [EO:word] marks overgeneralization error 

• [EP:word] marks pronoun error 

• [EW] marks an extraneous or unnecessary word in the utterance that, if 
omitted, would make the utterance syntactically correct, e.g., C And he 
shout/ed and[EW] to the frog. 

• [EW:word] marks other word-level error 

• [EU] marks utterance-level error (also marks utterances with 3 or more 
errors) 
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• [FP] marks filled pause words such as like, e.g., You (like[FP]) get six 
card/s. 

Using SALT to Compare Samples to the TNL Narrative Database 

Use SALT’s Database menu to compare your sample with age or grade-
matched samples selected from the TNL Narrative database.  SALT looks at 
the “+ Context” and “+ Subgroup” plus lines in your transcript to determine 
which database to pre-select.  To pre-select the TNL Narrative database, 
include the following plus lines in your transcript: 
+ Context: Nar 
+ Subgroup: TNL 
 
Although you can type these plus lines into your transcript, the easiest way 
is to select the correct sampling context (Nar) and subgroup (TNL) when first 
creating a new transcript (by completing the New Transcript Header 
information dialogue box).  
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New Zealand - Australia Databases  
 

Database 
Context 
(Subgroup) 

Age Range # Samples Location Section 

NZ-AU 
Conversation 

Con  
NZ: 4;5 - 7;7 
AU: 5;5 - 8;4 

NZ: 248 
AU: 102 

New Zealand 
Australia 

1 

NZ-AU 
Story Retell 

Nar (AGL & 
Bus) 

NZ: 4;0 - 7;7 
AU: 5l5 - 7;7 
AU: 5;3 - 8;9 

NZ: 264 
AU: 85 
AU: 127 

New Zealand 
Australia 
Australia 

2 

NZ-AU 
Personal 
Narrative 

Nar (NZPN) 
NZ: 4;5 - 7;7 
AU: 5;5 - 8;4 

NZ: 228 
AU: 127 

New Zealand 
Australia 

3 

NZ-AU 
Expository 

Expo 
NZ: 6;1 - 7;11 
AU: 7;4 - 8;4 

NZ: 65 
AU: 42 

New Zealand 
Australia 

4 

AU-USA 
Persuasion 

Pers 
AU: 12;10 - 18;4 
USA: 14;8 - 18;9 

AU: 66 
USA: 113 

Australia 
United States 

5 

 

 
1. New Zealand – Australia Conversation Database 
 

Database 
Context 
(Subgroup) 

Age Range 
# 

Samples 
Location 

NZ-AU 
Conversation 

Con  
NZ: 4;5 - 7;7 
AU: 5;5 - 8;4 

NZ: 248 
AU: 102 

New Zealand 
Australia 

 

General Description 
 

This database contains oral language samples collected from participants in 
a conversational context; a 10-minute conversation to elicit at least 50 
complete and intelligible utterances.  
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New Zealand Participants 
 

This language samples collected from New Zealand are from children aged 
4;5 - 7;7. The samples were collected from the participants in a 
conversational context. The children were randomly selected from schools 
in Auckland, Hamilton, and Christchurch (major urban areas in New Zealand) 
as well as secondary urban areas surrounding Christchurch. Approximately 
80% of the participants were from the Auckland/Hamilton region to reflect 
New Zealand's population density in these areas. Children with diagnosed 
disabilities were excluded from the sample. The schools reflected a range of 
socio-economic areas and English was the first language of all children 
included in the database. There was an even gender distribution. The 
ethnicity of the group is comprised of the following: New Zealand European: 
62%, Maori: 22%, Pasifika 5%, Asian 3%, and Other 8%. 
 
The Group Special Education speech-language therapists involved in the 
project were trained by one of the researchers on the assessment 
procedures and language sampling protocol. Each child was seen 
individually in the child's school setting and was administered a New 
Zealand speech and language screening test and reading or letter 
knowledge test to gain information regarding the child's general language 
development. Any child who performed very poorly on the receptive 
language screening task (i.e., could not follow basic instructions) was 
excluded from the database. Children's language samples were also 
excluded from the database for reasons such as poor recording quality and 
not engaging in the task (i.e., not willing to talk). Only samples that 
contained over 45 complete and intelligible utterances were included. 
 

Australian Participants 
 

Children, aged 5;5 - 8;4, were randomly selected from the first three years 
of primary school, grade 0 (Prep or Foundation Year), grade 1, and grade 2, 
across Queensland (regional: 55; City: 72), representing the full range of 
socio-economic areas (1 – 10). 
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Ethics approval for this project was granted by the University Human Ethics 
Committee (PES/31/12/HREC). Approval was also granted by the 
Department of Education and Training, Queensland Government 
(550/27/1258). Of the schools who agreed to participate, teachers were 
asked to identify children who 1) attended Foundation Year (known as Prep; 
YOS1), Year 1 (YOS2), or Year 2; YOS 3); 2) spoke English as their first 
language; 3) were progressing normally at school; and 4) had no history of 
speech and/or language impairments. Consent forms were sent home to 
these children via the teachers. From the children for whom consent to 
participate was obtained, participants were randomly selected, making sure 
there was an equal distribution of girls and boys, and an equal number of 
participants across the three grades. Conversational language samples were 
elicited from 102 children, from grade 0 (n = 37), grade 1 (n = 32), and grade 
2 (n = 33). There was an even gender distribution. These children were from 
the following ethnic backgrounds, as indicated by their parents on the 
project consent forms: 
          Australian (85.5%) 
          Aboriginal and Torres Strait Islander (3.9%) 
          Pacific Island (.8%) 
          Other (3.1%) 
          Non-specified (6.3%) 
      
A total of 21 speech pathologists assisted with the data collection. These 
therapists received a manual, observed a demonstration video, and 
attended a one-hour teleconference. Each child was seen individually in the 
child's school setting and was administered a range of oral language tasks. 
Children's language samples were excluded from the database if they 
contained less than 40 complete and intelligible utterances. For this reason 
24 transcripts were discarded (see Westerveld & Vidler, 2014). As reported 
in Westerveld and Vidler, samples of less than 5 minutes’ duration were 1.8 
times more likely to contain fewer than 50 utterances. 
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Elicitation Procedures 
 

The conversation protocol aimed to elicit 50 complete and intelligible 
utterances from the child in 10 minutes of conversation. The protocol was 
adapted from interview procedures described by Evans and Craig (1992). 
The child was asked to bring an object from the classroom to discuss with 
the examiner. The examiner encouraged the child to talk about the object. 
The child was then asked to talk about his or her family, school, and after-
school activities. To establish and maintain a productive communicative 
interaction, the suggestions listed by Miller (1981) were followed. These 
included listening and following the child's lead, maintaining the child's 
pace, using open-ended prompts, and adding new information when 
appropriate. 
 

Protocol 
 
The child has been asked to bring an object from the classroom to show the 
examiner.  
(10 minutes, use stopwatch) 
 
Interview with the child. Respond to child with rewording of child's 
comments or “that's interesting, tell me some more about that.” Try to 
avoid leading questions. Allow the child to take the lead. Start with the first 
question and introduce the remaining questions when appropriate. 

 
“What did you bring to show me?” Object discussed 
________________________  
“Can you tell me about it?” 
“Tell me about the sorts of things you do in the classroom“. 
“What do you like to do when you're not in school?” 
“Do you have any brothers or sisters?” 

 

Transcription Notes 
 

The utterances were segmented into C-units. A C-unit includes an 
independent clause with its modifiers (see Appendix N). All transcripts were 
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timed and pauses, within and between utterances, of two or more seconds 
in length, were marked. 
 

Coding Notes 
• [EO:word] marks overgeneralization error 

• [EP:word] marks pronoun error 

• [EW] marks an extraneous or unnecessary word in the utterance that, if 
omitted, would make the utterance syntactically correct, e.g., C And he 
shout/ed and[EW] to the frog. 

• [EW:word] marks other word-level error 

• [EU] marks utterance-level error (also marks utterances with 3 or more 
errors) 

• [FP] marks filled pause words such as like, e.g., You (like[FP]) get six 
card/s. 

 

Database Selection Options 
 

This database was created with two location options (New Zealand and 
Australia) and one ethnicity option (Maori). A language sample taken from a 
child can be compared against this population distribution as a whole or 
against a subset selected by location and/or including Maori (New Zealand) 
children only.  

Using SALT to Compare Samples to the NZ-AU Conversation 
Database 

Use SALT’s Database menu to compare your sample with age or grade-
matched samples selected from the NZ-AU Conversation database.  SALT 
looks at the “+ Context” plus line in your transcript to determine which 
database to pre-select. To pre-select the NZ-AU Conversation database, 
include the following plus lines in your transcript: 

+ Context: Con 
  
When first creating a new transcript using the New Transcript Header 
information dialogue box:  
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• Click on the “browse” button in the lower right corner of the dialogue 
box to select database for comparison 

• select NZ-AU Conversation.sltdb  
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2. New Zealand – Australia Story Retell Database 
 

Database 
Context 
(Subgroup) 

Age Range # Samples Location 
Special 
Coding 

NZ-AU 
Story Retell 

Nar (AGL) 
Nar (BUS) 

NZ: 4;0 - 7;7 
AU: 5;3 - 8;9 

NZ: 264 
AU: 212 

New Zealand 
Australia 

ONC & ONQ 
(AGL only) 

 

Participants and General Description  
 

This database contains oral language samples collected from New Zealand 
children, aged 4;0 - 7;7, and from Australian children, aged 5;3 - 8;9. The 
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language samples were collected from the participants in a story retelling 
context using a story format and vocabulary that is familiar to children in 
New Zealand and Australia.  
  
The initial data were collected in 2000/2001 from 4;6 to 7;7 year-old 
children who had been randomly selected from kindergartens and schools 
in Auckland, Hamilton, and Christchurch (major urban areas in New Zealand) 
as well as secondary urban areas surrounding Christchurch. Approximately 
80% of the participants were from the Auckland/Hamilton region to reflect 
New Zealand's population density in these areas. Children with diagnosed 
disabilities were excluded from the sample. The schools reflected a range of 
socio-economic areas, and English was the first language of all children 
included in the database. There was an even gender distribution. The 
ethnicity of the group comprised of the following: New Zealand European: 
62%, Maori: 22%, Pacific Island 5%, Asian 3%, Other 8%. 
  
A second set of data was collected in November 2009 from 76 children aged 
4;0 to 4;11. All children attended their local kindergarten in Christchurch, 
New Zealand. The kindergartens reflected a range of socio-economic areas, 
and English was the first language of all children. There were 58% girls and 
42% boys. Ethnic make-up of the group was as follows: NZ European 89%, 
Maori 8%, Pacific Island 1.5%, Other 1.5%. 
  
Two sets of samples were collected in Australia in 2012. The first set was 
based on the story "Ana Gets Lost". These samples were collected from 85 
children (ages 5;5 to 7;7) attending the first two years of primary school: 
Grade 0 (Prep or Foundation) and Grade 1 across Queensland, representing 
the full range of socio-economic areas (1 – 10). There were 44 (52%) girls 
and 41 (49%) boys. All children spoke English as their first language and 
were progressing normally at school as indicated by their teachers. Ethnic 
make-up of the group was as follows: Australian 80%, Aboriginal and Torres 
Strait Islander 4.7%, European 3.5%, Unspecified 10.6%, Other 1.2%. 
  
The second set of samples collected in Australia was based on the Bus story. 
This database contains language samples collected from Australian children 
attending the first three years of primary school:  Grade 0 (Prep or 
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Foundation Year), Grade 1, and Grade 2 across Queensland (regional: 55; 
City: 72), representing the full range of socio-economic areas (1 – 10). The 
language samples were collected from the participants in a narrative 
context, using the story retelling task “The Bus Story” (Renfrew, 1995). 
Ethics approval for this project was granted by the University Human Ethics 
Committee (PES/31/12/HREC). Approval was also granted by the 
Department of Education and Training, Queensland Government 
(550/27/1258). Of the schools who agreed to participate, teachers were 
asked to identify children who 1) were in their first three years of primary 
schooling; 2) spoke English as their first language; 3) were progressing 
normally at school; and 4) had no history of speech and/or language 
impairments. Consent forms were sent home to these children via the 
teachers. From the children for whom consent to participate was obtained, 
participants were randomly selected, making sure there was an equal 
distribution of girls and boys, and an equal number of participants across 
the three grades. A total of 127 children participated in this study, from 
Grade 0 (n = 44), Grade 1 (41), and Grade 2 (n = 42). These children were 
from the following ethnic backgrounds, as indicated by their parents on the 
project consent forms: Australian (85.5%), Aboriginal and Torres Strait 
Islander (3.9%), Pacific Island (.8%), Other (3.1%), and Non-specified (6.3%). 
 

Other criteria 
 

The therapists and educators involved in the project were trained by one of 
the researchers on the assessment procedures and language sampling 
protocol. Each child was seen individually in the child's school setting. 
Children's language samples were excluded from the database for reasons 
such as poor recording quality, not engaging in the task (i.e., unwilling to 
retell the story), or not able to retell the story without using the pictures in 
the book as a visual prompts. 
 

Elicitation Procedures – Subgroup AGL 
  

The child was required to listen to two audio-recordings of an unfamiliar 
story (while looking at pictures in the story book). Following the second 
listening of the story the child was asked to retell the story without the use 



 Appendix L  ●   New Zealand – Australia Databases   343 

 

 

of the pictures. The child listened to an English translation of the story "Ko 
au na galo"; Ana Gets Lost (Swan, 1992). The story is about a Pacific Islands 
girl who gets lost in the city while looking for her mum and dad. It is a 10-
page 'reader' (of the type typically used in New Zealand Year 1 and 2 
classrooms) with colored pictures and Tokelauan text. The story was 
selected for several reasons: The story has not been published in English, 
which minimized the chances of children being familiar with the book. 
Presenting text in an unknown language also prevented the children reading 
the text while they heard the story and thus removed any reading 
advantage. Having a text written in another language also provided a 
convincing reason for listening carefully to the recording of the English 
version of the text. Further, children from different cultures living in New 
Zealand or Australia were expected to be familiar with the story content and 
vocabulary translation, such as 'policeman', 'beach', and 'dairy'. The original 
translation of "Ko au na galo" was adapted to add a little further length and 
complexity to the story. 
 

Protocol – Subgroup AGL 
 
Prompt: “I brought a book to show you. We can't read this book as it is 
written in another language, but I have the story on tape, in English. Let's 
listen to the tape. I will ask you some questions about the story afterwards”. 

 
Ana Gets Lost Story 
One Saturday morning, Ana's mum and dad went fishing on the beach. 
Ana had been sick all week, so she had to stay at home with her big brother, 
Tom. 
She asked Tom if he wanted to play with her. 
No thanks, he said, I want to read a Sports Magazine. 
 

Ana got bored. 
So when Tom fell asleep, she decided to go looking for her mum and dad. 
She quietly opened the front door and went outside. 
 

Ana walked towards the beach, but she got lost. 
She kept walking until it got dark. 
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Ana got very scared and she started to cry. 
She stopped outside a dairy. 
 

She was still crying and didn't know what to do. 
Then Ana felt a pat on her shoulder. 
She looked around and saw a policeman. 
Hello, he said, are you Ana? 
Yes, said Ana, giving him a big smile. 
 

The policeman took Ana home in the police car. 
Mum and Dad were very happy to see Ana. 
They thanked the policeman for finding Ana, and bringing her home safely. 
The policeman told Ana not to get lost again. 
Then he smiled and drove away. 
 

Oral Narrative Comprehension (ONC) 
 
Following the first listening of the story, the child was asked eight questions 
about the story, to evaluate story comprehension. Four questions tapped 
factual comprehension (1,4,6,7) and four questions required inferential 
comprehension (2,3,5,8).  
 
To reduce the influence of story comprehension on individual children's 
retelling performance, all children were provided with the correct 
information if they did not respond to the question or if their answer was 
clearly incorrect. 

 
To reduce the influence of story comprehension on individual children's 
retelling performance, all children are provided with the correct information 
after answering the questions. It is essential that children listen to the story 
twice before attempting to retell the story. Instead of listening to the tape 
twice in a row, either the personal narrative section could be administered 
or a different activity of approximately 10-minute duration could be 
introduced. 
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Questions Correct Incorrect 
No 

response 
Comment 

 I F    

Who is the story 
about? 

 1 0 NR  

Why did Ana have 
to stay at home? 

1  0 NR  

Why did Ana get 
bored? 

1  0 NR  

Where did Ana go 
to find her parents? 

 1 0 NR  

Why did Ana get 
scared? 

1  0 NR  

Who found Ana?  1 0 NR  

What did the 
policeman do? 

 1 0 NR  

Why were Ana's 
parents happy to 
see her? 

1  0 NR  

TOTAL CORRECT /4 /4    

 
Following the second listening of the story the child was asked to retell the 
story without the use of the pictures. 

 
Prompt: “Let's listen to the story a second time. Afterwards we will put a 
new tape in the recorder and then I would like you to tell the story, so that 
other children can listen to it later”. 
 
Listen to the story together. Put the book aside before asking the child to 
tell the story. 
 
Prompt: “OK, now it's your turn to tell the story. Let's start at the 
beginning”.  
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If the child does not start telling the story spontaneously, one or two of the 
following prompts can be used: 

“What was the story about?” 
“What happened in the beginning?” 
“Just use your own words”. 
“Just tell me what you remember”. 

 
The following prompts are used to encourage the child to continue telling 
the story: 

“And then?” 
“Anything else you can remember?” 

 

Elicitation Procedures – Subgroup BUS 
 

The Bus Story (Renfrew, 1995) was administered using the standard 
elicitation guidelines as reported in the manual. In this task, the examiner 
reads the story, while the child follows along with the pictures in a wordless 
book (four pages containing three pictures each). After listening to the 
story, the child is asked “Now you tell me the story. Once upon a time, there 
was a ...?” (p. 5). Following the administration guidelines, only minimal or 
indirect prompts should be given, when needed. For example “and then?” 
or “so...?”. The model story contains: 15 utterances (UTT), MLU: 12.4, 
number of different words (NDW): 102, and clausal density (CD; total 
number of clauses divided by the number of utterances): 1.6. Refer to 
Westerveld and Vidler (2015) for more information. 

 

Transcription Notes 
 

The utterances were segmented into C-units. A C-unit includes an 
independent clause with its modifiers (See Appendix N). All transcripts were 
timed and pauses, within and between utterances, of two or more seconds 
in length, were marked. Age and gender information is included for all 
participants.  
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The following types of utterances were excluded from analysis by inserting 
an equal ( = ) sign in front of the utterance: 1) official title, e.g., “Ana Gets 
Lost”, 2) comments unrelated to the story, e.g., child comments on 
someone entering the room, 3) official ending, e.g., The end.  
 

Coding Notes 
• [EO:word] marks overgeneralization error 

• [EP:word] marks pronoun error 

• [EW] marks an extraneous or unnecessary word in the utterance that, if 
omitted, would make the utterance syntactically correct, e.g., C And he 
shout/ed and[EW] to the frog. 

• [EW:word] marks other word-level error 

• [EU] marks utterance-level error (also marks utterances with 3 or more 
errors) 

• [NGA] marks an utterance that is 'not grammatically accurate'  
 
All New Zealand samples contained the following plus lines: 
          + Context: Nar 
          + Subgroup: AGL 
          + Ethnicity: Maori  (only included for Maori subset) 
 
All Australian samples contained the following plus lines: 
          + Context: Nar 
          + Subgroup: AGL or BUS 
 

Special Coding 
 
The AGL samples were coded for Oral Narrative Comprehension (ONC) and 
Oral Narrative Quality (ONQ).  
 

• ONC - Following the first listening of the story, the child was asked eight 

questions about the story, to evaluate story comprehension. Four 

questions tapped factual comprehension (1,4,6,7) and four questions 

required inferential comprehension (2,3,5,8). The questions are listed in 

the previous section describing the elicitation process. 
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Storing the ONC Score Within the SALT Transcript 
 

The ONC score was stored in all the AGL samples in the database. The 
plus line, + ONC:, was inserted at the end of each sample. You can add 
this plus line with the Edit menu: Insert Template → Oral Narrative 
Comprehension (AGL) option. The coder assigned the ONC score. The 
following is an example of the plus line inserted at the end of each 
transcript: 

+ ONC: 6 
 
Reporting the ONC score 
 

The Standard Measures Report, selected from the Analyze menu, 
includes the ONC score. The Standard Measures Report, selected from 
the Database menu, includes the ONC score for your transcript and, if 
available, for the selected database samples. 
 

• ONQ – The ONQ assesses the quality and content of the narrative and is 
designed for AGL, Bus, and NZPN narratives. It is scored using a 0 - 5 
point scale for each of eight categories. Five (5) points are given for 
“proficient” use, 3 points for “emerging” or “inconsistent” use, and 1 
point for “minimal or “immature” use. An overall score of zero (0) is 
given if the story is not the same as the original at all. The ONQ rubric 
for AGL is provided in Appendix S. 
 
Storing the ONQ Scores Within the SALT Transcript 

 

Scores for each of the eight ONQ categories are inserted on plus lines at 
the end of the transcript. You can add these plus lines with the Edit 
menu: Insert Template → Oral Narrative Quality (AGL) option. The coder 
assigned the ONQ scores. The following is an example of the plus lines 
inserted at the end of each transcript: 

= Oral Narrative Quality 
+ Introduction: 2 
+ Theme: 3 
+ MainChar: 2 
+ SuppChar: 4 
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+ Conflict: 5 
+ Coherence: 2 
+ Resolution: 3 
+ Conclusion: 0   

 
Reporting the ONQ scores 

 

The SALT program summarizes these scores and calculates a total. You 
can then compare these scores to typical peer performance using the 
Database menu or view independently using the Analyze menu. You can 
also compare with a linked transcript to show intervention progress or 
language differences. This measure is key to understanding overall 
narrative performance. The Standard Measures Report, selected from 
the Analyze menu, includes the ONQ composite score (sum of the 
individual scores). The Oral Narrative Quality report selected from the 
Analyze menu lists the individual scores and the composite score. The 
Standard Measures Report, selected from the Database menu, includes 
the ONQ composite score for your transcript and, if available, for the 
selected database samples. The Oral Narrative Quality report selected 
from the Database menu lists the individual scores and the composite 
score for your transcript and, if available, for the selected database 
samples. 
 
ONQ for AGL, Bus, and NZPN narratives only 
 

The menu options in SALT are not available if the +Context line indicates 
that the transcript is conversation, expository, or persuasion or if the 
+Subgroup line does not contain AGL, Bus, or NZPN. 

 

Database Location and Ethnicity Selection Options 
 

This database was created with two location options (New Zealand and 
Australia) and one ethnicity option (Maori). A language sample taken from a 
child can be compared against this population distribution as a whole or 
against a subset selected by location and/or including Maori (New Zealand) 
children only. 
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Using SALT to Compare Samples to the NZ-AU Story Retell Database 

Use SALT’s Database menu to compare your sample with age or grade-
matched samples selected from the database. SALT looks at the “+ Context” 
and “+ Subgroup” plus lines in your transcript to determine which database 
to pre-select. To pre-select the NZ-AU Story Retell database, include the 
following plus lines in your transcript: 

+ Context: Nar  
+ Subgroup: AGL or BUS 

 
Although you can type these plus lines into your transcript, the easiest way 
is to select the correct sampling context (Nar) and subgroup (AGL or BUS) 
when first creating a new transcript using the New Transcript Header 
information dialogue box. 
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3. New Zealand – Australia Personal Narrative Database 
 

Database 
Context 
(Subgroup) 

Age Range 
# 

Samples 
Location 

NZ-AU 
Personal Narrative 

Nar (NZPN) 
NZ: 4;5 - 7;7 
AU: 5;5 - 8;4 

NZ: 228 
AU: 127 

New Zealand 
Australia 

 

Participants and General Description  
 

This database contains oral language samples collected from New Zealand 
children, aged 4;5 – 7;7, and from Australian children, aged 5;5 - 8;4. The 
language samples were collected from the participants in a personal 
narrative context (relating a personal experience). 
  
The New Zealand data were collected in 2000/2001. The children were 
randomly selected from schools in Auckland, Hamilton, and Christchurch 
(major urban areas in New Zealand) as well as secondary urban areas 
surrounding Christchurch. Approximately 80% of the participants were from 
the Auckland/Hamilton region to reflect New Zealand's population density 
in these areas. Children with diagnosed disabilities were excluded from the 
sample. The schools reflected a range of socio-economic areas and English 
was the first language of all children included in the database. There was an 
even gender distribution. The ethnicity of the group comprised of the 
following: New Zealand European 62%, Maori 22%, Pacific Island 5%, Asian 
3%, Other 8%. 
  
The Australian data were collected in 2012 from 127 children (aged 5;5 to 
8;4) attending the first three years of primary school: Grade 0 (Prep or 
Foundation, n = 44), Grade 1 (n = 41), or Grade 2 (n = 42) across Queensland 
(regional: 55, city: 72), representing the full range of socio-economic areas 
(1 – 10). There were 64 (50.4%) girls and 63 boys (49.6%). Of the schools 
who agreed to participate, teachers were asked to identify children who 1) 
spoke English as their first language; 2) were progressing normally at school; 
and 3) had no history of speech and/or language impairments. Consent 
forms were sent home to these children via the teachers. From the children 
for whom consent to participate was obtained, participants were randomly 
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selected, making sure there was an equal distribution of girls and boys. 
Children were from Australian (85.2%), Aboriginal and Torres Strait Islander 
(4.0%), Pacific Island (0.8%), Other (3.2%), or Non-specified (6.4%) ethnic 
backgrounds, as indicated by their parents on the project consent forms. 
 
The speech-language therapists involved in the project were trained by one 
of the researchers on the assessment procedures and language sampling 
protocol. Each child was seen individually in the child's school setting. 
Children's language samples were also excluded from the database for 
reasons such as poor recording quality and not engaging in the task (i.e., not 
giving any personal narratives). 

 
Elicitation Procedures 
 
The personal narrative protocol was adapted from a conversational 
technique developed by Peterson and McCabe (1983), called the 
Conversational Map. In adapting this technique, the examiner related a brief 
personal experience related to a photo prompt in order to encourage the 
child to share one of his or her personal experiences. A pocketsize photo 
album with a series of carefully selected photos was used for the stimulus 
items. Each photo was presented individually in separate sleeves of the 
photo album. The examiner provided a short prompting narrative with each 
photo followed by the question "Did anything like that ever happen to 
you?". If the child responded "no", the examiner turned the page of the 
photo album to the next photo. If the child responded "yes", a follow-up 
question was asked "Can you tell me about it?". The aim is to elicit at least 3 
narratives and 50 C&I utterances. 
 

Protocol 
 
Prompt: “I brought some photos to show you”. Talk about the photos as 
outlined below. If the child responds “no”, go to the next photo. If the child 
says “yes”, ask him/her “Can you tell me about it?” 
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Prompts  

Oh look who's this? (Ronald McDonald). I went to a birthday 
party at McDonald's last year. Have you ever been to 
McDonald's? 

Yes    No 

We went to the beach in the holidays. These children dug a big 
hole in the sand and waited for the sea to fill it up. Have you 
been to the beach? What happened last time you went to the 
beach. 

Yes    No 

This little girl had to go to the Doctor, cause she had a bad 
cough. Have you ever been to the Doctor's? 

Yes    No 

These friends are watching somebody arriving on a big plane. 
Have you ever been on a plane? Have you ever been out to the 
airport to watch the planes? 

Yes    No 

Oh look, this girl fell off the bars and hurt her knee. She had to 
go to the sick-bay and they put a plaster on. Have you ever 
broken anything? Did you ever hurt yourself in the playground? 

Yes    No 

These children went on a school-trip. They all went on a bus to 
Motat. (a museum with lots of old cars). Have you ever been on 
a school-trip? 

Yes    No 

Can you see the bee on the flower? I got stung by a bee once. On 
my big toe! Did a bee ever sting you? 

Yes    No 

Look, this is Santa. He visited my daughter's school in a fire 
engine. Has Santa ever been to your school? Have you ever seen 
Santa anywhere? 

Yes    No 

The dental nurse visited my daughter's school last year. All the 
children had to go for a check-up. Have you ever had a tooth-
ache? Have you ever been to the dental nurse? 

Yes    No 

Look, there's my daughter/niece/nephew ………He/ she was in a 
play at her school. They did the pied piper. All the children had 
to dress up and perform in the school hall. Have you ever been 
in a play? Have you ever seen a play? 

Yes    No 

We went to the movies in the holidays. Have you ever been to 
the Movies? Which one did you go to? 

Yes    No 
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To encourage the child to continue a personal narrative, the examiner can 
respond to the child's narrative by: 

• Repeating the exact words of the children when they pause 

• Using relatively neutral sub-prompts, such as "uh-huh" 

• Saying "tell me more" 

• Asking "and then what happened?" 
 
It is very important that the examiner does NOT evaluate the child's 
narrative. This gives the children the opportunity to demonstrate what they 
can do on their own. 
 

Transcription Notes 
 

The utterances were segmented into C-units which includes an independent 
clause with its modifiers (see Appendix N). All transcripts were timed, and 
pauses, within and between utterances, of two or more seconds in length, 
were marked. Age and gender information is included for all participants.  
 
The prompts were transcribed from (and including) the examiner's question 
that leads to a "yes" response from the child. For example, with the first 
prompt (McDonald's), only transcribe the underlined italicized utterances: 
 

Oh look who's this? I went to a birthday party at McDonald's last year. Have 
you ever been to McDonald’s? Child responds Yes or {Nods}. What 
happened last time you went to McDonald’s?  
 
The following plus lines were inserted as part of the header information: 
    + Context: Nar 
    + Subgroup: NZPN 
    + Ethnicity: Maori (only included for Maori subset) 
 
This database was created with two location options (New Zealand and 
Australia) and one ethnicity option (Maori). A language sample taken from a 
child can be compared against this population distribution as a whole or 
against a subset selected by location and/or including Maori (New Zealand) 
children only. 
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Coding Notes 
• [EO:word] marks overgeneralization error 

• [EP:word] marks pronoun error 

• [EW] marks an extraneous or unnecessary word in the utterance that, if 
omitted, would make the utterance syntactically correct, e.g., C And he 
shout/ed and[EW] to the frog. 

• [EW:word] marks other word-level error 

• [EU] marks utterance-level error (also marks utterances with 3 or more 
errors) 

• [FP] marks filled pause words such as like, e.g., You (like[FP]) get six 
card/s. 

 
Subordination Index (SI) Coding - Australia 
 
SI coding was applied to the samples from Australia only. SI is a measure of 
syntactic complexity which produces a ratio of the total number of clauses 
(main and subordinate clauses) to the number of C-units (see Appendix O).  

 
Using SALT to Compare Samples to the NZ–AU Personal Narrative 
Database 
 
Use SALT’s Database menu to compare your sample with age or grade-
matched samples selected from the database.  SALT looks at the “+ Context” 
and “+ Subgroup” plus lines in your transcript to determine which database 
to pre-select. To pre-select the NZ-AU Personal Narrative database, include 
the following plus lines in your transcript: 
 

+ Context: Nar 
+ Subgroup: NZPN 

+ Ethnicity: Maori (if comparing with Maori subset) 
 

Although you can type these plus lines into your transcript, the easiest way 
is to select the correct sampling context (Nar) and subgroup (NZPN) when 
first creating a new transcript (by completing the New Transcript Header 
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information dialogue box). Select the “NZ-AU Personal Narrative.sltdb” by 
clicking the browse button to select the database for comparison in the 
right lower corner of the dialogue box. 
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Protocol and Photos to Elicit Personal Narratives 
 

You can download the photos used to elicit the samples from the SALT web 
site at www.saltsoftware.com/resources/databases. The link to download 
the photos is in the text describing the NZ-AU Personal Narratives database. 
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4. New Zealand – Australia Expository Database 
 

Database 
Context 
(Subgroup) 

Age Range 
# 

Samples 
Location 

NZ-AU 
Expository 

Expo 
NZ: 6;1 - 7;11 
AU: 7;4 - 8;4 

NZ: 65 
AU: 42 

New Zealand 
Australia 

 

Participants and General Description  
 

A total of 65 six- and seven-year-old participants were recruited from three 
primary schools located in suburban Auckland, New Zealand (NZ). The 
schools were awarded mid socio-economic status based on the Ministry of 
Education ranking system. These children had no known history of hearing 
disorder, neurological disorder, or speech-language therapy, spoke English 
as their first language, and were progressing normally at school. The group 
consisted of 37 girls and 28 boys from NZ European (74%), Maori (14%), 
Pasifika (8%), and Other (4%) ethnic backgrounds. 
 
A second set of data was collected in 2013 from 42 children aged 7;5 to 8;4 
who attended Year 2 (year of schooling 3) of their local primary school in 
Queensland, Australia. Ethics approval for this project was granted by the 
University Human Ethics Committee (PES/31/12/HREC). Approval was also 
granted by the Department of Education and Training, Queensland 
Government (550/27/1258). The schools reflected the full range of socio-
economic areas. Of the schools who agreed to participate, teachers were 
asked to identify children who 1) spoke English as their first language; 2) 
were progressing normally at school; and 3) had no history of speech and/ 
or language impairments. Consent forms were sent home to these children 
via the teachers, and from the children for whom consent to participate was 
obtained, participants were randomly selected, making sure there was an 
equal distribution of girls and boys. The group consisted of 19 girls and 23 
boys, from Australian (90.5%), Aboriginal and Torres Strait Islander (2.4 %), 
or Non-specified (7.1%) ethnic backgrounds. 
 
This database was created with two options. A language sample taken from 
a child can be compared against this population distribution as a whole or 
against a database including NZ or AU children only. 



358  Assessing Language Production Using SALT Software  

 

 

Elicitation Procedures 
 

Expository language generation samples were elicited using the Favorite 
Game or Sports (FGS) task, developed by Nippold, et al. (2005). In this task, 
the examiner carefully follows a script. First, the child is asked what his or 
her favorite game or sport is and why. The examiner then asks the child to 
explain the game or sport, using the pragmatically felicitous prompt "I am 
not too familiar with the game of [..]". Finally, the child is asked what a 
player should do to win a game of [..]. The child should be allowed as much 
time as necessary to finish the explanation. The examiner needs to make 
sure to show interest in the child's explanation and only use neutral 
responses as needed to encourage the child to continue. 
 

Favorite Game or Sport (FGS) Task Protocol 
 

This task was developed by Nippold, et al. (2005). 
To elicit the sample, the examiner reads out the following script: 
 
I am hoping to learn what people of different ages know about certain 
topics.  
1. What is your favorite game or sport?  
2. Why is [chess, soccer, etc.] your favorite game/sport? 
3. I’m not too familiar with the game of (chess), so I would like you to tell 

me all about it. For example, tell me what the goals are, and how many 
people may play a game. Also, tell me about the rules the players need 
to follow. Tell me everything you can think of about the game of (chess) 
so that someone who has never played it before will know how to play. 

4. Now I would like you to tell me what a player should do in order to win 
the game of (chess). In other words, what are some key strategies that 
every good player should know?  

 

Following each prompt, the interviewer pauses, displays interest in the 
response, and allows the child as much time as necessary to complete the 
response. If the child fails to address a question or requests for the 
question to be repeated, the interviewer is allowed to ask the question 
again.  
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Transcription Notes 
 

The utterances were segmented into Communication Units (C-units). A 
C-unit includes an independent clause with its modifiers (Loban, 1976). 
Utterances that did not contain a subject and a predicate were coded as 
fragments, i.e., [FRG] code inserted at the end of these utterances, so they 
could be easily excluded from analysis. The transcripts begin with the 
student's first utterance which pertains to the child's answer to the question 
what his or her favorite game or sport is. All transcripts were timed and 
pauses, within and between utterances, of two or more seconds in length, 
were marked. 
 

Coding Notes 
• [EO:word] marks overgeneralization error 

• [EP:word] marks pronoun error 

• [EW] marks an extraneous or unnecessary word in the utterance that, if 
omitted, would make the utterance syntactically correct 

• [EW:word] marks other word-level error 

• [EU] marks utterance-level error (also marks utterances with 3 or more 
errors) 

• [FP] marks filled pause words such as like, e.g., You (like[FP]) get six 
card/s. 

• [FRG] marks utterance fragments 

• [NGA] marks utterances that are 'not grammatically accurate'  
 

• All Australian samples were also coded for dependent clauses [D].  
The following three types of dependent clauses were identified and coded: 

• Adverbial clauses [AVC] begin with a subordinating conjunction. 
Examples include: 
And if they get the highest number [AVC] when the game's finished 

[AVC], they win [IC]. 
And then once you've done that [AVC] (um) we pull out the blue mats 

and the (o* other k*) white mat [IC]. 
And if you remember that [AVC] and you don't get hit [AVC] you win the 

game [IC]. 
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• Relative clauses [RC] describe a noun and generally immediately follow 
the noun they describe. Examples include: 
But we (like) have to hit the person [IC] who's (um) doing that [RC]. 
And he brings me to all the games [IC] that I can go to [RC]. 
And you've got lines [IC] where you're allowed to go up to [RC]. 

• Nominal clauses name persons, places, things or ideas. These clauses 
often answer the question ‘what’? Examples include: 
And whoever grabs the ball (um) [NOM] they (um) get to start with the 

ball in centre [IC]. 
And that's [IC] how they lose the game sometimes [Nom]. 
And whoever finishes all their beads [NOM] wins [IC]. 

Using SALT to Compare Samples to the NZ-AU Expository Database 

Use SALT’s Database menu to compare your sample with age or grade-
matched samples selected from the NZ-AU Expository database.  SALT looks 
at the “+ Context” plus line in your transcript to determine which database 
to pre-select. To pre-select the NZ-AU Expository database, include the 
following plus lines in your transcript: 

+ Context: Expo 
  

When first creating a new transcript using the New Transcript Header 
information dialogue box:  

• Click on the “browse” button in the lower right corner of the dialogue 
box to select database for comparison 

• select NZ-AU Expository.sltdb  
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5. Australia – United States Persuasion Database 
 

Database 
Context 
(Subgroup) 

Age Range # Samples Location 
Special 
Coding 

AU - USA 
Persuasion 

Pers 
AU: 12;10 - 18;4 
USA: 14;8 - 18;9 

AU: 66 
USA: 113 

Australia 
USA 

SI, PSS 

 

The AU-USA Persuasion database contains the same samples as the 
Persuasion database (see Appendix F). The only difference is that the 
samples stored in the AU-USA Persuasion database do not contain +Grade 
(grade in school) information. 
 
Refer to Appendix F for a full description of this database. 



 

 



 

 

APPENDIX 

M 
 

Summary of SALT Transcription Conventions  
 

1. Transcript Format. Each entry begins with one of the following symbols. If an entry is longer 
than one line, continue it on the next line. 
$ Identifies the speakers in the transcript; always the first line of the transcript.  

Example:  $ Child, Examiner 
C Child/Client utterance. The actual character used depends on the $ speaker line. 
E Examiner utterance. The actual character used depends on the $ speaker line. 
+  Header information such as name, age, context, codes used in sample (e.g., + CA: 5;7). 

Also used for inserting test scores. 
-  Time marker. Example of two-minute marker:  - 2:00 
: Pause between utterances of different speakers.  

Example of five-second pause:   : :05  or  :05 
; Pause between utterances of same speaker.  

Example of three-second pause:   ; :03  or  ;03 
= Comment line. Information used for transcriber comments - not analyzed in any way. 

 

2. End of Utterance Punctuation. Every utterance must end with one of these six punctuation 
symbols. 
. Statement, comment. Do not use a period for abbreviations. 
! Surprise, exclamation. 
? Question. 
~ Intonation prompt. 

Example: E And then you have to~ 
^  Interrupted utterance. The speaker is interrupted and does not complete the 

thought/utterance. 
>  Abandoned utterance. The speaker does not complete the thought/utterance but has not 

been interrupted.  
 

3. { } Comments within an utterance.  
Example:  C  Lookit {C points to box}.  
Nonverbal utterances with communicative intent are placed in braces. Example: C  {nods}. 
  

4. Unintelligible Segments. X is used to mark unintelligible sections of an utterance. Use X for an 
unintelligible word, XX for an unintelligible segment of unspecified length, and XXX for an 
unintelligible utterance. 
Example 1:  C  They went X X park.  Example 2:  C  He XX today. Example 3:  C  XXX. 
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5. Bound Morphemes. Words which contain a slash “/” indicate that the word is inflected or 
contracted in a regular manner. The root word is entered in its base spelling followed by a 
slash “/” and then the bound morpheme. See the section at end of this appendix explaining 
the rationale behind marking bound morphemes. 
English and Spanish 
/S Plural. Examples: kitten/s, baby/s, rana/s, flor/s. 
 Do not mark words that end in “s” but represent one entity (e.g., pants, binoculars). 
 Do not mark irregular forms (e.g., mice, geese, deer) or when the sound of the root 

changes (e.g., leaves, wolves).  
English only 
/Z Possessive inflection. Examples: dad/z, Mary/z 
 Do not mark any possessive pronouns (e.g., mine, his, hers, ours, yours, its, theirs). 
/S/Z Plural and Possessive. Example: baby/s/z 
/3S 3rd Person Singular verb form. Examples: go/3s, tell/3s, try/3s 
 Do not mark irregular forms (e.g., has, was) or when the sound of the root changes 

(e.g., do→does, say→says). 
/ED Past tense. Examples: love/ed, die/ed 
 Do not mark irregular forms (e.g., did, grew, had, sank) or predicate adjectives (e.g., 

was tired, are bored, got fixed).  
 Transcription hint: regular past tense /ED verbs never follow a BE or GET verb. 
/EN Past participle. Examples: take/en, eat/en, prove/en 
 Do not mark irregular forms (e.g., gotten, spoken, seen, been) or when the sound of 

the root changes (e.g., write→written). 
 Transcription hint: Regular form: present tense + EN as separate syllable. /EN verbs 

always follow HAVE, HAS, or HAD. 
/ING Progressive verb form. Examples: go/ing, run/ing, bike/ing 
 Do not mark the gerund use of the verb form (e.g., went swimming, reading is fun). 
/N'T, /'T Negative contractions. Examples: can/'t, does/n't 
 Do not mark irregular forms (e.g., won't) or when the sound of the root changes (e.g., 

do→don’t). 
/'LL, /'M, /'D, /'RE, /'S, /'VE    Contracted  → WILL, AM, WOULD, ARE, IS, HAVE 
 Examples:  I/'ll, I/'m, I/'d, we/'re, he/'s, we/'ve 
/H’S, /H’D, /D’S, /D’D, /’US    Contracted  → HAS, HAD, DOES, DID, US 
 Examples:  He/h’s been sick.  We/h’d better go.  What/d’s he do for a living?  Why/d’d 

the boy look there?  Let/’us go. 
 

6. Bound Pronominal Clitics (Spanish only). Pronominal clitics may be either bound or unbound. 
When bound, they are preceded by a plus sign. Examples:  gritándo+le, déja+lo, dá+me+lo 

   
7. Mazes. Filled pauses, false starts, repetitions, and reformulations. 

( ) Surrounds the words/part-words that fall into these categories. Combine adjacent 
mazes.  Example:  C  And (then um) then (h*) he left. 
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8. Omissions. Partial words, omitted words, omitted bound morphemes, and omitted pronominal 
clitics are denoted by an asterisk (*). 
*  Following one or more letters indicates that a word was started but left unfinished.  

Example: C  I (w* w*) want it. 
*  Preceding a word indicates that an obligatory word was omitted.  
 Example: C  Give it *to me. 
/* Following a slash the * is followed by the obligatory bound morpheme which was 

omitted.  Example: C  The car go/*3s fast. 
+* Following a plus sign the * is followed by the obligatory Spanish pronominal clitic which 

was omitted.  Example: C  Él está gritándo+*le a la rana. 
   

9. Overlapping Speech. When two speakers are speaking at the same time, the words which occur 
at the same time are surrounded by angle brackets < >. 

 Example: C  Can I have that <one>? 
 E  <Uhhuh>. 
When one speaker interjects in the middle of another speaker’s utterance, use empty angle 
brackets to indicate the position of the interjection.  
Example: C  I want you to do it < > for me. 

 E  <Ok>.  
   

10. Linked words. The underscore “_” is used to link multiple words so they are treated as a single 
word. Uses include: 
Titles of movies and books. 
Examples: Beauty_and_the_Beast, Frog_Where_Are_You 
Proper names. 
Examples: Mrs_Jones, Sr_Rojas 
Words or phrases repeated multiple times. 
Example: He ran ran_ran|ran as fast as he could. 

   

11. Root identification. The vertical bar “|” is used to identify the root word. 
Overgeneralization errors.   

Example:  C  He goed|go[EO:went] to the park by himself.  
Linked words repeated for emphasis.   

Examples: C  The boy ran very very_very|very fast.  
 C  Dijeron rana rana_rana|rana dónde estás. 

Spanish only: Inflected word forms.   
Example:  C  Había|haber una vez un niño que tenía|tener una rana. 

Spanish only: Diminutives.   
Example: C  El perrito|perro tumbó|tumbar las abeja/s. 

English only: Root form of irregular verbs.  
Note that the root forms of irregular verbs are not identified in any of the SALT reference 
databases. 
Example: C  The bird flew|fly/ed away. 
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12. Sound Effects and Idiosyncratic Forms %. The percent sign is used to identify sound effects 
which are essential to the meaning or structure of the utterance. Non-essential sound effects 
are entered as comments. Strings of the same sound are linked together. 

Example 1:  C  The dog went %woof_woof. 
Example 2:  C  The dog barked {woof woof}. 

The percent sign is also used to identify idiosyncratic forms. These are immature productions 
which are consistent in reference to an object, person, or situation. 

Example 1:  C  See %vroom {car}. 
Example 2:  C  My %coopa {cookie}. 

   
13. Spelling Conventions. 

• Abbreviations: Periods are not legal word characters. Abbreviated words should either be 
written out or left as an abbreviation but without the period. Examples: Mr, Mister, Mrs, Dr, 
Sra, Señora 

• Filled pause words:  AH, EH, ER, HM, HMM, UH, UM, MM, and any word with the code [FP]  

• Yes words:  OK, AHA, MHM, UHHUH (English & Spanish) 
 YEAH, YEP, YES (English only) 
 SÍ (Spanish only) 

• No words: NO, AHAH, MHMH, UHUH (English & Spanish) 
 NAH, NOPE (English only)   

• Hyphenated words follow standard spelling conventions. Examples: mother-in-law, pick-
me-up, good-hearted, twenty-five 

• Numbers (examples): twenty-one or 21; dieci-siete or 17  (choose a format and be 
consistent) 

• Clock time: Do not use colons when typing clock time because it will be interpreted as a 
pause. Type out the words connected with an underscore character. Examples: 
eight_thirty, la_una_treinta 

• Counting and “spelled” words use the underscore character to connect the numbers or 
letters. 

 Examples: 1_2_3_4_5,  C_A_T 

• Shortened words: Either use the vertical bar to identify the word or use the full word. In 
the following example, the speaker said “cuz”. No matter which format you use, the word 
root in this example is analyzed as “because”. 

Example: C  He was sad cuz|because they left. 
 C  He was sad because they left. 

• English concatenatives: 
 BETCHA (bet you) LOOKIT (look at it) TRYNTA (trying to)  
 COULDA (could have) MUSTA (must have) USETA (used to)  
 GONNA (going to) OUGHTA (ought to) WANNA (want to)  
 GOTTA (got to) OUTTA (out of) WHATCHA (what are you)  
 HAFTA (have to) SHOULDA (should have) WOULDA (would have) 
 LIKETA (like to) SPOSTA (supposed to) 
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• Sounds with specific meanings: 
HMM, HUH (question or affirmation), IDK (intoned I don’t know), UHOH (something is 
wrong), SHH or %SHH (be quiet), PSST, %PSST (to get someone’s attention) 

• Other English spellings: 
AIN'T, ALOT, ATTA, NOONE, OH, OOH, OOP, OOPS, OOPSY 

• Reflexive vs Non-reflexive pronouns (Spanish only): 
The following pronouns can be used both reflexively and non-reflexively:  ME, TE, SE, 
OS, NOS. Attach the code [X] when used reflexively.   
Examples: C  El niño se[X] fue con el perro.   
 C  El perro me ayudó a conseguir la rana. 

 
14. [ ] Codes. Codes are used to mark words or utterances. Codes are placed in brackets [ ] and 

cannot contain blank spaces. Codes used to mark words are inserted at the end of a word 
with no spaces between the code and the word. Codes used to mark utterances are inserted 
at the end of the utterance or at the position of the feature you wish to mark, separated by 
at least one space from adjacent word(s). 

 
a) Codes used to mark errors in the reference database samples: 

[EO:__] marks overgeneralization errors. C  He falled|fall[EO:fell]. 

[EP:__] marks pronoun errors. C  And them[EP:they] found the frog. 

[EW] marks extraneous words. C  He were[EW:was] look/ing. 

[EW:__] marks other word-level errors. C  And then the boy is a[EW] sleep/ing. 

[EU] marks utterance-level errors. C  And they came to stop/ed [EU]. 

[FP] marks non-standard filled pause words. C  The dog (um like[FP]) fell down. 

 
b) Other codes used in the Bilingual Spanish/English reference database samples: 

[F] marks fragments due to utterance 
segmentation in modified communication 
units. 

C  The gopher look/ed out of the hole. 
C  and bit the boy [F]. 

[CS] marks code-switched words. C  The dog fell from la[CS] ventana[CS]. 

[WO] marks utterances with non-standard 
word order. 

C  And then fell down the dog and the 
boy [WO]. 

[I] marks vocabulary provided by the 
examiner (imitated word). 

C  And the :05 <> owl[I] scare/ed him.  
E  <Owl>. 

[X] marks Spanish reflexive pronouns.  C  El niño se[X] fue con el perro. 
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Why do we mark some bound morphemes and 
not others?  
 

Originally posted as a SALT 
blog on December 11, 2018 

 
The SALT reference databases use a 
very specific set of conventions for 
marking bound morphemes. Our 
protocols do not represent the only 
way to mark morphemes but if you want to compare your sample against our 
databases, it is important for you to use these same conventions.  
 
If you aren’t interested in the nuts and bolts, just skip down to the “Summary” 
section. It’s the most condensed version of the SALT rules for marking bound 
morphemes that we can manage! 
 
The SALT rules for marking bound morphemes may seem obscure at first. But 
there is method to our madness. This blog explains the rationale behind SALT’s 
conventions for marking bound morphemes. It goes beyond, “because it’s been 
this way for a long time and here are the rules to memorize”. Or, a little more 
clinically, “because these are the developmental morphemes and here are the 
rules to memorize”. Our hope in writing this blog is that by understanding the 
“why” behind the conventions, the rules will make more sense and, hopefully, it 
will be easier to implement them. 
 
To a large extent, SALT’s convention for marking bound morphemes is 
patterned after the conventions used by Roger Brown (1973) in the calculation 
of MLUm (mean length of utterance in morphemes) back in the early days of 
language sample analysis.  
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Inflectional morphemes versus Derivational morphemes 
 

Many of the explanations and examples in this section are taken from the 
following websites: 

• https://semanticsmorphology.weebly.com/inflectional-and-derivational-
morphemes.html  

• http://www.mathcs.duq.edu/~packer/Courses/Psy598/Ling-Morphology.pdf 
 
Brown excluded derivational morphemes in the calculation of MLUm. To 
understand why, we first need to distinguish between the two types of bound 
morphemes – inflectional and derivational. 
 

• Inflectional morphemes are used to show some aspects of the grammatical 
function of a word. They are always suffixes and always result in the same 
part of speech. We use inflectional morphemes to indicate if a word is 
singular or plural, whether it is a comparative or possessive form, and to 
mark tense. Inflectional morphemes never change the grammatical 
category (part of speech) of a word. For example, shoe and shoes are both 
nouns, tall and taller are both adjectives, and look and looked are both verbs. 
The inflectional morphemes simply produce different versions of the words. 

 

There are eight inflectional morphemes. They are shown in the following 
table: 

 

 

Inflectional Morphemes Added to Example 

-s, -es plural nouns I have two black cats. 

-‘s, -s’ possessive nouns My dog’s bark is very loud. 

-er comparative adjectives I have longer hair than you do. 

-est superlative adjectives He has the biggest pumpkin. 

-s 3rd person singular verbs She runs fast. 

-ed past tense verbs He played basketball. 

-en past participle verbs She has eaten everything. 

-ing progressive tense verbs He is playing basketball. 

https://semanticsmorphology.weebly.com/inflectional-and-derivational-morphemes.html
https://semanticsmorphology.weebly.com/inflectional-and-derivational-morphemes.html
http://www.mathcs.duq.edu/~packer/Courses/Psy598/Ling-Morphology.pdf
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When children use inflectional morphemes, they are (generally) 
demonstrating their knowledge of the base word as well as their ability to 
encode the plural, possessive, or tense of that root word. 

 

• Derivational morphemes, in contrast, are used to create new words or to 
make words of a different grammatical class (part of speech) from the root 
form. For example, by adding the derivational morpheme -er the verb read 
becomes the noun reader. The addition of -ize changes the adjective normal 
to the verb normalize. Similarly, we can derive the adjectives helpful and 
helpless by adding -ful and -less to the noun help.  

 

However, some derivational morphemes do not change the grammatical 
category of a word but they do significantly change the meaning of the 
word. For example, we can derive the nouns neighborhood and kingdom by 
adding the derivational suffixes -hood and -dom to the nouns neighbor and 
king. And derivational prefixes such as un- and re- generally do not change 
the category of the word to which they are attached. Thus, both happy and 
unhappy are adjectives, and both fill and refill are verbs. But each of these 
pairs of words, although clearly related, have very different meanings. 
 

Derivational morphemes may be either suffixes or prefixes and usually, but 
not always, result in a different grammatical category. The following table 
lists some of the common derivational morphemes: 
 

Common Derivational 
Morphemes (Suffixes) 

Added to Results in Examples 

-ize 
nouns 
adjectives 

verbs 
verbs 

rubberize 
normalize 

-ful nouns adjectives 
playful, helpful, 
beautiful 

-ly 
nouns 
adjectives 

adjectives 
adverbs 

manly, friendly 
proudly 

-sion verbs nouns discussion 

-hood, -dom nouns <same> 
neighborhood, 
kingdom 
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Derivational suffixes which overlap with inflectional suffixes 
(though they serve a different purpose) 

-er 
verbs 
nouns/verbs 

nouns 
nouns 

reader 
grader 

-ed  verbs adjectives am tired, was bored 

-en verbs adjectives this spot is taken 

-ing 
nouns/verbs 
nouns/verbs 

nouns 
adjectives 

biking is fun 
interesting story 

 

Common Derivational 
Morphemes (Prefixes) 

Added to Results in Examples 

un-, a- 
dis-, re- 
anti- 

Adjectives 
verbs 
nouns 

<same> 

unhappy, atypical 
dislike, refill, 
reevaluate, review 
anti-aircraft 

 
According to Brown, young children generally do not learn a base word and 
then apply a derivational morpheme to encode extra information. Instead, 
they usually learn these as fully-formed, independent words with their own 
specific meaning. Although derivational morphemes can logically be split into 
a root word and a prefix or suffix, these smaller parts are not meaningful to 
the child speaker and so they should not be considered separate morphemes 
in this case. 

 

Guo, et al. (2018) gives evidence for this, including: 
 

• There is ample psycholinguistic evidence that base words and derived 
words (e.g., beauty, beautiful) are stored as separate lexical entries and 
should be given equal weight. 

• Children may learn a derived word (e.g., beautiful, interesting) before the 
base word (e.g., beauty, interest). It seems unlikely that children would 
add the derivational morphemes to these base words to form the derived 
words. Side note: to test this, we looked at samples from 355 typically-
developing children under the age of 7 taken from the SALT Play and 
Conversation databases. The derived word beautiful was used five times 
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while its base form beauty was only used once. And interesting was used 
twice and there were no instances of its base form interest. 

 

They consider that derivation is a word-formation process, not a grammatical 
encoding process. Therefore, derivation reflects a speaker’s lexical skills, not 
grammatical skills. 

 

So what are the rules behind the SALT conventions? 
 
RULE 1: Do not mark derivational morphemes. Do mark (most) inflectional 
morphemes. 
 

Why?  
In short, we want to mark bound morphemes when they reflect the child 
speaker’s understanding that the prefix/suffix has a meaning separate from 
the root word. When using derivational morphemes - learned as fully-
formed, independent words - a child speaker is only utilizing a single 
meaning. In contrast, when using an inflectional morpheme, the child is 
utilizing two meanings: the root word and the encoded 
plural/possessive/tense meaning. 
 

By not marking derivational morphemes, we do not give the speaker credit 
for bound morphemes which change the meaning of the word (e.g., happy 
→ unhappy) or change its grammatical category (e.g., friend → friendly).  
 

However, when the child speaker is likely to have understood the separate 
meanings of the bound morphemes, we do want to mark them. So we mark 
most inflectional morphemes. Most, but not all... 

 
RULE 1a: Do not mark the comparative (inflectional) morphemes -er and -est.  

 

Why not? 
Although -er and -est are inflectional morphemes, Brown did not count 
them because they are not obligatory. According to Guo, et al (2018), this 
means that it is a stylistic choice whether to use comparative and 
superlative form rather than the uninflected adjective. For instance, when 
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given a choice of several balls of varying sizes, a child may select the largest 
one and say, “I have the big one” unless prompted to make a comparison. 

 
RULE 1b: Do not mark irregular forms.  

 

Why not? 
Irregular forms are counted as single morphemes because children 
(generally) learn them as separate forms, rather than inflections of their 
base forms. 
 

The following table lists examples of irregular words: 
 

Category Examples of irregular words 

plural 
man → men, foot → feet, cactus → cacti, 
deer → deer 

all possessive pronouns 
I → mine, he → his, she → hers, we → ours,  
you → yours, it → its, they → theirs 

3rd person singular have → has, is → was 

past tense 
begin → began, break → broke, go → went, 
get → got 

past participle 
(regular form is present 
tense + EN as separate 
syllable) 

begin → begun, break → broken, go → gone, 
get → gotten, see → seen, be → been 

negation will → won’t 
 

Some words are irregular because the sound of the base form changes. 
These words follow the standard spelling for inflected or contracted words 
but change its sound. Some examples follow: 
 

Category Examples of changed sound 

plural leaf → leaves, wolf → wolves 

3rd person singular do → does, say → says 

past participle drive → driven, write → written 

negation do → don’t 
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RULE 1c: Do not mark plurals for words which do not have a singular form. 
 

Why not? 
Children would not have learned the singular form in order to then apply 
the rule for plurals. Following are some examples: 
 

Examples of Plurals Without a Singular Form 

belongings  
binoculars 
breeches 
clothes 
drawers 

glasses 
(spectacles) 
goggles  
jitters 
knickers 
pajamas 

pants 
panties 
remains 
riches 
shenanigans 

shorts 
suds 
tights 
trousers  
tweezers 

 
RULE 2: Do not mark concatenatives. 

 
Why not? 
Brown counted concatenatives as single morphemes because, like irregular 
forms, children may have stored them as holistic chunks. Following is a list 
of concatenatives: 
 

Examples of Concatenatives (meaning) 

betcha (bet you) lookit (look at it) trynta (trying to) 

coulda (could have) musta (must have) useta (used to) 

gonna (going to) oughta (ought to) wanna (want to) 

gotta (got to) outta (out of) whatcha (what are you) 

hafta (have to) shoulda (should have) woulda (would have) 

liketa (like to) sposta (supposed to)  

 
RULE 3: Mark contracted words.  

 

Why?  
Contractions combine two words into one (e.g., we are → we’re). The 
speaker is given credit for the same number of morphemes whether using 
two words or the one contracted word. 
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Contractions Examples 

-‘t 
-n’t 

negation 
I can’t leave yet. 
He doesn’t know better 

-‘s 

is 
has 
does 
us 

It’s time to go. 
He’s been sick. 
What’s he do for a living? 
Let’s go. 

-‘re are You’re late.  

-‘m am I’m ready to take the test. 

-‘ll will I’ll wait over here. 

-‘d 
would 
had 
did 

He’d do it. 
He’d better leave now. 
Why’d the boy look over there? 

-‘ve have We’ve a lot to do. 

 
 

Summary 
 

These rules can be summarized as: 
 

• Only mark the following inflectional morphemes and contractions. 
 

Inflectional Morphemes  Contractions 

/s plural /’t, /n’t negation 

/z possessive /’s, /’re, /’m is, are, am 

/3s 3rd person singular /’ll, /’d will, would 

/ed past tense /’ve, /h’s, /h’d have, has, had 

/en past participle /d’s, /d’d does, did 

/ing progressive tense /’us us 
 

• Do not mark irregular forms, concatenatives, or plurals which do not have a 
singular form. 
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Formatting Notes 
  

• Use a slash (/) for bound morphemes which follow the free morpheme 
(suffixes) and use a backslash (\) for bound morphemes which precede the 
free morpheme (prefixes). There should be no spaces between the free 
morpheme and the bound morpheme(s).  

• When the spelling of a free morpheme such as CRY changes with the 
addition of the bound morpheme, use the root spelling of the free 
morpheme (as if the bound morpheme is not there). Then, simply add the 
slash plus the bound morpheme (i.e. CRY/ED). If this is not done, the stem 
CRI will be treated as a different word from CRY and thereby inflate Type-
token ratio (TTR) as well as Number of Different Words (NDW). 

  

A Final Note 
 

While we feel that Roger Brown’s research published in 1973 has stood the test 
of time, we understand that it is not the only way to understand the use of 
morphemes or to calculate MLUm. If you have a language sample from which 
you want to compare the transcript with samples selected from the SALT 
reference databases, then these conventions are the most appropriate. 
However, these conventions may not be appropriate for all speakers or in all 
cases. 
 



 

 

APPENDIX 
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C-Unit Segmentation Rules   

 
The analysis of oral language samples requires recorded speech to be 
segmented or divided into units. There are a few different approaches to 
segmenting utterances, such as phonological units, T-units, and C-units. This 
document describes the rules for segmenting utterances into Communication 
Units (C-units), a rule-governed and consistent way to segment utterances. 
 
Disclaimer: There is variation in the literature on how to segment utterances 
into C-units. All of the samples in the English SALT reference databases were 
segmented into C-units following the rules in this document. If you intend to 
compare your sample with samples selected from these databases, you should 
segment utterances following the same rules. 
 
Definitions 
 
• C-Unit 

The formal definition of a C-unit is “an independent clause with its 
modifiers”. It includes one main clause with all subordinate clauses attached 
to it. It cannot be further divided without the disappearance of its essential 
meaning. 

 
• Clause 

A clause, whether it is the main clause or a subordinate clause, is a statement 
containing both a subject and a predicate. Grammatically, a subject is a noun 
phrase and a predicate is a verb phrase. 
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Segmenting Utterances into C-Units 
 
Main clauses can stand by themselves and can be segmented into one C-unit. 
Subordinate clauses DEPEND on the main clause to make sense. They cannot 
stand alone or be separated from the main clause. So a C-unit will either consist 
of a main clause or a main clause with its subordinating clause(s). The following 
examples are broken down into main and subordinate clauses. The main clause 
is bolded and the subordinate clauses are underlined. 
 
The canary was perched on a branch when the man approached him.  
Anastasia was angry with her mother because she didn’t get to buy a toy. 
When the boy looked in the jar he saw that the frog was missing. 
 
Notice the subordinate clauses cannot stand alone, or are incomplete, without 
the main clause. Thus, they are not separated (segmented further) from the 
main clause. Each of the above utterances consists of one C-unit and would be 
transcribed as: 
 

C  The canary was perched on a branch when the man approach/ed him. 
C  Anastasia was angry with her mother because she did/n’t get to buy a toy.  
C  When the boy look/ed in the jar, he saw that the frog was missing. 

 
Coordinating and Subordinating Conjunctions 
 
When segmenting into C-units it is important to understand the different types 
of conjunctions which are used to link clauses. There are coordinating 
conjunctions and subordinating conjunctions. 
  
• Coordinating Conjunctions 
 

The segmenting rule is simple when utterances contain coordinating 
conjunctions. These conjunctions link two main clauses which should be 
separated/segmented into two utterances (or two C-units) that can each 
stand alone. Common coordinating conjunctions include: and, but, so (but 
not “so that”), and then, then. 
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Example 1: 
C  The frog was sit/ing on a lily pad.  
C  And then it jump/ed in. 

Example 2: 
C  He had to catch the frog. 
C Or the waiter would make them leave.  

Example 3: 
C  He climb/ed up on the branch/s.  
C  But they were/n’t branch/s. 

Example 4: 
C  My aunt gave me money for my birthday.  
C  So I use/ed it to buy some new jeans. 

 
• Subordinating Conjunctions 
 

Subordinating conjunctions link a main clause and a subordinate clause. A C-
unit includes the main clause with all subordinate clauses attached to it. The 
following are examples of subordinating conjunctions: 

Early Development:  because, that, when, who 
Later Development:  after, before, so (that), which, although, if, unless, 
while, as, how, until, as__as, like, where, since, although, who, before, 
how, while 

 
Example 1: 

C  He went to the store because he was out of milk.  
Example 2: 

C  When the boy saw it, the frog jump/ed. 
Example 3: 

C  The man, who usually come/3s to my exercise class, was/n’t there 
today. 

Example 4: 
C  We can/’t find my cat who always run/3s away. 
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• “because” and “so” 
 

Always consider "because" as a subordinating conjunction. It will not start an 
utterance unless:  
A) It is preceded by the utterance of another speaker as in this example: 

C  I like/ed the movie alot.  
E  Why did you like it? 
C  Because it was really funny. 
 

OR 
 

B) The subordinating clause is the first clause in the utterance as in this 
example: 

C Because my mom was so mad, I did my homework first thing after 
school. 

 
The word “so” can either be a coordinating conjunction or a subordinating 
conjunction. If its usage means “so that”, it is a subordinating conjunction. 
Otherwise it is a coordinating conjunction. 

 

Example 1 (“so” used as a coordinating conjunction):  
C He had to go home. 
C So we could/n’t go to the game. 

 

Example 2 (“so” used as a subordinating conjunction): 
C  He had to go home so his mom could take him to the dentist. 

  
Other rules for segmenting C-units 
 

• Sentence fragments 
 

Sentence fragments are counted as separate C-units when the final 
intonation contour of the utterance indicates that a complete thought has 
been spoken. For example: 

C The boy, the dog, and the frog, they were friend/s.  
Versus 
C  The boy, the dog, and the frog. { fragment based on intonation }  
C  They were friend/s. 
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• Elliptical responses 
 

Elliptical responses (sentence fragments) to questions or prompts from the 
examiner are counted as separate C-units. For example: 

E  What did you do next?   
C  Shop/ed. 

 
• Yes/No responses or affirmations 
 

If a question or intonation prompt is posed, segment the yes/no response 
from the subsequent utterance when succeeded by a complete utterance/C-
unit. Examples:  

 E  Is that the Spanish teacher? 
C  No. 
C That/'s my science teacher. 
 

E Do you want to read your book now? 
C No. 
C I don’t. 
 

E Do you have any pet/s? 
C Yeah. 
C I have a dog. 
 

If a question or intonation prompt is posed, do not segment the yes/no 
response to stand alone when followed by an incomplete utterance/C-unit. 
 E Do you have any pet/s?  
 C Yeah, a dog. 
 

If an utterance begins with an affirmation or starter, and does not follow a 
question or ~ prompt, do not segment the affirmation/starter from the 
subsequent words. 

E I like dog/s. 
C Yeah, I do too. 
E That sound/3s interesting. 
C Yeah, it was. 
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C It was really fun. 
C Yeah, we had such a great time. 

 
• Tags 
 

Do not segment phrases such as “you know”, “I guess”, and “I mean” when 
they are used as tags. For example: 

C  He/’s gonna live with his dad, I guess. 
C  And then, you know, they were go/ing to this town. 

 
• Questions as Tags 
 

Do not segment questions when they are used as tags. For example: 
C  They got in trouble, right? 
C He miss/ed the bus, did/n't he? 

 
• Dialogue Complement/Complement 
 

Dialogue quotes which are embedded in, or as part of, an utterance are 
counted as one C-unit as in this example: 

C  And the boy said, “That/’s my frog”. 
 

Successive main clauses that occur in dialogue quotes are counted as 
separate C-units. For example: 

C  And he said, “I/’m ready”. 
C “I want to go to the store now”. 

 

Complement: 
C  She thought, “Sam was incorrect”.  
C  He realize/ed, nothing has changed. 

  
• Grammatical errors 
 

Ignore grammatical errors when segmenting utterances. For example, 
C  They is[EW:are] go/ing now. {child said, “They is going now.”}  
C  We *are go/ing too. {child said, “We going too.”} 
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• Pauses and intonation 
 

Do not ignore pauses and intonation when segmenting utterances but, 
whenever reasonable, segment utterances based on grammar rules. When 
listening to speech, for example, there is sometimes a significant pause (with 
or without ending intonation) between a main clause and a subordinate 
clause. This inclines one to segment the utterance. With C-unit 
segmentation, however, the utterance would not be segmented as in this 
following example where the speaker paused for two seconds between the 
main clause and the subordinate clause: 

C  I like/ed the movie alot :02 because it was really funny. 
 

In the following example, however, consider pause time and intonation:  
C  I like/ed the movie alot. 
:  :02 
E Mhm. 
C Because it was really funny. 

 

If there is a significant pause and ending intonation (falling for statements, 
rising for questions) between the speaker’s first utterance and the 
examiner’s “Mhm”, segment the utterances as show above. Otherwise, give 
the speaker credit for subordination and transcribe these "prompt sounds" 
as interjections as follows: 

 

C  I like/ed the movie alot :02 < > because it was really funny.  
E  <Mhm>. 

 
References: 
The rules for C-unit segmentation were summarized from Hughes, McGillivray, 
and Schmidek (1997), Loban (1976), Strong (1998), and Jon Miller’s class notes 
from Communicative Disorders 640, Fall, 1999.
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Subordination Index  
 

Introduction 
 
This guide contains the scoring rules for the Subordination Index (SI), and 
directions for using SALT to enter SI codes into a transcript and to generate the 
SI reports. 
 

SI definition: SI is a measure of syntactic complexity which produces a ratio of 
the total number of clauses to the total number of C-units (or modified C-units 
for samples of bilingual Spanish/English speakers). A clause, whether it is main 
or subordinate, is a statement containing both a subject and a predicate. 
Grammatically, a subject is a noun phrase and a predicate is a verb phrase. Main 
clauses can stand by themselves. Subordinate clauses depend on the main 
clause to make sense; they are embedded within an utterance as noun, 
adjective, or adverbial clauses. The SI analysis counts clauses. 
 

This measure has been used in research studies since Walter Loban first created 
it to document complex sentence development (Loban, 1963). The attraction of 
this measure is the straight forward definitions of complex syntax with a scoring 
system that can be completed efficiently. It still requires hand coding in that 
these syntactic features cannot be identified accurately using lexical lists. An 
added feature is that it can be used with languages other than English. Our 
research on Spanish-English bilingual children used the SI to quantify complex 
syntax across the two languages. We found that a transcript can be coded in less 
than 10 minutes, with most time spent on the few unique utterances. Loban 
demonstrated that the SI captured advancing syntactic gains from kindergarten 
through grade 12.  
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SI codes: Language samples, which have been transcribed and segmented into 
C-units (or modified C-units), are coded at the end of each utterance using the 
codes [SI-0], [SI-1], [SI-2] which means subordination index – 0 clauses, 1 clause, 
2 clauses within the utterance. The code, [SI-X], should be inserted at the end of 
utterances which are excluded from the SI analysis set (see Scoring Rules). 
 

SI composite score: The SI composite score is calculated by dividing the total 
number of clauses by the total number of utterances. 
  

SALT reference databases: The following SALT reference databases have been 
coded for SI: Play, Conversation, Narrative SSS, Narrative Story Retell, 
Expository, Persuasion, Bilingual Spanish/English Story Retell, Bilingual 
Spanish/English Unique Story, and Monolingual Spanish Story Retell. Samples 
you code may be compared to age or grade-matched samples selected from 
these databases. 
 

Disclaimer: There is variation in the literature on how to count clauses, 
especially for some of the special cases. The SALT reference databases were 
coded for SI following the rules in this document. If you intend to compare your 
sample with samples selected from these databases, you should code your 
sample following the same rules. 
 

Scoring Rules 
 

1. Utterances that are incomplete, unintelligible, are nonverbal, or are marked 
with [EU] are excluded from the SI analysis set. Titles and true fragments, 
e.g., “The end”, “and the dog”, are not C-units and are also excluded from 
the SI analysis set. These excluded utterances are coded for SI using [SI-X] 
and are not included in the SI composite score.  
 

Examples of utterances not included in SI: 
 C  Then he [SI-X]> 
 C  He went XX yesterday [SI-X]. 
 

Examples of colloquialisms which are also not included in SI: 
C  You there frog  [SI-X]? 
C  Frog, you in there  [SI-X]? 
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C ¿Rana ahí  [SI-X]? 
 
These utterances are acceptable in conversation. Therefore, they are 
excluded from the SI analysis set so that the speaker is not penalized for not 
including a verb.  
 
When an elliptical response to a question is not a clause, it is excluded from 
the SI analysis set. With elliptical responses, the missing term(s) are 
understood from the context. “... they are answers to questions that lack 
only the repetition of the question elements to satisfy the criterion of 
independent predication” (Loban, 1963).  
 

Examples of elliptical response to a question:  
E  Why did you do that? 
C  Because [SI-X]. 
E  ¿Por qué hiciste eso? 
C  Porque sí [SI-X]. 
 

When an ellipsis has clausal structure and the subject can implied, it is 
scored and included in SI.  

 
Example of elliptical response with clausal structure: 
 E How do you win? 
 C Score the most point/s [SI-1]. –> The subject “you” was implied and 

scored for SI as though the subject was stated. 
 

The following types of ellipses are given credit for verb use.  
 E You should turn in your assignment. 
 C I will [SI-1].  
  
 E Did your friend come to the party? 
 C He did [SI-1].  

 
2. Ignore parenthetical remarks. Utterances which consist entirely of 

parenthetical remarks are excluded from the SI analysis set. 
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Examples: 
 C  The girl ((I forgot her name)) got lost [SI-1]. 
 

 C  Then the ((what is that animal called)) <> ((oh yeah)) gopher bit him 
on the nose [SI-1]. 
 E  <Gopher>. 
 
Example where the child does not repeat the subject supplied by the 
examiner: 
 C  Then the ((what is that animal called)) <>bit him on the nose [SI-1]. 
 E  <Gopher>. 
In this example, the child is given credit for the subject supplied by the 
examiner. Repeating the subject is optional in this context. 
 

Examples of utterances consisting entirely of parenthetical remarks: 
 C  ((I skip/ed a page)) [SI-X]. 
 C  (((Um) where was I)) [SI-X]? 
 

3. Clauses with *omitted subjects are included in the SI analysis and receive a 
score of SI-0.  
 
Example of omitted subject: 

C  *He got on the rock [SI-0]. 
 

Example of complex subordination with subject omission: 
C  And then *he grab/ed some branch/s so he would/n’t fall [SI-1]. 

In this example the first clause receives SI-0 score due to subject omission in 
English.  
 
Spanish note: Spanish is a pronoun-drop language (Bedore, 1999) and, as 
such, omission of nouns and personal pronouns is ubiquitous and 
grammatical. Therefore, these subjects are not considered to be omitted. 
Example:  C  Y luego agarró unas rama/s para que no se cayera [SI-2]. 
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4. Clauses with missing subjects due to pronoun error are included in the SI 
analysis and receive a score of SI-0. 
 
Examples:  

C  There[EW:they] see the frog/s [SI-0]. 
C  Ahí[EW:ellos] ven a las rana/s [SI-0]. 

In these examples the pronoun is a demonstrative pronoun instead of a 
personal pronoun (i.e. she, you, his) and therefore the clause receives a zero 
score. 

 
5. Commands with implied subjects are included in the SI analysis and scored 

as though the subject was stated. 
 

Examples where the subject “you” is implied (not obligatory): 
 C Give it to me [SI-1]. 
 C Look at this [SI-1]. 

 
6. Because of the pronoun-drop nature of Spanish, English and Spanish 

samples from bilingual speakers are segmented using modified C-units. 
Utterances containing successions of verbs without subjects are segmented 
and a fragment code, [F], is placed at the end of each utterance lacking a 
stated subject as a result of this segmentation. For these transcripts, 
subjects can be implied for fragments due to segmentation and receive SI 
scores. 
 
Examples: 

C  He got on the rock [SI-1]. 
C  and fell off the rock [F] [SI-1]. 
 
C  Se subió a la piedra [SI-1]. 
C  y cayó de la piedra [F] [SI-1]. 

 
Special case: If there is a fragment due to segmentation but the preceding 
utterance has an omitted subject, then you cannot imply the subject for the 
fragment. 
 C  Then *he ran [SI-0]. 
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 C  and look/ed [F] [SI-0]. 
Because Spanish is a pronoun-drop language, this special case does not 
apply to Spanish samples: 
 C  Luego corrió [SI-1]. 
 C  y miró [F] [SI-1]. 
 

7. Clauses with *omitted copula (main verb) are included in the SI analysis and 
receive a score of SI-0.  
 
Examples of omitted main verb/copula: 

C  (And the) and the frog *went through the big (ah) pond [SI-0]. 
C  (y la) y la rana *nadó por el estanque (eh) grande [SI-0]. 

 
Examples of omitted verb in the second clause: 

C  And he start/ed say/ing, “Froggy, Froggy of[EW:are] you there” [SI-1]? 
C  Y empezó a decir, “¿Rana, Rana fuera[EW:estás] ahí [SI-1]? 

In these examples the speaker did not state a verb in the second clause; 
thus that clause receives a score of zero. 
 

8. Utterances containing omitted auxiliary verbs, bound morphemes, functor 
words, direct objects, and articles are included in the SI analysis (coded for 
SI). This includes verbs which are not conjugated correctly. 
 

Examples of omitted auxiliary: 
 C  He *is go/ing [SI-1]. 
 C  When they *were sleep/ing the frog got out [SI-2]. 
 C  Él *estaba yendo [SI-1]. 
 C  Cuando ellos *estaban durmiendo la rana se salió [SI-2]. 
 

Example of an omitted bound morpheme: 
 C  The boy was fall/*ing off the rock [SI-1]. 

 

Example of an omitted article: 
 C  He see/3s *an owl [SI-1]. 

C  La rana se estaba cayendo de *la piedra [SI-1]. 
 



 Appendix O  ●   Subordination Index   391 

 

 

Examples of an omitted direct object: 
 C  He was pour/ing coffee into the *cup [SI-1]. 
 C  Él estaba sirviendo café en la *taza [SI-1]. 

 
9. The subordinate clause within an utterance containing an omitted 

obligatory subordinating conjunction will not receive credit. Examples: 
C There was a boy *who had a dog [SI-1]. 
C And the boy did/n’t see *that the frog went out [SI-1]. 
C  Había un niño *que tenía un perro [SI-1]. 
C  Y el niño no vio *que la rana se salió [SI-1]. 

 
10. When an incorrect subordinating conjunction is used, the subordinate 

clause will not receive credit. Example: 
C The deer was run/ing what[EW:so] he could throw the little boy in the 
water [SI-1]. 

If the word in error is a different subordinating conjunction, albeit the 
wrong one, the second clause may get credit. Use judgment. For example, 
bilingual (Spanish/English) children sometimes use the word “for” as a 
subordinating conjunction because the Spanish word “para,” which means 
“for” in English, can be used as a subordinating conjunction in Spanish. In 
this case the subordinate clause should be given SI credit. 

C The deer was run/ing for[EW:so] he could throw the little boy in the 
water [SI-2]. 

 

11. If a subordinating conjunction is not obligatory to the coherence of the 
utterance, the subordinate clause should still receive a score for SI. 
Examples: 

C I know I want to go [SI-2]. 
C I think I hear something [SI-2]. 

The subordinating conjunction “that” can be implied in these utterances. 
 

12. Dialogue is coded for SI. Consider the introducer, e.g., he said, as the main 
clause and what is in the quotes as the second clause. The direct quotation 
must have a subject and predicate in order to be considered a clause and 
get an SI count. Examples: 

C  And he *was say/ing, “Frog, where are you” [SI-2]? 
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C  Y él *estaba diciendo, “¿Rana, dónde estás” [SI-2]? 
 

C  The boy said, “Shh” [SI-1]. 
C  El niño dijo, “Shh” [SI-1]. 
 

Examples of commands in which the subject you/tú can be implied: 
C  The boy said, “Go away” [SI-2]. 
C  El niño dijo, “Vete” [SI-2]. 
 

13. Semantics should be ignored when scoring SI. If the wrong content word is 
used by the speaker, but is grammatically acceptable, score SI accordingly. 
Examples: 
 C The boy ran[EW:fell] off the rock [SI-1]. 

C  El niño se corrió[EW:cayó] de la piedra [SI-1]. 
 

14. Utterances with imitated words (coded with [I] in the examples) are 
included in the SI and are scored as though the imitated word originated 
from the speaker. Examples: 

C  The <> gopher[I] came out of the hole [SI-1].  
E <Gopher>. 
 

C  El <> topo[I] salió del hoyo [SI-1]. 
E <topo>. 
  

15. Counting Infinitives: there is variability in the literature on whether or not to 
count infinitives. Samples in the SALT databases do not count infinitives as 
clauses. Examples: 

C   The boy told the dog to be quiet [SI-1]. 
C  The dog want/ed to run away [SI-1]. 
C  El niño se fue a comprar un perro [SI-1]. 
C  El perro se quería escapar [SI-1]. 
 

16. The utterances containing code switches will be reviewed for SI. If the 
majority of the utterance (at least 50%) is in the target language (English or 
Spanish), code for SI. 
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Examples of code switching and SI coding with English as the target 
language: 
 C  The rana[CS] jump/ed off the boat [SI-1]. 

 C  El[CS] niño[CS] buscó[CS] en[CS] the hole [SI-X].    only 2 of the 6 words 
are in English, so not coded for SI 

Examples of code switching and SI coding with Spanish as the target 
language:  

C  La frog[CS] saltó del bote [SI-1]. 
C  The[CS] boy[CS] look/ed[CS] in[CS] el hoyo [SI-X]. only 2 of the 6 
words are in Spanish, so not coded for SI  

 

If the utterance has enough of the target language to score for SI but the 
speaker produces a partial verb in the non-target language then credit will 
be given for SI. 

C  The boy busc|buscar[CS] in the hole [SI-1]. (target language: 
English) 
C  El niño sear|search[CS] en el hoyo [SI-1]. (target language: Spanish) 

 

Tricky Scoring Examples 
 

The following table contains examples of utterances which may be tricky to 
score. Each utterance is given along with the rationale. 
 

Transcript Quote Rationale 

And she get/3s all the toy/s she want/3s [SI-2].  
 
When he was hold/ing an umbrella, he just 
knew he was/n't Fluffy [SI-3]. 

Implied subordinating 
conjunctions (Rule 11). 
Notice that in these 
examples the 
subordinating conjunction 
“that” can be implied. 

Sit down and get to work [SI-1]. 
"Wait," said Dr_DeSoto [SI-2]! 
The boy said to the dog, "Be quiet" [SI-2].  

Commands with implied 
“you” (Rule 5); in dialogue 
(Rule 12). 

When it began to rain (he he um) he said, "My 
hat will shrink if the rain get/3s on it" [SI-4]. 

Notice in this relatively 
short utterance there are 
four clauses. 
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Using SALT to enter SI scores 
 

The Edit menu: Insert SI Codes utility may be used to insert the appropriate SI 
code at the end of each qualifying utterance in your transcript. Each utterance is 
highlighted and you are prompted to select the appropriate SI code from a list. 

 
Analyzing the SI scores 

 

The Analyze menu: Subordination Index report lists the count of each SI code 
along with the composite SI score. 

 
Comparing your SI scores to the database samples 

 

The Database menu: Subordination Index report lists the count of each SI code 
along with the composite SI score. Scores are listed for your transcript and for 
the selected database samples. 

(Um) many player/s obviously would stretch 
before the game so that they would/n't (um 
like you know) cramp up as many people in 
athletics do [SI-3].  
 
So it usually take/3s longer also because the 
clock stop/3s when the ball is run out of 
bounds [SI-3]. 
 
C And each creature also has its own special 
ability/s that can either destroy a creature 
when it come/3s in to play, or destroy a 
creature when it come/3s out of play, or let an 
opponent draw a card, or let you draw a card 
[SI-4]. 

Expository samples taken 
from older speakers often 
produce long utterances 
with complex 
subordination. 

The higher your individual score, the more 
point/s get add/ed to your team/z score [SI-1]. 

The first clause does not 
contain a verb phrase. 
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Narrative Scoring Scheme  
 
Introduction 
 

The Narrative Scoring Scheme (NSS) is an assessment tool that provides an index 
of the student’s ability to produce a structurally sound and coherent narrative. 
It was developed to create a more objective narrative structure scoring system 
and is based on an earlier version, Rubric for Completing a Story Grammar 
Analysis, developed by the Madison Metropolitan School District SALT working 
group, 1998, following the work of Stein and Glenn, 1979; 1982. This scoring 
procedure combines many of the abstract categories of Story Grammar, adding 
features of cohesion, connecting events, rationale for characters’ behavior, and 
referencing. Each of the scoring categories has explicit examples to establish 
scoring criteria, reducing the abstractness of the story grammar categories. 
Heilmann, Miller, Nockerts, & Dunaway (2010) reviewed narrative scoring 
procedures used in research over the past 20 years detailing their sensitivity in 
capturing developing narrative skills. They concluded that “The NSS is an 
efficient and informative tool for documenting children's development of 
narrative macrostructure. The relationship between the NSS and microstructural 
measures demonstrates that it is a robust measure of children's overall oral 
narrative competence and a powerful tool for clinicians and researchers. The 
unique relationship between lexical diversity and the NSS confirmed that a 
special relationship exists between vocabulary and narrative organization skills 
in young school-age children.” 
 
The NSS scoring is done at the text level, for the most part, requiring you to 
review the narrative as a whole for many of the scoring categories. Scores for 
each category are inserted on plus lines at the end of the transcript. You can add 
these plus lines with the Edit menu: Insert Template → Narrative Scoring 
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Scheme option. The SALT program summarizes these scores and calculates a 
total. You can then compare these scores to typical peer performance using the 
Database menu or view independently using the Analyze menu. You can also 
compare with a linked transcript to show intervention progress or language 
differences. This measure is key to understanding overall narrative 
performance.  
 

Scoring Guidelines 
 

Assigning NSS Scores 
 

The NSS is scored using a 0 - 5 point scale. 5 points are given for “proficient” 
use, 3 points for “emerging” use, and 1 point for “immature” or “minimal” use. 
Scores of 2 and 4 require scorer’s judgment. Scores of zero (0) are given for poor 
performance and for a variety of child errors including telling the wrong story, 
conversing with the examiner, not completing/refusing the task, abandoned 
utterances, unintelligibility, and when target components of the NSS are 
imitated. The scores for each characteristic can be considered individually or 
combined into a total composite score (highest possible score being 35). 
 
Description of NSS characteristics 
 

1. Introduction: Scores are determined by the presence, absence, and 
qualitative depiction of character and setting components.  

2. Character Development: Scores are based on the acknowledgement of 
characters and their significance throughout the story. 

3. Mental States:  Narratives are evaluated based on the vocabulary used to 
convey character emotions and thought processes. The frequency as well 
as the diversity of mental state words is considered. For example, if a story 
provides frequent opportunities to verbalize anger themes and a child 
marks each of these with “mad,” he/she will not receive as high of a score 
as a child who explains one opportunity using “mad,” another using 
“angry,” another using “upset,” and so on. Mental state words can be 
either adjectives, e.g., sad, happy, scared, or active cognitive-state words, 
e.g., believe, know, remember. 
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4. Referencing: Scores are given according to the consistent and accurate use 
of antecedents and clarifiers throughout the story. Student’s use of correct 
pronouns and proper names should be considered in this score.  

5. Conflict/Resolution: Scores are based on the presence/absence of conflicts 
and resolutions required to express the story as well as how thoroughly 
each is described.  

6. Cohesion: The sequencing of, details given to, and transitions between 
each event are examined.  

7. Conclusion: Scores are based on the conclusion of the final event as well as 
the wrap-up of the entire story.  

 

NSS Scoring Rubric 
 

Refer to the scoring rubric at the end of this appendix for a guide to assigning 
scores for each of the NSS characteristics of a narrative.  
 

Helpful Scoring Tips: 

• Be familiar with the narrated story. It is recommended that the scorer have 
a copy of the story to reference while scoring.  

• Print the narrative transcript. 

• Read the transcript as fluidly/inclusively as possible, ignoring SALT 
transcription codes. 

• Write comments and circle or flag key words/utterances such as mental 
state words or difficulty with referents and pronouns.  

• For each characteristic, review the NSS before assigning a score. Read the 
criteria along the continuum of points. Determine what is present in the 
transcript and score accordingly. This will insure better intra- and inter-rater 
reliability. 

• Conflict/Resolution and Cohesion are story grammar elements which are 
distributed across the entire narrative. They do not occur at one static point 
within the story. The scoring of these characteristics must take into account 
the story as a whole.  

• Conflict/Resolution (CR) is based on the presence of CRs necessary for 
telling a complete story as well as the clarity and richness in which these 
story elements are expressed. A child who is missing elemental conflicts 
and/or resolutions will receive a proportionately lower score than a child 
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who narrates all conflicts and resolutions necessary for advancing that 
story. A child who expresses these CRs clearly and comprehensively receives 
a proportionately higher score than a child who narrates under-developed 
CRs.  

• Frequently review what constitutes a score of 0 or NA. Explanations are 
given at the bottom of the NSS scoring rubric.  

• Proficiency in assigning scores will develop with experience. 

 
Using SALT to enter NSS scores 
 

The Edit menu: Insert Template -> Narrative Scoring Scheme option may be used 
to insert the NSS plus line template at the bottom of your transcript. Then type 
the individual scores after each label. 

 

NSS Template Example of NSS Scoring 

+ Introduction:  
+ CharacterDev:  
+ MentalStates:  
+ Referencing:  
+ ConflictRes:  
+ Cohesion:  
+ Conclusion:  

+ Introduction: 3 
+ CharacterDev: 2 
+ MentalStates: 2 
+ Referencing: 2 
+ ConflictRes: 1 
+ Cohesion: 3 
+ Conclusion: 2 

 
Analyzing the NSS scores 
 

The Analyze menu: Narrative Scoring Scheme report lists each individual NSS 
score along with the composite score. 

 
Comparing your NSS scores to the database samples 

 

The Database menu: Narrative Scoring Scheme lists each individual NSS score 
along with the composite score. Scores are listed for your transcript and for the 
selected database samples. 
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NSS SCORING RUBRIC 
 

Characteristic  Proficient/Advanced (5) Satisfactory/Adequate (3) Minimal/Immature (1) 

Introduction 

1) Setting: 

• States general place 
and provides some 
detail about the 
setting, e.g., 
reference to the time 
of the setting, 
daytime, bedtime, 
season. 

• Setting elements are 
stated at appropriate 
place in story. 

 

2) Characters: 
• Main characters are 

introduced with 
some description or 
detail provided. 

1) Setting: 

• States general setting 
but provides no detail. 

• Description or 
elements of setting are 
given intermittently 
through story. 

• May provide 
description of specific 
element of setting, 
e.g., the frog is in the 
jar. 

 

2) Characters: 
• Characters of story are 

mentioned with no 
detail/description. 

• Launches into story 
with no attempt to 
provide the setting. 

Character 
Development 

• Main character(s) 
and all supporting 
character(s) are 
mentioned. 

• Throughout story it is 
clear child can 
discriminate between 
main and supporting 
characters, e.g., more 
description of, 
emphasis upon main 
character(s). 

• Child narrates in first 
person using 
character voice, e.g., 
“You get out of my 
tree”, said the owl. 

• Both main and active 
supporting characters 
are mentioned. 

• Main characters are 
not clearly 
distinguished from 
supporting characters. 

• Inconsistent mention 
of involved or active 
characters. 

• Character(s) necessary 
for advancing the plot 
are not present. 
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Mental States 

• Mental states of main 
and supporting 
characters are 
expressed when 
necessary for plot 
development and 
advancement. 

• A variety of mental 
state words are used. 

• Some use of evident 
mental state words to 
develop character(s). 

• No use of mental 
state words to 
develop character(s). 

Referencing 

• Provides necessary 
antecedents to 
pronouns. 

• References are clear 
throughout story. 

• Inconsistent use of 
referents/antecedents. 

• Excessive use of 
pronouns. 

• No verbal clarifiers 
used. 

• Speaker is unaware 
that listener is 
confused. 

Conflict 
Resolution 

• Clearly states all 
conflicts and 
resolutions critical to 
advancing the plot of 
the story. 

• Under developed 
description of conflicts 
and resolutions critical 
to advancing the plot 
of the story. 

OR 
• Not all conflicts and 

resolutions critical to 
advancing the plot are 
present. 

• Random resolution(s) 
stated with no 
mention of cause or 
conflict. 

OR 

• Conflict mentioned 
without resolution. 

OR 
• Many conflicts and 

resolutions critical to 
advancing the plot are 
not present. 
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Cohesion 

• Events follow a 
logical order. 

• Critical events are 
included while less 
emphasis is placed on 
minor events. 

• Smooth transitions 
are provided 
between events. 

• Events follow a logical 
order. 

• Excessive detail or 
emphasis provided on 
minor events leading 
the listener astray. 

OR 

• Transitions to next 
event unclear. 

OR 

• Minimal detail given 
for critical events. 

OR 
• Equal emphasis on all 

events. 

• No use of smooth 
transitions. 

Conclusion 

• Story is clearly 
wrapped up using 
general concluding 
statements such as 
“and they were 
together again happy 
as could be”. 

• Specific event is 
concluded, but no 
general statement 
made as to the 
conclusion of the 
whole story. 

• Stops narrating and 
listener may need to 
ask if that is the end. 

Scoring: Each characteristic receives a scaled score 0-5. Proficient characteristics=5, 
Emerging=3, Minimal/ Immature=1. The scores in between, 2 and 4, are undefined, use 
judgment. Scores of 0, NA are defined below. A composite is scored by adding the total of 
the characteristic scores. Highest score=35. A score of 0 is given for child errors. Examples 
include: telling the wrong story, conversing with examiner, not completing/refusing task, 
using wrong language creating inability of scorer to comprehend story in target language, 
abandoned utterances, unintelligibility, poor performance, and/or if components of the 
rubric are entirely imitated. A score of NA (non-applicable) is given for 
mechanical/examiner/operator errors. Examples include: interference from background 
noise, issues with recording (cut-offs, interruptions), examiner quitting before child does, 
examiner not following protocol, and examiner asking overly specific or leading questions 
rather than open-ended questions or prompts. 
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Expository Scoring Scheme  
 

Introduction 
 

The Expository Scoring Scheme (ESS) assesses the content and structure of an 
expository language sample, similar to how the Narrative Scoring Scheme (see 
Appendix P) provides an overall measure of a student’s skill in producing a 
narrative. Expository skills are critical to the curriculum in middle and high 
school and relate to state educational standards. The ESS is comprised of 10 
characteristics for completing an expository language sample. The first 8 
characteristics correspond to the topics listed on the planning sheet that is given 
to students. These topics, in turn, were developed based on the descriptions of 
sports (both individual and team) found in Rules of the game: the complete 
illustrated encyclopedia of all the sports of the world (Diagram Group, 1990). To 
ensure that the topics also reflected what is expected for explanations of 
games, The Card Game Web site (www.pagat.com) was consulted.  
 

There is less research on this procedure than on the NSS, but clinically it 
captures deficits in organization, listener perspective, and overall appreciation 
for explaining relative situations, the overall goal of the game, the rules, and 
strategies to win. We believe it provides you with a valuable tool to document 
expository language.  
 

Scoring Guidelines 
 

Assigning ESS Scores 
 

The ESS is scored using a 0 - 5 point scale. 5 points are given for “proficient” use, 
3 points for “emerging” use, and 1 point for “immature” or “minimal” use. 
Scores of 2 and 4 require scorer’s judgment. Scores of zero (0) are given for poor 
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performance and for a variety of errors including telling the wrong story, 
conversing with the examiner, not completing/refusing the task, abandoned 
utterances, unintelligibility, and/or when target components of the ESS are 
imitated. Significant factual errors reduce the score for that topic. The scores for 
each characteristic can be considered individually or combined into a total 
composite score. 
 

Description of ESS characteristics 
 

1. Object of Contest: The main objective the game/sport 
2. Preparations:  What players need to do to prepare for the game/sport, 

including playing area, equipment, and personal preparations 
3. Start of Play: The initial situation, e.g., One football team lines up at their 

own 30-yard line for the kickoff, while the other team spreads out in its own 
territory to receive, and how the game/sport begins 

4. Course of Play: Unit of play, e.g., turn, quarter, set, as well as major roles 
and major plays 

5. Rules: Major rules and consequences for rule violations 
6. Scoring: Various ways to score and point values 
7. Duration: How long the game/sport lasts using units, how the game ends, 

and tie breaking procedures 
8. Strategy: What skilled players do to win game/sport 
9. Terminology: Major terms of game/sport with definitions of new terms16  
10. Cohesion: Overall flow of the sample, including order, covering topics 

completely, and smooth transitions17 
 

ESS Scoring Rubric 
 

Refer to the scoring rubric at the end of this appendix for a guide to assigning 
scores for each of the ESS characteristics of an expository.  

 

 
16 This characteristic might be analogized to the Referencing category in the NSS, which 
also assesses how well a student takes into account the background knowledge of the 
listener. 
 

17 Cohesion was adopted directly from the NSS; consider how well sequencing and 
transitioning are handled 
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Helpful Scoring Tips 

• Be familiar with the topic of the expository, i.e., the game or sport being 
explained. 

• Print the expository transcript. 

• Read the transcript as fluidly/inclusively as possible, ignoring SALT 
transcription codes. 

• Write comments and circle or flag key words/utterances such as those 
relating to terminology and rules. 

• For each characteristic, review the ESS scoring rubric before assigning a 
score. Read the criteria along the continuum of points. Determine what is 
present in the transcript and score accordingly. This will insure better intra- 
and inter-rater reliability. 

• Frequently review what constitutes a score of 0 or NA. Explanations are 
given at the bottom of the ESS scoring rubric.  

• Scoring the ESS is a subjective measure by nature; however, as you gain 
experience, the process of scoring will become reliable.  

• When beginning to score, you may want to compare your scores against the 
training transcripts or with another scorer. The training transcripts were 
scored by several scorers experienced with the ESS.  

 

Using SALT to enter ESS scores 
 

Use the Edit menu: Insert Template → Expository Scoring Scheme option to 
insert the ESS plus line template at the bottom of your transcript. Then type the 
individual scores after each label. 

  ESS Template Example of ESS Scoring 

+ Preparations: 
+ ObjectOfContest: 
+ StartOfPlay: 
+ CourseOfPlay: 
+ Scoring: 
+ Rules: 
+ Strategy: 
+ Duration: 
+ Terminology: 
+ Cohesion: 

+ Preparations:  2 
+ ObjectOfContest:  3 
+ StartOfPlay:  3 
+ CourseOfPlay:  3 
+ Scoring:  4 
+ Rules:  3 
+ Strategy:  3 
+ Duration:  3 
+ Terminology:  3 
+ Cohesion:  3 



406  Assessing Language Production Using SALT Software  

 

Analyzing the ESS scores 
 

The Analyze menu: Expository Scoring Scheme report lists each individual ESS 
score along with the composite score. 
 

Comparing your ESS scores to the database samples 
 

The Database menu: Expository Scoring Scheme lists each individual ESS score 
along with the composite score. Scores are listed for your transcript and for the 
selected database samples. 
 

ESS Scoring Guide 
 

Characteristic  Proficient/Advanced (5) Satisfactory/Adequate (3) Minimal/Immature (1) 

Object 
Full description of the main 
objective. 

Mention of the main 
objective. 

Mention of winner but no, 
or limited, description how 
that is determined. 
OR 
Description of another 
aspect of the contest, such 
as strategy or scoring. 

Preparation 

1) Playing Area: Labels 
place and provides details 
about shape & layout. 
AND/OR 
2) Equipment: Labels items 
and provides detailed 
description, including 
function. 
AND/OR 
3) Player Preparations: 
Provides detailed 
description. 

1) Playing Area: Labels 
place and provides limited 
details about shape & 
layout. 
OR 
2) Equipment: Labels items 
with limited description. 
OR 
3) Player Preparations: 
Provides some description. 

1) Playing Area: Labels place 
but no details about shape & 
layout. 
OR 
2) Equipment: Labels items 
with no description. 
OR 
3) Player Preparations: 
Provides limited description. 

Start 
Describes initial situation 
and how play begins. 

Describes initial situation or 
how play begins, but not 
both. 

Limited description of the 
initial situation or how play 
begins. 

Course of Play 

Detailed description of: 
A unit of play 
AND/OR 
major roles 
AND/OR 
major plays 

Some description of: 
A unit of play 
AND/OR 
major roles 
AND/OR 
major plays 

Limited description of: 
A unit of play 
AND/OR 
major roles 
AND/OR 
major plays 
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Rules 

Clear statement of major 
rules and, when applicable, 
consequences for 
violations. 

Mentions major rules and, 
when applicable, 
consequences for violations 
but without full detail. 

Minimal or no mention of 
major rules or consequences 
for violations. 

Scoring 
Full description of ways to 
score and point values. 

Incomplete description of 
ways to score and point 
values. 

Limited description of ways 
to score or point values. 

Duration 

Clear description of: 
How long the contest lasts, 
including, when applicable, 
the units in which duration 
is measured.  
AND/OR 
How the contest ends. 
AND/OR 
Tie breaking procedures. 

Some description of: 
How long the contest lasts. 
OR 
How the contest ends. 
OR 
Tie breaking procedures. 

Limited description of: 
How long the contest lasts. 
OR 
How the contest ends. 
OR 
Tie breaking procedures. 

Strategy 

Full description of some 
ways to win the contest 
that are not required by the 
rules but are what 
competent players do. 

Mention of some ways to 
win the contest that are not 
required by the rules but 
are what competent players 
do. 

Vague or incomplete 
mention of some ways to 
win the contest that are not 
required by the rules but are 
what competent players do. 

Terminology 
Terms of art are clearly 
defined whenever 
introduced. 

Some terms of art defined, 
but not consistently or 
clearly. 

Terms of art introduced but 
not further defined. 

Cohesion  

Topics follow a logical 
order. 
AND 
Topics are completely 
covered before moving on 
to another. 
AND 
Smooth transitions 
between topics. 

Topics follow a logical 
order. 
OR 
Topics are completely 
covered before moving on 
to another. 
OR 
Smooth transitions 
between topics. 

Little discernable order to 
topics, much jumping 
between topics. 
AND  
Abrupt transitions between 
topics. 

Scoring: Each characteristic receives a scaled score 0-5. Proficient characteristics=5, Emerging=3, 
Minimal/ Immature=1. The scores in between, 2 and 4, are undefined, use judgment. Significant 
factual errors reduce the score for that topic. Scores of 0, NA are defined below. A composite is scored 
by adding the total of the characteristic scores. Highest score=50. A score of 0 is given for student 
errors. Examples include not covering topic, explaining a different game or sport, not 
completing/refusing task, student unintelligibility, and abandoned utterances. A score of NA (non-
applicable) is given for mechanical/examiner/operator errors. Examples include interference from 
background noise, issues with recording (cut-offs, interruptions), examiner quitting before student 
does, examiner not following protocol, and examiner asking overly specific or leading questions rather 
than open-ended questions or prompts. 



 

 

 



 

 

APPENDIX 

R 
 

Persuasion Scoring Scheme  
 

Introduction 
 

The Persuasion Scoring Scheme (PSS) assesses the content and structure of a 
persuasive language sample. Persuasion skills relate to state educational 
standards and cut across modes of communication: speaking, listening, reading, 
and writing (National Governor’s Association, 2010). The ability to persuade is 
critical to success in college and career and to full participation in social and civic 
life. The persuasion task challenges high school students to take into account 
the listener’s perspective and to use complex language to express complex 
ideas. The PSS is comprised of 7 characteristics for completing a persuasive 
language sample. The characteristics correspond to the topics listed on the 
planning sheet that is given to students.  
 

Samples contained in the SALT Persuasion reference database have all been 
coded for the PSS. This database can be utilized to compare a student’s 
persuasion skills to those of his/her typically-developing peers. Clinicians can 
compare individual characteristics of the PSS or the composite score using the 
database. The persuasion task may be repeated to assess progress of persuasion 
skills through the high school years.  
 

Scoring Guidelines 
 

Assigning PSS Scores 
 

The PSS is scored using a 0 - 5 point scale. 5 points are given for 
“Proficient/Advanced” production, 3 points for “Satisfactory/Adequate” 
production, and 1 point for “Minimal/Immature” production. Scores of 2 and 4 
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are undefined and require judgment. Refer to the PSS scoring guide at the end 
of this appendix. 
 

Helpful Scoring Tips 

• Print the transcript. 

• Read the transcript as fluidly/inclusively as possible, ignoring SALT 
transcription codes. 

• Write comments and circle or flag key words/utterances pertaining to 
points on the planning sheet 

• For each point, review the PSS scoring rubric before assigning a score. Read 
the criteria along the continuum of points. Determine what is present in the 
transcript and score accordingly. This will insure better intra- and inter-rater 
reliability. 

• Frequently review what constitutes a score of 0 or NA. Explanations are 
given at the bottom of the PSS scoring rubric.  

• Scoring the PSS is a subjective measure by nature; however, as you gain 
experience, the process of scoring will become reliable.  

 

Using SALT to enter PSS scores 
 

Use the Edit menu: Insert Template → Persuasion Scoring Scheme option to 
insert the PSS plus line template at the bottom of your transcript. Then type the 
individual scores after each label. 
 

 

 
Analyzing the PSS scores 
 

The Analyze menu: Persuasion Scoring Scheme report lists each individual PSS 
score along with the composite score. 

PSS Template Example of PSS Scoring 

+ IssueID: 
+ SupportReasons: 
+ PointOfView: 
+ Compromises: 
+ Conclusion: 
+ Cohesion: 
+ Effect: 

+ IssueID: 2 
+ SupportReasons: 3 
+ PointOfView: 3 
+ Compromises: 3 
+ Conclusion: 4 
+ Cohesion: 3 
+ Effect: 3 
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Comparing your PSS scores to the database samples 
 

The Database menu: Persuasion Scoring Scheme lists each individual PSS score 
along with the composite score. Scores are listed for your transcript and for the 
selected database samples. 
 

PSS Scoring Rubric 
 

Characteristic  Proficient/Advanced (5) Satisfactory/Adequate (3) Minimal/Immature (1) 

Issue 
Identification 
and  
Desired 
Change 

• Existing rule or situation 
is clearly understood 
before supporting 
reasons are stated. 

• Desired change is clearly 
stated. 

• Existing rule or 
situation can be 
discerned; may require 
shared knowledge. 

• Desired change can be 
discerned. 

• Speaker launches into 
persuasion with no 
mention of existing rule or 
situation. 

• Desired change is difficult 
to determine. 

Supporting 
Reasons 

• Reason(s) are 
comprehensive; include 
detail. 

• Benefit(s) to others are 
clearly understood. 

• One or more reasons 
are offered to support 
desired change. 

• Benefit(s) to others are 
unclear or omitted. 

• Reason(s) are confusing or 
vague. 

• Significant/obvious 
reason(s) are not stated. 

• Reason(s) are not plausible; 
do not support change. 

Other Point of 
View 
(Counter 
Arguments) 

• Other point(s) of view 
are clearly explained; 
include detail.  

• Includes language to 
support or refute other 
point of view. 

• Other point(s) of view 
are acknowledged. 

OR 

• Dismissive of other 
point(s) of view. 

• Other point(s) of view are 
unclear or omitted. 

Compromises 
• Includes language, with 

some detail, to support 
or refute compromising. 

• Compromise(s) are 
acknowledged. 

OR 

• Dismissive of 
compromising. 

• Compromises are unclear 
or omitted. 

Conclusion 

• Desired change is clearly 
restated/summarized. 

• Arguments are clearly 
restated/summarized. 

• Concludes using 
language such as, “to 
conclude”, “therefore”, 
“and so”, “in sum”, etc.  

• First step(s) for change 
are mentioned.  

• Desired change is 
restated. 

• One or more 
supporting reasons are 
restated. 

• Ending is inferred 
and/or lacks transition 
to conclusion, e.g., 
“And that’s all”, “that’s 
it”, “I’m done”. 

• Summary statement(s) are 
omitted. 

• Unclear to listener that the 
persuasion task is 
completed. 
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Cohesion 

• Points are fully covered 
before moving on to 
another. 

• Transitions between 
points are smooth/clear 
using mature language.   

• Referents are clear. 

• Listener can easily follow 
the argument. 

• Point are covered, but 
lack organization. 

• Transitions between 
points are acceptable. 

• Referencing is 
adequate. 

• Listener can follow the 
argument with some 
effort. 

• Points are not fully covered 
before moving onto 
another. 

• Abrupt transitions between 
points. 

• Referents are unclear, hard 
to follow. 

• Argument is difficult to 
follow. 

Effectiveness  

• Argument is extremely 
compelling. 

• Argument is entirely 
plausible. 

• Argument is well stated.   

• Mature language is used.  

• Minimal errors of 
syntax/form.  

• Supported points well. 

• Speaker’s delivery is 
passionate. 

• Speaker engages 
listener.  

• Argument is 
compelling. 

• Argument is plausible. 

• Argument requires little 
or no clarification. 

• Acceptable 
syntax/form. 

• Speaker’s delivery is 
clear; not necessarily 
passionate. 

• Effort to persuade is 
evident. 

• Speaker makes some 
attempt to engage 
listener. 

• Argument is minimally or 
not compelling. 

• Argument is not plausible. 

• Language is unclear. 

• Errors of syntax/form may 
be prevalent.  

• Speaker’s delivery lacks 
effort; not passionate . 

• Speaker makes no attempt 
to engage listener. 

• Speaker uses 
inappropriate/immature 
tone. 

Scoring: Each characteristic receives a scaled score 0-5. Use points as a guideline to 
determine level of proficiency for each characteristic. Not all points listed in each 
characteristic must be present when assigning score. Proficient/Advanced = 5, 
Satisfactory/Adequate = 3, Minimal/Immature = 1. The scores in between, 2 and 4, are 
undefined; use judgment. Add the scores for the seven characteristics to yield a composite 
score. Highest possible score = 35. A score of 0 is given for student errors such as not 
completing the task when prompted, refusing the task, unintelligible production(s), and 
abandoned utterances leaving characteristics incomplete.  
A score of NA (non-applicable) is given for mechanical/examiner/operator errors, e.g., 
interference from background noise, issues with recording (cut-offs, interruptions), 
examiner not following protocol, examiner interrupting student. 
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Oral Narrative Quality (ONQ)  
 

Introduction 
 

There are many ways to add hand-scored analyses to your language samples. 
The Oral Narrative Quality (ONQ) is one example. The ONQ scoring was applied 
to the AGL (Ana Gets Lost) samples in the NZ-AU Story Retell database.  

 
The ONQ is designed for AGL, Bus, or NZPN narratives. The SALT menu options 
are not available if the +Context line indicates that the transcript is 
conversation, expository, or persuasion or if the +Subgroup line does not 
contain AGL, Bus, or NZPN. 
 
The rubric for the AGL story is provided at the end of this appendix. 
 

Assigning ONQ Scores 
 

The ONQ is scored using a 0 - 5 point scale for each of eight categories. Five (5) 
points are given for “proficient” use, 3 points for “emerging” or “inconsistent” 
use, and 1 point for “minimal or “immature” use. An overall score of zero (0) is 
given if the story is not the same as the original at all. A score of NA (non-
applicable) is given for Mechanical/Examiner/Operator Errors (i.e., interference 
from background noise, issues with recording (cut-offs, interruptions), examiner 
quitting before child does, examiner not following protocol, examiner asking 
overly specific or leading questions rather than open-ended questions or 
prompts). The scores for each characteristic can be considered individually or 
combined into a total composite score (highest possible score being 40). Note 
that if any individual ONQ scores are NA, the composite score cannot be 
computed. 
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The ONQ consists of the following eight story characteristics: 

• Introduction : Scores are determined by the presence, absence, and 
qualitative depiction of character and setting components. 

• Theme: 

• Main Character : Scores are based on the acknowledgement of the main 
character and the significance of this character throughout the story. 

• Supporting Character(s) : Scores are based on the acknowledgement of the 
supporting characters and their significance throughout the story. 

• Conflict: Scores are based on the presence/absence of conflicts required to 
express the story as well as how thoroughly each is described. 

• Coherence : The sequencing of, details given to, and transitions between 
each event are examined. 

• Resolution: Scores are based on the presence/absence of 
resolutions required to express the story as well as how thoroughly each is 
described. 

• Conclusion : Scores are based on the conclusion of the final event as well as 
the wrap-up of the entire story. 

 

Helpful Scoring Tips 

• Be familiar with the story that has been narrated. It is recommended that the 
scorer have a copy of the story to reference while scoring. 

• Print the narrative transcript. 
• Read the transcript as fluidly/inclusively as possible, ignoring the codes. 
• Write comments and circle or flag key words/utterances. 
• For each characteristic, review the ONQ before assigning a score. Read the 

criteria along the continuum of points. Determine what is present in the 
transcript and score accordingly. This will insure intra- and inter-rater 
reliability. 

• The characteristics Conflict, Coherence, and-Resolution are story grammar 
elements which are distributed across the entire narrative. They do not occur 
at one static point within the story. The scoring of these characteristics must 
take into account the story as a whole. 
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• Application of scores for the characteristics of Conflict and Resolution (CR) is 
based on the presence of CRs necessary for telling a complete story as well as 
the clarity and richness in which these story elements are expressed. A child 
who is missing elemental conflicts and/or resolutions will receive 
proportionately lower scores than a child who narrates all conflicts and 
resolutions necessary for advancing that story. A child who expresses these 
CRs clearly and comprehensively receives proportionately higher scores than 
a child who narrates under-developed CRs. 

• Frequently review what constitutes a score of 0 or NA. Refer to the 
explanations given previously. 

• Proficiency in assigning scores will develop with experience. 

Using SALT to Enter ONQ Scores 
 

Use Edit menu → Insert Template → Oral Narrative Quality to insert the ONQ 
plus line template at the bottom of your transcript. Then type the individual 
scores after each label. 

 
 
 

 
 
 
 
 
 
 
 

Analyzing the ONQ Scores 
 

• Use the Analyze menu → Oral Narrative Quality report to list each 
individual ONQ score along with the composite score. 

 

• Use the Database menu → Oral Narrative Quality to list each individual 
ONQ score along with the composite score. Scores are listed for your 
transcript and, if available, for the selected database samples. 

ONQ Template Example of NSS Scoring 

+ Introduction:  
+ Theme:  
+ MainChar:  
+ SuppChar:  
+ Conflict:  
+ Coherence:  
+ Resolution:  
+ Conclusion:  

+ Introduction: 3 
+ Theme: 2 
+ MainChar: 5 
+ SuppChar: 1 
+ Conflict: 3 
+ Coherence: 3 
+ Resolution: 3 
+ Conclusion: 4 
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Oral Narrative Quality (ONQ) Rubric – Ana Gets Lost story 
 

Characteristic Content 
Proficient 
(5 points) 

Emerging 
(3 points) 

Minimal/ 
Immature 
(1 point) 

Introduction • Stay at home/ 
couldn’t go 

• Parents go out 

• Ana is sick 

• Brother looks 
after her 

Setting stated; 
At least 3 
setting points 
are mentioned. 

Setting stated 
minimally, i.e., 
no more than 2 
setting points 
are provided. 

Only 1 info 
point provided. 
Launches into 
the story with 
no attempt to 
provide setting 
or story theme. 

Theme Gets lost Story theme 
stated at the 
right moment in 
the story. 

Mentions “lost” 
in title or first 
sentence, not in 
story retell, or 
mentions at the 
end “don’t get 
lost again”.  

Says “can’t find 
them”. No story 
theme stated. 

Main 
Character 

Ana Main character 
introduced to 
listener by 
name in the 
first sentence. 
All further 
references are 
appropriate. 

“Ana” in title, 
later just “her” 
or a different 
name. Story 
does not start 
with Ana. E.g., 
“her parents go 
out. Ana is not 
allowed to 
go…..” 

Main character 
consistently 
referred to by 
pronoun. 
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Supporting 
Character/s 

• Mum and dad 

• big brother or 
(big) Brother 
Tom 

• A Policeman 

All supporting 
characters are 
mentioned. 
They are 
introduced 
appropriately. 
All further 
references are 
appropriate. 

No name for 
brother. Or just 
“Tom” and no 
explanation. 
Policeman 
introduced with 
The policeman. 
Parents 
introduced with 
“them”, later 
“mum and dad.” 

No mention of 
brother. 
Consistent use 
of The mum 
and dad OR 
Only 1 parent 
mentioned OR 
Parents not 
mentioned. No 
mention of 
police(man). 

Conflict Bored. Includes 
rationale for 
character’s 
behaviour. Ana 
goes out to find 
her parents 
because she is 
bored. Provides 
the relationship 
connecting 
events and 
actions. 

This can be 
implied: ”There 
was nothing to 
do/ no one to 
play with.” So, 
when Tom fell 
asleep, she 
went out...... 
Needs to be 
clear that Ana 
went out 
because she 
had nothing to 
do. 

Vague rationale 
or statement for 
the character’s 
behaviour. E.g., 
“asked brother 
to play, brother 
said no. When 
he fell asleep, 
she went out” 
Or “Ana 
wants/decides 
to go out.” 

No rationale for 
character’s 
behaviour. E.g,. 
“Asked her 
brother if he 
wanted to play. 
When he fell 
asleep she went 
out looking for 
mum and dad.” 
(It is not clear 
that the 
brother said no, 
or why she 
went out.) No 
mention that 
she wanted to 
play or was 
bored. 
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Coherence Critical Events: 
 

• Parents have 
gone out. 

• Leaves the 
house to look 
for mum and 
dad. 

• Gets lost /or/ 
not know what 
to do and cry 

• Policeman 
finds her 

• Policeman 
takes her 
home 

Events follow a 
logical order. All 
critical events 
are included. 
Smooth 
transitions 
provided 
between 
events. 

Events follow a 
logical order. 1 
critical event 
missing. Not 
clear why she 
left the house. 

Story is missing 
2 or more 
critical events. 
Events are 
provided in 
random order. 
Minimal or no 
connection 
between 
events. 
Transitions 
between events 
are lacking. 

Resolution Resolutions:  

• Home (safely) 

• Parents happy 
OR Parents 
thank the 
police. 

Clear resolution 
regarding 
characters, 
conflicts and 
events. Both 
resolutions are 
mentioned. 

One resolution 
provided for 
characters, 
conflicts or 
events. Only 
one mentioned. 
Or out of 
sequence.  

Poor resolution 
provided, some 
mention of the 
policeman. No 
resolution 
provided. 

Conclusion Endings:  
 

Policeman told 
her not to get 
lost again 
AND/OR 
Policeman drove 
away OR good 
alternative, e.g., 
“mother said she 
wouldn’t get lost 
again.” 

Smooth 
transition to 
conclusion. At 
least one 
“ending” is 
mentioned. 

Story finishes 
with parents are 
happy or 
policeman took 
her home (i.e., 
the 
resolution/s) 
without 
mentioning one 
of the endings. 

No conclusion is 
provided. Story 
stops halfway. 
Child stops 
talking and it’s 
not clear that 
that is the end 
of the story. 
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Guide to the SALT Variables  

 

Variables Included in the Standard Measures Report 
 

 Language Measure Description 
 Current Age Current age of speaker 

TRANSCRIPT LENGTH 

 Total Utterances Total number of utterances 

# C&I Verbal Utts 
(current analysis set)  

Number of utterances in the current analysis set 

 All Words Including Mazes 
Total number of completed words (excludes part 
words) 

 Elapsed Time Elapsed time in minutes 

INTELLIGIBILITY 

 
% Intelligible Utterances 
% Intelligible Words 

% of verbal utterances or words that do not contain 
unintelligible segments (excludes mazes) 

MACRO ANALYSIS 

 

NSS Composite Score 
ESS Composite Score 
PSS Composite Score 
ONQ Composite Score 

Included if the sample is a narrative, expository, or 
persuasion (defined by +Context: Nar, +Context: Expo, 
+Context: Pers) and the specific scoring scheme has 
been applied on plus lines in the transcript; 
composite score is the sum of the individual scores 

SYNTAX/MORPHOLOGY 

# MLU in Words 
MLU in Morphemes 

Mean length of utterances in words or morphemes 
(excludes mazes) 

# 
% Utterances with Verbs 
Mean Verbs per Utterance 

- percent of utterances which contain verbs 
- ratio of the number of verbs to the number of 
utterances 

(verbs are identified as either “Verbs” or “Copula 
Forms” using the Grammatical Category algorithm – 
only available for English samples) 
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# SI Composite Score 
Included only if the sample is coded for 
Subordination Index; composite score is the average 
of the individual scores 

SEMANTICS 

# 
Number Total Words 

(NTW) 
Total number of words (excludes mazes) 

# 
Number Different Words 

(NDW) 
Number of different word roots (excludes mazes) 

# 

Moving-Average NTW 
Moving-Average NDW 
Moving-Average Type-

Token Ratio (TTR) 

Estimates NDW using a moving window, e.g., for 
window size of 100 words, calculates NDW for words 
1–100, 2-101, 3-102, and so on to the end of the 
sample; final NDW is the average of the individual 
NDWs. NTW is the window size. TTR is the ratio of 
NDW to NTW.   

DISCOURSE (not included for narrative or expository samples) 

 
Mean Turn Length (utts) 
Mean Turn Length (words) 

Average number of consecutive utterances/words 
(excludes mazes) 

 
% Responses to Questions 
% Responses to Intonation 

Prompts 

% of another speaker's questions/intonation prompts 
that were responded to, where response is defined 
as an utterance from the target speaker immediately 
following the question or prompt 

 
% Utts with Overlapping 

Speech 
Number of utterances containing overlapping speech 

 
% Utts Interrupted Other 

Speaker 
Number of times target speaker interrupted another 
speaker 

VERBAL FACILITY 

 Words/Minute 
Ratio of all words produced to the elapsed time 
(excludes part words) 

 
Pause Time as % of Total 

Time 
% of elapsed time that consists of pause time 

# 
Maze Words as % of Total 

Words 
% of total words that are in mazes 

 % Abandoned Utterances % of total utterances that were abandoned 

ERRORS 

# % Utterances with Errors % of utts which contain omissions or error codes 

 Number of Omissions Number of omitted words or bound morphemes 

 Number of Error Codes Number of words or utterances coded as errors 

  # Measures based on the C&I Verbal Utts (current analysis set)  
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Follow-up reports based on results of the Standard Measures Report 
 

When one or more measures on the Standard Measures Report indicates the 
need for more detailed information, use the Analyze and Database menus to 
support your findings. Below are suggestions for where to look further. 

 

 Language Measure Additional Reports/Comments 

 • Current Age  

TRANSCRIPT LENGTH 

 
# 

 
 

• Total Utterances 

• C&I Verbal Utts  

• All Words Including Mazes 

• Elapsed Time 

• Read the transcript 

• Analyze menu: Summary of Utterance Types 

• Analyze quality of narratives by applying 
NSS/ESS/PSS/ONQ coding (see MACRO ANALYSIS 
section) 

INTELLIGIBILITY 

 
• % Intelligible Utterances 

• % Intelligible Words 

• Listen to the audio to determine if unintelligibility 
is due to the client’s speech production, or 
whether it is due to equipment and/or 
environment  

• Analyze menu: Standard Utterance Lists 
(select unintelligible & partly intelligible) 

• Database menu: Transcript Length & Intelligibility  

MACRO ANALYSIS 

 

• NSS Composite Score 

• ESS Composite Score 

• PSS Composite Score 

• ONQ Composite Score 

• Analyze/Database menus: Narrative Scoring 
Scheme 

• Analyze/Database menus: Expository Scoring 
Scheme 

• Analyze/Database menus: Persuasion Scoring 
Scheme 

• Analyze/Database menus: Oral Narrative Quality 
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SYNTAX/MORPHOLOGY 

# 
# 
# 
# 

• MLU in Words 

• MLU in Morphemes 

• % Utterances with Verbs 

• Mean Verbs per Utterance 

• Analyze/Database menus: Syntax/Morphology 
Summary 

• Analyze/Database menus: Utterance Distribution 
Tables 

• Analyze menu: Bound Morpheme Tables (expand 
if desired) 

• Apply Subordination Index (SI) coding 

# • SI Composite Score • Analyze/Database menus: Subordination Index 

SEMANTICS 

# 
 
# 
 
# 
# 
# 
 

• Number Total Words 
(NTW) 

• Number Different Words 
(NDW) 

• Moving-Average NTW 

• Moving-Average NDW 

• Moving-Average Type-
Token Ratio (TTR) 

• Analyze/Database menus: Semantics Summary 

• Analyze menu: Word Root Tables 
(expand if desired) 

• Analyze menu: Standard Word Lists 
(specify which to view) 

• Analyze/Database menus: Grammatical 
Categories (English only) 

• Analyze menu: Grammatical Category Lists 
(English only) 

DISCOURSE (not included for narrative, expository, or persuasion samples) 

 

• Mean Turn Length 
(utterances) 

• Mean Turn Length (words) 

• % Responses to Questions 

• % Responses to Intonation 
Prompts 

• % Utts with Overlapping 
Speech 

• % Utts Interrupted Other 
Speaker 

• Analyze/Database menus: Discourse Summary 

• Analyze/Database menus: Turn Length 
Distribution Tables 

• Analyze menu: Standard Utterance Lists 

(select 2nd speaker questions and/or intonation 

prompts and look at following entries; select 

utterances with overlapping speech; select 2nd 

speaker interrupted utterances and look at 

following entries) 
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VERBAL FACILITY AND RATE 

 
 
# 
 
 

• Words/Minute 

• Pause Time as % of Total Time 

• Maze Words as % of Total 
Words 

• % Abandoned Utterances 

• Analyze/Database menus: Verbal Facility 
Summary 

• Analyze menu: Standard Utterance Lists 
(select utterances with pauses, utterances with 
mazes, and/or abandoned utterances)  

• Analyze menu: Fluency Codes and Behaviors 
(if sample was coded for fluency) 

ERRORS 

 
 
 

• % Utterances with Errors 

• Number of Omissions 

• Number of Error Codes 

• Analyze/Database menus: Errors Summary 

• Analyze menu: Omissions and Error Codes 
(look for patterns) 

• Analyze menu: Code Summary 

• Analyze menu: Word Code Tables 

• Analyze menu: Utterance Code Tables 

• Analyze menu: Standard Utterance Lists 
(select utterances with omissions, error codes) 

 



 

 

  
 



 

 

APPENDIX 

U 
 

Using SALT to Assess the Common Core 
Grades K-12   

 

Contributed by  
Karen Andriacchi, M.S., CCC-SLP, 
Mary-Beth Rolland, M.S., CCC-SLP 
Joyelle Divall-Rayan, M.S., CCC-SLP 

 
Below are suggested SALT elicitation protocol, language measures, and reports 
to document selected English Language Arts Standards in the category of 
Speaking and Listening state standards in literacy for grades Kindergarten 
through 12th grade (Common Core State Standards Initiative, 2015). 
 

Kindergarten 

State Standard - Kindergarten 
Elicitation 
Protocol 

SALT Measures/Reports to 
Document Standard 

CCSS.ELA-
Literacy.SL.K 
Comprehension 
and 
Collaboration 

SL.K.1 Participate in 
conversations about 
kindergarten topics; 
listening to others and 
taking turns about the 
topic; continuing 
through multiple 
exchanges 

• Play 

• Conversation 

• Discourse Summary: 
% response to questions, 
mean turn length, 
utterances with overlaps, 
interrupted other speaker 

SL.K.3 Ask and answer 
questions to seek help, 
get info, or clarify 

• Play 

• Conversation 

• Discourse Summary: 
     % response to questions 

• Grammatical Categories: 
question words 

• Standard Utterance Lists: 
questions 



426  Assessing Language Production Using SALT Software  

 

State Standard - Kindergarten 
Elicitation 
Protocol 

SALT Measures/Reports to 
Document Standard 

CCSS.ELA-
Literacy.SL.K 
Presentation of 
Knowledge and 
Ideas 

SL.K.4 Describe familiar 
people, places, things, 
and events and, with 
prompting and support, 
provide additional detail 
 

• Play  

• Conversation 

• Narrative 
SSS  

 

• Standard Measures Report: 
number different words 

• Standard Word Lists 

• Grammatical Categories: 
adjectives, adverbs 

• Discourse Summary: 
questions and prompts 

• Standard Utterance Lists: 
responses, in context w/ 
utterances pre and post 

SL.K.6 Speaks audibly 
and expresses thoughts, 
feelings, and ideas 
clearly 

• Play  

• Conversation 

• Narrative 
SSS  

 

• Standard Measures Report: 
% Intelligible utterances, 
words/minute, % maze 
words, and abandoned 
utterances 

 
1st Grade 

State Standard – 1st Grade 
Elicitation 
Protocol 

SALT Measures/Reports to 
Document Standard 

CCSS.ELA-
Literacy.SL.1 
Comprehension 
and 
Collaboration 

SL.1.1 Participates in 
conversations about 1st 
grade topics; listening to 
others and taking turns 
about the topic; 
continuing via multiple 
exchanges; requests for 
clarification when 
needed. 

• Conversation 
 
 

• Discourse Summary: 
% response to questions, 
mean turn length, 
utterances with overlaps, 
interrupted other speaker 

SL.1.3 Ask and answer 
questions to gain info or 
clarify. 

• Conversation • Discourse Summary: 
      % response to questions 

• Grammatical Categories: 
question words 

• Standard Utterance Lists: 
questions 
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State Standard – 1st Grade 
Elicitation 
Protocol 

SALT Measures/Reports to 
Document Standard 

CCSS.ELA-
Literacy.SL.1 
Presentation of 
Knowledge and 
Ideas 

SL.1.4 Describe people, 
places, things, and 
events with relevant 
details, expressing ideas 
and feelings clearly. 
 
 

• Conversation 

• Narrative 
SSS 

• Narrative 
Story Retell 

 

• Standard Measures 
Report: number different 
words, % intelligibility, 
words/minute, % maze 
words, and abandoned 
utterances 

• Verbal Facility Summary 

• Standard Word Lists 

• Grammatical Categories: 
adjectives, adverbs, 
existentials, intensifiers 

• Discourse Summary: 
questions and prompts 

• Standard Utterance Lists: 
responses, in context w/ 
utterances pre and post 

SL.1.6 Produce complete 
sentences when 
appropriate to task and 
situation. 

• Conversation 

• Narrative 
SSS 

• Narrative 
Story Retell 

• Standard Measures 
Report; Analysis Set 
utterances: MLUw, MLUm 

• Subordination Index 

 
2nd Grade 

State Standard – 2nd Grade 
Elicitation 
Protocol 

SALT Measures/Reports to 
Document Standard 

CCSS.ELA-
Literacy.SL.2 
Comprehension 
and 
Collaboration 

SL.2.1 Participates in 
conversations about 
grade 2 topics; gaining 
the floor respectfully, 
with topic-appropriate 
turn-taking. 

• Conversation 
 
 

• Discourse Summary: 
% response to questions, 
mean turn length, 
utterances with overlaps, 
interrupted other speaker 

SL.2.1c Ask for 
clarification and further 
explanation as needed. 
 

• Conversation 
 

• Discourse Summary 

• Grammatical Categories: 
question words 

• Standard Utterance Lists: 
questions, responses to 
questions… 
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State Standard – 2nd Grade 
Elicitation 
Protocol 

SALT Measures/Reports to 
Document Standard 

SL.2.2 Recount or 
describe key ideas or 
details from a text read 
aloud or through other 
media. 

• Narrative 
Story Retell 

 

• NSS 

• Grammatical Categories: 
adjectives, adverbs, 
interjections, intensifiers… 

SL.2.3 Ask and answer 
questions about what a 
speaker says in order to 
clarify comprehension, 
gather additional 
information, or deepen 
understanding of 
topic/issue. 

• Conversation • Discourse Summary 

• Grammatical Categories: 
question words 

• Standard Utterance Lists: 
questions, responses to 
questions, yes/no responses 
to questions, responses to 
intonation prompts 

CCSS.ELA-
Literacy.SL.2 
Presentation of 
Knowledge and 
Ideas 

SL.2.4 Tell a story or 
recount an experience 
with appropriate facts, 
relevant descriptive 
details, using coherent 
sentences. 
 

• Narrative 
SSS 

• Narrative 
Story Retell 

 

• NSS 

• Grammatical Categories: 
adjectives, adverbs, 
prepositions… 

• SI 

• Standard Measures Report: 
MLU, NDW, abandoned 
utterances 

• Verbal Facility Summary 

SL.2.5 Create audio 
recordings of stories…or 
recounting experiences 
when appropriate to 
clarify ideas, thoughts, 
and feelings. 

• Narrative 
SSS 

• Narrative 
Story Retell 

• NSS 

SL.2.6 Produce complete 
sentences when 
appropriate to task in 
order to provide 
requested detail or 
clarification. 

• Conversation 

• Narrative 
SSS 

• Narrative 
Story Retell 

• Standard Measures Report: 
MLU, abandoned utts.  

• Subordination Index 

• Standard Utterance Lists: 
responses to questions, 
yes/no responses to 
questions, responses to 
intonation prompts 

• NSS 
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3rd Grade 

State Standard – 3rd Grade 
Elicitation 
Protocol 

SALT Measures/Reports to 
Document Standard 

CCSS.ELA-
Literacy.SL.3 
Comprehension 
and 
Collaboration 

SL.3.1 Engage effectively 
in collaborative 
discussions (one on 
one); on grade three 
topics, building on 
others’ ideas, expressing 
ideas clearly. 

• Conversation 
 
 

• Standard Measures Report: 
% intelligibility, % pause 
time, % maze words, and 
abandoned utterances 

• Verbal Facility Summary 

• Discourse Summary 

SL.3.1b Follow rules of 
discourse. 

• Conversation 
 

• Discourse Summary: 
% response to questions, 
mean turn length, 
utterances with overlaps, 
interrupted other speaker 

SL.3.1c Ask questions to 
check understanding of 
information presented 
and stay on topic. 

• Conversation 
 

• Discourse Summary 

• Grammatical Categories: 
question words 

• Standard Utterance Lists: 
questions 

SL.3.2 Determine the 
main ideas and 
supporting details of a 
text read aloud or 
information presented 
in diverse media and 
formats, including 
visually, quantitatively, 
and orally. 

• Narrative 
Story Retell 

 

• NSS 
 

CCSS.ELA-
Literacy.SL.3 
Presentation of 
Knowledge and 
Ideas 

SL.3.4 Tell a story, or 
recount an experience 
with appropriate facts, 
and relevant descriptive 
details, speaking clearly, 
at an understandable 
pace. 

• Narrative 
SSS 

• Narrative 
Story Retell 

 

• NSS 

• Grammatical Categories: 
adverbs, adjectives, 
prepositions, existentials, 
intensifiers… 

• Standard Measures Report: 
NDW, % Intelligibility, 
% pause time, % maze 
words, abandoned 
utterances, words/minute, 
omissions, and errors 

• Verbal Facility Summary 

• Errors Summary 
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State Standard – 3rd Grade 
Elicitation 
Protocol 

SALT Measures/Reports to 
Document Standard 

SL.3.6 Speak in 
complete sentences 
when appropriate to 
task/situation in order 
to provide requested 
detail or clarification. 

• Conversation 

• Narrative 
NSS 

• Narrative 
Story Retell 

• Standard Measures Report: 
abandoned utterances  

• Subordination Index 

• Standard Utterance Lists: 
responses to questions, 
yes/no responses to 
questions, responses to 
intonation prompts 

 
4th Grade 

State Standard – 4th Grade 
Elicitation 
Protocol 

SALT Measures/Reports to 
Document Standard 

CCSS.ELA-
Literacy.SL.4 
Comprehension 
and 
Collaboration 

SL.4.1 Engage effectively 
in collaborative 
discussions (one on one); 
on grade four topics, 
building on others’ ideas, 
expressing ideas clearly. 

• Conversation 
 
 

• Standard Measures Report: 
% intelligibility, % pause 
time, % maze words, and 
abandoned utterances 

• Verbal Facility Summary 

• Discourse Summary 

SL.4.1b Follow rules of 
discourse. 
 

• Conversation 
 

• Discourse Summary: 
% response to questions, 
mean turn length, 
utterances with overlaps, 
interrupted other speaker 

SL.4.1c Pose and respond 
to questions to clarify or 
follow-up on 
information, and make 
comments that 
contribute to the 
discussion, link to the 
remarks of others. 

• Conversation 
 

• Discourse Summary 

• Grammatical Categories: 
question words 

• Standard Utterance Lists: 
questions, responses to 
questions, yes/no responses 
to questions, responses to 
intonation prompts (with 
context pre/post) 
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State Standard – 4th Grade 
Elicitation 
Protocol 

SALT Measures/Reports to 
Document Standard 

SL.4.2 Paraphrase 
portions of a text read 
aloud or information 
presented in diverse 
media and formats, 
including visually, 
quantitatively, and orally. 

• Narrative 
Story Retell 

 

• NSS 

CCSS.ELA-
Literacy.SL.4 
Presentation of 
Knowledge and 
Ideas 

SL.4.4 Tell a story or 
recount an experience in 
an organized manner, 
using appropriate facts, 
and relevant descriptive 
details to support main 
ideas or themes; speak 
clearly, at an 
understandable pace. 
 

• Narrative 
SSS 

• Narrative 
Story Retell 

• Exposition 

• NSS 

• ESS 

• Grammatical Categories: 
adverbs, adjectives, 
prepositions, existentials, 
intensifiers… 

• Standard Measures Report: 
NDW, % Intelligibility, 
% pause time, % maze 
words, abandoned 
utterances, words/minute, 
pauses, omissions, and 
errors 

• Verbal Facility Summary: 
pause summary  

• Errors Summary 

 
5th Grade 

State Standard – 5th Grade 
Elicitation 
Protocol 

SALT Measures/Reports to 
Document Standard 

CCSS.ELA-
Literacy.SL.5 
Comprehension 
and 
Collaboration 

SL.5.1 Engage effectively 
in collaborative 
discussions (one on one, 
and teacher-led); on 
grade five topics, building 
on others’ ideas, 
expressing ideas clearly. 

• Conversation 
 

• Standard Measures Report: 
% intelligibility, mazes and 
abandoned utterances 

• Discourse Summary 

• Verbal Facility Summary 

SL.5.1b Follow rules of 
discussions/discourse. 
 

• Conversation 
 

• Discourse Summary: 
% response to questions, 
mean turn length, 
utterances with overlaps, 
interrupted other speaker 
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State Standard – 5th Grade 
Elicitation 
Protocol 

SALT Measures/Reports to 
Document Standard 

SL.5.1c Pose and respond 
to questions, make 
comments that 
contribute to the 
discussion, elaborate on 
the remarks of others. 

• Conversation 

• Persuasion 

• Discourse Summary 

• Grammatical Categories: 
question words 

• Standard Utterance Lists: 
questions, responses to 
questions, yes/no 
responses to questions, 
responses to intonation 
prompts (with context 
pre/post) 

CCSS.ELA-
Literacy.SL.5 
Presentation of 
Knowledge and 
Ideas 

SL.5.4 Report on a topic 
or text, or present an 
opinion, sequencing 
ideas logically and using 
appropriate facts and 
relevant descriptive 
details to support main 
ideas or themes. Speak 
clearly at an 
understandable pace. 

• Persuasion  

• Narrative 
SSS (from 
text 
previously 
read or 
heard) 

• Narrative 
Story Retell 

• Exposition 

• PSS 

• NSS 

• ESS 

• Grammatical Categories: 
adverbs, adjectives, 
prepositions, existentials, 
intensifiers… 

• NSS 

• Standard Measures Report: 
NDW, % Intelligibility, 
words/minute, % pause 
time, % maze words, 
abandoned utterances, 
omissions and errors 

• Verbal Facility Summary 

• Errors Summary 

 
6th Grade 

State Standard – 6th Grade 
Elicitation 
Protocol 

SALT Measures/Reports to 
Document Standard 

CCSS.ELA-
Literacy.SL.6 
Comprehension 
and 
Collaboration 

S.L.6.1 Engage effectively 
in a range of 
collaborative discussions 
(one-on-one, and 
teacher-led) with diverse 
partners on grade 6 
topics, texts, and issues, 
building on others’ ideas 
and expressing their own 
clearly. 

• Conversation • Standard Measures Report: 
% intelligibility, % maze 
words, and abandoned 
utterances 

• Discourse Summary 

• Verbal Facility Summary 
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State Standard – 6th Grade 
Elicitation 
Protocol 

SALT Measures/Reports to 
Document Standard 

S.L.6.1b Follow rules for 
collegial discussions 
(pragmatics/discourse). 

• Conversation • Discourse Summary: 
% response to questions, 
mean turn length, 
utterances with overlaps, 
interrupted other speaker 

S.L.6.1c Pose and 
respond to specific 
questions with 
elaboration and detail by 
making comments that 
contribute to the topic, 
text, or issue under 
discussion. 

• Conversation 

• Persuasion 

• Discourse Summary 

• Grammatical Categories: 
question words 

• Standard Utterance Lists: 
questions, responses to 
questions, yes/no 
responses to questions, 
responses to intonation 
prompts (with context 
pre/post) 

CCSS.ELA-
Literacy.SL.6 
Presentation of 
Knowledge and 
Ideas 

S.L.6.4 Present claims 
and findings, sequencing 
ideas logically and using 
pertinent descriptions, 
facts, and details to 
accentuate main ideas or 
themes; use appropriate 
eye contact, adequate 
volume, and clear 
pronunciation. 
 
 
 

• Persuasion 
 

• PSS 

• Standard Measures Report: 
% intelligibility 

 

S.L.6.6 Adapt speech to a 
variety of contexts and 
tasks, demonstrating 
command of formal 
English when indicated or 
appropriate. 

• Compare 
Conversation 
to Narrative 
Story Retell 
or Exposition 

• Clinical Impressions 

• SI 

• NSS/ESS 
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7th Grade 

State Standard – 7th Grade 
Elicitation 
Protocol 

SALT Measures/Reports to 
Document Standard 

CCSS.ELA-
Literacy.SL.7 
Comprehension 
and 
Collaboration 

S.L.7.1 Engage effectively 
in a range of 
collaborative discussions 
(one-on-one and 
teacher-led) with diverse 
partners on grade 7 
topics, texts, and issues, 
building on others’ ideas 
and expressing their own 
clearly. 

• Conversation • Standard Measures Report: 
% intelligibility, % maze 
words, and abandoned 
utterances 

• Discourse Summary 

• Verbal Facility Summary 
 

SL.7.1b Follow rules for 
collegial discussions. 

• Conversation • Discourse Summary: 
% response to questions, 
mean turn length, 
utterances with overlaps, 
interrupted other speaker 

SL.7.1c Pose questions 
that elicit elaboration 
and respond to others’ 
questions and comments 
with relevant 
observations and ideas 
that bring the discussion 
back on topic as needed. 

• Conversation 

• Persuasion 
 

• Discourse Summary 

• Grammatical Categories: 
question words 

• Standard Utterance Lists: 
questions, responses to 
questions, yes/no responses 
to questions, responses to 
intonation prompts (with 
context pre/post) 

SL.7.1d Acknowledge 
new information 
expressed by others and, 
when warranted, modify 
their own views. 

• Persuasion • PSS 
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State Standard – 7th Grade 
Elicitation 
Protocol 

SALT Measures/Reports to 
Document Standard 

CCSS.ELA-
Literacy.SL.7 
Presentation of 
Knowledge and 
Ideas 

SL.7.4 Present claims and 
findings, emphasizing 
salient points in a 
focused, coherent 
manner with pertinent 
descriptions, facts, 
details, and examples; 
use appropriate eye 
contact, adequate 
volume, and clear 
pronunciation. 

• Persuasion • PSS 

• Standard Measures Report: 
% intelligibility, % maze 
words, abandoned 
utterances 

SL.7.6 Adapt speech to a 
variety of contexts and 
tasks, demonstrating 
command of formal 
English when indicated 
or appropriate. 

• Compare 
Conversation 
to Narrative 
SSS or 
Exposition 

• Clinical Impressions 

• SI 

• ESS 

 
8th Grade 

State Standard – 8th Grade 
Elicitation 
Protocol 

SALT Measures/Reports to 
Document Standard 

CCSS.ELA-
Literacy.SL.8 
Comprehension 
and 
Collaboration 

SL.8.1 Engage effectively 
in a range of 
collaborative discussions 
(one-on-one and 
teacher-led) with diverse 
partners on grade 8 
topics, texts, and issues, 
building on others’ ideas 
and expressing their own 
clearly. 

• Conversation • Standard Measures Report: 
% intelligibility, % maze 
words, and abandoned 
utterances 

• Discourse Summary 

• Verbal Facility Summary 
 

SL.8.1b Follow rules for 
collegial discussions. 

• Conversation • Discourse Summary: 
% response to questions, 
mean turn length, 
utterances with overlaps, 
interrupted other speaker 
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State Standard – 8th Grade 
Elicitation 
Protocol 

SALT Measures/Reports to 
Document Standard 

SL.8.1c Pose questions 
connect the ideas of 
other speakers and 
respond to others’ 
questions and comments 
with relevant evidence, 
observations, and ideas. 

• Conversation 

• Persuasion 
 

• Discourse Summary 

• Grammatical Categories: 
question words 

• Standard Utterance Lists: 
questions, responses to 
questions, yes/no responses 
to questions, responses to 
intonation prompts (with 
context pre/post) 

• PSS 

SL.8.1d Acknowledge 
new information 
expressed by others, 
and, when warranted, 
qualify or justify their 
own views in light of the 
evidence presented. 

• Persuasion • PSS 

CCSS.ELA-
Literacy.SL.8 
Presentation of 
Knowledge and 
Ideas 

SL.8.4 Present claims and 
findings, emphasizing 
salient points in a 
focused, coherent 
manner with relevant 
evidence, sound valid 
reasoning, and well-
chosen details; use 
appropriate eye contact, 
adequate volume, and 
clear pronunciation. 

• Persuasion • PSS 

• Standard Measures Report: 
% intelligibility, % maze 
words, abandoned 
utterances  

• Verbal Facility Summary 

SL.8.6 Adapt speech to a 
variety of contexts and 
tasks, demonstrating 
command of formal 
English when indicated 
or appropriate. 

• Compare 
Conversation 
to Exposition 

• Clinical Impressions 

• SI 

• ESS 
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9th and 10th Grade 

State Standard – 9th and 10th Grade 
Elicitation 
Protocol 

SALT Measures/Reports to 
Document Standard 

CCSS.ELA-
Literacy. 
SL.9-10 
Comprehension 
and 
Collaboration 

SL.9-10.1 Initiate and 
participate effectively in a 
range of collaborative 
discussions (one-on-one, 
and teacher-led) with 
diverse partners on 
grades 9–10 topics, texts, 
and issues, building on 
others’ ideas and 
expressing their own 
clearly and persuasively. 

• Conversation 

• Persuasion 
 

• Standard Measures Report: 
% intelligibility, % maze 
words, and abandoned 
utterances 

• Discourse Summary 

• Verbal Facility Summary 

• PSS 

SL.9-10.1c 
Propel conversations by 
posing and responding to 
questions that relate the 
current discussion to 
broader themes or larger 
ideas; actively 
incorporate others into 
the discussion; and 
clarify, verify, or challenge 
ideas and conclusions. 

• Conversation 

• Persuasion 
 

• Discourse Summary 

• PSS 

SL.9-10.1d 
Respond thoughtfully to 
diverse perspectives, 
summarize points of 
agreement and 
disagreement, and, when 
warranted, qualify or 
justify their own views 
and understanding and 
make new connections in 
light of the evidence and 
reasoning presented. 

• Persuasion • PSS 
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State Standard – 9th and 10th Grade 
Elicitation 
Protocol 

SALT Measures/Reports to 
Document Standard 

CCSS.ELA-
Literacy. 
SL.9-10 
Presentation of 
Knowledge and 
Ideas 

9-10.4 Present 
information, findings, and 
supporting evidence 
clearly, concisely, and 
logically such that 
listeners can follow the 
line of reasoning and the 
organization, 
development, substance, 
and style are appropriate 
to purpose, audience, and 
task. 

• Exposition 

• Persuasion 
 

• ESS 

• PSS 

• Standard Measures Report: 
% intelligibility, % maze 
words, abandoned 
utterances, omissions, and 
errors 

• Verbal Facility Summary 

• Errors Summary 
 

9-10.6 Adapt speech to a 
variety of contexts and 
tasks, demonstrating 
command of formal 
English when indicated or 
appropriate. 

• Compare 
Conversation 
to Exposition 
or 
Persuasion 

• Clinical Impressions 

• SI 

• ESS 

• PSS 

 
11th and 12th Grade 

State Standard – 11th and 12th Grade 
Elicitation 
Protocol 

SALT Measures/Reports to 
Document Standard 

CCSS.ELA-
Literacy. 
SL.11-12 
Comprehensio
n and 
Collaboration 

SL.11-12.1 Initiate and 
participate effectively in a 
range of collaborative 
discussions (one-on-one, 
in groups, and teacher-
led) with diverse partners 
on grades 11–12 topics, 
texts, and issues, building 
on others’ ideas and 
expressing their own 
clearly and persuasively.  

• Conversation 

• Persuasion 
 

• Standard Measures Report: 
% intelligibility, % maze 
words, and abandoned 
utterances 

• Discourse Summary 

• Verbal Facility Summary 

• PSS 

11-12.1c Propel 
conversations by posing 
and responding to 
questions that probe 
reasoning and evidence; 
ensure a hearing for a full 
range of positions on a 

• Persuasion • PSS (planning sheet) 
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State Standard – 11th and 12th Grade 
Elicitation 
Protocol 

SALT Measures/Reports to 
Document Standard 

topic or issue; clarify, 
verify, or challenge ideas 
and conclusions; and 
promote divergent and 
creative perspectives. 

11-12.1d Respond 
thoughtfully to diverse 
perspectives, synthesize 
comments, claims, and 
evidence made on all 
sides of an issue; resolve 
contradictions when 
possible; and determine 
what additional 
information or research is 
required to deepen the 
investigation or complete 
the task. 

• Persuasion • PSS (planning sheet) 
 

CCSS.ELA-
Literacy. 
SL.11-12 
Presentation of 
Knowledge and 
Ideas 

SL.11-12.4 Present 
information, findings, and 
supporting evidence, 
conveying a clear and 
distinct perspective, such 
that listeners can follow 
the line of reasoning, 
alternative or opposing 
perspectives are 
addressed, and the 
organization, 
development, substance, 
and style are appropriate 
to purpose, audience, and 
a range of formal and 
informal tasks. 

• Persuasion • PSS (planning sheet) 

SL.11-12.6 Adapt speech 
to a variety of contexts 
and tasks, demonstrating 
command of formal 
English when indicated or 
appropriate. 

• Compare 
Conversation 
to 
Persuasion 

• Clinical Impressions 

• SI 

• PSS 
 



 

 



 

 

APPENDIX 

V 
 

Understanding SALT Measures: Standard 
Deviation 
 
Originally posted as a SALT blog on October 10, 2018 
 

So there is this odd thing that happens once 
in a while when you are using SALT: a 
measure comes back with a seemingly 
nonsensical standard deviation (SD) value. 
We’ve seen them come in as low as 21 SDs 
below the mean. And it’s not a mistake.  

 
Why does this happen? Is there anything valuable you can learn from this 
result? How can you report this result (for example on an IEP report) in a 
meaningful way? 
 
Ok, so a quick refresher on the concept of standard deviations. Standard 
deviation is roughly: the amount of difference you might expect to see between 
scores. 
 
*Not interested in the stats? You can skip this section if you want. We get back 
to speech and language stuff below. 
 
___________________ 
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The statistical formula used to calculate standard deviations looks like this: 
 

You don’t really need to understand 
this formula for our purposes. The 
point is this: standard deviation is 
basically the average variation in your 
data. 
 
Imagine I’m measuring the height of 
patients in my women’s clinic. I might 
find that they range from 53 to 74 
inches, with an average of 63.8 inches 
and a standard deviation of 3.5 
inches. What does that mean? Well, the average woman will be 63.8 inches tall, 
but anywhere between 60.3 and 67.3 inches is pretty standard. 
 
And what does “pretty 
standard” mean in this 
context? That’s the joy of the 
standard deviation: by the 
magic of math, 68.3% of the 
observations in our normally-
distributed data are always 
within 1 standard deviation 
above or below the mean. In 
turn, 2 standard deviations 
contain 95.4% of the observed 
data, and 3 standard 
deviations contain 99.7% of 
the observed data. In our 
height example, 1 standard deviation = 3.5 inches. So, 68.3% of the women in 
our data are between 60.3 and 67.3 inches. And the inverse also holds: if 68.3% 
of women are within 1 standard deviation, then 31.7% are further out (in the 
“tails” of the distribution), half (15.9%) above and half below the mean.  
 

Illustration from: Statistics in Plain 
English, 4th Ed. (Urdan, 2017) 
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But we can also turn the standard deviation around and use it as a standardized 
unit of measure to describe individual data points. This is called the Z-score and 
it is defined as the number of standard deviations a given data observation lies 
away from the mean. On SALT reports you will see the Z-score labeled as “+/- 
SD.” 
 
So what if a woman walked into my clinic who was exactly 1 standard deviation 
above the mean? Well, she would be 67.3 inches tall, 15.9% of women in the 
clinic would be taller than her, and the rest of the women (84.1%) would be 
shorter.  
  
But what if I pulled a women’s file from my records at random? Without 
opening the file, how likely is it that this woman is taller than 67.3 inches? Well, 
it’s not a very good bet: only a 15.9% chance. 
 
Finally, imagine we find a misplaced file in the hallway, right between our clinic 
and the men’s basketball clinic next door. We look at the file and see that the 
person’s height is 74.3 inches. Without knowing anything else about this 
individual, we can say that he or she is exactly 3 SDs above the norm for women 
in my clinic. So how likely is it that this file belongs to my clinic? Well, recall that 
3 SDs contains 99.7% of the observed data and the remaining 0.3% is split 
between the upper and lower tails of the distribution. This means that one of 
my clients, chosen at random, would have only a 0.15% chance of being that 
tall, so maybe we better check next door first. 
 
And that is what standard deviation and the Z-score really have to tell us: the 
likelihood that a randomly-selected member of the population from which our 
sample is drawn would have a result at least as extreme as the one we are 
observing in this case. 
 
So, what do I want you to take away from this example? Three things: 

• You need to know who the sample population is. 
• Standard deviation depends on the variation in your sample population. 
• Standard deviation measures the likelihood that a randomly-selected 

member of the sample population would have a result at least as 
extreme as the one we are observing in this case. 
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Standard 
Deviation 
(SD) 

Percent of scores 
that are within 
this many SDs 
(above or below) 
the norm 

Percent of scores that are 
NOT within this many SDs 
(above or below) the norm, 
i.e., percent of scores 
which are more than this 
many SDs either above or 
below norm. 

Percent of scores 
which are more than 
this many SDs above 
the norm OR below 
the norm, but not 
both above and 
below. 

1 68.3% 31.7% 15.85% 

2 95.4% 4.6% 2.30% 

3 99.7% 0.3% 0.15% 

 
(A nifty calculator for calculating probability given the +/- standard deviation 
(aka: Z-score) can be found here: https://measuringu.com/pcalcz/) 
 
___________________ 
 
Now let’s bring it back to speech and language pathology. 
 
So, what’s happening when SALT returns ridiculously extreme +/- SD scores? To 
illustrate, I’ll use an example of one SALT measure where this happens most 
often: intelligibility. And the key to understanding why this happens is to look at 
1) who the sample population is, and 2) how much variation there is in the 
results. 
 
First, the sample population. The students sampled in the SALT databases are 
typically developing, the samples were elicited by experienced SLPs in a quiet 
area using good recording equipment, and the samples were transcribed by 
professional SALT transcribers. These are near-perfect circumstances for getting 
high intelligibility scores. For example, in the SALT Narrative Story 
Retell database, an average of 98.9% of utterances from 10-year-olds have no 
unintelligible segments. 
 
Second, the variation. There is very little variation in the number of intelligible 
utterances found in the database samples; the results are clustered in a very 
small range. For 10-year-olds in the Narrative Story Retell database, scores 

https://measuringu.com/pcalcz/
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range from 93.75% to 100% intelligible. This small variation results in a small 
standard deviation value. So even seemingly minor deviations from the mean 
can result in very high +/- SD scores. 
 
The real takeaway here is that you may have clients who have low intelligibility 
scores and thus have very high standard deviations from the SALT database 
norms. But is this a meaningful result? That really depends on what question 
you are asking. Remember, what SALT’s +/- SD for intelligibility really measures 
is: the likelihood that a typically-developing speaker under near-perfect 
sampling conditions would randomly produce the observed amount of 
intelligible utterances. 
 
In determining whether or not a client has a speech sound disorder, this can be 
a meaningful bit of information. If your client’s transcript was 21 standard 
deviations below the norm, for example, the answer is: it is very, very, very 
unlikely (the actual probability is beyond most calculators’ ability to display 
correctly) that a typically-developing speaker would have this result. 
 
But if the question you want to ask is: ‘how big a problem does this speaker 
have?’ then, no, the standard deviations do not really tell you very much at all. 
It is SO tempting to say that if your client’s result is that extreme, then their 
problem must be that extreme as well. But it just doesn’t work that way 
because the very high number of +/- SDs is just a result of the limited variability 
of this measure found in the database samples collected from typically-
developing speakers. 
 
So what should you put in your report? Well, you can present this information 
as strong evidence of the existence of a speech sound disorder. But take care 
when including the +/- SD value. Remember, by definition approximately 99.7% 
of the sample data lies within 3 standard deviations from the mean. Reporting 
anything beyond +/- 3 SDs may improve accuracy, but it does not add much 
meaning to your report and may confuse your audience (unless, of course, they 
too read this blog). This is why the text-based Performance Report, introduced 
with SALT 18, now reports +/- SD scores greater than 3 as “more than 3 SDs” 
rather than using the calculated SD values. That way, the result is highlighted as 
significant, but doesn’t look ridiculously extreme. 
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